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Control4 Disclaimer 
Control4® makes no representations or warranties with respect to this publication, and specifically disclaims 
any express or implied warranties of merchantability or fitness for any particular purpose. Control4 reserves 
the right to make changes to any and all parts of this publication at any time, without any obligation to notify 
any person or entity of such changes. 

Trademarks 
Control4 and the Control4 logo are registered trademarks of Control4 Corporation. Other product and 
company names mentioned in this document may be the trademarks or registered trademarks of their 
respective owners. 

Legal Notice 
GNU 
GNU GENERAL PUBLIC LICENSE TERMS AND CONDITIONS FOR COPYING, DISTRIBUTION AND 
MODIFICATION (Section 3.b.) 

You may copy and distribute the Program (or a work based on it, under Section 2) in object code or 
executable form under the terms of Sections 1 and 2 above provided that you also do one of the following:  

Accompany it with a written offer, valid for at least three years, to give any third party, for a charge no more 
than your cost of physically performing source distribution, a complete machine-readable copy of the 
corresponding source code, to be distributed under the terms of Sections 1 and 2 on a medium customarily 
used for software interchange. 

The complete text for this license is available on the Control4 website at: http://www.control4.com.  

Gracenote 
Gracenote®, Gracenote logo and logotype, and the "Powered by Gracenote" logo are either a registered 
trademark or a trademark of Gracenote, Inc. in the United States and/or other countries. 

Music and DVD recognition technology and related data are provided by Gracenote®.   

Gracenote is the industry standard in Music and DVD recognition technology and related content delivery. 
For more information visit www.gracenote.com. 

MPEG 
Fraunhofer IIS and Thomson. MPEG Layer-3 audio coding technology licensed from Fraunhofer IIS and 
Thomson. Supply of this product does not convey a license nor imply any right to distribute content created 
with this product in revenue-generating broadcast systems (terrestrial, satellite, cable, and /or other 
distribution channels), streaming applications (via Internet, intranets, and/or other networks), other content 
distribution systems (pay-audio or audio-on-demand applications, and the like) or on physical media 
(compact discs, digital versatile discs, semiconductor chips, hard drives, memory cards, and the like). An 
independent license for such use is required. For details, visit http://mp3licensing.com. Radio Locator is the 
service provider of AM/FM channel list. 

© 2005-2008 All Media Guide, LLC provides music and video recognition technology that provides cover art 
and related text that enriches the Control4 user Navigators. 

Copyright 
© 2013 Control4. All rights reserved. Control4, the Control4 logo, the Control4 iQ logo and the Control4 
certified logo are registered trademarks or trademarks of Control4 Corporation in the United States and/or 
other countries. All other brands or names may be claimed as property by their respective owners. Pricing 
and specifications subject to change without notice.  

No part of this publication may be reproduced, photocopied, stored on a retrieval system, or transmitted 
without the express written consent of the publisher.  

Contact Information 

Control4 Corporation 
11734 S. Election Road 
Salt Lake City, UT  84020 USA 
http://www.control4.com 
Part Number: 200-00005 
Composer Professional Edition User Guide, OS 2.5.0 

http://www.control4.com/
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Introduction 
Composer Professional Edition (Composer Pro) is a Control4® software application that Control4 
Dealers and Installers use to set up and configure Control4 and third-party devices to 
communicate with each other in the Control4 home automation system. 

Purpose 
The purpose of this document is to provide steps, tips, and examples about how to use the 
Composer Pro software for the Control4 Operating System (OS 2.5.0). To learn about what’s 
new in this release, see the Composer Pro Getting Started guide in the Composer Pro 
application help or on the Control4 web. 

Scope 
This Control4 Composer Pro User Guide, which was formerly separated into two parts, is now 
compiled into a single manual. The User Guide covers these topics:  

• Installing devices 
• What's new in this release 
• Configuring properties 
• Configuring devices 
• Customizing the Navigators 
• Updating Composer and Director 
• Example projects 
• Troubleshooting the system 
•  Setting up the network configuration 
• Creating device drivers 
• Connecting and verifying devices 
• Setting up the media 
• Programming the system 

If you've never used Composer Pro before, we suggest that you start by reading Composer Pro 
Getting Started, available in the Composer Pro application's Help menu or on the Control4 
website in PDF. If you're already familiar with Composer Pro, you can skip through the 
Composer Pro Getting Started, and then continue with this document.  

For information about what’s new in this release, see the Composer Pro Getting Started guide. 

http://dealer.control4.com/dealer/support/documentation
http://dealer.control4.com/dealer/support/documentation
http://dealer.control4.com/dealer/support/documentation
http://dealer.control4.com/dealer/support/documentation
http://dealer.control4.com/dealer/support/documentation
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Related documents and resources 
Document Title Location 

Composer Pro Getting Started 
(200-00168) 

Application Help: Available in the Composer Pro Help 
menu 
PDF: Composer Pro Getting Started 

Control4 System Quick Start Guide (200-
00153) 

PDF Only: System User Guide  

Control4 System User Guide  
(200-00001) 

Web Help: System User Guide  
PDF: System User Guide 

Control4 Operating System Release 
Version 2.0.1 Release Notes 
(TechDoc00031) 

PDF Only: Included with software package on the 
Control4 Dealer website. Also available on the Control4 
Knowledgebase. 

Composer Pro Software Release Update 
Instructions - Release 1.7.4 to OS 2.0 
(TechDoc00024) 

PDF Only: Control4 Knowledgebase 

Managing Dealer Accounts on 
My.Control4.Com (TechDoc00025) 

PDF Only: Control4 Knowledgebase 

Control4 MyHome Setup Guide (DOC-
00003) 

PDF Only: Control4 MyHome Setup Guide for Dealers 

http://dealer.control4.com/dealer/support/documentation
http://dealer.control4.com/dealer/support/documentation
http://dealer.control4.com/dealer/support/documentation
http://dealer.control4.com/dealer/support/documentation
http://kb.control4.com/
http://kb.control4.com/
http://kb.control4.com/
http://kb.control4.com/
http://dealer.control4.com/dealer/support/documentation
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Basics 
Composer Pro basics 

If you are a new user, start by using the application Help in Control4® Composer Pro (same 
content as Composer Pro Getting Started). These sections assume that you are familiar with 
Composer Pro. This product runs on Control4 Operating System (OS) 2.5.0 and earlier.  

Use this chapter to learn how to: 

• Install and configure devices 
• Configure Composer Pro properties 

Installing devices 
Use the Control4 dealer website at http://www.control4.com, Products > Additional Resources or 
Support > Documentation pages to access PDFs or web help for all current and past product 
installation and setup guides, and then install and set up your Control4 system devices according 
to these guides. OS 2.3.0 or later supports the auto discovery of many current devices. See 
“Guidelines for Configuring Devices” and “Configuring Third-Party Devices” in this document for 
details.  

If you're installing devices that are not owned by Control4, you may need to edit an existing 
driver or create a new one. See “Creating Device Drivers.” 

To access the installation, setup, and user documents in PDF format: 
1 Go to the dealer Documentation page. 
2 Log in using your dealer username and password. 
3 If the list of documents doesn’t appear, click the Products link, and then select Software > 

Documentation. 
4 View the list and then click the link for the document you want to view or print. 

Configuring device properties 
Use the Control4 Composer Pro Properties pane in System Design to change device properties. 
The Properties pane lets you make configuration changes to a project, room, or device.  

In the Control4 system, you have a choice of configuration options using these property types: 

• Project Properties—Lets you set project-specific configuration options. 

http://dealer.control4.com/dealer/support/documentation
http://www.control4.com/
http://dealer.control4.com/dealer/support/documentation
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• Room Properties—Lets you set room-specific configuration options. 
• List View Properties—Lets you set device properties listed by location, for example, room, 

floor, house, etc. 
• Device Properties—Lets you set device-specific configuration options. 

To configure properties: 
1 Start Composer and connect to a Director. 
2 Click System Design. 
3 Select one of the following property types: 

• Project—Select the root node in the project tree, for example the project name (such as 
Franklin Smith Home) to access the project properties and modify the: 
• Project name 
• Zip Code 
• Latitude/longitude 
• Date 
• Time (12-hour and 24-hour clocks) 
• Time zone 

For more information, see “Composer Pro Properties” in Composer Pro Getting Started. 

• Room—Select the room in the project tree, for example, Theater; the Properties tab is 
visible (default).  

Room properties let you: 

• View room-specific devices 
• View media information 
• Help you troubleshoot any incorrect room connections 

For more information, see “Room Properties” in Composer Pro Getting Started. 

• List View—Select a room, and then select the List View tab. View and/or modify the 
devices in the room. For more information, see “Device Properties” in Composer Pro 
Getting Started. 

• Device—Select the device to modify the available user options. For more information, 
see “Device Properties” in Composer Pro Getting Started. 

http://dealer.control4.com/dealer/support/documentation
http://dealer.control4.com/dealer/support/documentation
http://dealer.control4.com/dealer/support/documentation
http://dealer.control4.com/dealer/support/documentation
http://dealer.control4.com/dealer/support/documentation
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Example of device properties configurations 
Device properties vary by type of device. This example uses a light switch (C4-SW120277) and 
uses simplified descriptions. 

Changes made to the properties of most devices are immediately applied to the system. 
Changes made to Navigators may not be noticeable until you refresh the Navigators using 
Composer Pro’s File > Refresh Navigators command (Shift+F5). 

Tip: For the most up-to-date device properties information, click the Documentation tab in the 
Properties window (available only on select devices). 

 

Device Settings for a Switch 
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Properties 

• LED Information—Sets the LED colors for on, off, and toggle states of the switch’s top and 
bottom buttons. 

Advanced Properties 

• Fault Detection—Displays the fault status of the switch. 
• Ambient Light Profiles—Sets the brightness levels (variable according to the room’s 

ambient light) and backlight color.  
• Button Settings—Defines the text to be engraved on the keycaps, whether buttons control 

an electrical load, and whether the switch can be configured as a 2-button keypad. 
• 2 Button Keypad Settings (visible only when “Use as 2 Button Keypad” is selected)—Sets 

how the LEDs behave (follow the bound device, follow the load, or toggle). 
• Energy Information (view only)—Displays device stats, such as time in use and energy 

used. 
• Network—The current MAC address and firmware version of the selected device. 
• Replace Legacy Control4 Device—Replaces a legacy device in your project with this new 

device and copies the old device’s settings to the new one. 
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Configuring  
Devices 

Use this chapter to learn how to configure Control4® devices. “Configuration” can mean anything 
from identifying the device to the network to configuring the device’s properties within 
Composer Pro. 

Note: The device listings in this chapter have been reorganized to better match the order in 
Composer Pro’s My Drivers tab. 

How to add devices to a project 
There are three options to add a device to a project and identify it in the Control4 system: 

• Auto Discovery—In OS 2.3.0 or later, current Control4 devices support auto discovery via 
the Simple Device Discovery Protocol (SDDP) using the Discovered tab in the Items pane. 
This is the easiest way to add and identify new devices attached to a Control4 system 
because it works automatically. If the device you want to add to a project and identify in the 
system appears in the Discovered tab, all you do is double-click to add the device to the 
selected room and Director does the rest. See “Auto Discovery (SDDP)” below for more 
details. 

• Composer Views—You can add a Control4-supported device driver or a third-party driver 
to an existing project any time using the System Design and Connections views. See 
“Composer Views” or “Example Projects” in this guide or "Using Composer Views to Build a 
Project" in Composer Pro Getting Started. 

• Interviewer wizard—You can add Control4-supported device drivers or third-party drivers to 
a project using the Interviewer method which shows you step by step how to add and 
identify devices to the system. See “Interviewer wizard” or “Example projects” in this guide or 
"Using the Interviewer wizard to build a project" in Composer Pro Getting Started. 

http://dealer.control4.com/dealer/support/documentation
http://dealer.control4.com/dealer/support/documentation
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Auto Discovery (SDDP) 
Auto discovery uses SDDP to automatically discover IP devices and ensure that the correct 
device drivers are added to a project and installed into the Control4 system. When a device uses 
SDDP, it can advertise on the network what it is, what driver it uses, and what its network 
address is. 

Note: As a best practice, Control4 recommends that you add and identify the Panelized Lighting 
products manually rather than using Auto Discovery. 

The Auto Discovery function through SDDP does these things: 

• Enables devices to use DHCP (Dynamic Host Configuration Protocol) while still being able 
to identify them uniquely 

• Enables Director to discover and identify Control4 and some third-party devices in the 
Control4 system 

• Enables automatic installation of drivers for discovered devices 

Note: Auto Discovery does not make the room connections. You must do that manually. See 
“Connecting and verifying devices” in this guide. 

Benefits: 

• It discovers devices that are not yet in the project 
• It adds the manufacturer’s driver without having to search for it 
• It identifies the device using a unique identifier when adding it to the project 
• You don’t need to type in TCP/IP addresses or restrict devices to static IP addresses 

To use Auto Discovery: 
1 Start Composer Pro and connect to a Director. 
2 Click System Design (default view). 
3 In the Items pane, click the Discovered tab. View the devices in the list. 
4 In the project, click the room to add the device to. 
5 In the Discovered list (Items pane), double-click the device to add it to the project. If the 

device you want to add does not appear in the list, it may be already added to the project or 
it does not support Auto Discovery. If you need to add a device that doesn’t support Auto 
Discovery, you can use the Composer views or the Interviewer wizard to add and identify 
your device. 
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Add/Identify Options. Both options will add and identify a device in one step. 

• Devices listed in the Discovered tab 
• ‘Auto add identified devices’ box in the Discovered tab 

To add discovered devices to the project: 
1 Double-click the device to add it to the current room in the project which will add and identify 

it in one step. 

To use the ‘auto add identified’ box: 
1 Check the auto add identified devices box at the bottom of the Discovered Items pane. 

This allows you to go directly to the device and use the Identify button to add and identify it. 
This box is useful if you want to be very specific about the device you’re adding. Without the 
box checked, the add/identify process will not be executed with a button press. 

2 Press the Identify button or button-press sequence on the device. 
3 The device will automatically be added to the current room in the project.  

Note: If the Identify button is pressed when ‘auto add identified devices’ is not selected, that 
device will be highlighted in yellow in the Discovered tab. It will not be automatically added 
to the project. 

Example: If you have third-party devices, for example, three (3) different TVs in three (3) 
different rooms in the home, you can check ‘auto add identified devices,’ select the room 
where the TV is located, and then have someone identify at the TV. The device will be 
added automatically to the project. 

To view all devices on the network (including those already in the project) that use SDDP: 
1 In Composer, click the Connections view. 
2 Click the Network tab. 
3 Notice in the right pane the list of devices. SDDP-recognized devices will have an SDDP text 

highlight. 

To use the Info button: 
1 Click the Info button in the Discovered tab, or right-click the device. 
2 Select the device. An Info box opens which will give you identification and other information 

about that device (based on what the driver developer has provided). 

Composer views 
Using the My Drivers tab  

In the System Design view, click the My Drivers tab to find device drivers and add them to the 
project tree (if you are not using Auto Discovery or the Interviewer wizard). 

Read “Purpose of Device Drivers” and “Adding Items to the Project Tree” in Composer Pro 
Getting Started first to understand how to create and populate the project tree for a project. 

Note: Some devices also require a free app from the Control4 4Store; for example, to take full 
advantage of Black & Decker KwikSet SmartCode lock management in a touch screen, MyHome 
app, or on-screen Navigator, you can download their free app. See the 4Store sections in the 
Control4 System User Guide for details.  

To use the My Drivers tab: 
1 Install and connect the physical devices that need to be added to the Composer Pro project. 
2 In the project tree, click the room to add the driver to. 

http://dealer.control4.com/dealer/support/documentation
http://dealer.control4.com/dealer/support/documentation
http://dealer.control4.com/dealer/support/documentation
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3 In the System Design view, click the My Drivers tab in the Items pane. 
4 Locate the device and double-click or drag the device to the System Design pane's project 

tree. 

 

Tip: To ensure that you’ve got the correct device driver (SKU) in your project tree, after 
you’ve added it to the tree, hover over it. The SKU appears. 

5 Click the Connections view, and then click the Network tab.  
6 Locate the added driver in the IP Network Connections pane. 
7 Select the device and then click Identify. 
8 Follow the on-screen prompts in the popup. In most cases, you’ll need to go to the physical 

device and press a button several times to identify it to the system. 
9 Make the necessary control, network or AV connections. See “Connecting a Device to the 

Network,” “Connecting and Verifying Devices,” or “Connecting Devices” and “Testing the 
Device Connections” in Composer Pro Getting Started for information. 

10 Set any necessary device properties by selecting the device (see “Properties Pane” in 
Composer Pro Getting Started). If any properties are available for a device, they will display 
in the Properties pane. The following “Configuring…” sections describe the various 
properties for devices. 

11 If you are adding WiFi devices, refer to the Control4 training courses on the Control4 Dealer 
website to learn how to install and configure WiFi. 

Using the Search tab 
Thousands of third-party device drivers are supported in the device driver database. Drivers that 
are not in the local database can be found in the online database, if they are available. Use the 
Search tab to search for and add device drivers to the project tree that do not appear in the My 
Drivers list. 

Certified and non-certified drivers are available. Look for the certification icon to the right of the 
driver in the list. Certified drivers appear at the top of the list if you search under manufacturer > 
all certified. 

Note: Due to the large quantity of drivers in the database, Control4 has not validated every 
device driver provided. If you experience limited functionality using any device driver provided by 
Control4, please report the limitations to Control4 Technical Support. To report defects or 
enhancements, please contact Control4 (phone: 1-888-400-4072 or email: 
support@control4.com). 

http://dealer.control4.com/dealer/support/documentation
http://dealer.control4.com/dealer/support/documentation
https://www.control4.com/account/login.php
mailto:support@control4.com
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Read “Purpose of Device Drivers” and “Adding Items to the Project Tree” in Composer Pro 
Getting Started first to understand how to create and populate the project tree for a project. 

To find a device driver using Search: 
1 Install and connect the physical devices that need to be added to the Composer Pro project. 
2 In the project tree, click the room to add the driver to. 
3 In the System Design view, click the Search tab in the Items pane. 

 

4 From the project tree, select the room where the device resides. 
5 In the Search tab, select the device type from the Device Types filter. 
6 Select the manufacturer from the Manufacturers filter. 
7 Drag the driver to the project tree, or double-click the device driver to add it the project tree. 

• [search text field]—Type the text to search for here. You can use the drop-down menu 
to select terms that were previously typed. 

• Local (default)—The Local checkbox lets you view device drivers stored on your local 
database. 

• Online—The Online checkbox lets you view and download drivers from the online 
database. 

• Certified Only—This checkbox specifies that only Control4-Certified drivers will appear 
in the search results.  

• Device Types—Lets you select the device type (proxy), for example, AV Switch 
(includes audio switches), Blinds, CD, Disc Changer (includes DVD and CD Changers), 
DVD, Light, Receiver, Satellite (includes DVRs), Cable TV, Television, Thermostat, 
Tuner, VCR and more.  

• Manufacturers—Lets you select the manufacturer. 

http://dealer.control4.com/dealer/support/documentation
http://dealer.control4.com/dealer/support/documentation
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• Sort by—Lets you select the order that search results are displayed. 
• Results—Detailed search results appear, including the manufacturer, model, and driver 

location. 
8 Configure the device by setting up the connections (Network and/or Control/AV tabs). See 

“Connecting and Verifying Devices” for details. 

Interviewer wizard 
If the device you want to add and identify doesn’t support Auto Discovery, you can follow the 
steps in “Composer Views,” “Example Projects” in this guide or see Composer Pro Getting 
Started. 

Configuring third-party devices 
Use the Control4 Composer Pro System Design and Connections views to configure third-party 
devices using third-party device drivers. The same basic steps apply to third-party drivers as with 
Control4 devices. Many of these drivers are ‘certified’ and are available in the drivers online 
database. Some of them will use Auto Discovery in the future. 

Notes: (1) If the device you want to add and identify doesn’t support Auto Discovery, you can 
follow the steps in “Composer views” or “Example projects” later in this guide. (2) New drivers for 
Sony STR-DA2800ES and DA5800ES receivers (ZSO-STR-DA2800ES or ZSO-STR-
DA5800ES) are available in the Search > Online Database list (‘Receiver’ if the device is used as 
a receiver only in the Control4 system). If the receiver will be used with full Control4 automation 
as a receiver and a controller, see “Configure an HC-Class Home Controller” or “Configure a 
Sony STR-DA2800ES or STR-DA5800ES Receiver” in this document.  

Although third-party drivers are supported, they are not documented in this guide. For 
information about the devices and drivers, see the product’s own website.  

Configuring controllers 
Use the Control4 Composer Pro System Design view to add and identify a controller to the 
network connection, including Sony STR-DA2800ES and STR-DA5800ES with full Control4 
automation (you can use Auto Discovery for this product if it is a primary controller). Refer to the 
sections below for the controller type you want to configure. This section also covers other 
controller-related tasks.  

Note: Home Theater Controller, Home Controller HC-500, HC-200, HC-300, HC-1000, and 
Media Controller are no longer sold by Control4.  

Configure an HC-class home controller  
Use the Composer Pro System Design view to add and configure controllers (HC-200, HC-250, 
HC-300, HC-800, and HC-1000) or Sony STR-DA2800ES and STR-DA5800ES with full Control4 
automation. The steps below are basically the same for all of these controllers; however, some 
properties may vary. 

Note: Emphasis is placed on the most recently released controllers. 

http://dealer.control4.com/dealer/support/documentation
http://dealer.control4.com/dealer/support/documentation
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Prerequisites 

Ensure that the controller is installed as directed in the controller’s installation guide, which is 
available on the Control4 Dealer website. 

To add and configure a controller HC-x00 or HC-x000 (for example, HC-800): 
1 To add the driver and identify the device see “Guidelines for configuring devices.” Ensure 

that the correct driver is added to the project tree. The Digital Media object is added 
automatically also. 

Notes: (1) Several drivers are available for the Sony STR receiver. To ensure you’re adding 
the correct Sony STR receiver drivers, refer to the Sony ZSO-STR-DA2800ES/5800ES-
C4/ZSO-STR-DA5800ES-C4 Receiver with Control4 Automation Quick Start Guide and the 
Sony STR-DA2800ES/DA5800ES Receiver Control4 Automation Activation Guide available 
on the Control4 Dealer website under Products > Sony or Support > > Documentation. (2) If 
you use the Sony STR receiver as a primary controller, the drivers are already added to a 
project and the device is identified. 

2 Change the Properties for each controller as shown below. 

Notes:  

(1) Home controller HC-1000 V2 and HC-1000 V3 use the same driver, e.g., HC1000V2/V3. 
Release 1.7.3 and later use these driver versions.  
For OS 2.0.1, the HC-200 (C4-HC200B-E-B-NR-1) and HC-300 (C4-HC300C-E-B) have 
been updated.  
For OS 2.2, the HC-800 (C4-HC800-E-B) has been added.  
For OS 2.2.1, the HC-250 controller (C4-HC250-E-B) has been added.  
For OS 2.2.4, the Sony STR-DA2800ES or STR-DA5800ES receiver and controller drivers 
have been added and the device has been identified if used as a primary controller. For a 
secondary controller, use the Local Database to get these Sony drivers: Sony STR-
DA2800ES or STR-DA5800ES (the receiver and the Sony Receiver Home Controller 2800 
or the Sony Receiver Home Controller 5800 will be added automatically along with various 
other AV drivers). 

(2) If a controller is not listed in My Drivers, right-click in My Drivers and select Restore 
Default List. This action updates the list. See “Using My Drivers or Search Tabs.” 

3 To establish a WiFi network connection to for older controllers, configure a USB WiFi 
Adapter for home controllers (sold separately). See “Configuring a WiFi Connection” or 
“Configure a USB WiFi Adapter for HC-300 for details.”  WiFi is built-in to HC-250 and HC-
800 controllers, but you still have to configure them for WiFi. 

Note: The Sony STR receiver comes with a USB ZigBee Wireless Adapter (UWA-C4Z) to 
be used with your ZigBee devices and should not be used for wireless connections. 

4 (Optional) For additional controller setup, configure the properties.  
a In the System Design view project tree, select the Home Controller object.  
b Modify the properties in the Properties pane: 
• Controller Status—Shows whether the controller is Online or Offline. 
• ZigBee Server Configuration—Lets you view, enable and disable the Zserver. Edit 

ZigBee Configuration opens the ZigBee Network Settings dialog.  

Note: The ZigBee Network Settings box shows which ZAPs are configured, identified, 
or enabled. See also Tools > Network Tools and select the ZigBee Network tab. 

• ZigBee Server Status—Shows whether the controller as ZigBee Server is 
Running or Not Running. Older controllers show ‘Not Supported.’ 

• ZAP Configuration Type—Shows whether the controller is the Coordinator or 
ZAP. Older controllers show ‘Not Supported.’ 

• ZAP Status—Shows whether the controller as ZAP is Running or Not Running. 
Older controllers show ‘Not Supported.’ 
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• SD Video Mode (HC-200 and HC-300 only)—Lets you set the Standard Definition 
video format that the controller handles. NTSC mode is used in the U.S. Canada, 
Central America, and Japan; PAL mode is generally used in Europe, Africa, Australia, 
South America, and China. (Release 1.8 and earlier: This option is called Video Mode.) 

• For Video Connection (HC-250 and HC-800 only)—Select component or HDMI, 
change the Video Resolution, and then click Set Resolution. This will cause the 
controller to set the configuration and restart. Select HDMI only for video, as it won't 
stream audio. Note: This does not reflect what is set in the Connections view for video 
output. 

• Video Resolution (HC-250 and HC-800 only)—If your video doesn’t display properly, 
use the drop-down to select your correct video resolution. 

• Current Resolution (HC-250 and HC-800 only)—Displays what hardware resolution is 
currently configured. 

• I/O Firmware Version (HC-250, HC-800, and Sony Receiver Home Controller xx00 
only)—Lists the current firmware version of this controller. 

Configure a USB WiFi adapter for  
Home Controller HC-300 

Use the Control4 Composer Pro Tools menu and Connections > Network tab to configure a USB 
WiFi adapter (sold separately).  

USB WiFi Adapter for Home Controller HC-300 lets the Home Controller HC-300 communicate 
with system devices via a WiFi (wireless) network. These steps can apply to the HC-500 also. 

Notes: The USB WiFi Adapter should be used for secondary controllers. Control4 recommends 
that the USB WiFi Adapter not be used in a primary controller for a large system or a controller 
that is streaming digital audio to other end points on the network. Those usage scenarios will be 
better served by an Ethernet connection to the primary controller.  

To connect and set up the USB WiFi Adapter for a Home Controller HC-300: 
1 Connect the Home Controller HC-300 to the Ethernet network using an Ethernet CAT5 cable 

(this is a temporary connection to support set-up activities). 
2 Plug the adapter to the USB port on the controller. 
3 Start Composer and connect to Director on Local Network. 

a In the Tools menu, select System Manager. 
b In the Devices pane, select the network address of the device where you want to set 

up the network configuration, and click Connect.  
• If the device’s network address is not on this list, click Refresh.  
• If it still does not appear, click Add to enter it manually.  
• If you do not know the network address, find it at the Connections view > Network 

tab. 
c Click the Network tab, and click Configure.  

4 Click Next when a Network Configuration wizard dialog appears.  
a Continue through the wizard screens, and provide the following information appropriate 

for your system. Much of this information has to match that of your Wireless Access 
Point (WAP). 

b Enter the new device name, but do not include spaces in the new name.  
c Indicate the network type: Wireless (WiFi) network. 
d Indicate the method for obtaining the DNS server address: DHCP or Static IP. Control4 

recommends DHCP (automatically selected). 
e Enter the SSID. 
f Enter the WEP key (if any). 
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g Enter the encryption type (64 or 128). 
h Click on a Key type (hex or ascii). 
i Click Finish to complete the wizard and reboot the adapter to apply the network 

configuration changes. 
5 Disconnect the Ethernet CAT5 cable from the controller. 

Ensure that ZigBee Server is running  
Use the Control4 Composer Pro System Design view to check the controller's properties and 
ensure that ZigBee server is running on a controller.  

Note: This does not apply to Home Controller HC-1000. 

To ensure the controller properties are set correctly: 
1 In the project tree, select the Controller object for the properties to appear. 
2 Ensure that the ZigBee server is running. If not, see “Example: Verify the Network 

Connections” in this document. 

Tip: Be patient. In cases where the ZigBee mesh is moved, it can take up to five minutes 
for all connections to get re-established. 
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Ensure that video mode is set correctly 
Use the Control4 Composer Pro System Design view to check the controller's properties and 
ensure that video mode is set correctly on a controller. Video Mode lets you set the video format 
that the controller handles. 

To ensure the controller properties are set correctly: 
1 In the project tree, select the Controller object for the properties to appear. 
2 Ensure that the video format is set correctly. NTSC mode is used in the U.S. and PAL mode 

is generally used in Europe. 

 

Configure multiple controllers 
Use the Composer Pro System Design view and Connections > Network tab to configure 
multiple controllers. If you have more than one (1) controller in your Control4 system, you must 
designate one of them as the primary controller. The others will be secondary controllers. 

To add and configure multiple controllers: 
1 Start Composer Pro and connect to a Director on Local Network. 
2 From the Directors dialog that appears, select the Director’s network address of the 

primary controller hardware you are setting up, and click Connect. 
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3 If you have multiple controllers in the system, when you make this selection you are defining 
the primary controller. The next time you launch Composer Pro, only the network address of 
the Director of the primary controller appears on this screen. If the correct address is not 
listed, click Add to add the address manually. 

  

4 In the project tree, select the room where the controller resides, and add it to the system. Do 
the same for all the controllers you plan to add to the system. See “Guidelines for 
Configuring Devices” for details. 

5 Click the Connections view. 
6 In the Connections view, select the Network tab. 
7 Select the first controller listed, and click Identify. 
8 On the dialog that appears, follow the on-screen instructions, and click Next to continue to 

identify the other controllers you have added to the system. 
9 When you finish identifying all of the controllers and any other devices in your project, click 

Close to return to the Network tab in the Connections view. 
10 In the IP Network Connections pane under Address make sure that all the devices in your 

project have an address on the list. 
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Configure an IO Extender 
The Control4 IO Extender opens up a whole world of options in the Control4 system to control 
home theaters, distributed audio systems, video devices, motion sensors, and other devices that 
use infrared (IR), serial, contact, and relay connections and has digital and analog audio outputs. 
This device is a great companion to the HC-800 controller to expand output capability. 

Ensure that the IO Extender is installed and set up as directed in the Control4 IO Extender 
Installation Guide available on the Control4 Dealer website. 

To add and configure an IO Extender: 
1 Follow the steps in “Guidelines for Configuring Devices” to add and identify the device. 

Ensure that the IO Extender driver is added to the project tree. 
2  (Optional) For additional IO Extender setup, you can adjust the volume for three (3) outputs.  

a In the System Design view project tree, double-click the IO Extender object.  
b Use the slider bar to adjust the Stereo Volume x as needed. 

Configuring lighting  
Use the Composer Pro System Design and Connections views to configure dimmers, switches 
and keypads.  

Tip: Double- and triple-tap events apply to the Control4 dimmers, switches, and keypads. When 
you tap a button consecutively two (2) or three (3) times for about one-half of one second the 
events fire. You can use these events for programming without requiring the more complex 
programming logic tied to timers and button 'Press/Release' events.  

Note: When programming using double and triple-tap events, be aware that Press and Release 
events also occur when double and triple-tap events occur. Plan your programming using these 
events so that they don't conflict with the intended outcome. In most cases, when using double 
and triple-tap programming events, don't program on the Press and Release events.  

Tip: These sections are organized by how devices are listed in the My Drivers tab. 

Light 
Dimmers and switches 

Configure a Wireless Switch, Dimmer, or Inline Dimmer 
Use the Composer Pro System Design and Connections views to configure Control4 switches 
and dimmers. 

Ensure that the wireless switch, dimmer, or inline dimmer is installed as directed in the Control4 
Wireless Switch Installation Guide, Control4 Wireless Dimmer Installation Guide or Control4 
Inline Dimmer Installation Guide available on the Control4 Dealer website. 

To configure a wireless switch, dimmer, or inline dimmer: 
1  Add the device to your project tree, then identify it. For instructions, see “Guidelines for 

Configuring Devices.”  

Note: The Wireless ELV Dimmer uses the same driver as the Wireless Dimmer. 

http://dealer.control4.com/dealer/support/documentation
http://dealer.control4.com/dealer/support/documentation
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2 In the System Design view, select the device.  The device properties tab opens. 
3 Configure the settings described below, then click Set to save the changes. 
4 Click Apply to… to apply the changes to other lighting devices. 
5 Click OK. 

Device settings  

 

Properties (applies to only the wireless dimmer and  inline dimmer.) 

• Click Ramp Rate Up—The rate in seconds when the light ramps from OFF to ON. 
• Click Ramp Rate Down—The rate in seconds when the light ramps from ON to OFF. 
• Preset Level—The percentage that the load ramps up to when tapped. Press and hold 

the button to ramp to a level beyond the preset value, however, this value will not ramp 
beyond the Max On Level (see below). 

Advanced Properties (applies to all dimmers and switches) 

• LED 
• Top Color On—The LED color for the top LED when the LED state is ON. 
• Top Color Off—The LED color for the top LED when the LED state is OFF. 
• Bottom Color On—The LED color for the bottom LED when the LED state is ON. 
• Bottom Color Off—The LED color for the bottom LED when the LED state is OFF. 

• Options 
• Buttons Attached—If checked, pressing the buttons on the dimmer or switch 

directly controls the connected load. If unchecked, pressing the buttons on the 
dimmer or switch doesn't control the load. 

• LED Attached—If checked, the LED state is controlled by the load status. If 
unchecked, the LED state and colors can be controlled by custom programming 
and not by the load status. 

• Hold Ramp Rate (Note: These properties apply to only the wireless dimmer and the 
inline dimmer.) 
• Up—The rate in seconds when the load reaches the Maximum On Level from an 

Off state when the Top button is held down. 
• Down—The rate in seconds when the load reaches 0% from a full On state when 

the Bottom button is held down. 



Composer Pro 2.5 User Guide   Configuring lighting 

18 

Network—The current MAC address and Firmware Version of the selected dimmer or switch. 
These fields are not editable.  

Configure a Wireless Puck Dimmer or Switch Module 
Use the Composer Pro System Design and Connections views to configure Wireless Puck 
Dimmer or Switch modules. 

Ensure that either the Puck Switch Module or Puck Dimmer Module is installed as directed in the 
Control4 Wireless Puck Dimmer or Switch Module Installation Guide available on the Control4 
Dealer website. 

To add and configure a Wireless Puck Dimmer or Switch Module: 
1 To add the driver and identify the device see “Guidelines for Configuring Devices.” Ensure 

that the Puck Switch or Puck Dimmer driver is added to the project tree (see the next 
step). 

2 In the Items pane > Search tab > Device Type: Light > Manufacturer: Control4 double-click 
the Wireless Puck Dimmer Module: C4-DM201-Z or the Wireless Puck Switch Module: 
C4-SM201-Z to add the object to the project tree. 

3 Identify the device. 
4 (Optional) To change the properties, click System Design. In the project tree, select the 

Puck Switch or Puck Dimmer object for the properties to appear as shown below. Click 
Set to save your changes. 

5 Click Apply to… to apply the changes to other lighting devices. 

http://dealer.control4.com/dealer/support/documentation
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Puck Dimmer properties:  

 

Puck Switch properties:  
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Modifiable properties for the Wireless Puck Dimmer Module or Wireless Puck Switch Module 
include: 

Properties (Wireless Puck Dimmer Module Only) 

• Click Ramp Rate Up—The rate the light ramps from off to on when the button is clicked. 
• Click Ramp Rate Down—The rate the light ramps from on to off when the button is clicked. 
• Preset Level—The percentage of the load to which the Puck Dimmer Module ramps when 

turned on. 

Advanced Properties 

Aux 1 or Aux 2 Properties 

Set these properties when you want to control the Puck module with a switch connected to 
the auxiliary terminals. 

• Aux Type—From the drop down select the type of auxiliary switch connected to the 
terminal. 
• Momentary—A momentary switch only closes the circuit when the button is pressed. 

Momentary switches typically have a “spring-back” action that returns the button to its 
original position after it is released. 

• Latch—A latching switch typically takes the form of a toggle or rocker button and opens 
or closes the circuit depending upon the position of the switch. When using a latching 
switch with the Puck Module, the Puck reacts to each transition of the switch from on-to-
off or off-to on. It does not react to the actual on/off state of the switch. Each transition is 
treated as a “click.” Note: It is not possible to perform a press-and-hold with a latching 
switch. 

• Aux Behavior—From the drop-down list select the desired behavior that will occur when a 
momentary button is pressed or a latching switch is toggled. 
• Load On—The load is set to on (not available with latching switches). 
• Load Off—The load is set to off (not available with latching switches). 
• Load Toggle—The load is toggled between on and off. 
• Generic—The button/switch is not tied to the load and can be programmed as desired. 

• LED Behavior—From the drop down select the desired behavior for the associated LED. 
• Load On—The LED is on when the load is on. 
• Load Off—The LED is on when the load is off. 
• Contact Open—The LED is on when the auxiliary contact is in the Open position. 
• Contact Closed—The LED is on when the auxiliary contact is in the Closed position. 
• Unmanaged—The LED is not tied to the contact or load and can be controlled using 

the Programming view. 

Virtual Button Colors 

The virtual button color defines the LED color that will appear on a keypad button that is 
bound to the Puck module when that keypad button is set to Follow Bound Color. 

Select a virtual button LED from the drop-down list, select the LED color and then click the 
Set button. (Note: the Set button must be clicked before selecting a different virtual button 
LED from the drop-down list or the previous selection will be lost.) 

Fault Detection 

The status field indicates whether the Puck Module is in a fault state. Fault conditions can be 
caused by a short circuit, overloading the module, or potentially an incandescent bulb 
blowing.  

To reset the device, click the Reset button. Alternatively, the button on the Puck or the 
button attached to Contact 1 can be clicked 15 times to reset the device.  
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If the device returns to a fault state after reset, verify the wiring and and/or the total wattage 
of loads connected to the device. 

Load Profile (Wireless Puck Dimmer Module Only) 

These are the minimum and maximum load settings for light output which includes the Cold 
Start Level and time. Test the settings to determine what fits best with your bulb type. 

Note: The Navigators show 0% to 100% even though the settings may be set at Minimum 
On Level percent at 25%, and the Max On Level percent at 80%. 

Minimum On Level (%)—Use the arrows selection box to select the minimum % in 1% 
increments. The default is 0. The minimum level can vary, depending on the light type 
(incandescent, fluorescent, LED, etc.). 

This is especially important in compact fluorescent (CLF) and LED lighting that sometimes 
have a minimum threshold for producing visible light that could be anywhere from the 10 – 
40% range. Some loads will flicker or pulse right at their minimum threshold. 

Example: A bulb doesn’t produce visible light until it reaches 20%. The minimum On to 25% 
will ensure a clean On transition. 

Cold Start Level (%)—Use the arrows selection box to select the start level in 1% 
increments. The default is 0. This level is set above the Minimum On Level % setting. 

This setting is mainly applicable to CFL loads. Switching from an Off state to On sometimes 
exhibits a higher visible light threshold than after the CFLs have been on and have warmed 
up. If a Cold Start % is set (above the Minimum On %), the dimmer cleanly jumps to that 
level from Off to On. However, when the dimmer has been on for the time period designated 
by the Cold Start timer, the dimmer can ramp below the Cold Start On % to the minimum 
On%. 

Example: Fluorescent lights go on, warm up, and then will dim down to the Minimum On 
Level % setting.  

Cold Start Time (milliseconds)—Use the arrows selection box to select the time in 
milliseconds. The default is 0. This is the length of time a light takes to warm up before it 
dims down to the Cold Start Level setting.  

Max On Level (%)—Use the arrows selection box to select the maximum % light level in 1% 
increments. The default is 100. This is the level set for maximum light output, such as 100%. 
This setting enables capping of the light level for a given load below 100%, either to 
enhance bulb life or better match the light level in a given living space. This is an absolute 
maximum level rather than the Preset On level, which can be bypassed. 

Dimming Mode 

• Autodetect—Automatically detects the load type and determines whether the dimmer 
should use Forward or Reverse Phase dimming. This is the default and should not be 
changed unless the load is not dimming properly. 

• Forward Phase—Forces the dimmer module to use forward phase dimming. Should only be 
used with magnetic transformers. 

• Reverse Phase—Forces the dimmer module to use reverse phase dimming. 

Hold Ramp Rate (Wireless Puck Dimmer Module Only) 

• Up—The time, in seconds, it takes the load to ramp to 100% when a button controlling the 
load is pressed and held. 

• Down—The time, in seconds, it takes the load to fade to 0% when a button controlling the 
load is pressed and held. 



Composer Pro 2.5 User Guide   Configuring lighting 

22 

Energy Information 

• Minutes Off—The number of minutes that the load has been off since the Puck Module was 
last reset. 

• Minutes On—The number of minutes that the load has been on since the Puck Module was 
last reset. 

• Minutes On Today—The number of minutes that the load has been on today. 
• Current Power—The current power being used by the load (in watts). 
• Energy Used—The total number of watt hours used by the load since the device was last 

reset. 
• Energy Used Today—The total number of watt hours used by the load from 12:00 AM until 

11:59 PM today. 

Network 

This is the current MAC address and firmware version of the selected Puck Dimmer or Switch. 
These fields are not editable.  

Outlet switches and dimmers 

Configure a Wireless Outlet Switch 
Use the Composer Pro System Design and Connections views to configure a wireless outlet 
switch. 

Configure and use the wireless outlet switch and its plugged-in device to: 

• Control a plugged-in audio/video component (such as a DVD player or VCR) or other 
electrical equipment controlled by IR. 

• Control power to a plugged-in relay device (such as a pump) or other household appliances. 
• Switch a plugged-in lamp to On or Off.  

Each wireless outlet switch has two (2) outlets: Outlet 1 and Outlet 2. When the wireless outlet 
switch is plugged into the wall, Outlet 1 is on the left and Outlet 2 is on the right. 

 

Prerequisites 

1 Ensure that the wireless outlet switch is installed as directed in the Control4 Wireless Outlet 
Switch Installation Guide available on the Control4 Dealer website. 

2 Ensure that your project has a controller added and identified in the Control4 system. 

http://dealer.control4.com/dealer/support/documentation
http://dealer.control4.com/dealer/support/documentation
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To add and configure a wireless outlet switch: 

IMPORTANT TIP: When configuring the wireless outlet switch, add two (2) drivers: one for the 
wireless outlet switch and one for the plugged-in device. In addition, define the connection 
between these two (2) devices In the Connections view > Control/AV tab.  

1 To add the driver and identify the device see “Guidelines for Configuring Devices.” Ensure 
that the Wireless Outlet Switch driver is added to the project tree. 

2 Add a driver for the device you want to plug into the wireless outlet switch as appropriate for 
your use (power sensing, power controlling, or switching lamps on and off).  

Power Sensing (Contact)—Using the wireless outlet switch, the system can sense the 
power state of the plugged-in device, and the controller can send the appropriate control 
commands based on the power state.  

For a plugged-in device:  

a Add the appropriate driver. 
b (For an AV device only, such as a DVD Player) Edit the driver to change the power 

management option in the driver for the correct connection to appear in the 
Connections view. To do this, see the "Change Power Management Options." For other 
devices, it is not necessary to edit the driver. 

c Before you can use power sensing for the plugged-in device, perform Power Learning 
on the wireless outlet switch for the plugged-in device on the appropriate outlet. For 
information about Power Learning when using the wireless outlet switch power sensing, 
see “Perform Power Learning” later in this section.   

Power Control (Relay)—For a plugged-in device, add the appropriate driver.  

Example: Add a relay device by selecting a Pump to the project. Go to the System Design 
view in the Items pane, select the My Drivers tab > Motorization, and double-click the 
Pump object. 

Lighting—For a lamp, add an Outlet Light to the project. Go to the System Design view in 
the Items pane. Select the My Drivers tab > Lighting > Light, and double-click the Outlet 
Light object.  

Note: This is the Outlet Light object, and not the regular Wireless Outlet Switch object. 

3 Define the connection between the wireless outlet switch and the plugged-in device. 
a Click the Control/AV tab. 
b Make a connection between the wireless outlet switch and the device that is plugged 

into the wireless outlet switch. Make this connection for any of these three (3) possible 
uses: power sensing (contact), power control (relay), and switching a lamp On or Off. 

c In the Connections view, select the device that is plugged into the wireless outlet switch. 
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d From the top screen, drag the appropriate connection to the wireless outlet switch 
connection on the bottom screen.  

Example: Connection between the wireless outlet switch and the light outlet. 

 

Perform power learning 
To enable use of the power-sensing features, configure your wireless outlet switch to read the 
power state of the devices that you plug into it. 

To perform power learning: 
1 Follow the steps in the previous section. 
2 Turn Off the device plugged into the wireless outlet switch. 
3 Push and hold the button on the Top panel of the wireless outlet switch until the two (2) 

LEDs toggle orange On/Off, alternating back and forth. 
4 Select an outlet to configure (Outlet 1 or 2) by releasing the button when the LED that 

corresponds to that outlet number lights up.  

Example: If a device is plugged into Outlet 1, release the button when LED 1 lights up. 
Upon doing so, the LED you chose flashes orange, indicating that the wireless outlet switch 
is learning a steady state of the device (such as On or Off). When the LED turns solid 
orange, the wireless outlet switch has learned the steady state, but has not yet determined 
whether the state is On or Off.  

5 With the LED now solid orange, turn the device plugged into the wireless outlet switch to an 
On state. The LED again flashes orange while the wireless outlet switch is learning the On 
state of the device. When learning completes, the LED glows solid orange again to indicate 
the wireless outlet switch has learned the steady state. 

6 With the LED now solid orange again, turn the device Off. The LED flashes orange to 
indicate the wireless outlet switch is waiting for a steady state. When the device reaches a 
steady state, the LED glows red to indicate the wireless outlet switch has learned the Off 
state. 

7 With the LED now solid red, turn the device On again. The LED flashes orange to indicate it 
is waiting for a steady state. When the device reaches a steady state, the LED glows green 
to indicate the wireless outlet switch has learned the On state. 

8 With the LED now solid green, press the button on the wireless outlet switch one time to 
save and exit the Power Learning mode.  
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IMPORTANT TIP: You can use a quick button press during any step of this process prior to 
the LEDs turning solid red or green to exit the Learning mode without saving.  

9 Repeat the steps to configure the other outlet (Outlet 1or 2) as needed for any additional 
plugged-in device.  

Note: To unlearn a device, press the button nine (9) times, but use with care; this will reset 
both outlets. 

Configure a Wireless Outlet Switch for power-sensing 
AV devices 

Use the wireless outlet switch and its plugged-in device to: 

• Control a plugged-in audio/video component (such as a DVD player or VCR) or other 
electrical equipment controlled by IR. 

• Control power to a plugged-in relay device (such as a pump) or other household 
appliances. 

• Switch a plugged-in lamp On or Off. 
  

The instructions below describe how to configure an Outlet Switch in Composer Pro for a 
Samsung television. For instructions about how to configure the other actions, see “Configure a 
Wireless Outlet Switch.”  

Each wireless outlet switch has two (2) outlets: Outlet 1 and Outlet 2. When the wireless outlet 
switch is plugged in to the wall, Outlet 1 is on the left and Outlet 2 is on the right. 

 

IMPORTANT! When configuring the wireless outlet switch, you need to add two (2) drivers: 

• One (1) for the wireless outlet switch 
• One (1) for the plugged-in device 

In addition, define the connection between these two (2) devices in the Connections view > 
Control/AV tab. 

Prerequisites 

1 Ensure that your project has a Control4 controller added and identified on the Control4 
system. 

2 Ensure that the Wireless Outlet Switch object is added to the project tree, and is identified 
on the Control4 system. 

3 Ensure that the AV device, for example, the Samsung Television object, is added and 
configured for the device. 
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To configure a wireless outlet switch to use an AV device: 

Select the Power Codes 

1 In the project tree, right-click, for example, Samsung Television and select Edit Driver. 
The Driver Wizard opens. 

2 In the Driver Wizard, check Has power feedback. 
3 Change the Power Management option to Contact sensor; ensure that the Send toggle 

code is selected. 
4 Click Codes. 

a In Codes under Default Commands, make sure Power On and Power Off, or Power 
Toggle items are not checked. If they are, any programming you do in conjunction with 
power using the wireless outlet switch and the television is invalid. 

b Click Finish. 
c Click next to close the window.  
IMPORTANT! Don’t click back to check if the selection was saved because it refreshes the 
screen; in that case, you will need to redefine what you just defined.  

 

Define the connection 

5 Define the connection between the wireless outlet switch and the plugged-in device 
(Samsung Television). 

6 To do this, in the Connection > Control & Audio Video Connections pane select the 
Samsung Television that is plugged into the wireless outlet switch. 

7 From the top screen drag the Contact Sensor connection to the correct sensor on the 
wireless outlet switch in the bottom screen. 

8 Before you can use power sensing for the plugged-in device, perform Power Learning on 
the wireless outlet switch for that plugged-in device on the appropriate outlet. 
a Turn off the device plugged into the wireless outlet switch. 
b Push and hold the button on the top panel of the wireless outlet switch until the two (2) 

LEDs toggle orange On/Off, alternating back and forth. 
c Select an outlet to configure (Outlet 1 or 2) by releasing the button when the LED that 

corresponds to that outlet number lights up. 
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Example: If a device is plugged into Outlet 1, release the button when LED 1 lights up. 
The LED you chose flashes orange, indicating that the wireless outlet switch is learning 
a steady state of the device (such as On or Off). When the LED turns solid orange, the 
wireless outlet switch has learned the steady state, but has not yet determined whether 
the state is On or Off. 

d With the LED now solid orange, turn the device plugged into the wireless outlet switch 
On. The LED again flashes orange while the wireless outlet switch is learning the On 
state. When the learning completes, the LED glows solid orange again to indicate the 
wireless outlet switch has learned the steady state. 

e With the LED now solid orange again, turn the device Off. The LED flashes orange to 
indicate the wireless outlet switch is waiting for a steady state. When the device 
reaches a steady state, the LED glows red to indicate that the wireless outlet switch has 
learned the Off state. 

f With the LED now solid red, turn the device On again. The LED flashes orange to 
indicate it is waiting for a steady state. When the device reaches a steady state, the 
LED glows green to indicate the wireless outlet switch has learned the On state. 

g With the LED now solid green, press the button on the wireless outlet switch one time 
to save and exit the Power Learning mode.  

Tip: Use a quick-button press during any step prior to the LEDs turning solid red or green to 
exit the Power Learning mode without saving.  

9 Repeat the steps to configure the other outlet (Outlet 1or 2) as needed for any additional 
plugged-in device. 

10 To unlearn a device, press the button nine (9) times, but use with care; as this will reset 
both outlets. 

Configure a Wireless Outlet Dimmer 
Use the Composer Pro System Design and Connections views to configure a Wireless Outlet 
Dimmer. Configure the Wireless Outlet Dimmer to control and dim lamps. 

Prerequisites 

1 Ensure that the Wireless Outlet Dimmer is installed and set up as directed in the Control4 
Wireless Outlet Dimmer Installation Guide available on the Control4 Dealer website. 

2 Ensure that your project has a Control4 controller added and identified on the Control4 
system. 

To add and configure a Wireless Outlet Dimmer: 

Note: Each Wireless Outlet Dimmer has two (2) outlets: Outlet 1 and Outlet 2. When the 
Wireless Outlet Dimmer is plugged into a wall, Outlet 1 is on the left and Outlet 2 is on the right. 

 

  

http://dealer.control4.com/dealer/support/documentation
http://dealer.control4.com/dealer/support/documentation
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3 In the Items pane > My Drivers tab > Lighting > Light double-click the Wireless Outlet 
Dimmer object driver to add it to the project. 

4 Double-click the Outlet Light twice to add one for each outlet. 
5 Ensure that three (3) objects are added to the project tree: 

• One (1) for the Wireless Outlet Dimmer 
• Two (2) other objects representing Outlet 1 and Outlet 2 (Light 1 and Light 2) 

6 To configure the properties, click System Design. In the project tree, select the Wireless 
Outlet Dimmer object to view the device properties. 
• LEDs—Enabled/Disabled radio buttons—Lets you enable or disable the LED lights on 

the Wireless Outlet Dimmer. 
• Networking 

• Channel—Lets you view the channel that the device is using to communicate on 
the network. 

• Gateway —Lets you view the Gateway that the Wireless Outlet Dimmer is using on 
the network. 

• MAC—The MAC address that the device is using on the network. 
• Version—The device version. 

Light (v2) 
Device settings for dimmers 

 

Properties (applies to: Keypad Dimmer, Forward Phase Dimmer, Adaptive Phase Dimmer, 
0-10V Dimmer) 
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• Click rates 
• Preset Level—The percentage of light output is used for On. 

• Ramp Up—The time it takes to reach the preset On level. 
• Ramp Down—The time it takes to reach 0% (Off). 

• Hold Ramp Rates 
• Up—The rate in seconds for reaching the Max On level from an Off state when the 

top button is held down. 
• Down—The rate in seconds for reaching the Off state from an On state when the 

bottom button is held down. 
• Range Levels 

• Min On—The percentage of light for the minimum “On” power level. The default 
is 0. The functional minimum level can vary, depending on the light type (such as 
incandescent, fluorescent, compact fluorescent, and LED). 

This is especially important in compact fluorescent (CLF) and LED lighting that 
sometimes have a minimum threshold for producing visible light that could be 
anywhere from the 10-40% range. Some loads will flicker or pulse right at their 
minimum threshold.  

Example: A bulb doesn’t produce visible light until it reaches 20%. The minimum 
On to 25% will ensure a clean On transition. 

• Max On—This setting enables capping the light level for a given load below 100%, 
either to enhance bulb life or match the light level in a given living space better. 
This is an absolute maximum level rather than the Preset On level, which can be 
bypassed. 

• Cold Start Values—These settings are mainly applicable to compact fluorescent (CFL) 
loads. Switching from an Off state to On sometimes exhibits a higher visible light 
threshold than after the CFLs have been on and have warmed up. If a Cold Start % is 
set (above the Minimum On %), the dimmer cleanly jumps to that level from Off to On. 
However, when the dimmer has been on for the time period designated by the Cold 
Start timer, the dimmer can ramp below the Cold Start On % to the minimum On%.  

Example: Fluorescent lights go on, warm up, and then will dim down to the Minimum 
On Level % setting. Tapping the keypad on a 2-button dimmer sets the light to its preset 
level. If you press and hold the button, the light checks the Minimum On Level % 
setting.  

• Time— The time a light takes to warm up before it dims (ramps) down to the Cold 
Start Level setting. 

• Level— The light level that the bulb returns to after bulb warmup. This value must 
be higher than the Min On level defined under Range Levels. 

• LED Information 
• Top—The On and Off LED colors for the top LED. 
• Bottom—The On and Off LED colors for the bottom LED. 
• Toggle—The LED colors of the LEDs while being held down(?). 

Advanced Properties 

• Fault Detection 
• Status—Displays the device’s current fault status. Green is normal, but red indicates a 

fault. 
• Reset—Resets the fault status indicator. If the fault repeats, make sure that the load 

type is compatible, that the device is wired correctly, and that the device is not 
damaged. 
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• Dimming Mode (Adaptive Phase Dimmer only) 
• Ambient Light Profiles 

• Select a preset brightness profile for the keypad backlight and LEDs that changes their 
brightness according to the room’s ambient light. You can also select Fully Customized 
and manually set each brightness level according to ambient lighting. 

• Backlight Color—Sets the keypad’s backlight color. If you don’t want a keypad 
backlight, keep the default setting (black). 

Button Settings 

• Engraving—Text that you want printed onto the buttons. See “Ordering keycap engraving” 
on page 65. Note: When the custom engraved keycaps are installed, make sure that the 
device properties in Composer Pro match the device’s actual configuration. 

• Finish—Color of the buttons. 
• Icons—Icons that you want printed onto the buttons. To add an icon to the Engraving text 

box, click Icons, then double-click the icon to add. 
• Buttons Control Load—When selected, this checkbox tells the system that the device 

directly controls an electrical load, such as a light fixture.  
• LEDs Follow Load—When selected, this checkbox tells the dimmer’s LEDs to indicate the 

electrical load status. 
• Use as 2 Button Keypad—When selected, this checkbox allows you to configure and 

program the device as a 2-button keypad, and a new section “2 Button Keypad Settings” 
appears. 
• Hide From Nav—When selected, this hides the keypad from any Navigator. Navigators 

must be refreshed for this setting to take effect. 

2 Button Keypad Settings (visible only when “Use as 2 Button Keypad” option is selected) 

• Button—Select the button to configure. 
• LED Behavior 

• Follow Bound Device—LED behavior reflects the state of the device the button is 
bound to. 

• Follow Load—LED behavior reflects the state of the lighting load (on or off). 
• On Color—Sets the LED color when the controlled load is on. 
• Off Color— Sets the LED color when the controlled load is off. 

• Push/Release—LED behavior reflects the button state (pressed or released). 
• Push Color—Sets the LED color while the button is pressed. 
• Release Color— Sets the LED color while the button is released. 

Energy Information (view only) 

• Minutes Off—Elapsed minutes since device was turned off. 
• Minutes On—Elapsed minutes since device was turned on. 
• Minutes On Today—Total minutes device has been on for the current day. 
• Current Power—Power being consumed by the device at the present time. 
• Energy Used—Total watt hours consumed by the device over its lifetime. 
• Energy Used Today—Watt hours consumed by the device for the current day. 

Network—The current MAC address and firmware version of the selected device. These fields 
are not editable.  
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Replace Legacy Control4 Device 

• Replace Light—Replaces a legacy device in your project with this new device. After you 
configure this new device, click this button, select the older device in the mini project tree 
that opens, then click OK. 

 

• Ignore device when it comes online—When selected, this checkbox tells the system to 
ignore the older device when it comes back online. 

Configuring the Keypad Dimmer’s buttons 
When you add a new lighting Keypad Dimmer, a “Keypad” proxy is added underneath the 
Keypad Dimmer in the project tree.  
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To configure the Keypad Dimmer’s buttons: 
1 Add the keypad to your project tree, then identify it. For instructions, see “Guidelines for 

Configuring Devices.”  
2 In the System Design view, select the device.  The device’s Properties tab opens. 

 

3 In the Button Settings area, click and drag the appropriate Keypad Parts items to the 
Assembled Keypad example until the example matches the desired keypad configuration. 

 

Tips: 
• The Down/Up buttons can be placed only in the bottom slot and cannot have custom 

engraving. 
• Drag the desired button to the top slot of the range where you want the button 

positioned. 

 

4 Configure the settings described below. 
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5 Click Apply to… to apply the changes to other lighting devices. 
6 If you entered text for custom engraving, go to “Ordering keycap engraving” on page 65. 

Device settings for the keypad dimmer 
Properties 

• Button Settings 
• Name—The name of the button (used for defining its connections to other devices or 

events within Composer Pro). 
• Engraving—Text that you want printed onto the buttons. For more information, see 

“Ordering keycap engraving” on page 65. 
• Icons—Icons that you want printed onto the buttons. To add an icon to the Engraving 

text box, click Icons, then double-click the icon to add. 
• Button Behavior 

• Load On—Turns on the load (always acts as an “on only” switch). 
• Load Off— Turns off the load (always acts as an “off only” switch). 
• Toggle—Toggles the load on and off. 
• Keypad—Performs actions as programmed in Composer Pro. 

• LED Behavior 
• Follow Bound Device—LED behavior reflects the state of the device the button is 

bound to. 
• Follow Load—LED behavior reflects the power state. 
• Push/Release—LED behavior reflects the button state (pressed or released). 

• Push Color—Sets the LED color while the button is pressed. 
• Release Color— Sets the LED color while the button is released. 

• Finish—Color of the buttons. 
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Device settings for switches 

 

Properties (applies to new lighting Switch C4-SW120277) 

• LED Information 
• Top—The On and Off LED colors for the top LED. 
• Bottom—The On and Off LED colors for the bottom LED. 
• Toggle—The LED colors of the LEDs while being held down. 

Advanced Properties 

• Fault Detection 
• Status—Displays the device’s current fault status. Green is normal, but red indicates a 

fault. 
• Reset—Resets the fault status indicator. If the fault repeats, make sure that the load 

type is compatible, that the device is wired correctly, and that the device is not 
damaged. 
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• Ambient Light Profiles 
• Select a preset brightness profile for the switch backlight and LEDs that changes their 

brightness according to the room’s ambient light. You can also select Fully Customized 
and manually set each brightness level according to ambient lighting. 

• Backlight Color—Sets the switch’s backlight color. If you don’t want a switch backlight, 
keep the default setting (black). 

• Button Settings 
• Engraving—Text that you want printed onto the switch. See “Ordering keycap 

engraving” on page 65. Note: When the custom engraved keycaps are installed, make 
sure that the device properties in Composer Pro match the device’s actual 
configuration. 

• Finish—Color of the switch. 
• Icons—Icons that you want printed onto the buttons. To add an icon to the Engraving 

text box, click Icons, then double-click the icon to add. 
• Buttons Control Load—When selected, this checkbox tells the system that the device 

directly controls an electrical load, such as a light fixture.  
• LEDs Follow Load—When selected, this checkbox tells the dimmer’s LEDs to indicate 

the electrical load status. 
• Use as 2 Button Keypad—When selected, this checkbox allows you to configure and 

program the device as a 2-button keypad, and a new section “2 Button Keypad 
Settings” appears. 
• Hide From Nav—When selected, this hides the switch from any Navigator. 

Navigators must be refreshed for this setting to take effect. 
• 2 Button Keypad Settings (visible only when “Use as 2 Button Keypad” option is selected) 

• Button—Select the button to configure. 
• LED Behavior 

• Follow Bound Device—LED behavior reflects the state of the device the button is 
bound to. 

• Follow Load—LED behavior reflects the state of the lighting load (on or off). 
• On Color—Sets the LED color when the controlled load is on. 
• Off Color— Sets the LED color when the controlled load is off. 

• Push/Release—LED behavior reflects the button state (pressed or released). 
• Push Color—Sets the LED color while the button is pressed. 
• Release Color— Sets the LED color while the button is released. 

• Energy Information (view only) 
• Minutes Off—Elapsed minutes since device was turned off. 
• Minutes On—Elapsed minutes since device was turned on. 
• Minutes On Today—Total minutes device has been on for the current day. 
• Current Power—Power being consumed by the device at the present time. 
• Energy Used—Total watt hours consumed by the device over its lifetime. 
• Energy Used Today—Watt hours consumed by the device for the current day. 

• Network—The current MAC address and firmware version of the selected device. These 
fields are not editable.  
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• Replace Legacy Control4 Device 
• Replace Light—Replaces a legacy device in your project with this new device. After 

you configure this new device, click this button, select the older device in the mini 
project tree that opens, then click OK. 

 

• Ignore device when it comes online—When selected, this checkbox tells the system 
to ignore the older device when it comes back online. 

Changing LED colors on a switch or dimmer 
After you verify that your connections are correct in Composer Pro, you can set the properties 
and configure the system to meet the home control needs. 

To change the LED colors on a switch or dimmer: 
1 In the project tree, select the Switch or Dimmer object for the properties to appear.  

 

2 For each LED light (Top and Bottom), click the color box to set a different color for the On 
and Off states.  
• Top Color On—The LED color for the Top LED when the LED state is On. 
• Top Color Off—The LED color for the Top LED when the LED state is Off. 
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• Bottom Color On—The LED color for the Bottom LED when the LED state is On. 
• Bottom Color Off—The LED color for the Bottom LED when the LED state is Off.  
Tip: You can change the LED lights based on programming. See the Programming view > 
Switch or Dimmer objects for the events available. Also, see the actions available for both 
switch and dimmer. 

Panelized Lighting 
Panelized Lighting lets you install a lighting control central panel in a mechanical room for new 
construction. Along with terminal blocks, the 8-Channel Dimmers, 8-Port Ethernet switches, 8-
Channel 0-10V Dimmers, and 8-Channel Relay modules can be installed in these panels and 
connected to dimmers and switches in all rooms of the house. With any Navigator, you can 
control lights in any room or in the entire house, while eliminating wall clutter. 

The products in the Panelized Lighting family include: 

• 5-Slot Panel (C4-DIN-5PAN) 
• 2-Slot Panel (C4-DIN-2PAN) 
• 8-Channel Dimmer (C4-DIN-8DIM-E) 
• 8-Port Ethernet Switch (C4-DIN-8ESW-E) 
• 8-Channel Relay (C4-DIN-8REL-E) 
• 8-Channel 0-10V Dimmer (C4-DIN-8TV-E) 
• Bus Power Supply (C4-DIN-BPS) 
• Bus Ethernet Gateway, DIN Rail (C4-DIN-BEG) 
• 4-Channel Bus Dry Contact Input (C4-BDCI4)  

Each device you install needs to be: 

1 Added to the project. 
2 Identified (except for the panels and 8-Port Ethernet Switch). 
3 Configured.  

See the following sections for details. Configure the light properties first (next section), and then 
configure each of the modules after that. 

To learn how to design, plan, set up, and install the Panelized Lighting products, see the 
Panelized Lighting information under Lighting on the Control4 Dealer website. 

Tip: Use the Advanced Lighting Scenes and Light Properties agents with Panelized Lighting. 

Tip: Also refer to “Configuring user interfaces” for Panelized Lighting keypad configurations.  

Adding Panelized Lighting to your project 
Use the Composer Pro System Design view to add dimmable, non-dimmable, and 0-10V lights. 

• Dimmable light—Use for any line-voltage dimmable light. Connect only to an 8-
Channel Dimmer. 

• Non-dimmable light—Use for non-dimmable lights including non-dimmable CFLs and 
fluorescents. Connect to an 8-Channel Relay or 8-Channel Dimmer if the wattage is low 
enough. 

• 0-10V light—Use for 0-10V lights (fluorescent lights and LEDs). Connect to an 8-
Channel 0-10V Dimmer and an 8-Channel Relay at the same time). 
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Ensure that a project has been created using Virtual Director and rooms have been added. Refer 
to the Control4 training or the Panelized Lighting Quick Start Guide on the dealer portal for 
details. 

To add a Panelized Lighting device: 
1 To add the drivers, see “How to add devices to a project” on page 5. Ensure that the Light 

drivers are added to the project tree (see the next step). 
2 Start Composer Pro and connect to a Director. 
3 Click System Design. 
4 In the Items pane, click the MyDrivers tab > Light V2 > Dimmable Light (Panelized), Non-

Dimmable Light (Panelized), or 0-10V Light (Panelized) to add the lights to the project 
tree. 

5 (Optional) Rename the lights to something meaningful in the room, for example, “Overhead 
Lights.” 

Next, you need to configure the light’s properties. 

Configure light properties for Panelized Lighting 
Use the Composer Pro System Design view to configure dimmable, non-dimmable, and 0-10V 
lights. 

To add and configure a Panelized Lighting device: 
1 In the project tree, select the light, then make changes to the device in the Properties pane.  

Tip: Before you do anything else, set the values for the Load # and Watts. For your 
convenience, we recommend that you add all of the lights to the project first, and then go to 
Agents and add the Light Properties agent. This will bring up a table with all of your lights. 
You can then add all of the Load#s and Watts to that page, eliminating the need to go into 
the properties for each light and configure these two values individually. 

2 To save your changes, click Set. 

http://dealer.control4.com/dealer/support/documentation
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Dimmable Light properties 

 

Properties: Dimmer Information 

• Click Rates 
• Preset Level—The percentage of the load to which the dimmer module ramps 

when turned on. 
• Ramp Up—The rate the light ramps from off to on when the button is clicked. 
• Ramp Down—The rate the light ramps from on to off when the button is clicked. 

• Hold Ramp Rates 
• Up—The time, in seconds, it takes the load to ramp to 100% when a button 

controlling the load is pressed and held. 
• Down—The time, in seconds, it takes the load to fade to 0% when a button 

controlling the load is pressed and held. 
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• Range Levels. Setting the Range Levels smooths out the dimming curve between the 
minimum and maximum values. This provides a much better dimming experience, 
particularly with LED lights. 
• Min On—The minimum dimmed level, for example, 10%. 
• Max On—The maximum dimmed level where the light will not get any brighter, for 

example, at 80%, the light will never get brighter than that. 
• Cold Start Values. Many dimmable fluorescents and some LEDs require an initial burst 

of energy to get them to turn on. In this case, you could set the Time to 500 
milliseconds and the Level to 50%. 
• Time—Use the arrows selection box to select the time in milliseconds. The default 

is 0. This is the length of time a light takes to warm up before it dims down to the 
Cold Start Level setting. 

• Level—Use the arrows selection box to select the minimum cold start % light level 
in 1% increments.  

• LED Information—The virtual LED colors used when a keypad button is bound to the 
load. Select Top, Bottom, or Toggle LED Colors. 

Advanced Properties 

• Options 
• Load #—The Load number or circuit number may be specified in the lighting plan. 

Adding that information here will provide the link from the lighting plan to the project 
and then to the reports that must be generated later (see "Creating Reports" in this 
document for details). If the lighting plan doesn't include load numbers it's a good 
idea to create a unique load number for each load leg. To do this, assign a number 
for each floor (e.g., Basement = 1, Main = 2). Assign a number for each room on 
the floor (e.g., Kitchen=01, Master Bedroom = 02), and add a number for each light 
in the room (e.g., 01, 02, 03, etc.), so the load number would look something like 
this: '02-01-03.’ The load number must be unique for each Panelized Lighting light. 

• Watts—The wattage value of the light (or collection of lights in the load leg). You 
must enter this value prior to connecting the light to a module to ensure that the 
wattage calculations are correct and that the module does not overload. Example: 
the light leg controls six (6) can lights in the Kitchen; each can is 100 watts. In this 
case, enter 600 watts (6 x 100). 

• Override Level (%)—Defines the level or on/off state that the dimmer load will be 
set to when the module override button is pressed or when the auxiliary override is 
engaged. 

• Dimming Mode (8-Channel Dimmer only)—Defaults to Autodetect until the dimmer 
detects the load type and sets the forward or reverse-phase dimming mode 
appropriately. LEDs usually auto detect as reverse-phase. Some LEDs work better 
in forward-phase. Experiment with forward and reverse phase after installation to 
see which option works the best. 

• Detected—(8-Channel Dimmer only). Indicates whether forward-phase or reverse-
phasedimming is detected when the dimming mode is set to Autodetect. 

• Use Power Booster—(8-Channel Dimmer only). Select this option as a power 
booster that will be used to control the light. Power boosters allow loads greater 
than the maximum wattage for individual channels on the 8-Channel Dimmer to be 
properly dimmed. Selecting the Power Booster option automatically changes the 
wattage to 25W for the load calculations, and indicates in the reports that a power 
booster should be used. 

• Energy Information 
• Minutes Off—The number of minutes that the load has been off since the dimmer 

module was last reset. 
• Minutes On—The number of minutes that the load has been on since the dimmer 

module was last reset. 
• Minutes On Today—The number of minutes that the load has been on today. 
• Current Power—The current power being used by the load (in watts). 
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• Energy Used—The total number of watt hours used by the load since the device 
was last reset. 

• Energy Used Today—The total number of watt hours used by the load from 12:00 
AM until 11:59 PM today. 

Non-Dimmable properties 

 

Properties: LED Information 

• The virtual LED colors used when a keypad button is bound to the load. Select Top, 
Bottom, or Toggle LED Colors. 

Advanced Properties 

• Options 
• Load #—The Load number and circuit number may be specified in the lighting 

plan. Adding that information here will provide the link from the lighting plan to the 
project and then to the reports that must be generated later (see "Creating Reports" 
in this document for details). If the lighting plan doesn't include load numbers, it's a 
good idea to create a unique load number for each load leg. To do this, assign a 
number for each floor (e.g., Basement = 1, Main = 2). Assign a number for each 
room on the floor (e.g., Kitchen=01, Master Bedroom = 02), and add a number for 
each light in the room (e.g., 01, 02, 03, etc.). So the load number would look 
something like this: '02-01-03.’ The load number must be unique for each 
Panelized Lighting device. 

• Watts—The wattage value of the light (or collection of lights in the load leg). You 
must enter this value prior to connecting the light to a module to ensure that the 
wattage calculations are correct and that the module does not overload. Example: 
The light leg controls six (6) can lights in the Kitchen; each can is 100 watts. In this 
case, enter 600 watts (6 x 100). 

• Override Level (%)—Defines the level or on/off state that the dimmer load will be 
set to when the module override button is pressed or when the auxiliary override is 
engaged. 

• Energy Information 
• Minutes Off—The number of minutes that the load has been off since the dimmer 

module was last reset. 
• Minutes On—The number of minutes that the load has been on since the dimmer 

module was last reset. 
• Minutes On Today—The number of minutes that the load has been on today. 
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• Current Power—The current power being used by the load (in watts). 
• Energy Used—The total number of watt hours used by the load since the device 

was last reset. 
• Energy Used Today—The total number of watt hours used by the load from 12:00 

AM until 11:59 PM today. 

0-10V properties 

 

Properties 

• Dimmer Information 
• Click Rates 

• Preset Level—The percentage of the load to which the dimmer module ramps 
when turned on. 

• Ramp Up—The rate the light ramps from off to on when the button is clicked. 
• Ramp Down—The rate the light ramps from on to off when the button is clicked. 
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• Hold Ramp Rates 
• Up —The time, in seconds, it takes the load to ramp to 100% when a button 

controlling the load is pressed and held. 
• Down—The time, in seconds, it takes the load to fade to 0% when a button 

controlling the load is pressed and held. 
• Range Levels 

• Min On—The minimum dimmed level, for example, 10%. 
• Max On—The maximum dimmed level where the light will not get any brighter, for 

example, at 80%, the light will never get brighter than that. 
• Cold Start Values  

• Time—Use the arrows selection box to select the time in milliseconds. The default 
is 0. This is the length of time a light takes to warm up before it dims down to the 
Cold Start Level setting. 

• Level—Use the arrows selection box to select the minimum cold start % light level 
in 1% increments.  

• LED Information—The virtual LED colors used when a keypad button is bound to 
the load. Select Top, Bottom, or Toggle LED Colors. 

Advanced Properties 

• Options 
• Load #—The load number and circuit number may be specified in the lighting plan. 

Adding that information here will provide the link from the lighting plan to the project and 
then to the reports that must be generated later (see "Creating Reports" in this 
document for details). If the lighting plan doesn't include load numbers, it's a good idea 
to create a unique load number for each load leg. To do this, assign a number for each 
floor (e.g., Basement = 1, Main = 2). Assign a number for each room on the floor (e.g., 
Kitchen=01, Master Bedroom = 02), and add a number for each light in the room (e.g., 
01, 02, 03, etc.). So the load number would look something like this: '02-01-03.’ The 
load number must be unique for each Panelized Lighting device. 

• Watts—The wattage value of the light (or collection of lights in the load leg). You must 
enter this value prior to connecting the light to a module to ensure that the wattage 
calculations are correct and that the module does not overload. Example: The light leg 
controls six (6) can lights in the Kitchen; each can is 100 watts. In this case, enter 600 
watts (6 x 100). 

• Override Level(%)—Defines the level or on/off state that the dimmer load will be set to 
when the module override button is pressed or when the auxiliary override is engaged. 

• Load Type—Select an option based on the specific type of 0-10V light being used: 
• 0-10V Regular—Used when 0V = minimum dimmed level and 10V = maximum 

level. Note that most “0-10V” lights do not actually use 0-10V, they use 1-10V. Only 
select this option if you know that the light actually requires true 0-10V control. 

• 1-10V Regular—Used when 1V = minimum dimmed level and 10V = maximum 
level. This is the default selection as it is the actual standard for 0-10V lights. 

• 0-10V Inverted—Used when 10V = minimum dimmed level and 0V = maximum 
level. (Rarely used.) 

• 1-10V Inverted—Used when 10V = minimum dimmed level and 1V = maximum  
               level. (Rarely used.) 

• Use External Relay—Check the box if an external relay such as a Leviton Power Pack 
Relay will be used for on/off control of the 0-10V light. Uncheck if on/off control will be 
provided by a Control4 Relay Module or if the 0-10V light does not require separate 
on/off control. If the Use External Relay box is checked, the 0-10V light will not be able 
to be connected to a Control4 Relay Module and the reports will indicate that an 
external relay should be used. 
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Energy Information 

• Note—Energy information is only provided when the 0-10V light is connected to a 
Control4 Relay Module. 

• Minutes Off—The number of minutes that the load has been off since the relay module 
was last reset. 

• Minutes On—The number of minutes that the load has been on since the relay module 
was last reset. 

• Minutes On Today—The number of minutes that the load has been on today. 
• Current Power—The current power being used by the load (in watts). 
• Energy Used—The total number of watt hours used by the load since the device was 

last reset. 
• Energy Used Today—The total number of watt hours used by the load from 12:00 AM 

until 11:59 PM today. 

Configure an 8-Channel Dimmer 
Use the Composer Pro System Design and Connections views to configure an 8-Channel 
Dimmer module for Panelized Lighting. 

Ensure that the 8-Channel Dimmer module (C4-DIN-8-DIM-E) is installed as directed in the 
Control4 8-Channel Dimmer Installation Guide, 8-Channel Dimmer Operation and Configuration 
Guide, and the 8-Channel Dimmer Wiring Guide on the Control4 Dealer website. 

To add and configure an 8-Channel Dimmer module: 
1 To add the driver and identify the device see “Guidelines for Configuring Devices.” Ensure 

that the 8-Channel Dimmer driver is added to the project tree (see the next step). Add as 
many 8-Channel Dimmer drivers as needed (eight (8) loads per module). 

2 In the Items pane > My Drivers tab > Lighting > Panelized Lighting select the 8-Channel 
Dimmer to add the driver to the project tree.  

Notes: (1) Auto Discovery is available, but we recommend that you add the drivers manually 
for best results.(2) It’s best to add all of the modules at the same time before making all of 
the connections. 

3 (Optional) Rename the module drivers to something meaningful in the room, for example, 8-
Channel Dimmer 1 in the Mechanical Room. 

4 (Optional) To configure the dimmer’s properties, in the project tree select the 8-Channel 
Dimmer object and view the items in the Properties pane. 

http://dealer.control4.com/dealer/support/documentation
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Dimmer Properties:  

 

Module Information 

• Nominal Voltage—(110V – 277V) The voltage of the circuit to which the module will be 
connected. Measured voltage may differ slightly from nominal voltage depending on the 
electrical supply. This is used for wattage calculations when connecting loads to the module. 

• Measured Voltage—Indicates the electrical voltage that the module is measuring. Not 
editable. 

• Frequency—Indicates the electrical frequency that the module is measuring. Not editable. 
• Temperature—View the module’s temperature. 
• Overtemp Fault—View the module’s temperature fault, if displayed. 
• In Control4 Panel—Check if this module will be installed in a Control4 2-slot or 5-slot panel. 

Do not check if the module will be installed in a third-party DIN rail panel. This is used in 
maximum wattage calculations. Dimmers in third-party panels must be derated with lower 
wattage limits. 

• Auxiliary Override Switch Location—Indicates where the override switch should be 
installed and wired, e.g., the Master Bedroom Closet. Type the room’s name. This 
information will be included in the Module Report that can be provided to the electrician. 

• Circuits (2 maximum)—Set to 1 or 2. It’s usually best to set this value to 2 and then reduce 
it to 1 if the connections made later are under the maximum wattage for a single circuit. 

• Circuit 1, 2—The breaker size for each circuit. This can be set from 10A to 20A. Used for 
maximum wattage calculations. 

• Arc Fault—Check with the local electrician to determine the local requirements for arc-fault 
breakers. In the U.S., NEC requires arc-fault breakers (AFCIs) for circuits serving most living 
areas. Some municipalities using an older version of the code may require them only on 
lights in bedrooms or not require them on lighting circuits. AFCIs are prone to interpret 
dimming as a fault and nuisance trip. They are limited to only 8.3A of dimming on the circuit. 
This setting is used for maximum wattage calculations. 

Channel Information 

• Channel#—The channel number indicated on the module’s hardware. 
• Load Name—The name of the load that is connected to the indicated channel. 
• Fault Status—Refer to the 8-Channel Dimmer Installation Guide for fault details. 

http://dealer.control4.com/dealer/support/documentation
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Network 

• Firmware Version—Indicates the firmware driver version for this module. 
• Modules Config Page—Click to open the network configuration page for the module in your 

internet browser. 

Configure an 8-Channel Relay 
Use the Composer Pro System Design and Connections views to configure an 8-Channel Relay 
module for Panelized Lighting devices. 

Ensure that the 8-Channel Relay module (C4-DIN-8REL-E) is installed as directed in the 
Control4 8-Channel Relay Installation Guide on the Control4 Dealer website. 

To add and configure an 8-Channel Relay module: 
1 To add the driver and identify the device see “Guidelines for Configuring Devices.” Ensure 

that the 8-Channel Relay driver is added to the project tree (see the next step). Add as 
many 8-Channel Relay drivers as needed (eight (8) relays per module). 

2 In the Items pane > My Drivers tab > Lighting > Panelized Lighting select the 8-Channel 
Relay to add the driver to the project tree.  

Notes: (1) Auto Discovery is available for this product, but we recommend that you add the 
drivers manually for best results. (2) It’s best to add all of the modules at the same time 
before making all of the connections. 

3 (Optional) Rename the module drivers to something meaningful in the room, for example, 8-
Channel Relay 1 in the Mechanical Room. 

4 (Optional) To configure the relay’s properties, in the project tree select the 8-Channel Relay 
object and view the items in the Properties pane. 

Relay Properties:  

 

Module Information 

• Nominal Voltage (110V – 277V)—The voltage of the circuit to which the module will be 
connected. Measured voltage may differ slightly from nominal voltage depending on the 
electrical supply. This is used for maximum wattage calculations. 

• Measured Voltage—Not editable. 
• Frequency—Not editable. 

http://dealer.control4.com/dealer/support/documentation
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• Temperature—View the module’s temperature. 
• Overtemp Fault—View the module’s temperature fault, if displayed. 
• In Control4 Panel—Check if this module is installed in a 2-slot or 5-slot panel. Do not check 

if the module will be installed in a third-party DIN rail panel. This is used in maximum 
wattage calculations. Relays in third-party panels must be derated with lower wattage limits. 

• Auxiliary Override Switch Location—Indicates where the override switch should be 
installed and wired, e.g., the Master Bedroom Closet. Type the room’s name in the box. 

• Circuit 1, 2, 3, 4—The breaker size for each circuit. This can be set from 10A to 20A. Used 
for maximum wattage calculations. 

Channel Information 

• Channel#—The channel number indicated on the module’s hardware. 
• Load Name— The name of the load that is connected to the indicated channel. 

Network 

• Firmware Version—Indicates the firmware version for this driver. 
• Modules Config Page—Click to open the network configuration page for the module in your 

Internet browser. 

Configure an 8-Port Ethernet Switch 
There are no properties to define for the 8-Port Ethernet Switch (C4-DIN-8ESW-E) driver in 
Composer Pro. 

Configure an 8-Channel 0-10V Dimmer 
Use the Composer Pro System Design and Connections views to configure an 8-Channel 0-10V 
Dimmer module. 

Ensure that the 8-Channel 0-10V Dimmer module (C4-DIN-8TV-E) is installed as directed in the 
Control4 8-Channel 0-10V Dimmer Installation Guide and 8-Channel 0-10V Dimmer Wiring 
Guide available on the Control4 Dealer website. 

To add and configure an 8-Channel 0-10V Dimmer module: 
1 To add the driver and identify the device see “Guidelines for Configuring Devices.” Ensure 

that the 8-Channel 0-10V Dimmer module driver is added to the project tree (see the next 
step). Add as many 8-Channel 0-10V Module drivers as needed (eight (8) dimmers per 
module). 

2 In the Items pane > My Drivers tab > Lighting select the 8-Channel 0-10V Module to add 
the driver to the project tree.  

Notes: (1) Auto Discovery is available, but we recommend that you add the drivers manually 
for best results. (2) It’s best to add all of the modules at the same time before making all of 
the connections. 

3 (Optional) Rename the module drivers to something meaningful in the room, for example, 8-
Channel 0-10V Module 1 in the Mechanical Room. 

4 (Optional) To configure the dimmer’s properties, in the project tree select the 8-Channel 0-
10V Module object and view the items in the Properties pane. 

http://dealer.control4.com/dealer/support/documentation
http://dealer.control4.com/dealer/support/documentation
http://dealer.control4.com/dealer/support/documentation
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0-10V Dimmer Properties:  

 

Module Information 

• Temperature—View the module’s temperature. 
• Overtemp Fault—View the module’s temperature fault, if displayed. 
• Auxiliary Override Switch Location—Indicates where the override switch should be 

installed and wired, e.g., the Master Bedroom Closet. Type the room’s name in the box. 

Channel Information 

• Channel#—The channel number indicated on the module’s hardware. 
• Load Name—The load name used. 

Network 

• Firmware Version—Indicates the firmware driver version for this module. 
• Modules Config Page—Click to open the network configuration page for the module in your 

internet browser. 

Configure a 4-Channel Bus Dry Contact Input 
Use the Composer Pro System Design and Connections views to configure a 4-Channel Bus Dry 
Contact Input device. 

To add and configure a 4-Channel Bus Dry Contact Input:  
1 To add the driver and identify the device see “Guidelines for Configuring Devices.” Ensure 

that the 4-Channel Bus Dry Contact Input driver is added to the project tree (see the next 
step). 

2 In the Items pane > My Drivers tab > Lighting select the 4-Channel Bus Dry Contact Input 
to add the driver to the project tree.  

3 Click each button to define its name and behavior. 
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4-Channel Bus Dry Contact Input Properties:  

 

Button Settings 

• Name—The name of the button (used for defining its connections to other devices or 
events). 

• Button Behavior—How the button works mechanically.  
• Latch—Pressing and releasing the button toggles between “button pressed” and 

“button released” states. 
• Momentary—Pressing and releasing a button creates only a momentary connection. 

Configure a Bus Ethernet Gateway 
Use the Composer Pro System Design and Connections views to configure a Bus Ethernet 
Gateway. 

To add and configure a Bus Ethernet Gateway: 
1 To add the driver and identify the device see “Guidelines for Configuring Devices.” Ensure 

that the Bus Ethernet Gateway driver is added to the project tree (see the next step). 
2 In the Items pane > My Drivers tab > Lighting select the 4-Channel Bus Dry Contact Input 

to add the driver to the project tree.  
3 Click each button to define its name and behavior. 
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Bus Ethernet Gateway Properties:  

 

Configuring user interfaces 
Use the Composer Pro System Design and Connections views to configure Navigators for the 
Control4 system.  

Notes: (1) You may have noticed a "Commissioning Remote Control SR-250" driver in the 
Online Database; this driver is not used for residential customers. (2) As of OS 2.3.0, the 
MyHome drivers no longer appear in the drivers list. This is because if you have a valid license, 
new apps will be installed and identified automatically. See the MyHome Setup Guide for Dealers 
or MyHome Setup Guide for Homeowners for updates. 

These subsections provide information about configuring system remote controls and touch 
screens: 

• “Configure System Remote Control SR-150B” 
• “Configure System Remote Control Version 3, SR-250” 
• “Configure a 7” Portable Touch Screen with Camera” 
• “Configure a 7” Portable Touch Screen” 
• “Configure a 7” Tabletop or Wall-Mounted Touch Screen” 
• “Configure a 7” In-Wall Touch Screen with Camera” 
• “Configure a 5” or 7” In-Wall Touch Screen” 

http://dealer.control4.com/dealer/products
http://dealer.control4.com/dealer/products
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• “Configure Mobile Devices or PCs/Tablets as Navigators” 
• “Configure a Door Station” 

Change the order of Watch/Listen sources 
To change the order of your customer's sources when they press Watch/Listen: 
1 In the project tree, click the room to control. 
2 Click the Navigator tab. 
3 From the Menu (left side), select the function to change; for example, Watch or Listen. 
4 Select the item in 'Device Visibility and Display Order,' and then click Modify. 
5 Change to the desired order, and then click OK. 

Configuring remote controls 
Configure System Remote Control SR-150B 

Use the Composer Pro System Design and Connections views to add and identify this device. 

Ensure that the SR-150B is installed as directed in the Control4 System Remote Control SR-
150B Setup Guide. 

To add and configure an SR-150B: 
1 To add the driver and identify the device see “Guidelines for Configuring Devices.” Ensure 

that the System Remote Control SR-150 driver is added to the project tree.  

Note: To complete the identification process, the system remote control must be on the 
same ZigBee channel as the controller, and the controller must have Zserver enabled. To 
change the ZigBee channel on the remote, see Step 5.  

2 (Optional) To configure the properties, click System Design. 
3 In the project tree, select the System Remote Control object. 
4 View and change the properties in the Properties pane.  

Note: Press any button on the system remote control to display the configurable property 
values in the Properties pane. Because the SR-150B has no window, some of the options 
below are not supported in the SR-150B.  

Modifiable properties include: 

• Screen Backlight—Not used. 
• Keypad Backlight—Lets you set the light level of the backlight. The default is 0%. Click 

Set Level. 
• Sleep Mode—Lets you configure sleep mode settings. The default is five (5) seconds, 

but can be extended to 60 seconds. Select Wake on Movement if you want the remote 
control to wake up when moved. 

• Batteries—Lets you view the battery level on your remote control. 
• Enable Recharge Station—Check this box if you received a Remote Recharging 

Station with a remote. This feature updates your existing remote to recognize the 
new rechargeable battery. 

• Network—Lets you view the remote control’s ZigBee channel, gateway, MAC address 
and firmware version. 
• MAC—Displays the remote’s own MAC address. 
• Firmware Version—Displays the current firmware version of the remote control. 

http://dealer.control4.com/dealer/support/documentation
http://dealer.control4.com/dealer/support/documentation
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• Watch/Listen Button Behavior—If you select one of the options below, the following 
action occurs when you press the Watch button. 
• No Action—When you press the Watch button, nothing happens. This option can 

be tied to programming a button (see the section below). 
• Select Most Recently Used Device—Lists the last three (3) devices; e.g., DVD 

player, media player, television, etc. 
5 Change the system remote control settings as needed at the physical system remote control 

SR-150B using the applicable button-press sequence: 
• Check ZigBee Channel—To determine the current ZigBee channel, press Room Off, 

0, 0, 3 (or Room Off, 7, 4, 7) (in that order), and then count the blinks of Room Off. The 
number of blinks corresponds with the channel number. 

• Reset to Factory Defaults—To reset all settings to the factory defaults (including 
ZigBee channel), press Room Off, 9, 9, 9. 

Program the System Remote Control SR-150B 
programmable buttons 

On the system remote control SR-150, you can program six (6) buttons (red, green, yellow, blue, 
*, and #) to perform programmed activities. The buttons can be programmed to execute any of 
the AV device’s macros or IR codes or be programmed by room. 

To program the buttons: 
1 Ensure that you have the following devices in your project: 

• Controller 
• System remote control SR-150B 
• An AV device to be controlled 

2 In Composer Pro, click Connections. 
3 Click the Network tab. Ensure that the controller and the remote are both network identified. 
4 Program the programmable buttons (Red, Green, Yellow, Blue, *, or #) either based on the 

selected AV device or the selected room. 

Based on AV device: 

a Click System Design. 
b Select an AV device to display the device’s Properties page.  

 



Composer Pro 2.5 User Guide   Configuring user interfaces 

53 

c On the device’s Properties page, select Code or Macro for the button you want to 
program, and then select a code or macro from the drop-down list. 

d Edit the Help text as needed, and then select Set.  

Note: Help text describes custom programming to users in the House option in any of the 
Navigators.  

Example: (1) In System Design, select Disc Changer. (2) In the Red button, select Code. 
(3) From the drop-down list, select Subtitle. (4) Select the Set button to create a Subtitle 
button.  

Based on room: 

a Click Programming. 
b Select a room in the Device Events pane. 
c Select the Commands radio button in the <Room> Events pane. 
d Use the drop-down menu to select a command or button (example, Blue Button). 
e In the Actions pane, build the script using the items to program the actions in the 

selected room when the selected command or button is used. 

Configure System Remote Control SR-250 
Use the Composer Pro System Design and Connections views to add and identify this device. 

Ensure that the system remote control SR-250 is installed as directed in the Control4 System 
Remote Control SR-250 Setup Guide available on the Control4 Dealer website. 

To add and configure an SR-250: 
1 To add the driver and identify the device see “Guidelines for Configuring Devices.” Ensure 

that the System Remote Control SR-250 driver is added to the project tree. 

Note: To complete the identification process, the remote must be on the same ZigBee 
channel as the controller, and the controller must have Zserver enabled. To change the 
ZigBee channel on the remote, see Step 6.  

2 (Optional) To configure the properties, click System Design. 
3 In the project tree, select the System Remote Control object. 
4 View and change the properties in the Properties pane.  

Note: Press any button on the SR-250 to display the configurable property values in the 
Properties pane.   

Tip: You can also change most of these settings on the SR-250 using Info > Config.  

Modifiable properties include: 

• Screen Backlight—Lets you set the light level of the screen's backlight. Select a 
percentage from 0 (Off) to 100 (full brightness). The default is 100%. Click Set Level. 

• Keypad Backlight—Lets you set the light level of the keypad's backlight. Select a 
percentage from 0 (Off) to 100 (full brightness). The default is 100%. Click Set Level. 

• Sleep Mode—Lets you set how long the remote control stays awake after no activity. 
The default setting is five (5) seconds, but can be extended to 60 seconds. Select Wake 
on movement to wake the SR-250 up when moved. 

• Batteries—Lets you view the battery level (strength in %) of your remote. 
• Enable Recharge Station—Check this box if you received a Remote Recharging 

Station with a remote. This feature updates your existing remote to recognize the 
new rechargeable battery. 

http://dealer.control4.com/dealer/support/documentation
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• Network—Lets you view the remote’s ZigBee channel, gateway, MAC address and 
firmware version. 
• Channel—Displays your ZigBee channel (1-15), which should match the ZigBee 

channel set for the controller. 
• Gateway—Displays the MAC address of the ZigBee server (usually your controller 

unless you specify otherwise). 
• MAC—Displays the remote's own MAC address. 
• Firmware Version—Displays the current firmware version of the remote. 

• Watch/Listen Button Behavior—If you select one of the options below, the following 
action occurs when you press the Watch button. 
• No Action—If you select this option and you press the Watch button, nothing 

happens. This option can be tied to programming a button (see the section below). 
• Select Most Recently Used Device—Lists the last three (3) devices; e.g., DVD 

player, Media Player, Television, etc. 
• Show Device List—Lists the source device of the selection. 

5 (Conditional) Change ZigBee Channel: If you need to change the ZigBee channel to match 
the controller’s channel or to improve reception, do the following on the system remote 
control SR-250.  

If the system remote control is NOT identified, follow these steps: 
a Press buttons 2, 4, 8, 6, #, *, and then press the List button (in that order) to get into 

Edit mode. 
b Use the up or down arrows to pick the ZigBee channel. 
c Press Select to change the ZigBee channel. 
d Press CNCL to exit Edit mode.  

If the system remote control IS identified, follow these steps: 
a Press the List button once or twice to display the menu options. 
b Press buttons 2, 4, 8, 6, #, * and then press the List button (in that order) to get into 

Edit mode. 
c Use the up or down arrows to pick a ZigBee channel. 
d Press Select to change the ZigBee channel. 
e Press CNCL to exit Edit mode. 

Program the SR-250 programmable buttons 
On the system remote control SR-250, you can program six (6) buttons (Red, Green, Yellow, 
Blue, *, and #) to perform programmed activities. You can program these buttons to execute any 
of the AV device’s macros or IR codes or they can be programmed by room. 

To program the SR-250 programmable buttons: 
1 Ensure that you have the following devices in your project: 

• Controller 
• System remote control SR-250 
• An AV device to be controlled 

2 In Composer Pro click Connections. 
3 Click the Network tab. Ensure that the controller and the remote are both network identified. 
4 Program the programmable buttons (Red, Green, Yellow, Blue, *, or #) either based on the 

selected AV device or the selected room. 
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Based on AV device: 

a Click System Design. 
b Select an AV device to display the device’s Properties page. 

 

c On the device’s Properties page, select Code or Macro for the button you want to 
program, and then select a code or macro from the drop-down list. 

d Edit the Help text as needed, and then select Set.  

Note: Help text describes custom programming to users in the House option in any of 
the Navigators.  

Example: (1) In System Design view, select Disc Changer. (2) In the Red button, 
select Code. (3) From the drop-down list, select Subtitle. (4) Select the Set button to 
create a Subtitle button.  

Based on room: 

a Click Programming. 
b Select a room in the Device Events pane. 
c Select the Commands radio button in the <Room> Events pane. 
d Use the drop-down menu to select a command or button (example, Blue Button). 
e In the Actions pane, build the script using the items to program the actions in the 

selected room when the selected command or button is used. 

Program the SR-250 Paging feature 
Configure the Beep paging feature for this remote version through programming. Use this feature 
to page a lost remote. You can program a keypad or a custom button to cause the remote to 
beep when pressed. 

To program the paging feature for this system remote control: 
1 In Composer Pro click Programming. 
2 Select the event that you want to use to start the page. Example: To select a keypad button 

press, first select the Keypad in the Device Event pane, and then select the button in 
Events. 

3 In the Actions list, select System Remote Control SR-250. 
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4 In the Commands list, select an action below for the remote, and then drag the green arrow 
to the Script pane.  

  

• Beep until button press—The remote beeps until you press one of its buttons. 
• Beep for X seconds (<254)—The remote beeps until X seconds have elapsed or you 

press one of its buttons. 
• Stop Beep—The remote stops beeping. 

5 Click Execute. 

Configuring touch screens 
Configure a 7″ In-Wall Touch Screen with Camera (C4-TW7CO) 

Use the Composer Pro System Design and Connections views to add and configure the 7″ In-
Wall Touch Screen (C4-TW7CO) with a camera. 

Note:This particular touch screen includes full duplex point-to-point Intercom sessions, 
broadcast support to multiple touch screens, monitoring from the interface, and comes with a 
camera for video conferences to another device that supports cameras. An Intercom driver and 
agent must be added and configured in the Composer project before the customer can use the 
Intercom functions on their touch screen. See this section, the Control4 System User Guide, and 
“Example: Using the Intercom agent” for details. 

As of June 1, 2013, the HC-800 (C4-HC800-BL-1) and HC-250 (C4-HC250-BL-1) ship with 
included support for Intercom and MyHome. For controllers shipped before that time, you must 
purchase an Intercom and MyHome license for consumers who want this feature. In either case, 
the license must be assigned and active on the consumer's account for the Intercom and 
MyHome to function. See Managing Dealer Accounts on My.Control4.Com on the 
Knowledgebase for information about how to purchase and assign an Intercom license. 

http://dealer.control4.com/dealer/support/documentation
http://kb.control4.com/
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Scenarios 
1 The user wants to have full-duplex, room-to-room calling. In this case, the Control4 

system must have at least two (2) 7" In-Wall Touch Screens installed. 
2 The user wants to broadcast a message without a response. In this case, the Control4 

system must have at least one (1) 7" In-Wall Touch Screen installed. 
3 The user wants to broadcast a message with a response. In this case, the Control4 

system must have at least two (2) 7" In-Wall Touch Screens installed. 
4 The user wants to monitor the sounds in another room. In this case, the Control4 system 

must have at least two (2) 7" In-Wall Touch Screens installed. 
5 The user wants to have a video conference with others. In this case, the Control4 

system must have at least two (2) devices that support Video Intercom (7” In-Wall Touch 
Screen with Camera, 7” Portable Touch Screen with Camera, or Door Station – Exterior). 

Prerequisites 
1 Ensure that the 7" In-Wall Touch Screen (C4-TW7CO-XX) is installed as directed in the 

Control4 7" In-Wall Touch Screen Installation Guide available on the Control4 Dealer 
website. 

2 Ensure that your project has a Control4 controller added and identified in the Control4 
system. 

To add and configure a 7" In-Wall Touch Screen with Camera: 
1 To add the driver and identify the device see “Guidelines for Configuring Devices.” Ensure 

that the In-Wall 7” Touch Screen V2 driver is added to the project tree. 

Note: If this touch screen will be providing audio output, the touch screen needs to be 
connected as an Audio end point for the room. 

2 (Optional) To configure the properties, click System Design. 
3 In the project tree, select the 7″ Touch Screen object. 
4 View and change the properties in the Properties pane as needed. 

Modifiable properties include: 

Backlight Level—Use the up or down arrows to set the light level of the backlight. You can 
change the brightness of the backlight with this option by percentage, so 100% is On at full 
brightness and 0% is Off. Click Set to save your changes. 

Backlight Preset Level—Lets you set the default backlight level. If you ever restart or 
power the touch screen again, this is the backlight level it would go to. Click Set to save your 
changes. 

WiFi Signal Strength (%)—If WiFi is used this shows the strength of the signal. Ensure that 
the signal is strong and robust if you use the Door Station for WiFi. We recommend using 
Ethernet rather than WiFi for best results. 

Notes: (1) Video Intercom usage. Although this device supports b/g/n, 802.11 b is not 
recommended for Video Intercom. (2) Wireless-n is recommended for Video Intercom. See 
“Wireless Network Limitations” below. 

Refresh—Click to refresh the signal strength values. 

Enable Camera— Checked by default. When checked, this allows the device to use the 
camera for Video Intercom in addition to audio. 

http://dealer.control4.com/dealer/support/documentation
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Wireless Network Limitations—Many WiFi Access Points handle Multicasts (WiFi 
simultaneously sent to multiple devices, for example, when the 7” In-Wall Touch Screen with 
Camera broadcasts video to all stations) by slowing down transmission speed to the 1 Mb 
basic rate. This can cause overall WiFi congestion in the WiFi network during the broadcast. 
Video Intercom response times and images may degrade at each device.  

If a home requires a large number of WiFi Video Intercom devices, ensure that you have a 
robust WiFi network (possibly consisting of multiple access points). 

Configure a 7” Portable Touch Screen (C4-TSM7) 
Use the Composer Pro System Design and Connections views to add and configure this device.  

Note: If you want to add and configure the new 7” Portable Touch Screen with Camera released 
with OS 2.2, see the next section. 

Prerequisites 

1 Ensure that the 7" Portable Touch Screen (C4-TSM7-G-B) is installed as directed in the 
Control4 7" Portable Touch Screen Installation Guide available on the Control4 Dealer 
website.  

2 Ensure that your project has a Control4 controller added and identified in the Control4 
system. 

To add and configure a 7" Portable Touch Screen: 
1 To add the driver and identify the device see “Guidelines for Configuring Devices.” Ensure 

that the Touch Screen - 7" Portable driver is added to the project tree.  

Note: If this touch screen will be providing audio output, the touch screen needs to be 
connected as an Audio end point for the room.  

2 (Optional) To configure the properties, click System Design. 
3 In the project tree, select the Touch Screen - 7" Portable object. 
4 View and change the properties in the Properties pane.  

Modifiable properties include: 

Backlight Level—Use the up or down arrows to set the light level of the backlight. You can 
change the brightness of the backlight with this option by percentage, so 100% is On at full 
brightness and 0% is Off. 

Backlight Preset Level—Lets you set the default backlight level. If you ever restart or 
power the Mini Touch Screen again, this is the backlight level it would go to. 

Button Animation Enabled—Lets you select a button to glow. 

Volume Control Follows Selected—Lets you select other rooms aside from the one that 
contains the touch screen, and change its volume when leaving the room. 

Wake on motion—Select to wake up the touch screen when it is moved. 

Configure a 7” Portable Touch Screen with Camera 
(C4-TSMC7-EN) 

Use the Composer Pro System Design and Connections views to add and configure this device. 

Prerequisites 
1 Ensure that the 7" Portable Touch Screen with Camera (C4-TSMC7-EN) is installed as 

directed in the Control4 7" Portable Touch Screen with Camera Setup Guide available on 
the Control4 Dealer website.  

http://dealer.control4.com/dealer/support/documentation
http://dealer.control4.com/dealer/support/documentation
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Note: If you want to install the new 7" Portable Touch Screen with Camera, ensure that the 
part number says "C4-TSMC7-EN" when you add the driver. 

2 Ensure that your project has a Control4 controller added and identified in the Control4 
system. 

To add and configure a 7" Portable Touch Screen with Camera: 
1 To add the driver and identify the device see “Guidelines for Configuring Devices.” Ensure 

that you add the driver Portable 7” Touch Screen V2 to the project tree.  

Note: If this touch screen will be providing audio output, the touch screen needs to be 
connected as an audio end point for the room.  

2 (Optional) To configure the properties, click System Design. 
3 In the project tree, select the Portable 7” Touch Screen V2 object. 
4 View and change the properties in the Properties pane. 

Modifiable properties include: 

Backlight Level—Use the up or down arrows to set the light level of the backlight. You can 
change the brightness of the backlight with this option by percentage, so 100% is On at full 
brightness and 0% is Off. Click Set to save. 

Backlight Preset Level—Lets you set the default backlight level. If you ever restart or 
power the touch screen again, this is the backlight level it would go to. Click Set to save. 

WiFi Signal Strength—If using WiFi, shows you the strength of your wireless signal. 

Notes: (1) Video Intercom. Although this device supports b/g/n, 802.11 b is not supported 
for Video Intercom use. (2) Wireless-n is recommended for Video Intercom. See “Wireless 
Network Limitations” below. 

Enable Camera—Check to use the camera with this device for video intercom. 

Wireless Network Limitations 

Many WiFi Access Points handle Multicasts (WiFi simultaneously sent to multiple devices, 
for example, when the 7” Portable Touch Screen with Camera broadcasts video to all 
stations) by slowing down transmission speed to the 1 Mb basic rate. This can cause overall 
WiFi congestion in the WiFi network during the broadcast. Video Intercom response times 
and images may degrade at each device. 

If a home requires a large number of WiFi Video Intercom devices, ensure that you have a 
robust WiFi network (possibly consisting of multiple access points). 

Configure a 7” Tabletop Touch Screen  
(C4-TST7-EG-B or C4-TSTR7-EG-B) 

Use the Composer Pro System Design and Connections views to add and configure this device. 

Prerequisites 
• Ensure that the 7" Tabletop Touch Screen (C4-TST7-EG-B or C4-TSTR7-EG-B) is installed 

and on (not in Sleep Mode) as directed in the Control4 7" Tabletop Touch Screen Installation 
Guide on the Control4 website. 

• Ensure that your project has a Control4 controller added and identified in the Control4 
system. 

To add and configure a 7" Tabletop Touch Screen: 
1 To add the driver and identify the device see “Guidelines for Configuring Devices.” Ensure 

that the Touch Screen - 7" object is added to the project tree. 

http://dealer.control4.com/dealer/support/documentation
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2 (Optional) To configure the properties, click System Design. 
3 In the project tree, select the Touch Screen - 7" object. 
4 View and change the properties in the Properties pane.  

Modifiable properties include: 

• Backlight Level—Use the up or down arrows to set the light level of the backlight, and 
then click Set. You can change the brightness of the backlight with this option by 
percentage, so 100% is On at full brightness and 0% is Off. 

• Backlight Preset Level—Lets you set the default backlight level. If you ever restart or 
power the touch screen again, this is the backlight level it would go to. Click Set to save 
your changes. 

• Button Animation Enabled—Lets you enable animated buttons for a 3D effect. 
• Wake on proximity—Lets you set the touch screen to wake up when someone 

approaches within four (4) feet of the device. 
• Detect Ambient Light Levels—Lets you set the options according to how much light is 

in the room. You can use this option in programming also. 
• Set Threshold—Threshold settings from 0 to 100; 0 means no light; 100 means 

full light. 
• Current Light Level—Shows current light level. 

Configure a 5” or 7” In-Wall Touch Screen  
(C4-TSWMC5 or C4-TSWMC7) 

Use the Composer Pro System Design and Connections views to add and configure this device. 

Note:This touch screen includes full duplex point-to-point Intercom sessions, broadcast support 
to multiple touch screens, and monitoring from the interface.  

As of June 1, 2013, the HC-800 (C4-HC800-BL-1) and HC-250 (C4-HC250-BL-1) ship with 
included support for Intercom and MyHome. For controllers shipped before that time, you must 
purchase an Intercom and MyHome license for consumers who want this feature. In either case, 
the license must be assigned and active on the consumer's account for the Intercom and 
MyHome to function. See this section, the Control4 System User Guide, and “Example: Using 
the Intercom agent” for details. See Managing Dealer Accounts on My.Control4.Com on the 
Knowledgebase for information about how to purchase and assign an Intercom license. 

Scenarios 
1 User wants to have full-duplex, room-to-room calling. In this case, the Control4 system 

must have at least two (2) 5" or 7" In-Wall Touch Screens installed. 
2 User wants to broadcast a message without a response. In this case, the Control4 

system must have at least one (1) 5" or 7" In-Wall Touch Screen installed. 
3 User wants to broadcast a message with a response. In this case, the Control4 system 

must have at least two (2) 5" or 7" In-Wall Touch Screens installed. 
4 User wants to monitor the sounds in another room. In this case, the Control4 system 

must have at least two (2) 5" or 7" In-Wall Touch Screens installed. 

Prerequisites 
• Ensure that the 5" In-Wall Touch Screen (C4-TSWMC5) or 7" In-Wall Touch Screen (C4-

TSWMC7) is installed as directed in the Control4 5" and 7" In-Wall Touch Screen Installation 
Guide available on the Control4 Dealer website. 

• Ensure that your project has a Control4 controller added and identified in the Control4 
system. 

http://dealer.control4.com/dealer/support/documentation
http://dealer.control4.com/dealer/support/documentation
http://dealer.control4.com/dealer/support/documentation
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To add and configure a 5" or 7" In-Wall Touch Screen: 
1 To add the driver and identify the device see “Guidelines for Configuring Devices.” Ensure 

that the IE 5" Touch Screen or IE 7" Touch Screen driver is added to the project tree. 

Note: If this touch screen will be providing audio output, the touch screen needs to be 
connected as an Audio End Point for the room. 

2 (Optional) To configure the properties, click System Design. 
3 In the project tree, select the IE 5" Touch Screen or IE 7" Touch Screen object. 
4 View and change the properties in the Properties pane as needed. 

Modifiable properties include: 

• Backlight Level—Use the up or down arrows to set the light level of the backlight. You 
can change the brightness of the backlight with this option by percentage, so 100% is 
On at full brightness and 0% is Off. 

• Backlight Preset Level—Lets you set the default backlight level. If you ever restart or 
power the touch screen again, this is the backlight level it would go to. Click Set to save 
your changes. 

• Button Animation Enabled—Lets you enable animated buttons for a 3D effect. 
• Volume Control Follows Selected—Lets you select other rooms aside from the one 

that contains the touch screen, and change its volume when leaving the room. 

Keypads 
Configure a 2-, 3-, or 6-Button Keypad 

Use the Composer Pro System Design and Connections views to configure keypads.  

Note: To configure a 2-, 3-, or 6-Button Keypad for a 3-way switch, see “Configuring Lights for 3-
Way,” “Configuring a 2-Button Keypad as a 3-Way Light,” or “Configuring a 3-Button Keypad to 
Control a 3-Way Light.” 

Ensure that the Keypad is installed as directed in the Control4 Wireless 2, 3, or 6-Button Keypad 
Installation Guide available on the Control4 Dealer website. 

To add and configure a 2-, 3-, or 6-Button Keypad: 
1 To add the driver and identify the device see “Guidelines for Configuring Devices.” Ensure 

that the correct driver is added to the project tree. 
2 (Optional) To configure the properties, click System Design. In the project tree, select the 

2-Button Keypad, 3-Button Keypad, or 6-Button Keypad object for the properties to 
appear.  

Modifiable properties include (depending on the device selected): 

• LED 
• Button x—You can change these properties for each button. 
• Keypad Managed—The LED state is controlled by pressing and releasing the 

buttons on the keypad (the LEDs are managed at the keypad). This is the factory 
default for the keypad. 

If you check Keypad Managed, the following buttons can be activated. 

• Push Color—Indicates the LED color when the button is pushed. Click to 
select the LED color. 

• Release Color—Indicates the LED color when a pressed button is released. 
Click to select the LED color. 

http://dealer.control4.com/dealer/support/documentation
http://dealer.control4.com/dealer/support/documentation
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If you uncheck Keypad Managed the following buttons change and can be 
activated. The LED state can be controlled by custom programming. 

• ON Color—Ensures that the LED state is ON with the selected color. 
• OFF Color—Ensures that the LED state is OFF with the selected color. 

• Follow Bound Color—If checked, Keypad Managed is grayed out. The keypad 
LED colors are set based on the device to which they are bound using the button-
link bindings. This lets the installer specify the On/Off colors for the keypad LEDs 
independently of the device to which they are linked. 

If unchecked, Keypad Managed is available. No other settings can be assigned for 
this option. See the sections related to “Connecting Devices” in this document.  

Example: You can set a 3-way dimmer or switch  to use the same colors for On 
and Off for the two (2) physical dimmers if requested by the customer. 

• On Color—LED color when button is pressed to ON. 
• Off Color—LED color when button is pressed to OFF. 

• Network 
• MAC—The device’s MAC address. 
• Version—The version of the firmware the controller is running. 

Changing LEDs on 2-, 3-, or 6-Button Keypads 
Use the Composer Pro System Design view to change keypad button LEDs. 

To change the LED colors on the keypad: 
1 In the project tree, select a 2-Button Keypad, 3-Button Keypad, or 6-Button Keypad 

object for the properties to appear. 

 

2 To change the LED color when the button is pushed and released, check Keypad 
Managed. 
• If Keypad Managed is checked, the LED state is controlled by pressing the buttons on 

the keypad. 
• If Keypad Managed is unchecked, the LED state can be controlled by custom 

programming. 

Tip: You can change the LED lights based on programming. See the Programming view > 
2-Button Keypad, 3-Button Keypad, or 6-Button Keypad objects for the events available. 
Also, see the actions available for the keypads. 
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3 Select the Push and Release colors: 
a Click the color box next to Push Color for a color dialog to appear where you can 

select the color. The Push Color indicates the LED color when the button is pushed. 
b Click the color box next to Release Color for a color dialog to appear where you can 

select the color. The Release Color indicates the LED color when a pressed button is 
released. 

Configure a Configurable Keypad 
This applies to next generation lighting (compatible with OS 2.5 and later).  

To configure a Configurable Keypad: 
1 Add the keypad to your project tree, then identify it. For instructions, see “Guidelines for 

Configuring Devices.”  
2 In the System Design view, select the device.  The device’s Properties tab opens. 
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3 In the Button Settings area, click and drag the appropriate Keypad Parts items to the 
Assembled Keypad example until the example matches the desired keypad configuration. 

 

Tips: 
• The Down/Up buttons can be placed only in the bottom slot and cannot have custom 

engraving. 
• Drag the desired button to the top slot of the range where you want the button 

positioned. 

 

4 Configure the settings described below. 
5 Click Apply to… to apply the changes to other lighting devices. 
6 If you entered text for custom engraving, go to “Ordering keycap engraving” on page 65. 

Device settings for Configurable Keypads 
Properties 

• Button Settings 
• Name—The name of the button (used for defining its connections to other devices or 

events within Composer Pro). 
• Engraving—Text that you want printed onto the buttons. For more information, see 

“Ordering keycap engrav” below. 
• Icons—Icons that you want printed onto the buttons. To add an icon to the Engraving 

text box, click Icons, then double-click the icon to add. 
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• LED Behavior 
• Follow Bound Device—LED behavior reflects the state of the device the button is 

bound to. 
• Push/Release—LED behavior reflects the button state (pressed or released). 

• Push Color—Sets the LED color while the button is pressed. 
• Release Color— Sets the LED color while the button is released. 

• Finish—Color of the buttons. 

Advanced Properties 

• Ambient Light Profiles 
• Select a preset brightness profile for the keypad backlight and LEDs that changes their 

brightness according to the room’s ambient light. You can also select Fully Customized 
and manually set each brightness level according to ambient lighting. 

• Backlight Color—Sets the keypad’s backlight color. If you don’t want a keypad 
backlight, keep the default setting (black). 

• Network—(wireless keypads only) Displays the MAC address and firmware version of the 
selected device. These fields are not editable.  
• Replace Legacy Control4 Device 

• Replace Keypad—Replaces a legacy device in your project with this new device. 
After you configure this new device, click this button, select the older device in the 
mini project tree that opens, then click OK. 

 

• Ignore device when it comes online—When selected, this checkbox tells the 
system to ignore the older device when it comes back online. 

Ordering keycap engraving 
If you entered text to be engraved onto keycaps, you need to special order the custom 
engraving. You can order in three ways: 

United States and Canada: 

• Upload the engraving order file on the dealer website (easiest for most orders). 
• Enter the information on the dealer website (good for small orders of individual 

keycaps). 
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All other regions: 

• Send the engraving order file to your ISA. 

When your custom engraved keycaps arrive, install the keycaps according to the keycap 
installation guide, then make sure that the keypad configuration matches the device properties in 
Composer Pro. 

To create an engraving order file: 
1 In Composer Pro, make sure that the text and icons for each keycap have been entered on 

the device Properties pages exactly as you want them to appear. Pay special attention to 
spelling. 

Tip: In a keypad’s Button Settings properties, the button Name is used only for defining 
connections within Composer Pro. For engraving, make sure that you enter text in the 
Engraving fields. 

2 Click Tools, then Reports.  
3 Click Keypad Engraving, then click Display Report. 

 

4 Print the report and review with your customer to make sure that all engraving meets the 
customer’s expectations. 

5 Click Export Engraving Order, then click Export Order File. 
6 Specify a location to store the file, then click Save. 

To upload the engraving report file on the dealer website: 
1 Access the Dealer website at dealer.control4.com. 
2 Go to Products > Lighting > Engraving. 
3 Click Upload Composer File. The file upload page opens. 
4 Select the file you created above, then click OK.  
5 Complete the order process. 

http://dealer.control4.com/
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To enter engraving information on the dealer website: 
1 While building the system, take note of the text and icons you want to be engraved on each 

keycap. Pay special attention to spelling. 
2 Access the Dealer website at dealer.control4.com. 
3 Go to Products > Lighting > Engraving. 
4 Click Single Keycap Engraving. The configuration page opens. 
5 Select the type of keycap, then type the text for the engraving into the ____ box.  
6 Complete the order process. 

To send the engraving report file to your ISA (international customers only): 
1 Create an email message to send to your ISA. 
2 Attach the engraving report file you created above, then send the message.  
3 Follow up with your ISA regarding order status and schedule. 

Configuring lights for 3-way 
Rather than creating programming to tie lighting variables and Control4 3-way lights together, 
you can use a simplified lighting configuration to set up lighting control. In the Connections view, 
you can configure global changes in Composer Pro Properties, and configure 3-way lights by 
dragging the lighting and control connections.  

The Push and Release features available on the keypads let you dim lights like a dimmer.  

Tip: To find out how to configure global changes for lights and other devices, see "Accessing 
Properties from the Project Tree" in Composer Pro Getting Started. 

Configuring a 2-Button Keypad as a 3-way light 
Use the Composer Pro Connections view to configure a 3-way light using a 2-button keypad.  

Example: Configure a 2-Button Keypad to turn On (Top button) and turn Off (Bottom button) a 
dimmer, and to use the Push/Release function available on the 2-Button Keypad to dim a light. 

Prerequisites 
1 Ensure that your controller hardware is added and identified to the Control4 system. 
2 Ensure that you have a 2-Button Keypad and dimmer (or switch) added and identified to the 

project. 

To configure a 2-button keypad as a 3-way light: 
1 In the project tree, select the 2-Button Keypad. 
2 In the Control & Audio Video Connections pane under Control Inputs, click the Button 1 

Link connection, and drag it to the dimmer’s Top Button Link in the bottom pane. 

http://dealer.control4.com/
http://dealer.control4.com/dealer/support/documentation
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3 Click the Button 2 Link connection, and drag it to the dimmer’s Bottom Button Link in the 
bottom pane.  

  

4 Test to ensure that the 2-Button Keypad turns the light on and off, and that the 
Push/Release functions dim the light. 

Configuring a 3-Button Keypad to control a 3-way light 
Use the Composer Pro Connections view to configure a 3-Button Keypad to use a toggle for a 3-
way light.  

Example: Configure a 3-Button Keypad to toggle the light On and Off. Use Push and Release to 
dim and brighten the light as desired. 

Prerequisites 
1 Ensure that your controller hardware is configured properly, and that the 3-Button Keypad 

and dimmer (or switch) are added to the project and identified. 
2 Ensure that you have a 3-Button Keypad added and identified to the project. 
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To configure a button on a 3-Button Keypad to control a 3-way light: 
1 In the project tree, select the 3-Button Keypad. 
2 In the Control & Audio Video Connections pane, drag the Button 1 Link connection from the 

top list over the light’s Toggle Button Link in the bottom list. 

  

3 Test to ensure that the 3-Button Keypad turns the light On and Off, and that the 
Push/Release functions dim the light. 

Configure mobile devices or PCs/tablets as Navigators 
Use the MyHome apps to configure an iPod Touch, iPad, iPhone, Android, or PC device for use 
as a touch screen in a Control4 system. 

Ensure that the license and correct apps are installed as indicated in the Control4 MyHome 
Setup Guide for Dealers or Control4 MyHome Setup Guide for Homeowners. These documents 
are located on the Control4 website. 

Note: As of OS 2.3.0, the MyHome drivers no longer appear in the drivers list. This is because if 
you have a valid license, the drivers will be installed and identified automatically so you won’t 
have to select them from the drivers list. For new installations, the driver will be added during the 
wizard install. See the latest revision of MyHome Setup Guide for Dealers or MyHome Setup 
Guide for Homeowners for updates. 

Follow the instructions in the documents mentioned previously to set up the apps for these 
devices. You don't need to do anything in Composer Pro. 

http://dealer.control4.com/dealer/support/documentation
http://dealer.control4.com/dealer/support/documentation
http://dealer.control4.com/dealer/support/documentation
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Configure a Door Station (C4-DSC-EN-XX or 
C4-DSC-EN-INT) 

Use the Composer Pro System Design and Connections views to add and configure a Door 
Station – Exterior (C4-DSC-EN-XX) or Door Station – Interior (C4-DSC-EN-INT). 

Prerequisites 
• Ensure that the Door Station – Exterior (C4-DSC-EN-XX) or Door Station – Interior (C4-

DSC-EN-INT) is installed as directed in the Control4 Door Station – Exterior Setup Guide or 
Door Station-Interior Setup Guide available on the Control4 Dealer website. 

• Ensure that your project has a Control4 controller added and identified in the Control4 
system. 

To add and configure a Door Station: 
1 To add the driver and identify the device see “Guidelines for Configuring Devices.” Ensure 

that the Door Station driver is added to the project tree. 

Note: If this device will be providing audio output, the device needs to be identified as an 
Audio End Point for the room. 

2  (Optional) To configure the properties, click System Design. 
3 In the project tree, select the Door Station object. Both Door Station models use the same 

driver. 
4 View and change the properties in the Properties pane as needed. 

Modifiable properties include: 

• Reboot—Click Reboot to reboot the Door Station. 
• WiFi Signal Strength (%)—If WiFi is used this shows the strength of the signal. Ensure 

that the signal is strong and robust if you use the Door Station for WiFi. We recommend 
using Ethernet rather than WiFi for best results. 

Notes: (1) Video Intercom. Although this device supports b/g/n, 802.11 b is not 
supported for video intercom use. (2) Wireless-n is recommended for video intercom. 

• Refresh—Click to refresh the signal strength values. 
• Select Intercom Group—If a group has been created, use the drop-down list to select 

the group. The default is All. 

Door Station Options: 

• Button 1 Name—Check to select this button, and then type the button's name in the 
box. This can be used in programming, for example, if you set up an 'Outside Lights On' 
custom button to turn on the porch lights when the Door Station button is pushed. 

• Button 2 Name—Check to select this button, and then type the button's name in the 
box. 

• Broadcast Calls—Checked by default. When checked, this allows the device to receive 
broadcast calls. This can be disabled if programming is used; for example, if you want 
to send an announcement rather than send a broadcast to all touch screens in the 
home or if you don’t want this device to receive broadcast calls. 

• Enable Camera—Checked by default. When checked, this allows the device to use the 
camera for video intercom in addition to audio. 

http://dealer.control4.com/dealer/support/documentation
http://dealer.control4.com/dealer/support/documentation
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• Door Bell Ring—Checked by default. When checked, this allows the device to be used 
with the doorbell. This can be disabled if programming is used; for example, if you want 
a different sound or lights to come on. 

• Enable Button Backlight—Checked by default. When checked, this turns on the 
button's backlight. If you don't want to use the backlight, uncheck this option. Tip: This 
option can be used in programming to turn on the backlight at night. 

Wireless Network Limitations 

Many WiFi Access Points handle Multicasts (WiFi simultaneously sent to multiple devices, 
for example, when the Door Station broadcasts video to all stations) by slowing down 
transmission speed to the 1 Mb basic rate. This can cause overall WiFi congestion in the 
WiFi network during the broadcast. Video intercom response times and images may 
degrade at each device.  

If a home requires a large number of WiFi Video Intercom devices, ensure that you have a 
robust WiFi network (possibly consisting of multiple access points). 

Configuring AV devices 
Configuring audio-video (AV) devices means that you want to 'identify' or make the device 
connection to the Control4 system so the devices communicate with the controller and other 
devices in the system. Use the Control4 Composer Pro System Design and Connections views 
to configure audio-video devices. See “Guidelines for Configuring Devices” to add and identify 
the device.  

Configure an Audio Matrix Switch 
Use the Composer Pro System Design and Connections views to identify an Audio Matrix Switch 
to the Control4 system. This device switches up to 16 input sources and up to 16 outputs. The 
driver contains no user-configurable fields. 

Ensure that the home controller is installed as directed in the Control4 Audio Matrix Switch 
Installation Guide on the Control4 Dealer website. 

To add the driver and identify an Audio Matrix Switch see “Guidelines for Configuring Devices.” 
Ensure that the Audio Switch driver is added to the project tree. 

IMPORTANT! (Applies to only C4-16S2-E-B) The Audio Matrix Switch driver can be identified by 
IP or ZigBee. The Audio Matrix Switch can communicate with the Control4 system either using 
the TCP/IP network or via the ZigBee network. Identify it to the network you want to use for 
communications. Do not identify it on both the IP and the ZigBee networks. 

Note: If using a TCP/IP network and the latest shipping version of this device, you can set this 
device to either DHCP Client (default) or a client that uses Static IP. To change this setting, see 
the LCD screen menu on the device. 

Configure an audio or AV switch 
Use the Composer Pro System Design and Connections view to set up an audio or audio/video 
switch.  

You can access the AV switch drivers from the System Design view in the Items pane by clicking 
the Search tab > Device Type: A/V Switch or Audio Switch > Manufacturer: All 
Manufacturers. Use the Driver Wizard for additional support for your audio or AV switch. 

http://dealer.control4.com/dealer/support/documentation
http://dealer.control4.com/dealer/support/documentation
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Install the audio or AV switch according to the manufacturer’s instructions. 

To add and configure an audio or audio/video switch: 
1 Install and set up the audio or audio/video switch and any associated hardware. 
2 In the System Design view, locate the driver. Click the Search tab > Device Type: Audio 

Switch or A/V Switch > Manufacturer: All manufacturers. 
3 Select the Audio Video or AV Switch object in the project tree to view the device properties 

for that object and make configuration changes if applicable. 

Example: The Knox AV Switch has no properties to modify, but other switches have 
properties, for example, the Control4 Audio Switch.  

4 Make any necessary network or control/AV connections as necessary for your configuration. 
See “Connecting and Verifying Devices” for details. 

5 Modify any room connections as needed for your configuration. 

Configure a Dock for iPod 
Use the Composer Pro System Design view to configure the Dock for iPod. The Dock for iPod is 
a dock in which your iPod sits. With your iPod connected to the dock and the Control4 system, 
you can enjoy music throughout the home. 

Configure the Dock for iPod as directed in the Control4 Dock for iPod Tabletop Kit Setup Guide 
available on the Control4 Dealer website. 

To add and configure Dock for iPod: 
1 To add the driver and identify the device see “Guidelines for Configuring Devices.” Ensure 

that the iPod driver is added to the project tree. 
2 Connect the Dock for iPod. See “Connecting and Verifying Devices” for details. 
3 Change the properties as needed. In the System Design view, select iPod. 
4 In the Properties pane, click the Properties tab. 

• Cover Art—Select the delay or Off. 
• Now Playing Timer—Select when to play. 
• Room Off—Select whether to stop the iPod from playing or pause it when Room Off is 

pressed on the system remote control. 
• Debug Mode—Use the drop-down list to select an option to log or print in this mode. 

Select from Print, Log, or Print and Log. This option is tied to the output options in the 
Lua tab (Step 9). 

• Firmware Version—Shows the version number for the firmware. 
5 (Optional) See the Documentation tab for more information. 
6 Click the Lua tab to view logging output. 

Configure a 4-Zone Amplifier 
Use the Composer Pro System Design and Connections views to add and configure a 4-Zone 
Amplifier. This device lets you enjoy up to four (4) zones (rooms) of music in the home. 

Ensure that the 4-Zone Amplifier is installed as directed in the Control4 4-Zone Amplifier 
Installation Guide available on the Control4 Dealer website. 

http://dealer.control4.com/dealer/support/documentation
http://dealer.control4.com/dealer/support/documentation
http://dealer.control4.com/dealer/support/documentation
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To add and configure a 4-zone Amplifier: 
1 To add the driver and identify the device see “Guidelines for Configuring Devices.” Ensure 

that the Multi Channel Amplifier 4 Zone driver (under Audio/Video > Amplifier) is added to 
the project tree. 

IMPORTANT! The amplifier can be identified by IP only. The amplifier can communicate 
with the Control4 system using the TCP/IP network. 

Note: If you are using a TCP/IP network and the latest shipping version of this device, you 
can set this device to either DHCP Client (default) or a client that uses Static IP. To change 
this setting, see the LCD screen menu on the device. 

2 Make the necessary connections. See “Connecting and Verifying Devices” for details. 
3 (Optional) Change the 4-Zone Amplifier properties. 

a In the System Design view on the project tree, select the Amplifier object. 
b Modify the properties in the Properties pane:  

 

Modifiable properties include: 

• Advanced Properties 
• Inputs Locked—This locks Audio Inputs to set Audio Outputs. You can have 

one (1) Audio Input with several Audio Outputs, but an Audio Output may only 
have one Audio Input. 

• Power Save Enabled—Check to save power. 
• Device Firmware—This displays the firmware version. 
• Power Save Status—This displays when power save is enabled. 
• Volume Curve—Shows how the output volume of the amplifier reacts (the 

device compensates) to an increase in volume as heard by the human ear. 
• Output Settings 

• Output Zones—Select zones 1 through 8. 
• Maximum Volume—Use the drop-down menu to select the volume up to 100. 

Click Set. 
• Parametric EQ Settings 

• Frequency—Center frequency to be adjusted. 
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• Gain—Set from -24dB (cut) to +6dB (boost) for the center frequency. 
• Quality Factor (Q)—Width of the EQ boost/cut can be set from 0.5 to 1.0 in 

0.1 steps and 1.0 to 10.0 in 1 step (there are no units for Q). 
• Shelving EQ Settings 

• Frequency—Center frequency to be adjusted. 
• Gain—Set from -24dB (cut) to +6dB (boost) for the center frequency 

Notes on EQ settings: The Q setting on the EQ setting determines the bandwidth of 
the boosted frequency (or cut frequency). 

The Quality Factor is the center frequency divided by the bandwidth (Q=Center 
Frequency/Bandwidth), where bandwidth is determined by the frequency points; either 
side of the center frequency are -3dB from the center frequency. A setting of 1kHz with 
a Q of 1 means that the boosted frequencies affected are from 500Hz to 1.5kHz (1kHz 
wide to the -3dB points centered at 1kHz). 

Example: If the Q is increased to 10 with the same 1kHz center frequency, then the 
bandwidth must decrease by the same ratio. Mathematically: 

Q = Freq/BW 
10 = 1kHz/BW 
BW = 100Hz 
Affected frequencies are Center Frequency +/- ½ (BW) 
1kHz +/- ½ (100Hz) 
1kHz +/- 50Hz = 950Hz to 1,050Hz 

The higher the Q setting the narrower the frequency range affected by the gain setting, 
while a lower Q setting increases the frequency range affected by the gain setting at 
each EQ frequency.  

The frequency response can be visualized as a tall, skinny building with a high Q value 
or a tall, wide (or pyramid shaped) building with a low Q value. The peak (or height of 
the building) at the center frequency is set by the Gain setting. 

Configure a Multi-Channel Amplifier 
Use the Composer Pro System Design and Connections views to add and configure a Multi-
Channel amplifier. This device provides eight (8) stereo inputs and outputs with full audio 
switching.  

Note: In Release 1.8 and later, the Multi-Channel amplifier does not work with ZigBee Pro. 
Configure this device with Ethernet. 

Ensure that the Multi-Channel amplifier is installed as directed in the Control4 Multi Channel 
Amplifier Installation Guide available on the Control4 Dealer website. 

To add and configure a Multi-Channel amplifier: 
1 To add the driver and identify the device see “Guidelines for Configuring Devices.” Ensure 

that the Multi Channel Amplifier - 16 driver is in the project tree.  

IMPORTANT! Two (2) amplifier objects appear for identification. The amplifier can be 
identified either by IP or by ZigBee. The amplifier can communicate with the Control4 
system either using the TCP/IP network or via the ZigBee network. Identify it on the network 
you want to use for communications. Do not identify it on both the IP and the ZigBee 
networks.  

Note: If using a TCP/IP network and the latest shipping version of this device, you can set 
this device to either DHCP Client (default) or a client that uses Static IP. To change this 
setting, see the LCD screen menu on the device. 

http://dealer.control4.com/dealer/support/documentation
http://dealer.control4.com/dealer/support/documentation
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2 Make the necessary connections. See “Connecting and Verifying Devices” for details. 
3 (Optional) Change the properties as needed. 

a In the System Design view on the project tree, select the Amplifier object. 
b Modify the properties in the Properties pane: 

 

Modifiable properties include: 

• Inputs Locked—This locks Audio Inputs to set Audio Outputs. You can have one Audio 
Input with several Audio Outputs, but an Audio Output may only have one Audio Input. 

• Device Firmware—This displays the version of firmware. 
• ZigBee Firmware—This displays the version of firmware. 
• Volume Curve—Shows how the output volume of the amplifier reacts to an increase in 

volume; the soft-to-loud response of the volume control. 
• Output Settings: 

• Output Zones—Select zones 1 through 8. 
• Maximum Volume—Use the drop-down menu to select the volume up to 100. 

Click Set. 
• Parametric EQ Settings: 

• Frequency—Center frequency to be adjusted. 
• Gain—Set from -24dB (cut) to +6dB (boost) for the center frequency. 
• Quality Factor (Q)—Width of the EQ boost/cut settable from 0.5 to 1.0 in 0.1 steps 

and 1.0 to 10.0 in 1 step (there are no units for Q). 
• Shelving EQ Settings 

• Frequency—Center frequency to be adjusted. 
• Gain—Set from -24dB (cut) to +6dB (boost) for the center frequency. 

Notes on EQ settings: The Q setting on the EQ setting determines the bandwidth of the 
boosted frequency (or cut frequency). 

The Quality Factor is the center frequency divided by the bandwidth (Q=Center 
Frequency/Bandwidth), where bandwidth is determined by the frequency points are either 
side of the center frequency are -3dB from the center frequency. A setting of 1kHz with a Q 
of 1 means that the boosted frequencies affected are from 500Hz to 1.5kHz (1kHz wide to 
the -3dB points centered at 1kHz). 
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Example: If the Q is increased to 10 with the same 1kHz center frequency, then the 
bandwidth must decrease by the same ratio. Mathematically: 

Q = Freq/BW 
10 = 1kHz/BW 
BW = 100Hz 
Affected frequencies are Center Frequency +/- ½ (BW) 
1kHz +/- ½ (100Hz) 
1kHz +/- 50Hz = 950Hz to 1,050Hz 

The higher the Q setting the narrower the frequency range affected by the gain setting, while 
a lower Q setting increases the frequency range affected by the gain setting at each EQ 
frequency.  

The frequency response can be visualized as a tall, skinny building with a high Q value or a 
tall, wide (or pyramid shaped) building with a low Q value. The peak (or height of the 
building) at the center frequency is set by the Gain setting. 

Configure a Multi Tuner – Versions 1 and 2 
Use the Composer Pro System Design view to add and configure a Multi Tuner for Versions 1 
and 2. This device provides up to three (3) audio signals and an optional satellite radio signal for 
multi-zone versatility.  

Notes: (1) Refer to the Control4 XM Module for Multi Tuner V2 Installation Guide available on 
the Control4 Dealer website for instructions about how to add and configure the XM Module that 
is compatible with Multi Tuner V2. (2) If you are installing C4-TUN2-E-B or C4-TUN2-E-
B_with_C4-XMOD, refer to Version 2 notes. (3) In Release 1.8 and later, the Multi Tuner Version 
1 does not work with ZigBee Pro. 

Installation scenarios 
Several possible installation scenarios for the multi tuner products exist, depending on the 
version.  

Version 1: 

• Model AVM-TUN1-B (AM/FM tuner) —Use the Multi Tuner in the My Drivers tab. 
• Model AVM-TUN1X-B (AM/FM/XM tuner) —Use the Multi Tuner w/XM in the My Drivers tab. 
• XM module being added to an existing AVM-TUN1-B—Remove the original Multi-Tuner  

driver (AVM-TUN1-B) and replace it with Multi Tuner w/XM (AVM-TUN1X-B), then re-create 
the connections.  

Version 2: 

• Model C4-TUN2-E-B—Adding a C4-Multi Tuner V2 (with AM/FM tuners). 
• Model C4-TUN2-E-B_with_C4-XMOD—Adding a Multi Tuner V2 (with AM/FM tuners) that 

also has the XM module installed. 
• To add an XM Module to a tuner already installed, you must (1) delete the original tuners in 

the project tree, Tuner and Tuner 2 (which were added for C4-TUN2-E-B), (2) replace them 
with C4-TUN2-E-B_with_C4-XMOD (which adds Tuner, Tuner 2, and TunerXM to the tree), 
and (3) re-create the connections.  

http://dealer.control4.com/dealer/support/documentation
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See the following sections as applicable to configure the tuner: 

• “Activate the XM Satellite Radio Service” 
• “Configure the Multi Tuner” 
• “Set Up Radio Stations” 

Ensure that the Multi Tuner, Version 1 or 2, is installed as directed in the Control4 Multi Tuner 
Installation Guide. 

Activate the XM Satellite Radio service 
Notes: 

Version 1—Model # AVM-TUN1X-B or tuners upgraded with the XM® Module Kit require a 
monthly subscription to the XM Satellite Radio service to receive XM radio channels. 

Version 2—Model # C4-TUN2-E-B_with_C4-XMOD or tuners upgraded with the XM Module Kit 
require a monthly subscription to the XM Satellite Radio service to receive XM radio channels.  

To subscribe and activate these services: 
1 Use the Select dial to tune the XM tuner to Channel 0 and record the XM Radio ID (SDARS 

ID) that displays in the LCD window. 
2 Contact XM Satellite Radio Inc., to subscribe to the XM radio service. Go to 

http://www.siriusxm.com or call XM’s Listener Care at 1-800-XMRADIO (800-967-2346), 
which requires your SDARS ID. 

3 When instructed to do so by XM Satellite Radio Inc., tune the XM tuner to Channel 1 for 
about 20 minutes. When the tuner begins receiving XM stations, the LCD screen is enriched 
with station-specific information. 

4 If the XM tuner is not receiving XM stations after 20 minutes: 
a Move your antenna to a new location. 
b Go to http://www.siriusxm.com. 
c Tune to Channel 1 again, and wait approximately 20 minutes for the LCD screen to 

refresh. 

Configure the Multi Tuner 
Notes: (1) If you are installing C4-TUN2-E-B or C4-TUN2-E-B_with_C4-XMOD, refer to the 
Version 2 notes. (2) If you are installing models AVM-TUN1-B or AVM-TUN1X-B, refer to Version 
1 notes.  

To add and configure the Multi Tuner V1 to an existing system: 
1 To add the driver and identify the device see “Guidelines for Configuring Devices.” Ensure 

that the correct driver is added to the project tree. 
2 Add the driver: In My Drivers, double-click the applicable Control4 Multi Tuner model: 

• Version 1—Multi Tuner for the AVM-TUN1-B model. 
• Version 1—Multi Tuner w/XM for the AVM-TUN1X-B model or if adding the XM Module 

to the AVM-TUN1-B model. 
• Version 2—C4-TUN2-E-B or C4-TUN2-E-B_with_C4-XMOD if the XM Module upgrade 

kit (sold separately) is being used with an C4-TUN2-E-B model. 
3 Make the necessary connections: 

a In the Connections view, click the Control/AV tab. 
b For each tuner object in the project tree—such as Tuner, Tuner 2, and Tuner XM (XM 

Models only)—select each one, and ensure it is connected to a radio. 

http://dealer.control4.com/dealer/support/documentation
http://dealer.control4.com/dealer/support/documentation
http://www.siriusxm.com/
http://www.siriusxm.com/
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c For each tuner object in the project tree, select each Audio Video Output, and then 
drag them one-by-one onto an item in the Input Devices list below. The association 
displays in both lists. 

d Click the Network tab, right-click on the tuner with the appropriate address type: IP or 
ZigBee, and then select Identify. 

IMPORTANT! (Version 1 only) Two (2) Tuner objects appear for identification. The tuner 
can be identified either by IP or by ZigBee. The Multi Tuner V1 can communicate with the 
Control4 system either using the TCP/IP network or via the ZigBee network. Identify it on the 
network you want to use for communications. Do not identify it on both the IP and the 
ZigBee networks.  

4 Press the Select dial on the Multi Tuner’s front panel to identify this device to the system. 
After a brief delay, the network address for this Multi Tuner is added to the Device list. 

5 Verify that the Multi Tuner is an accessible device. In the System Design view, select the 
room, and then click the Properties tab and Audio Video Devices tab to view the Available 
Audio Sources list for that room. 

6 Go to the next section. 

Set up radio stations 
To provide users easy access to radio stations throughout the system and to enrich the graphical 
interfaces, use Composer Pro to search for radio broadcasts and refresh your Navigators. 

1 In Composer Pro click the Media view. 
2 Select a radio in the media list (on the left): XM Radio, FM Radio, or AM Radio, and then 

click Search. 
3 When the dialog box appears, enter your zip code in the box, and then click Search. The 

available stations display in the Search Results list. 
4 In the Search Results list, select the stations to add to the Navigators (on-screen Navigator, 

touch screen, MyHome, and system remote control). Select them individually or click Select 
All. 

5 Click OK. The selected stations populate the XM, FM, or AM Radio pane. 
6 Repeat Steps 2 through 5 for the remaining radios. 
7 Refresh the Navigators (see Composer Pro Getting Started for details). Each radio station 

you select is now available in the Navigators.  

For XM Tuner models: 

8 Click System Design, and select Tuner XM in the project tree. 
9 In the Properties tab, ensure that the tuner has a good signal and that the SDARS ID 

matches the Radio ID listed on Channel 0 of the tuner. 

Configure an XM module for Multi Tuner V2 
Refer to the Control4 XM Module for Multi Tuner V2 Installation Guide for instructions about how 
to add and configure this module. 

http://dealer.control4.com/dealer/support/documentation
http://dealer.control4.com/dealer/support/documentation
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Configure Speaker Point – Ethernet or WiFi 
Use the Composer Pro System Design and Connections views to add and configure Speaker 
Point. This device provides output to multiple speakers while connected to a Control4 system. 

Prerequisites 
1 Ensure that the Speaker Point device is installed as directed in the Control4 Speaker Point 

Installation Guide available on the Control4 Dealer website. 
2 Connect the Speaker Point device to an Ethernet CAT5 cable to set up the Ethernet or 

wireless connection.  

IMPORTANT TIP: The Speaker Point device requires an Ethernet connection for initial 
setup. 

The following procedures teach you to configure: 

• Speaker Point for Ethernet use, or 
• Speaker Point for WiFi use. 

Configure Speaker Point for Ethernet 
To add and configure an Ethernet Speaker Point to a Control4 project: 

Note: By default, Speaker Point is configured for Ethernet use. If you are using WiFi, however, 
also follow the instructions in the section, "Configure Speaker Point for WiFi Use" later in this 
section.  

1 To add the driver and identify the device see “Guidelines for Configuring Devices.” Ensure 
that the Speaker Point driver is added to the project tree. 

2 Ensure that the room connections are set correctly for the room.  

Note: When you add a Speaker Point, Audio or AV switch to a room, by default the Audio 
End Point is assigned by the first device added to the room. When you add a Receiver to a 
room, it is automatically set or reset as the Audio End Point.  

a To get to Room Connections, go to Connections and select the room. 
b Verify that the Audio End Point setting matches the intended setup of your Control4 

system. The Room Connections appear in the center pane. If you are setting up a 
custom configuration, adjust the Room Connections accordingly. For more information 
about Room Connections, see ”Connecting Rooms.”  

3 Preset Treble, Bass, and Balance. In either the System Design or Connections view, double-
click the Speaker Point object in the project tree to bring up its on-screen controls, and then 
click to make the adjustments for Treble, Bass, and Balance (supported values are 0 - 100). 

 

4 (Optional) Change the properties as needed.  

Modifiable properties include: 

http://dealer.control4.com/dealer/support/documentation
http://dealer.control4.com/dealer/support/documentation
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• Local Amp Mode—not checked (default). When the box is not checked, the Speaker 
Point streams the analog input through the Control4 audio distribution system, making 
the source digitized and available to other audio zones throughout the house. 

• Local Amp Mode—checked. When the box is checked, it sets the Speaker Point in 
Local Amp Mode, enabling a local input source outputs directly, is not digitized and 
provides audio and video in one room. This enables devices that provide audio and 
video, such as a DVD, VCR, or Satellite Receiver to send output to the amplified audio 
outputs: the Right and Left Speakers in the room. If Local Amp Mode is not checked 
and you try to watch video in the room, the video or audio sound will be out of sync with 
the video.  

5 Now configure the system for WiFi. By default, the Speaker Point is configured for Ethernet 
use. If you are using WiFi, follow the instructions next. 

Configure Speaker Point for WiFi 
To configure Speaker Point for WiFi use: 
1 Start Composer Pro and connect to Director on Local Network. 
2 In the Tools menu, select System Manager. 
3 In the Devices pane, select the network address of the device you want to configure, and 

click Connect. 

  

Tip: If the device’s network address is not on this list, click Refresh. If it still does not 
appear, click Add to enter it manually. If you don’t know the network address, look in the 
Tools menu > Network Tools.  
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4 Click the Network tab, and click Configure.  

 

5 Click Next when a Network Configuration wizard dialog appears. 
6 If desired, enter a new name for the device, and click Next. 

IMPORTANT TIP! If the device has already been identified on the Control4 system, and you 
change the name (on this wizard screen), identify the device again. Until it is identified 
again, the controller cannot recognize the name and will not be able to communicate with 
the device. 

 

7 Select the type of network you want the device to be a part of, and click Next.  
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Example: Wireless network.  

8 Select the method to obtain an IP address, such as DHCP (first option) or Status IP (second 
option) distribution, and click Next.  

Example: Obtain an IP address automatically using DHCP.  

9 Select the method to obtain the DNS server address automatically, and click Next.  

Example: Obtain the DNS server address automatically.  

10 Enter the Network Name (SSID) of your wireless access point. 
11 Use the pull-down menu to indicate your Data encryption preference (64 or 128 bit). 
12 Select the Key type (hex or ASCII). 
13 Enter your Network Key (WEP Key), and click Test. 

• Hex—64 bit (10 digits) or 128 bit (26 digits)—acceptable values 0 - 9, A- F 
• ASCII—64 bit (5 digits) or 128 bit (13 digits)—acceptable values ASCII characters  

Example: 

• Network Name (SSID)—<name of wireless access point> 
• Data encryption—wep64 
• Key Type—hex 
• Network Key (in hex)—ABCDE12345. 

  

Note: If the hex Network Key you insert is not valid, a screen with a red exclamation point 
comes up. In this case, enter your key again.  

14 Click Test to test your network connection. If it fails, follow the on-screen instructions. 
15 Click Finish when you come to the “Congratulations! You have successfully changed your 

network configuration” screen. 
16 At this time, the system reboots. Do not disconnect any temporary Ethernet cables until the 

device has successfully rebooted and is powered on. 
17 If you are using the WiFi to communicate to your controller, disconnect the Ethernet cable. 
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Configure a Media Player 
Use the Composer Pro System Design and Connections views to add and configure a Media 
Player. The device automatically scans videos. A Media Player (such as Netgear EVA8000) lets 
you play media that is stored on a network drive or available through the Internet to a TV. 

The Media Player driver lets the Control4 system interact with the Media Player hardware 
through one of the Control4 system remote controls. The driver also supports the video playback 
functionality of the hardware, allowing the Control4 Navigators to be used to select a video title. 

Note: In Release 1.8, the Media Player (V1) does not work with ZigBee Pro. Use Media Player 
V2. The Media Player V2 driver is C4-MP2-E, located in the driver database.  

Ensure that your Media Player is installed as directed in the Media Player Installation Guide and 
Media Player User Guide shipped with the hardware or available on the Control4 Dealer website. 

To configure a Media Player in your system: 
1 To add the driver and identify the device see “Guidelines for Configuring Devices.” Ensure 

that the Media Player V2 driver is added to the project tree. 
2 Add a Network File Storage driver to your Composer Pro project (available on the My 

Drivers tab), then configure the properties including browsing to the network location. For 
information on adding and configuring network file storage, see “Using External Storage 
Devices.” The network location must be an open share location (no password required). The 
Network File Storage driver supports both audio and video content. 

3 Make the necessary audio and video connections. See “Connecting and Verifying Devices” 
for details. 

4 To use the features of the Media Player, do one of the following: 
• Scan the videos. In the Media view, scan the videos that are in video_ts format: 

• Select Video Media under the network file share where you want to add the 
videos. 

• Click Scan. The scan operation identifies the video_ts format video files, adds them 
to the media database, and automatically associates the video metadata including 
cover art. When the scan completes, the videos in video_ts format are available for 
playback from the Navigators. 

• Manually add the videos. In the Media view, manually add videos that are in formats 
other than video_ts. Video formats other than video_ts that are supported by your 
Media Player can be added to the media database in Composer Pro manually. 
• Select Video Media under the network file share where you want to add the 

videos. 
• Click New, and then select the Browse option next to the Location text box in the 

pop-up window. A new pop-up window will appear. 
• In the pop-up window, select the drop-down menu for Files of type, and then select 

the *.* option. 
• Select the file format you want to add to the database.  

When the videos in alternative video formats are added to the system manually, those 
videos become available for playback from the Navigators. 

Note: When using a system remote control Version 2, the Cancel button is mapped to the 
EVA8000 Back button and the DVR button toggles between aspect ratios.  

5 Check the properties. In the System Design view, select the Media Player. 
6 In the Properties pane, click the Properties tab.  

http://dealer.control4.com/dealer/support/documentation
http://dealer.control4.com/dealer/support/documentation
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Modifiable properties include: 

• Debug Mode—Use the drop-down list to select an option to log or print in this mode. 
Select from Print, Log, or Print and Log. This option is tied to the output options in the 
Lua tab (see Step 13). 

• Resolution—Use the drop-down list to select the video output screen resolution. Auto 
indicates that the device negotiates over HDMI. 

• Current Resolution—Indicates the current video output screen resolution. If you know 
the highest resolution allowed for this device, set it to that resolution for best results. 

• Background Image URL—Indicates the background image. 
• Screen Saver Image URL—Indicates the screen saver image. 
• Firmware Version—Indicates the device's firmware version. 
• Update Status—Indicates the status of the current update if being updated. This status 

box is used with the Actions tab. See Step 8. 
• Last Error—Displays error messages if found. 
• Update URL—Indicates the URL for the updates. 
• Switchable Resolutions—Use all of the boxes below this box with the system remote 

control Pg up and Pg down buttons. If set to True, the option can be changed on the 
remote. 

7 Click the Documentation tab for more information about this device. 
8 To update this device, in the Properties pane, click the Actions tab, and then click Start 

Update to update this device. Note: Updates to this device occur separately from Update 
Manager updates. 

9 To view logging output, in the Properties pane, click the Lua tab. 

Configure a Sony STR-DA2800ES or STR-DA5800ES 
Receiver 

Use the Composer Pro System Design and Connections views to add the driver to the project 
and identify the receiver to the Control4 system (secondary controller and receiver only – primary 
controllers get added and identified automatically using Auto Discovery).  

Use the Connections view to configure the bindings. See “Connecting and Verifying Devices” in 
this guide. 

Models supported: 

• Sony STR-DA2800ES AV Receiver (ZSO-STRDA2800ES, receiver only) 
• Sony STR-DA2800ES with Full Control4 automation (ZSO-STRDA2800ES-C4, use as 

primary or secondary controller, Control4 Automation License is included) 
• Sony STR-DA5800ES AV receiver (ZSO-STRDA5800ES, receiver only) 
• Sony STR-DA5800ES with full Control4 automation (ZSO-STRDA5800ES-C4, use as 

primary or secondary controller, Control4 Automation License is included) 

IMPORTANT!  

• If the receiver is configured as a simple receiver only (ZSO-STRDA2800ES or ZSO-
STRDA5800ES) controlled by another controller in the Control4 system, then the dealer can 
find the appropriate certified Sony driver in Search > Online Database. 
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• If the receiver has a Control4 Activation License and is also configured as a primary 
controller (the drivers are added and identified for you via Auto Discovery) or secondary 
controller (ZSO-STRDA2800ES-C4 or ZSO-STRDA5800ES-C4), then the dealer needs to 
install both a receiver (Sony STR-DA2800ES or Sony STR-DA2800ES, considered an 
"internal" receiver driver which is different from the "certified" external receiver driver in the 
Online Database) and a controller driver (added automatically: Sony Receiver Home 
Controller 2800 or Sony Receiver Home Controller 5800) in the project. These are located in 
the Composer Pro Search > Local Database that ships with OS 2.2.4 or later (see the next 
figure). These drivers are tied together, so if one is added to the project, then the other one 
is added with it. Both devices must be identified (first the receiver then the controller). 

• Before installing the Control4 Activation License or using the receiver, perform a Sony 
software update. To update go to the following page: Home > Settings > Network Update. 
The update may take up to 15 minutes—so please be patient. 

Notes: (1) If you intend to use full Control4 automation with this receiver and configure it as the 
primary controller or secondary controller, see “Configuring an HC-Class Controller.” (2) If you 
intend to use this device as a receiver only, follow the steps below. The certified Sony STR 
receiver driver (if using as a receiver only), available in the Online Database, lets the user 
interact with the receiver as a receiver only in a Control4 system. (3) If you intend to use this 
receiver as a ZigBee device, the ZigBee adapter will need to be installed. See the documentation 
listed below on the Products > Audio/Video > Amplifiers/Receivers > Sony STR Receiver pages 
at control4.com for details. 

Make sure you add the correct drivers as mentioned in the Sony® ZSO-STR-DA2800ES-
C4/ZSO-STR-DA5800ES-C4 Receiver with Control4 Automation Quick Start Guide and Sony 
STR-DA2800ES/DA5800ES Receiver Control4 Automation Activation Guide available on the 
Control4 Dealer website under Products > Sony STR Receiver or Support > Documentation. 

Prerequisites 

Ensure that your Sony STR AV Receiver is installed as directed in the Sony STR receiver 
documentation in the box or on the Sony product pages at control4.com (for your model). Also 
refer to the Sony ZSO-STR-DA2800ES-C4/ZSO-STR-DA5800ES-C4 Receiver with Control4 
Automation Quick Start Guide or Sony STR-DA2800ES/DA5800ES Receiver Control4 
Automation Activation Guide and videos available on the Control4 Dealer website under 
Products > Sony STR Receiver. 

Procedures 

To configure a Sony STR-DA2800ES/DA5800ES with Full Control4 automation (model 
ZSO-STRDA2800ES-C4 or ZSO-STRDA5800ES-C4): 

Notes:  

(1) You’ll be adding a receiver driver and a controller driver (the controller driver is added 
automatically with the receiver driver) in these steps (secondary controller only, unless the 
primary controller driver needs to be added again). You’ll also need to identify both drivers to the 
Control4 system.  

(2) If the receiver will be a primary controller, the drivers are already added and the device is 
identified in a default project. If the receiver will be a secondary controller, you must add the 
drivers and identify the devices.  

(3) The identification procedure is slightly different from the identification of other Control4 
devices to the system. You’ll need to push a sequence of buttons on the receiver to identify it 
(the controller’s identification window in Composer shows you how to identify). See the Sony 
STR-DA2800ES/DA5800ES Receiver Control4 Automation Activation Guide for details. 

1 Add the driver and identify the device; see “Guidelines for Configuring Devices.” Ensure that 
the correct drivers are added to the project tree from the Local Database (see the next 
figure).  
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Note: You can add the drivers from the Local Database either using Device Type: 
Receivers and Manufacturer: Sony or Device Type: Others and Manufacturer: Sony. Either 
way installs the same drivers. 

 

The drivers will appear in the project as Receiver along with the Sony Receiver Home 
Controller xx00 and several other AV drivers. 

2 Make the necessary audio and video connections which are set up on the back of the 
receiver. See “Connecting and Verifying Devices” in this guide for details. 

3 To use the features of the Sony STR receiver, see the Sony STR receiver documentation on 
the Control4 website, Product pages, for your model.  

4 Check the properties. In the System Design view, select the receiver. 
5 In the Properties pane, click the Properties tab.  

Modifiable properties include: 

• IP Port—The port on which the receiver is listening. 
• Connected To Network—Shows ‘true’ if connected or ‘false’ if not connected. 
• Debug Mode—Set to Off by default. 
• GUI Mode—The mode used: Sony GUI or Control4 GUI. 
• Firmware Version—The firmware version for the receiver. 
• Auto Updates Enabled—Allow or not allow receiver firmware updates. See the section, 

“Updating Composer and Director” for details about updates for the Sony STR AV 
Receiver. 

• Update Status—Shows the status of a receiver update. 
• GUI Language—Shows the language selected for the receiver to display in the 

interface. 

To configure a Sony STR AV Receiver (as a receiver only; model ZSO-STRDA2800ES or 
ZSO-STRDA5800ES): 

Note: The identification procedure is slightly different from the identification of other Control4 
devices to the system. You’ll need to push a sequence of buttons on the receiver to identify it. 
See the Sony STR-DA2800ES/DA5800ES Receiver Control4 Automation Activation Guide for 
details. 

1 Add the driver and identify the device; see “Guidelines for Configuring Devices.” Ensure that 
the Sony STR-DA2800ES or Sony STR-DA5800ES driver is added to the project from the 
Online Database. The driver will appear as “Receiver” along with a bunch of other AV 
drivers. 

2 Make the necessary audio and video connections which are set up on the back of the 
receiver. See “Connecting and Verifying Devices” in this guide for details. 

3 To use the features of the Sony STR receiver, see the Sony STR receiver documentation on 
the Control4 website Product page for your model.  

4 Check the properties. In the System Design view, select the Receiver (the properties are 
the same for both the Sony STR models). 
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5 In the Properties pane, click the Properties tab.  

Modifiable properties include: 

• IP Port—The port on which the receiver is listening. 
• Command Delay-Millisecond—Not used for the receiver. 
• Connected to Network—If ‘true,’ the receiver is connected; if ‘false’ the receiver is not 

connected. 
• Debug Mode—Set to Off by default. 
• Power On Delay-Seconds—Not used for the receiver. 
• Volume Ramp Delay-Millisec—Not used for the receiver. 

Configure a Wireless Music Bridge 
Use the Control4 Composer Pro System Design view to identify a Wireless Music Bridge 
(C4-WMB-B) to a Control4 system. This bridge lets you play music, Internet radio, podcasts, and 
more through your smartphone and tablet devices to the whole house (supported in OS 2.5 and 
later). 

Prerequisites 
• Ensure that the Wireless Music Bridge is installed as directed in the Control4 Wireless Music 

Bridge Installation Guide. 
• Ensure that a 4-Zone Amplifier or 8-Zone Amplifier is installed and configured. The bridge 

connects to the amplifier. 

This audio output device uses SDDP (Auto Discovery) to identify the device automatically.See 
Composer Pro Getting Started for details about Auto Discovery. If you ever need to identify the 
device again, use the standard method. If you want to play different streams for each zone in the 
home, you need a separate bridge for each stream. This device will play one stream in all 
supported zones, however. 

To add and configure the Wireless Music Bridge: 
1 In Composer Pro > System Design > Discovered tab (Items pane), locate the Wireless 

Music Bridge (also listed in My Drivers > Audio/Video). 
2 Click the room to add the bridge to.  
3 Double-click the bridge driver to add it to the room. 
4 Make the necessary connections. See "Connecting and Verifying Devices" for details. 
5 Change the properties as needed. Select the bridge in the room.  
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6 In the Properties pane, click the Properties tab. View and change the properties as needed. 
See the Documentation tab for more detailed information. 

 

• Device Name—Type a unique name for this device. This name displays in the mobile 
device. 

• Media State—Displays “Playing,” “Paused,” or “Stopped” for Airplay and DLNA devices. 
Bluetooth also displays “Pairing” and “Connected.” 

• Media Source—Displays the source being played: None, Airplay, Bluetooth, or DLNA. 
• Album—Displays the metadata of the album being played. 
• Artist—Displays the metadata of the artist playing. 
• Track—Displays the metadata of the track number. 
• Play Time—Displays the elapsed and total play time for the current stream. 
• Play Time Interval—Use the drop-down list to select the interval for Control4 

Navigators to update their information. Values are: Disabled, Every 1 Second, Every 2 
Seconds, Every 3 Seconds, Every 4 Seconds, Every 5 Seconds, Every 10 Seconds. 
Click Set to apply the change. 

• Output Volume (read only)—Displays the current output volume level (0 to 100, 
default=100). Programming may be used to set the default room volume. 
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• Auto Room(s) Select—When a source device starts streaming audio, this is the 
room(s) in which the Wireless Music Bridge will be automatically selected as the room 
device. Auto room selection occurs when the Wireless Music Bridge is not already 
selected in any room and there is no other device selected in a room. 

• Room(s) Override—When thi s option is enabled, the Wireless Music Bridge will be 
auto selected as the room device, overriding the currently selected room device. 

• Auto Room(s) Off— Automatically turns off a room when playback stops for the 
selected number of minutes. The room off command will occur in all rooms where the 
Wireless Music Bridge is the selected device. A value of 0 causes this action to be 
performed immediately when playback stops or pauses, so use caution when using a 
value of 0. A timeout value of 1441 disables the timeout. Default timeout is 3 minutes.  

• Bluetooth Module—Enables or disables the Bluetooth module functionality. 
• Firmware Version—Shows the version number for the firmware. 
• Update Status—Displays the firmware update status for the bridge. 
• Update URL—Displays the URL source of the firmware update. 
• Update Method—Select Automatic or Manual firmware updates. Automatic mode 

causes the Wireless Music Bridge to be automatically updated when a new version of 
firmware is available. A firmware update check will occur each time a connection is 
made between the driver and the device. Manual mode requires you to click the Start 
Firmware Update Action button to start the update. 

• Network Connection—Displays Ethernet or WiFi, depending on how the device is 
connected. 

• IP Address—Displays the IP address for this device. 
• Net Mask—Displays the net mask address. 
• MAC Address—Displays the MAC address for this device. Ethernet and WiFi 

connections share this address. 
• Network Status—Displays whether the device is Online or Offline. 
• SSID—Displays the wireless ID number or is blank. 
• Debug Level—Select one of these levels: 0-Alert, 1-Error, 2-Warning, 3-Info, 4-Trace, 

or 5-Debug. Click Set to apply the change. 
• Debug Mode—While enabled, this setting allows you to capture traces for the Wireless 

Music Bridge. The Log option sends debug output to the Control4 director log. Debug 
mode is automatically disabled after 45 minutes.  

See the Documentation tab for more detailed information. 

7 Click the Lua tab to view logged output. 

Configure TuneIn 
Use the Control4 Composer Pro System Design view to access and change TuneIn properties 
for a Control4 system. The TuneIn app lets you play music, Internet radio, podcasts, news, 
sports, and more through your Navigators and smartphone devices to the whole house 
(supported in OS 2.4 and later). 

Prerequisites 
• The TuneIn app, driver, and license are included in OS 2.4 and later, but your customers will 

need to set a TuneIn account to pair TuneIn with their system and they must have a 
HC-250, HC-800, or HC-1000 Controller as their primary controller. The TuneIn driver 
appears below the controller in the Composer Pro project when these conditions are met. 

• For the best audio experience, have your customers create a TuneIn account and add 
Favorites. They can then pair their TuneIn account to the Control4 system so they can play 
their favorite stations on their Navigators. See the TuneIn Setup Guide or TuneIn User 
Guide in the Residential or dealer Documentation page for details. 
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This TuneIn driver is added automatically (see "Prerequisites" above). If you need to add the 
driver again, use the standard method. The driver is located in the Search > Local Database > 
Media Service category. 

To configure the TuneIn properties: 
1 In Composer Pro > System Design > Controller (HC-250, HC-800, or HC-1000), locate the 

TuneIn driver. 
2 Change the properties as needed. Select TuneIn (next to the primary controller). 
3 In the Properties pane, click the Properties tab. View and change the properties as needed: 

• Debug Mode—Use the drop-down list to select Off or On. When On, this setting lets 
the dealer capture traces for the TuneIn driver. Click Set to apply your change. 

• Allow Browse Settings—Use the drop-down list to select True or False. When True, 
this setting displays a root menu item 'Settings' if the system is not registered on a 
TuneIn account. This lets the user pair their system with TuneIn without dealer 
intervention. Click Set to apply your change. 

• Now Playing History Length—Use the up or down arrows to select the number of 
stations to display in the 'Now Playing' screen. Click Set to apply your change. 

• TuneIn Account Group—Use the up or down arrows to select the number of 
instances of this driver (0-99) for use in separate TuneIn accounts. Click Set to apply 
your change. 

• Username—The TuneIn account username registered with the system (not 
recommended). The customer should use the 'Settings' button to register their system. 
See the 'Documentation' tab for details. 

• Password—The TuneIn account password (not recommended). The customer should 
use their 'Settings' button to register their system. See the 'Documentation' tab for 
details. 

• Status—Displays various status messages when the TuneIn account is or is not paired 
with the system. See the 'Documentation' tab and Step 4 (Actions tab) for details. 

• Supported Controller—Displays a True message if the primary controller is a valid 
model to use with TuneIn or False if it is not. 

• Disabled—Use the drop-down list to select True or False. 

Click the Documentation tab for more information. 

4 (Optional) Click the Actions tab to sync Favorite stations, update the TuneIn pairing status, 
drop a TuneIn account, or join a TuneIn account. 
• Sync Favorites for Programming—Click to sync the TuneIn Favorites in the 

Navigators. This is useful for programming purposes, for example, if you set up a 
'Wakeup' scene to play a certain Internet station. 

• Update Status—Click to update and display the current status in the 'Status' option on 
the Properties page. 

• Drop—Click to drop the TuneIn account and pairing from this device. 
• Join—Click to join the TuneIn account and pair this device to the Control4 system. 

5 (Optional) Click the Lua tab to view logged output. 
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Configuring Motorization 
Use the Composer Pro System Design and Connections views to add and configure contacts 
and relays.  

Configure a Gas Fireplace Relay 
Use the Composer Pro System Design and Connections views to configure a Gas Fireplace 
Relay. 

Ensure that the Wireless Fireplace Switch is installed as directed in the Control4 Wireless 
Fireplace Switch Installation Guide available on the Control4 Dealer website. The Gas Fireplace 
Relay installs with the Wireless Fireplace Switch. 

To add and configure a Gas Fireplace Relay: 
1 To add the driver and identify the device see “Guidelines for Configuring Devices.” Ensure 

that the Gas Fireplace driver is added to the project tree. 
2 Click Connections. 
3 Make the necessary connections. See “Connecting and Verifying Devices” for details. 
4 (Optional) To configure the properties, click System Design. 
5 In the project tree, select the Gas Fireplace object. 
6 View and change the properties in the Properties pane.  

Modifiable properties include:  

Invert Relay—Normally, the relay is open when the switch is off. If you check this option, 
the switch's off position closes the relay.  

Radio Buttons: 

• Toggle Type—Select if the fireplace needs two (2) wires always touching to stay on. 
• Pulse Type—Select if two (2) fireplace wires only need to touch momentarily to turn the 

fireplace on or off. 

Pulse length is x milliseconds. Add the desired value here. 

Watts—(For use with a future product.) 

Configure a Wireless Fireplace Switch 
Use the Composer Pro System Design and Connections views to configure a Wireless Fireplace 
Switch. 

Ensure that the Wireless Fireplace Switch is installed as directed in the Control4 Wireless 
Fireplace Switch Installation Guide available on the Control4 Dealer website. The Gas Fireplace 
Relay installs with the Wireless Fireplace Switch. 

To add and configure a Wireless Fireplace Switch: 
1 To add the driver and identify the device see “Guidelines for Configuring Devices.” Ensure 

that the Fireplace Switch driver is added to the project tree. 
2 Click Connections. 
3 Make the necessary connections. See “Connecting and Verifying Devices” for details. 
4 (Optional) To configure the properties, click System Design. 
5 In the project tree, select the Fireplace Switch object. 

http://dealer.control4.com/dealer/support/documentation
http://dealer.control4.com/dealer/support/documentation
http://dealer.control4.com/dealer/support/documentation
http://dealer.control4.com/dealer/support/documentation
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6 View and change the properties in the Properties pane.  

Modifiable properties include: 

Properties: 

• Invert Relay—If checked, the relay that appears as normally open becomes a closed 
circuit. The default is open. 

Advanced Properties: 

• LED 
• Top Color 

• On—The LED color for the Top LED when the LED state is On.  
• Off—The LED color for the Top LED when the LED state is Off. 

• Bottom Color 
• On—The LED color for the Top LED when the LED state is On.  
• Off—The LED color for the Top LED when the LED state is Off. 

• Options 
• Top LED Link—Select to enable. If checked, swap on and off the state and color 

on the top LED. 
• Bottom LED Link—Select to enable. If checked, swap the on and off state and 

color on the bottom LED. 
• Buttons Attached—Select to enable. If checked, pressing the buttons on the 

Switch directly controls the connected load. 
• LED Attached—If checked, the LED state is controlled by the button presses. If 

unchecked, the LED state and colors can be controlled by custom programming. 
• Hold Ramp Rate (Seconds) 

• Up—The rate in seconds when the load increases when the top button is held 
down. 

• Down—The rate in seconds when the load decreases if the bottom button is held 
down. 

• Network—The network information is added automatically (Channel, Gateway, MAC, 
and Version). 

Configure Pulse Single Relay Support 
Use the Composer Pro System Design view to check and change relay properties.  

When using a Pulse Type Relay in your project, you can add a single relay device, and then 
configure it as a “Pulse Type” relay rather than having to program anything to provide the pulse 
functionality. This option is in the System Design Properties pane when you select a relay. 

To view relay properties: 
1 Click System Design. 
2 Select the relay object from the project tree. View its properties in the Properties pane.  

Modifiable properties include:  

Invert Relay—Normally, the relay is open when the switch is off. If you check this option, 
the switch's off position closes the relay. 

Radio Buttons: 

• Toggle Type—Select if the device needs two (2) wires always touching to stay on. 
• Pulse Type—Select if two (2) wires only need to touch momentarily to turn the device 

on or off. 
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Pulse length is x milliseconds. Add the value here. 

Watts—When making the connection between a device and the 8-Channel Relay module, 
the 8-Channel Dimmer and 8-Channel Relay keep track of the watts of each light or relay 
connected to them and don’t allow you to exceed the maximum wattage for the module. Use 
the up or down arrows to set the wattage. Click Set.  

3 To use this option, select the Pulse Type radio button, and select the Pulse Length is x 
milliseconds for the relay pulse (the default is 500 milliseconds).  

 

Configure Single Contact Relay Support 
Use the Composer Pro System Design view to check and change Single Contact Trigger support 
for contacts. 

When using a contact in your project, the physical change of the contact’s state might not always 
result in a single open-to-close or close-to-open state change, but rather bounce between states 
multiple times before the final state is reached. 

To eliminate false notification of the contact state to the Control4 system, you can configure a 
'Debounce Timer' to allow the system to see only a single state change. 

In the System Design view, you can set this option in the Properties pane when you select a 
contact. 

To set this option: 
1 Select the contact object from the project tree. View its properties in the Properties pane. 

Modifiable properties include: 

Invert Sensor—Depending on the sensor type, the controller sends a small amount of 
voltage through the sensor to close it, if for example when a door is closed with feedback 
indicating such. You use Invert Sensor if you want to feedback to be the opposite. 

Enable Debounce Timer—Sets an amount of time that lapses before the sensor triggers to 
on. 

Debounce Time(ms)—The amount of time in milliseconds before the sensor state changes 
to on. 

2 Check the Enable Debounce Timer box. 
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3 In the Debounce Time(ms) (in milliseconds) drop-down menu, select to delay notification of 
the contact state (the default is 100 milliseconds).  

 

Configure a Fan Speed Controller 
This applies to next generation lighting (compatible with OS 2.5 and later).  

When adding a Fan Speed Controller to your project, a keypad is also added underneath it. Both 
devices need to be configured. 

  

To configure a Fan Speed Controller: 
1 Add the Fan Speed Controller to your project tree, then identify it. For instructions, see 

“Guidelines for Configuring Devices.”  
2 In the System Design view, select Fan Speed Controller. The device’s Properties tab 

opens. 
3 Configure the settings for the device as described in the following Properties sections. 
4 If you entered text for custom engraving, go to “Ordering keycap engraving” on page 65. 
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Fan properties 

 

Properties 

• Preset Level— Select a fan speed from the drop-down list. This is the speed that will be 
used when the fan is toggled on. 

Advanced Properties 

• Fault Detection 
• Status—Displays the device’s current fault status. Green is normal, but red indicates a 

fault. 
• Reset—Resets the fault status indicator. If the fault repeats, make sure that the load 

type is compatible, that the device is wired correctly, and that the device is not 
damaged. 

• Fan Speed Colors 
• Name—Select the fan speed using the Name drop-down menu, then click the True or 

False color bars to change them. True is the keypad color when that speed is active. 
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• Ambient Light Profiles 
• Select a preset brightness profile for the keypad backlight and LEDs that changes their 

brightness according to the room’s ambient light. You can also select Fully Customized 
and manually set each brightness level according to ambient lighting. 

• Backlight Color—Sets the keypad’s backlight color. If you don’t want a keypad 
backlight, keep the default setting (black). 

Energy Information (view only) 

• Minutes Off—Elapsed minutes since device was turned off. 
• Minutes On—Elapsed minutes since device was turned on. 
• Minutes On Today—Total minutes device has been on for the current day. 
• Current Power—Power being consumed by the device at the present time. 
• Energy Used—Total watt hours consumed by the device over its lifetime. 
• Energy Used Today—Watt hours consumed by the device for the current day. 

Network—(read only) The current MAC address and firmware version of the selected device. 
These fields are not editable. 

Keypad properties 

 

Properties 

• Button Settings 
• Name—The name of the button (used for defining its connections to other devices or 

events within Composer Pro). 
• Engraving—Text that you want printed onto the buttons. For more information, see 

“Ordering keycap engraving” on page 65. 
• Icons—Icons that you want printed onto the buttons. To add an icon to the 

Engraving text box, click Icons, then double-click the icon to add. 
• Button Behavior—The fan speed that the selected button activates. You can also 

select Keypad for the button to act like a standard keypad button that doesn’t directly 
control the fan speed. 

• LED Behavior 
• Follow Bound Device—LED behavior reflects the state of the device the button is 

bound to. 
• Follow Fan Speed—LED behavior reflects the fan speed. 
• Push/Release—LED behavior reflects the button state (pressed or released). 
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• Push Color—Sets the LED color while the button is pressed. 
• Release Color— Sets the LED color while the button is released. 

• Programmed—LED behavior follows programming commands. 
• Finish—Color of the buttons. 

Configuring HVAC systems 
Use the Composer Pro System Design and Connections views to configure a Control4 Wireless 
Thermostat. Control4 also supports multiple third-party thermostat models.  

Note: Previous releases of Composer Pro documentation included instructions about how to 
configure third-party products and older versions of the Wireless Thermostat. Starting with OS 
2.0, third-party device configurations are no longer included in the Control4 documentation, 
although they are still supported in the drivers list (for example, EnviraZone and Aprilaire 
RS232). Refer to previous releases of the Composer Pro User Guide for information about these 
third-party drivers and examples of older thermostat models. 

Setting up a Wireless Thermostat 
Use the Composer Pro System Design and Connections views to set up a Control4 Wireless 
Thermostat. 

Prerequisites 

• Ensure that your project has a Control4 controller added to the project tree and is identified 
on the Control4 system. 

• Ensure that the thermostat is installed at the wall as directed in the Control4 Wireless 
Thermostat Installation Guide available on the Control4 Dealer website. 

• Ensure that the Control4 Wireless Thermostat is added to the project tree. 

To configure a Wireless Thermostat for the Control4 system: 
1 To add the driver and identify the device see “Guidelines for Configuring Devices.” Ensure 

that the Residential Thermostat driver is added to the project tree (unless you’re using a 
third-party thermostat). 

2 To add the driver and identify the device see “Guidelines for Configuring Devices.” Ensure 
that the Residential Thermostat driver is added to the project tree (unless you’re using a 
third-party thermostat). 
• To program the schedule, see “Programming the Control4 Thermostat Schedule.” 
• To set up advanced properties, see “Using the Wireless Thermostat Advanced 

Properties.” 

Programming the Control4 Thermostat schedule 
Use the Composer Pro System Design view to set a heating and cooling schedule for your 
Control4 Wireless Thermostat (model number: Control4-CCZ-T1-x for OS 2.0 and later). The 
Control4 Wireless Thermostat works with your heating and cooling system to maintain a 
consistent temperature called a ‘set point.’ Using the Control4 Wireless Thermostat, you can 
specify separate heating and cooling set points.  

Tip: New in OS 2.0 and later, you can set the heating and cooling schedule from a touch screen 
or on-screen Navigator. See the Control4 System User Guide for details.  

http://dealer.control4.com/dealer/support/documentation
http://dealer.control4.com/dealer/support/documentation
http://dealer.control4.com/dealer/support/documentation
http://dealer.control4.com/dealer/support/documentation
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The Control4 Wireless Thermostat automatically engages the appropriate heating or cooling 
system until the room reaches the desired temperature. In Composer Pro, you can set up a Heat 
Point and a Cool point for six (6) possible Program Events in a day time period.  

Program Events include: 

• Awake—Sets the wakeup time and related Heat/Cool Points. 
• Leave—Sets the away time and related Heat/Cool Points. 
• Return—Sets for return time and related Heat/Cool Points. 
• Sleep—Sets for sleep time and related Heat/Cool Points. 
• Custom 1—Sets a specified time and related Heat/Cool Points. 
• Custom 2—Sets a specified time and related Heat/Cool Points.  

You can enable these Program Events for weekdays, weekends, or individual days to match 
activity in the home. 

Prerequisite 

Ensure that the thermostat is installed as directed in the Control4 Wireless Thermostat 
Installation Guide available on the Control4 Dealer website. 

To program the Wireless Thermostat schedule: 
1 In the System Design view, select the Control4 Wireless Thermostat object. 
2 The Properties appear in the center pane. Fahrenheit is selected by default; select Celsius 

as needed. 
3 In the Properties tab, select View/Edit Schedule. The Schedule dialog appears with the 

currently programmed schedule for Monday through Sunday.  

Note: You can schedule the thermostat either in Composer Pro or in the Control4 touch 
screens, MyHome apps, or on-screen Navigators. See the Control4 Wireless Thermostat 
User Guide or the Control4 System User Guide for information about scheduling a Wireless 
Thermostat from a Navigator. 

 

Tip: To return to the original settings, click the Restore Default button. 

4 For each line item: Awake, Leave, Return, Sleep, Custom 1, and Custom 2, use the up and 
down arrows to set the day and temperature Heat and Cool set points. 

Notes: (1) You can view the schedule by selecting the 12 Hour Display or the 24 Hour 
Display. (2) The Cool and Heat Points stay two (2) degrees apart. Example: If you set the 
Heat Point to 72 degrees, the lowest you can set the Cool Set Point is 74 degrees. This 
keeps your furnace and your air conditioner from competing with each other. 

http://dealer.control4.com/dealer/support/documentation
http://dealer.control4.com/dealer/support/documentation
http://dealer.control4.com/dealer/support/documentation
http://dealer.control4.com/dealer/support/documentation
http://dealer.control4.com/dealer/support/documentation
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5 When you are finished, click Ok. Your updated schedule displays. You may then set the 
modifiable properties. See “Using the Wireless Thermostat Advanced Properties.” 

Using the Wireless Thermostat advanced properties 
Use the Composer Pro System Design view to view and change the Wireless Thermostat 
properties. Set the Properties to create a schedule and the Advanced Properties to modify the 
thermostat’s configuration. 

Ensure that the Control4 Wireless Thermostat (model number: Control4-CCZ-T1-x for OS 2.0 
and later) is installed as directed in the Control4 Wireless Thermostat Installation Guide available 
on the Control4 Dealer website. 

To use the thermostat advanced properties: 
1 In the project tree select the Control4 Wireless Thermostat. 
2 Click the Properties tab to view the list below.  

Note: Different properties may appear, depending on the thermostat model. The properties 
below apply to the Control4 Wireless Thermostat for OS 2.3.0 or later. 

 

Modifiable Advanced Properties include:  

Properties 

• Fahrenheit or Celsius—Sets the temperature display in Fahrenheit or Celsius. 

http://dealer.control4.com/dealer/support/documentation
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• View/Edit Schedule—Brings up the schedule page to set heat and cool set points for 
auto mode (see below). In the mode (Awake, Leave, Return, etc.), set the day and 
temperature set points. Click OK to close the window. Note: You can view the schedule 
by selecting the 12 Hour Display or the 24 Hour Display.  

 

• Vacation—Lets you set the Heat Set Point and Cool Set Point when the homeowner is 
on vacation. Use the up or down arrows to set the heat and cool set points, and then 
click OK. 

 

• Use Remote Temperature Sensor—Sets the thermostat to use either the on-board 
Local temperature sensor (default) or an optional Remote temperature sensor to control 
the HVAC system by selecting the Use Remote Temperature Sensor radio button. 

• Buttons—Locks local buttons to prevent unwanted changes to thermostat settings. 
Select the Locked and Unlocked radio buttons. Note: If buttons are disabled, they will 
be re-enabled when the thermostat power cycles. This is a safety mechanism to prevent 
a thermostat from becoming completely inoperable if it were removed from a project 
while the buttons were disabled.  

Advanced Properties 

• General Setup 
• Backlight Mode—Lets you select your preferences for the backlight. Select On 

Button Press to light the backlight for ten (10) seconds when any button is 
pressed. Select Always On to keep the backlight on constantly. When using 
batteries for power with power stealing enabled, the Always On option is not 
recommended. 

• Battery—Shows the power source or battery level (for example, "Externally 
Powered"). 

• Time Format (Date and Time)—Lets you set preferences regarding Date Format 
(MM/DD/YYYY or DD/MM/YYY) and Time Format (12 h or 24 h). Click the Sync Time 
button under Time Format to update the time on your thermostat manually to the 
controller. (The thermostat also updates automatically at 3:00 AM each morning.)  
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• Network—Displays informational boxes that provide ZigBee networking information 
(MAC and Firmware Version). 

• Advanced Device Configuration—Click this button to fine-tune your thermostat (see 
below). 

3 Select Apply to to apply the current properties to the selected Wireless Thermostats. 

Advanced Device Configuration 
Control4 has enhanced the available thermostat settings to allow users and installers to 
modify engage and cutoff temperature deltas—as well as maximum and minimum run time, 
off, and delay times—so that the thermostat can be configured to run optimally with any 
HVAC system.  

Note: Allowing such fine tuning of all settings can result in setting improper values and 
combination of values to cause the HVAC system to run less than optimal. To prevent 
thrashing the cool and heating engage (constant heat, then cool, engagement), cutoff and 
set points are enforced to have at least a one (1) degree difference for engage 
temperatures.  

The formula for the dependency of these values is: 

Heat/cool engage delta—Opposite stage (if heat engage, then cool cutoff and visa versa) 
cutoff delta + set points delta (cool set point – heat set point) >=1  

The screen below shows the Advanced Device Configuration properties.  

 

• Temperature Calibration—Use the up or down arrows to set x degree(s), and then click 
Set Calibration. This lets you fine tune the current temperature reported by the thermostat 
by +/- 5 degrees. Example: If your thermostat reads 72 degrees Fahrenheit, and you 
determine that the current temperature should be 70 degrees Fahrenheit, press the down 
button two times to lower the thermostat’s reading to 70 degrees Fahrenheit. Click Set 
Calibration.   

Note: No changes to calibration should be made within 20 minutes of powering on the 
thermostat. The thermostat generates a small amount of heat which affects the calibration. 
After 20 minutes of continuous operation, this will stabilize allowing proper calibration. 
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• Heating Cutoff Point—Use the up or down arrows to set x degree(s) from the set point, 
and then click Set Heat Cutoff. This sets how far over the setpoint you want the heating 
system to remain engaged before shutting off. Example: If the heat set point is set to 68 
degrees Fahrenheit and the cutoff point is set to 2 degrees Fahrenheit, the heating system 
will engage until reaching 70 degrees. 

• Cooling Cutoff Point—Use the up or down arrows to set x degree(s) from the set point, 
and then click Set Cool Cutoff. This sets how far under the setpoint you want the cooling 
system to remain engaged before shutting off. Example: If the cool setpoint is set to 68 
degrees Fahrenheit and the cutoff point is set to 2 degrees Fahrenheit, the cooling system 
will engage until reaching 66 degrees.  

• Stage Minimum Off Time (Minutes)—Use the up or down arrows to set the minimum off 
time in minutes. Note: This setting takes effect as soon as the Advanced Device 
Configuration box is closed.  

This is the minimum amount of time that the heating or cooling will remain off before 
initiating again. Example: If while cooling, the temperature does not reach the designated 
cutoff point before the maximum run time is reached, the cooling system will shut off and not 
initiate cooling again until the Minimum Off Time is reached. Note: Some HVAC systems 
automatically enforce a Minimum Off Time. In this case, the heating or cooling will remain off 
for the higher of the two settings (thermostat or HVAC system). 

Stage Configuration (Heat Stage 1, 2; Cool Stage 1, 2; Auxiliary; Emergency) 

The stage configuration boxes allows for setting the engage delta, minimum run time and 
maximum run time for each stage.  

Note: These settings take effect as soon as the Advanced Device Configuration box is 
closed. 

• Delta (degrees)—Use the up or down arrows to set the stage engage temperature delta. 
This sets how many degrees the current temperature will reach beyond the setpoint before 
the stage engages.  

Example:  

For heat, if the heat setpoint is 70 degrees Fahrenheit and the engage delta is 2 degrees 
Fahrenheit, the heat stage will engage when temperature reaches 68 degrees.  

Note: For multi-stage systems, the deltas for the first and second stages are cumulative. If 
the first stage delta is set at 2 degrees Fahrenheit and the second stage delta is set at 2 
degrees Fahrenheit, the second stage will not engage until the current temperature has 
passed the stage setpoint by 4 degrees Fahrenheit. However, the Auxiliary Heat and 
Emergency Heat deltas are NOT cumulative. 

• Minimum Run Time—Use the up or down arrows to set the stage x minimum run time in 
minutes. The minimum run time is one (1) minute. This sets the minimum time the heating 
and cooling will run before shutting off.  Example: If while cooling or heating, the 
temperature reaches the designated Cutoff Point before the Minimum Run Time is reached, 
the system will not shut off until the Minimum Run Time is reached. Also, if heat or cool is 
engaged and shut off manually, the system will not shut off until the Minimum Run Time is 
reached. Note: Some HVAC systems have built-in Minimum Run Times that may be greater 
than that set on the thermostat. 

• Maximum Run Time—Use the up or down arrows to set the Heat Stage x maximum run 
time in minutes.  The maximum run time is 255 minutes. This sets the maximum time the 
heating or cooling will run before turning off. Example: If heating or cooling is engaged, but 
does not reach the Cutoff Point before the Maximum Run Time is reached, the cooling 
system will turn off. Note: The Maximum and Minimum Run Times are not per stage, but for 
cooling and heating run times regardless of first or second stage transitions.  
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Auxiliary Stage 

The Auxiliary and Emergency Heat stages are specifically for heat pump systems. The 
switches on the back of the thermostat allow the thermostat to operate a heat pump system.  

Note: These settings take effect as soon as the Advanced Device Configuration box is 
closed. 

• Stage Delay (Minutes)—Use the up or down arrows to set the stage delay for x 
minutes. This sets the allotted time the main heat pump system will run without reaching 
the desired heat setpoint goal before the Auxiliary stage engages. Note: If set to the 
maximum time allowed, the auxiliary system will be disabled and never engage.  

• Stage Cutoff Delay (seconds)—Use the up or down arrows to set the stage cutoff 
delay in seconds. This sets how much of a delay before the main heat pump cuts off, 
leaving the Auxiliary heating stage to run on its own. Note: If set to the maximum time 
allowed, the main heat pump stage and the Auxiliary heat stage will run together 
indefinitely.  

IMPORTANT! Starting with OS 2.0, the thermostat driver and firmware use a different 
temperature scale. Due to this, existing programming which evaluates temperature values 
will not work correctly and must be deleted and re-done. Also, any thermostat variables 
used for the Email Notification agent must be changed to use the new V1 variables for the 
temperatures to be displayed correctly. 

Configuring an IP camera or web image 
Use the Composer Pro System Design and Connections views to configure this device. Internet 
Protocol (IP) security cameras, including on-screen controls in Navigators, such as pan, tilt, 
zoom, and preset settings are supported along with HTTP control and JPEG or MJPEG images. 

Prerequisites 
• Ensure that your project has a Control4 controller added to the project tree and is identified 

on the Control4 system. 
• Ensure that the IP security camera is installed at the wall as directed in the manufacturer's 

installation guide. 

To add and configure an IP security camera or Web JPEG image: 
1 To add the driver and identify the device see “Guidelines for Configuring Devices.” Ensure 

that the IP Cameras driver is added to the project tree. 
2 In the Properties pane, do the following: 

• For an IP Security camera, configure the IP Address, port, and authentication 
information (if applicable).  

• For Web JPEG Image only, enter the URL and authentication user name and password 
(if a secure HTTP address), select the refresh rate in minutes, and then tests. 

• Click Test HTTP Connection to test it. 
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Configuring Black & Decker locks 
Use the Composer Pro System Design view to add and configure Black & Decker KwikSet® 
SmartCode® with Home ConnectTM Technology ZigBee Deadbolt locks, Baldwin, or other 
supported locks for exterior doors. In general, these instructions can be used to add and 
configure lock drivers for other lock products compatible with Control4 systems. 

Ensure that the Black & Decker locks are installed as directed in the Black & Decker Installation 
instructions shipped with the product. 

To add and configure Black & Decker locks: 
1 To add the driver and identify the device see “Guidelines for Configuring Devices.” Ensure 

that the Black and Decker SmartLock RF ZigBee driver is added to the project tree.  

Tip: If you are adding several locks in a home, it might be useful to give each lock a unique 
name. 

2 For each lock you add to the project, add a Relay to the project tree also. See “Configuring 
Contacts and Relays.” 

3 Click the Connections view. 
4 In the Connections view, use the Control & Audio Video Connections tab to make the 

necessary control connection.  
5 Under Control Outputs, select the Lock State and drag it down to the Relay in the RELAY 

Input Devices pane. 
6 (Optional) For additional Black and Decker ZigBee Lock setup, configure the Properties.  

a In the System Design view project tree, select the Black and Decker ZigBee Lock 
object.  

b Modify the properties in the Properties pane, and then click Set (if applicable). 
• Debug Mode—Use the drop-down menu to select logging and printing. 
• Lock Sleep Timer—Use the drop-down menu to select how long the lock is in 

sleep mode (in seconds). 
• # of Log Items—Use the up or down arrows to set the number of items to log. 
• Last Status—Last change made in Debug Mode. 
• Firmware Version—Indicates the ZigBee firmware version for the lock. 
• Instructions—See the Documentation tab. 
• Name, Code x—Enter the lock name and code here. You can enter up to 30 code 

entries. Set up the user codes here. Type the user's name, then a comma (,), and 
then add the numeric code (4 to 8 characters allowed). Example: Bob, 12345. Up 
to 30 codes can be entered.  

Tip: The codes can be entered also on the touch screen or on-screen Navigator if you 
download the Black & Decker application from 4Store. 

c Click the Documentation tab for additional information about setting the properties, 
user codes, and actions for the locks.  

d Click the Actions tab. 
• Get Battery Status—Click to show the status of the battery on the lock. 
• Show User Codes—Click to show all of the user codes assigned to this lock. The 

user codes appear in the Properties tab. 
• Hide User Codes—Click to hide all user codes assigned to this lock. The user 

codes appear as x's in the Properties tab. 
• Delete All Codes—Click to delete all user codes assigned to this lock.  
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Note: You can set the user codes either from Composer Pro, or from the touch screen 
or on-screen Navigator in My Apps (downloaded from 4Store). The priority for setting 
user codes and Actions is whoever set the codes or actions last, whether it was in 
Composer Pro or on a touch screen or on-screen Navigator, will be the valid codes or 
actions used. See the Black & Decker KwikSet SmartCode with HomeConnect™ Locks 
User Guide on the Control4 Products page for details. 

e Click the Lua tab. This is used for the DriverWorks SDK (developers only). 

Configuring SNMP 
Installing the SNMP MIBs 

The following SNMP MIBs are required to use SNMP to manage a Control4 network remotely: 

• Control4 MIBs—CONTROL4-DIRECTOR-MIB, CONTROL4-GLOBAL-REG, and 
CONTROL4-TEST MIB. These MIBs are installed by default when you install Composer 2.2. 
They appear in Program>Files>Control4>Composer 2.2>SNMP>MIBs/ on the computer 
where Composer resides. 

• SNMP MIBs—Make sure the NMS console you use has the following SNMP MIBs: 
SNMPV2-SMI, SNMPV2-TC, SNMPV2-CONF, and INET-ADDRESS-MIB. The Control4 
MIBs reference these MIBs. 

Configuring the SNMP Configuration Agent 
Use the Control4 Composer Pro Agents view to use and manage SNMP devices, including; 
adding trap targets; setting up route information; enabling SNMP; configuring SNMP settings; 
setting up SNMP system and user variables, and more. 

You can change the SNMP Configuration agent settings either using Director or Virtual Director.  

Notes:  

• If you use Virtual Director, even though you click Apply to save your changes, they will not 
take effect until the project displays and the SNMP-enabled devices are online. 

• If you use SSH and VI at the command line to edit a configuration file, and later change any 
settings in the Agents view, your changes in Composer will overwrite those made at the 
command line. 

Prerequisites 

To use SNMP in a Control4 system, you need: 

• An NMS console or an installed MIB browser and the three (3) Control4 MIBs (installed by 
default with Composer 2.2): CONTROL4-DIRECTOR-MIB, CONTROL4-GLOBAL-REG, and 
CONTROL4-TEST-MIB. These MIBs are located in Program>Files>Control4>Composer 
2.2>SNMP>MIBs/ on the computer where Composer resides. 

• SNMP MIBs. Make sure the NMS console you use has the following SNMP MIBs: SNMPV2-
SMI, SNMPV2-TC, SNMPV2-CONF, and INET-ADDRESS-MIB (Dave to provide links). The 
Control4 MIBs reference these MIBs. 

• SNMP Configuration agent. To configure SNMP in a Control4 system you must add the 
SNMP Configuration agent in the Composer Pro Agents view. See Example: Program Using 
the SNMP Configuration Agent to add the agent. 
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Procedure 

1 In Composer Pro click Agents. 
2 In Agents, select the SNMP Configuration agent, or add it if it's not already in the list. 
3 When you are finished with your changes, click Apply at the top of the page. 

To configure SNMP settings in the Properties pane: 
1 In the SNMP Configuration pane, click Properties. 
2 If they are SNMP-enabled, all of your controllers, IO Extenders, and touch screens in the 

project will appear in the Managed SNMP Devices pane. If you've updated the system to OS 
2.2 or later, those devices appear automatically. 

3 Use the Properties pane to disable SNMP from the project, add traps, set community 
strings, and change contact information. 
• SNMP Enabled—By default SNMP is enabled if controllers, IO Extenders, and touch 

screens have been updated to OS 2.2. Uncheck to disable a selected device. 
• Trap Targets—Use to add the IP address for the NMS console or MIB browser to send 

traps to. See "To add trap targets" below. 
• Community Strings—The default is Read: Public, Write: Private. Use the MIB browser 

and this Properties tab to change these settings for Get and Set commands. The strings 
must match in the MIB browser and in this page. Example: Read: Public must be the 
same in the MIB and in the Properties tab. 

• Contact Information.  
• sysContact—Check Use Project Primary Contact to populate this text box with 

information from the Info tab in the System Design view, or uncheck and type a 
contact name here. 

• sysLocation—Check Use Project System Owner Address to populate this text 
box with information from the Info tab in the System Design view, or uncheck and 
type the owner's address and city here. 

• sysName—Check Use Room to populate this text box with information from the 
room name that the device is in (appears automatically), or uncheck and type 
another value, for example, a hotel room number. 

To add one or more devices:  

Add devices that you want to manage using SNMP in the Properties pane. 

1 In the Managed SNMP Devices pane, click Add or right-click and select Add Device. 
2 In Add Device, select the device to add. To add several devices use CTRL or SHIFT and 

select the devices. 
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3 Click OK. The device(s) appear in the Managed SNMP Devices pane. 

 

Note: If you select multiple devices and their properties are different, a red warning 
message appears, and Composer Pro attempts to notify you of the conflict. 

Tip: You can configure one device and then copy it to other devices to save the properties 
you've defined. See the next steps for details. 

To copy a device: 

Copy a device to other devices if you want to use the device's properties. 

Note: You cannot copy a device to another device that's already been identified in 
Composer Pro. 

1 In the Managed SNMP Devices pane, click Copy or right-click and select Copy Device. 
2 In Target Device, select the device to copy. 
3 Click OK. The device appears in the Managed SNMP Devices pane. 
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4 In the Managed SNMP Devices pane, select the devices to copy to. 

 

To delete a device: 

Remove a device from the managed list in the Properties pane. 

1 In the Managed SNMP Devices pane, click Delete or right-click and select Delete Device. 
2 In Target Device, select the device to delete. To delete several devices use CTRL or SHIFT 

and select the devices. 
3 Click OK. The device(s) disappear from the Managed SNMP Devices pane. 

Notes: 

(1) Deleting a device removes it from the list, but the properties are saved. 

(2) You can add the device back into the project with the last saved SNMP settings. 

To add trap targets: 

Add the IP address or host name of the NMS console to send trap targets to in the Properties 
pane. 

1 In the Managed SNMP Devices pane, select the device to manage. 
2 In the Trap Targets pane, click Add. 
3 In Add Trap Target, type the following:  

• Target—IP address of the console that will receive the traps. 
• Community— (Optional) Information will be taken from the Community Strings boxes. 
• Port—(Optional) The default is 162. 
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4 Click OK. The information will be added to the Trap Targets pane. 

 

Tip: If you click the System Variables tab and select SNMP Trap Enabled, the traps will be 
enabled for the selected variable. 

Caution: You may have conflicts if the Trap Enabled values in System Variables are 
different (some True, some False). 

To change the 'Trap Enabled' system variables in the System Variables pane: 

Change the 'Trap Enabled' status in the System Variables pane when you want traps sent to the 
NMS console you set up (see the previous steps) for the selected variable(s) agents or in 
programming. Example: You can set a 'Trap Enabled' status to 'True' for the 
CURRENT_SELECTED_DEVICE variable in Room 100. 

1 In SNMP Configuration, click the System Variables tab. 
2 Select the Variables to change. Select all that apply. 
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3 Check or uncheck SNMP Trap Enabled or right-click and select Enable Trap or Disable 
Trap in System Variables. The 'Trap Enabled' column changes from 'False' to 'True' or vice 
versa for those selections. 

 

To change the 'Trap Enabled' user variables in the User Variables pane: 

Change the 'Trap Enabled' status in the User Variables pane when you want traps sent to the 
NMS console you set up (see the previous steps) for the selected variable(s) agents or in 
programming. Example: You can set a 'Trap Enabled' status to 'True' for 'Boolean Var.' 

1 In SNMP Configuration, click the User Variables tab. 
2 Select the variables to change. Select all that apply. 
3 Check or uncheck SNMP Trap Enabled or right-click and select Enable Trap or Disable 

Trap in System Variables. The 'Trap Enabled' column changes from False to True or True to 
False for those selections. 
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Connecting  
Devices 

After you plan and create the project in Composer Pro's System Design for a Control4 system 
(adding the buildings, rooms, devices, etc.), you are ready to make the necessary connections in 
the system. Just like you connect cables and wires between your physical devices so they work 
together, those same connections need to be added virtually in Composer Pro using the 
Connections view. 

Use this chapter to learn how to: 

• Connect devices virtually 
• Verify the connections by testing them 

Why you need connections 
The software connections represent either connections between the controller and its attached 
devices OR connections among AV devices. 

When you match the connections together in Composer Pro, the software connections mirror the 
hardware connections in the system where appropriate. The system can then control the 
connected devices and identifies where to route the media where it’s available.  

These types of connections are used in the Control4 system: 

• Network Connections—Defines the devices that use a network address. Network 
connections include IP and ZigBee or ZigBee Pro devices. 

• Control Connections—Defines the control connection between a device and the controller. 
Control connections include contacts, relays, serial, and IR -controlled devices. 

• Audio and Video Connections—Defines the devices that have audio and/or video signals. 
• Room Connections—Defines the video, audio, or video/audio end points and the 

video/audio or audio volume for the selected room. 
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Connection design tips for Panelized Lighting 
Because there could be potentially many devices in a Panelized Lighting solution, making the 
proper connections between the modules and loads is key to efficient Panelized Lighting design. 
It will require some practice and trial and error on each project to get the system designed the 
way you want it.  

Keep these things in mind: 

• Each module ideally should use all channels and be close to the maximum wattage allowed. 
This must be traded off, however, against certain realities; for example, arc-fault breakers, 
numerous small loads, and very large loads. 

• Whenever possible, put the loads in the same room on the same module. This allows each 
module override scene to control loads that would be grouped together logically. 

• When using multiple panel/module installation locations, connect loads to modules in a 
nearby location to minimize long wiring runs. 

Connect and verify devices 
In Composer Pro Connections, you can: 

• Identify Control4 devices to establish a network connection 
• Check all network connections 
• Define AV connections 
• Define control connections 

When only one (1) connection is available in a room for a given connection type, Composer Pro 
assumes that connection. 

Tip: To remove any inappropriate connection, right-click the connection, and select Disconnect. 

Example: If a TV is the only Audio Output device in a room, the system assumes that the Audio 
Output connection is routed to the TV. This feature adds value to Composer Pro, but increases 
the need to verify every connection. 

To connect devices: 
1 Start Composer Pro and connect to a Director. 
2 Click Connections. 
3 Identify the devices to add their network addresses to the project.  

a In Connections, click the Network tab > IP Network (default).  

Notice the devices that do not have an address listed in the Address column of the IP 
Network Connections pane. These devices need to be identified and connected.  
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Tip: Devices that appear with a highlighted SDDP in the Available Devices pane can be 
added and identified using Auto Discovery. See “Auto Discovery” in Composer Pro 
Getting Started for details. 

 

b Select an unidentified device in the address list, then right-click and select Identify (or 
click the Identify button in the list header). A device-specific instruction screen with a 
graphic of the device displays (for example, Home Controller HC-1000). 

 

c At the physical device, press the Identification button or dial, as indicated on the 
screen. The button to be pushed on the device flashes on the screen. 

d When the device’s network address displays in the box, click Next to continue, or click 
Close if you’ve identified the IP network device. Follow these steps for each device. 

  

http://dealer.control4.com/dealer/support/documentation
http://dealer.control4.com/dealer/support/documentation
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When you are finished, notice that the Address column is populated with an address for the 
network device. 

 

Define the control and AV connections 

4 For each device, define the following when applicable: 
• Video connections (path of video signals) 
• Audio connections (path of audio signals) 
• Control connections (how the controller communicates with the device) 

To define the connections: 
a In Connections, click the Control/AV tab. 
b Select a device in the Control/AV tab. The Control & Audio Video Connections for the 

selected device display in the top pane. 
c Select one of the device’s connections in the top pane. The available connections for 

the selected connection display in the bottom pane. 
d To make a connection, drag a device’s input (or output) in the top pane to the output (or 

input) in the bottom pane. 

  



Composer Pro 2.5 User Guide   Connect and verify devices 

115 

Example 1: Make Receiver Connections  

In the top pane under Audio Video Inputs: 

5 Click INPUT DVD (Video-COMPOSITE), and drag it to DVD (Output—Theater) in the 
bottom pane. 

6 Click INPUT VIDEO 1 (Video-COMPOSITE), and drag it to Home Controller HC-1000 
(Video Out 1-Theater) in the bottom pane. This connects the Receiver Video 1 input to the 
controller Video 1 output. 

7 Click INPUT DVD (Audio-STEREO), and drag it to DVD (Output-Theater) in the bottom 
pane. 

8 Click INPUT VIDEO 1 (Audio-STEREO), and drag to Controller (Stereo 1-Theater) in the 
bottom pane. 

9 In the top pane under the Control Inputs pane (scroll down), click IR Sensor (Control-
IR_OUT), and drag it to Controller (IR Output 2-Theater) in the bottom pane.  

  

Example 2: Make Television Connections  

In the top pane under the Audio Video Inputs pane: 

10 Click AV (Video-COMPOSITE), and drag it to Receiver (Output-Theater) in the bottom 
pane. 

11 Click AV (Audio-STEREO), and drag it to Receiver (Output -Theater) in the bottom pane. 
12 Under Control Inputs, click IR Sensor (Control-IR_OUT), and drag to Controller (IR 

Output 1-Theater) in the bottom pane. 
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Example 3: Make module and load connections for Panelized Lighting 

In the Control/AV tab: 

13 Select the room where the module is located, Mechanical Room, and then select the 
module, for example, 8-Channel Dimmer 1. 

14 In Control & Audio Video Connections, locate the first entry Channel 1 under Circuit 1. 
15 Click Channel 1 and drag it to Overhead Lights in the bottom pane. 
16 Click Channel 2 and drag it to Fan Light in the bottom pane. 
17 Click Channel 3 and drag it to Alcove Lights in the bottom pane. 
18 Note ‘Connected To’ in the top pane and ‘Connections’ in the bottom pane. You should see 

that the module and load are now connected. 

 

19 Filter the loads by Unbound, Bound, Dimmable lights, and Non-Dimmable lights: 

  



Composer Pro 2.5 User Guide   Connect and verify devices 

117 

20 The following example shows bound, non-dimmable lights. This is an easy way to make 
sure all of your connections are correct. 

 

21 View the wattage: max, used, and available wattage for each circuit as you make the 
connections. 

 

Watt types: 

• Circuit watts—The total number of watts allowed on each circuit. 
• Dimming watts—The dimming number of watts allowed when using Arc-Fault 

breakers. 
• Module watts—The total number of watts allowed for the module. 



Composer Pro 2.5 User Guide   Connecting rooms 

118 

22 If you get an overloaded circuit error message, connect the load to a different module. 

 

23 Connect the modules to the panels. 
• It’s easier to connect from the panel to the module.  
• Ethernet switches are installed in Slot 5 (bottom slot).  
• If 8-channel dimmers are mixed with other module types, the dimmers should be 

installed toward the top of the panel for the best heat ventilation. 

 

Connecting rooms 
Use the Control4 Composer Pro Room Connections to set configuration connection options to 
customize and optimize audio and AV paths to control devices in a room. 

Get room connections 
To get to room connections: 
1 Start Composer Pro and connect to a Director. 
2 Click Connections. 
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3 Select the room in the project tree. 
4 Click the Control/AV tab. The Control & Audio Video Connections pane displays. 

If you run Interviewer or set up your system using System Design, room connections use the 
default settings according to the devices you add.  

  

Example: For a basic system with a television, DVD player, VCR, and satellite, Composer Pro 
by default makes the television the video end point which is the end of the AV path for viewing 
video. The video audio end point is the end of the AV path for listening and managing volume for 
sound when viewing a DVD, VCR or satellite. 

Example: Video End-Point—The Plasma Television displays video for DVD, VCR, and satellite. 

 

Note: For the Control4 system to work properly, verify that the default settings match your 
physical environment. Define each room connection according to your Control4 system. If the 
default settings do not match your system setup exactly, change the settings to match the 
physical environment, and define each room connection according to that system setup. 

An End Point defines the software path that an audio or video signal must follow to reach the 
desired destination.  

Example: When a device is selected as a Video End Point, start at the device and work 
backward to figure out the source-selection and input-switching that must take place to display 
video.  

Note: Speakers are not included in the Control4 project configuration.  

A room provides two (2) priority levels for end points of audio (Audio End Point 1 and 2) and two 
(2) for audio playing for video (Video Audio End Point 1 and 2). The system automatically 
connects the first end point in the room to End Point 1 as the first priority. If that device is part of 
AV path selected, it manages the volume in the room automatically. 
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Room connection types 
The general types of room connections are: 

• Video End Point—On the Control4 system, this is the end of the path in the selected room 
that defines video. The default is the Television. 

• Audio End Point 1 and 2—On the Control4 system, this is the end of the path in the 
selected room that defines audio. The default is the first applicable devices added to the 
system, for example, a Speaker Point or touch screen. However, when a television is added, 
it overrides the initial setting. When a receiver is added, it overrides the television. 

• Video Audio End Point—On the Control4 system, this is the end of the path in the selected 
room that defines audio when watching video on the Control4 system. The default is the first 
applicable device added to the system. However, when a television is added, it overrides the 
first device. When a receiver is added, it overrides the television. 

• Video Volume 1 and 2—Options that let you set the volume management to a device that is 
not an audio end point or a video audio end point. 

Example: If you added an AV switch to your system, the television is probably the video 
audio end point, but you want to use the AV switch for volume control to utilize added 
features of the switch.  

• Audio Volume 1 and 2—Options that let you set the volume management to a device that 
is not an audio end point or an audio video end point.  

Example: If you added an audio switch to your system, another device is probably the audio 
end point, but you should use the audio switch for volume control.  

• On-Screen Device—Defines the device (television) that displays the on-screen Navigator. 
• Temperature and Temperature Control—Defines the device that manages the 

temperature in the room, such as a thermostat. 
• Security System—Defines the device that manages the security system in the room, such 

as a security system. 

Examples of system configurations 
The following examples show possible system configurations: Video Audio End-Point 1 
and 2—The Plasma Television is Video Audio End-Point 1 and the receiver is Video.  

Example 1: Audio End Point 2—The Plasma Television manages the volume when the 
homeowner watches cable, and the receiver manages the volume when the homeowner watches 
the DVD or VCR. 
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Example 2: Video Audio End-Point 1—The receiver is Video Audio End Point 1 and manages 
the volume in the room when the homeowner watches video using the DVD, VCR, or cable. 

  

Example 3: Video End-Point—The Plasma Television switches video for DVD, VCR, and 
satellite. 

 

Example 4: Video Audio End-Point (combined)—The receiver switches both audio and video 
for DVD, VCR, and satellite. 

 

Example 5: Audio End-Point—The receiver switches audio for DVD, VCR, and satellite. 

 

Tip: Understand the physical room connections on your system. The system uses default 
settings. It cannot auto-detect how your system is set up. 
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Verify default room connections 
To verify default room connections including prioritized AV audio end point providers: 
1 Set up a project either using Interviewer or Composer Pro views. See Composer Pro Getting 

Started for details. 

While you set up the project, room connections are set for you according to the default 
settings. The defaults are set by rules in the system, and they might not match your physical 
environment. Manually ensure that the settings match your desired outcome. 

2 Verify that the initial room connections are set up correctly for each room. 
a From Connections, click the Control/AV tab (default). 
b Click the room in the project tree. 
c Verify each connection by ensuring that it mirrors your exact hardware setup. 
d To change a connection, select a device in the project tree, and then select the device 

to change in the Control & Audio Video Connections pane. 
e In the Room Control list, select an item in the upper list, and then drag it to an item in 

the lower list to connect the two (2) items. When successful, both lists update to reflect 
the connection. 

Example: To show how to change a connection from the top center pane, click Video 
Audio End Point (RoomControl-AUDIO_SELECTION), and drag it to the bottom pane 
to connect it to Television (Room Selection - Output-Theater). 

Example Project: Using the sample project, ensure that the following room 
connections exist as outlined in the table. 

Room End Point or Volume Device (End Point or Volume 
Management) 

Theater Video End Point 1 Television (default setting) 

  Audio End Point 2 Receiver (default setting) 

  Video Audio End Point 1 Receiver (default setting) 

  Video Volume Not set 

  Audio Volume Not set 

Bedroom Audio End Point Mini Touch screen 

  Audio Volume Touch screen 

Front 
There are no video or audio End Points or any devices that can 
manage volume in the Front room, so you don’t need to identify the 
video or audio source or volume control device in that room, or modify 
the room for room connections. 

3 Create a connection to define the other devices in the room where you want volume. 
a Select a room in the project tree. 
b In the Room Control list, select an item in the Control & Audio Video Connections, and 

then drag it to an item in the lower list to connect the two (2) items. When successful, 
both lists are updated to reflect the connection. 

Example: From the top center pane, click Video Volume 2 (RoomControl-
AUDIO_VOLUME), and drag to the bottom center pane to connect it to Television 
(Room Selection - Output-Theater). 

http://dealer.control4.com/dealer/support/documentation
http://dealer.control4.com/dealer/support/documentation
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Connecting devices to the network 
After you complete your planning and design of a Control4 system (adding the buildings, rooms, 
devices, etc., see the Composer Pro Getting Started guide for details), you are ready to make 
the necessary connections in the system.  

Connecting a device to the network 
The Control4 Composer Pro Network tab lists all devices in the systems with a network 
connection and lists network addresses. 

Verify the network address for any device that communicates to the controller using TCP/IP, 
WiFi, ZigBee, ZigBee Pro or any other device that uses a network address. 

To connect network devices: 
1 Start Composer Pro and connect to a Director. 
2 Click Connections > Network tab. 
3 Select the device, and then click Identify for the wizard to open. 
4 Follow the on-screen instructions to identify each device as indicated. After identifying the 

network connection, the device’s address appears. 
5 Use the Network tab to identify devices to the Control4 system that use a network address. 

There are two (2) places to verify network connections: the Network tab and the Tools 
menu.  

Configuring a WiFi connection 
Use the Control4 Composer Pro System Manager tool to connect to WiFi.  

Some devices can be connected directly to Ethernet, and then can be configured on a Navigator. 
See your device's installation instructions for details about how to configure wireless on a 
Navigator page (More > Settings > Network). 

Prerequisites 

To establish a WiFi network connection to a Home Controller HC-300 or other wireless device in 
the Control4 system, first establish an Ethernet connection, and then configure a USB WiFi 
Adapter for Home Controllers (sold separately). 

To connect to WiFi, complete the following steps: 
1 Establish an initial temporary Ethernet connection from the device to the Ethernet network 

using a Category 5 (CAT5) cable. 
2 Plug the USB WiFi Adapter into the USB port on the controller (if configuring WiFi on a 

controller). 
3 Start Composer Pro and connect to a Local Director. 
4 From the Tools menu, select System Manager. 
5 From the Devices pane, select the network address for the device you want to set up, and 

click Connect. 
• If the device’s network address is not on this list, click Refresh. 
• If it still does not appear, click Add to enter it manually. 
• If you do not know the network address, you can find it at the Connections > Network 

tab. 
6 Click the Network tab, and then click Configure. 

http://dealer.control4.com/dealer/support/documentation
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7 Click Next when the Network Configuration Wizard dialog appears. Continue through the 
wizard screens and provide the following information appropriate for your system. Much of 
this information has to match that of your Wireless Access Point (WAP). 

8 Enter the new device name. Do not include spaces in the new name. 
9 Indicate the network type: Wireless (WiFi) network. 
10 Indicate the method for obtaining DNS server address: DHCP or Static IP. Control4 

recommends DHCP (automatically selected). 
11 Enter the SSID number. 
12 Enter the WEP key (if any). 
13 Enter the encryption type (64 or 128). 
14 Click on a key type (hex or ascii). 
15 Click Finish to complete the wizard; reboot the adapter to apply the network configuration 

changes. 
16 Disconnect the Ethernet cable from the controller. 

Verifying the network connections 
Use the Composer Pro Network tab or Network Tools to verify the Control4 system network 
connections. 

Prerequisites 

Ensure that the devices to be connected have been added to the project. 

Network Tab 

To ensure that all network connections are identified on the Network tab: 
1 Click Connections > Network tab > IP Network. 
2 In the Address column, check whether there is an address for every line item. 

Network Tools Option 

To ensure that all Network connections are connected and active at the Network Tools: 
1 From the Tools menu, select Network Tools. 
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2 Check both the IP Network and Zigbee Network tabs for Green, Yellow, and Red connection 
icons. 

The colors indicate the following: 

• Green—An address is identified and the device is online. For example, the dimmer is 
identified and communicating to the system. 

• Yellow—An address is identified and the device is offline. For example, if the System 
Remote Control goes to sleep, the status turns yellow. This indicates that the System 
Remote Control has been identified, but is offline. Make this device active so it can 
communicate to the system. 

• Red—A device is not identified. Go to the Connections view > Network tab and 
identify the device to the system. 

Tip: Be patient. In cases where the ZigBee mesh is moved, it can take up to five minutes 
for all connections to get re-established. 

3 If you find yellow or red icons, do the following: 
• Yellow icons—Go to the device and activate it according to its documentation. 
• Red icons—Go to the Connections view > Network tab and identify the device to the 

system. 
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Example: At this point in your project, the System Remote Control should be yellow (or the 
only device not green). The System Remote Control turns green as soon as you wake it. To 
wake the System Remote Control press the red Control4 4 button. 

 

Tip: You can also review a device’s ZigBee signal strength by checking the strength meter 
icons in the Signal column. The strength meters show the strength of the signal as detected 
by the next nearest ZigBee device. 

Connecting and managing control and AV devices 
Control/AV connections are visible when you select the Control/AV tab in the Control4 Composer 
Pro Connections view. The Control/AV tab lets you define the physical connections between the 
controller or other devices, including AV signals, IRs, relays, contacts, and/or serial connections. 

 

Tip: If connections do not appear as needed, edit the driver to create the needed connections as 
described in “Editing a Driver Using the Driver Wizard.” 
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Verifying control and AV connections 
Use the Control4 Composer Pro Control & Audio Video Connections pane to verify connections, 
and use the System Design view to verify room connections. 

To verify all Control and AV connections by checking the connection list: 
1 Click Connections, and select the project from the project tree. The Control & Audio Video 

Connections pane displays. 
2 Carefully go through all your Control and AV connections by verifying each connection in the 

pane. 

To verify all Control and AV connections by checking room properties: 
1 Start Composer Pro and connect to a Director. 
2 Click System Design. 
3 Select a room in the project tree. 
4 Click the List View tab. On the List View tab check whether your AV devices are accessible 

in the room. If an AV device is in a room and in your project; but if it is not in the view, see 
“Connecting and Verifying Devices.” 

Disconnecting or removing control/AV connections 
Use the Control4 system Composer Pro Connections view to remove and disconnect a 
connection. 

To disconnect or remove a Control/AV connection: 
1 Start Composer Pro and connect to a Director. 
2 Click Connections. 
3 Click the Control/AV tab. 
4 In the Control/AV project tree, select a device for the device’s control and AV connections to 

appear. 
5 In the Control and AV Connections pane, right-click an input (or output) connection and 

select Disconnect. 
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Reassigning control/AV connections 
Use the Control4 Composer Pro Connections view to reassign connections. 

To re-assign Control/AV connections: 
1 Start Composer Pro and connect to a Director. 
2 Click Connections > Control/AV tab. 
3 In the project tree, select a device. The device’s control and AV connections appear. 
4 In the Control and AV Connections pane, drag an input from the top pane to a different 

output on the bottom pane. The connection is moved to the specified output.  

 

Updating connections when a location changes 
If you use the same project but you change locations, update all of the Control4 system 
connection information in Composer Pro. 

To update the connection information in an existing project: 
1 Start Composer Pro and connect to a Director. 
2 Click Connections. 
3 Click the Control/AV tab, and review your connections to ensure they are updated in the 

current control and AV topology. 
4 Click the Network tab. Disconnect all connections by right-clicking and selecting 

Disconnect. 
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5 Re-assign each connection.  

 

Testing device connections 
Use the Control4 Composer Pro Connections view to test that connected devices work.  

After you've added and identified the device, in Connections check the Network tab to see if an 
IP address appears in the IP Network Connections pane. If it doesn't, the device has not been 
connected properly. Try to connect the device again.  

Testing device controls 
After you add an item to the Control4 Composer Pro project tree and the device is physically 
connected, test that you can control the device. 

To ensure the devices are controllable: 
1 Click System Design. 
2 In the project tree, double-click the icon of each device for its Device Control window to 

appear.  

Example: Television  
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3 Click the available controls in the graphical representation to:  
• Ensure that the commands work 
• Set the parameters temporarily (for example, configuring the LED lights on dimmers)  

Notes: 

• If you double-click a device and a Device Control window does not appear, it indicates that 
one is not available for that device or item. 

• These user interfaces are not specific for each device and model. Understand the 
capabilities of a device before testing it. 

Discrete power control 
Example: The Samsung TX-P1430 Television does not have discrete power control. 

Discrete Power Control means that a device can turn on with the On button and turn off with the 
Off button. Some devices, like the Samsung television, only offer Toggle Power Control which 
means you can toggle between On and Off using one button. The control system has to assume 
that toggle devices are always On, because with a power toggle, the power state cannot be 
determined with these models. For the Samsung model, the Television Device Control shows 
discrete power buttons. These buttons do not apply to devices that do not have discrete power. 

Device Control Examples 

Note: The Device Control windows in Composer Pro are provided for testing purposes only. 
When you make changes on the Device Control windows for each device, it only changes the 
device settings temporarily. Use the Properties pane or programming to change the device 
settings permanently. 

The following examples show Device Control windows for various devices: 

3 Button Keypad 

 

6 Button Keypad 
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Controller 

 

Dimmer 

 

DVD Player 
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Electronic Gate 

 

Gas Fireplace 

 

Motorized Screen 

 

Receiver 
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Sprinkler System 

 

System Remote Control, SR-250 

 

Television 
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Wireless Thermostat 

 

Wireless Outlet Switch  

 

7" Portable Touch Screen 
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Examples 
Use this chapter to see examples of how to: 

• Set up a project using the interviewer method 
• Set up a project using the Composer Views method 
• Set up an Intercom agent 
• Manage apps with the 4Store agent 
• Use the Access agent 
• Use the Advanced Lighting agent  
• Use the Rhapsody agent 
• Use the SNMP Configuration agent 

Example home project: 
Interviewer method 

The following sample project sections step you through the creation of a Control4® project using 
Interviewer wizard in Composer Pro. Alternatively, you can create a new project using the 
Composer Pro views in Composer Pro. See Composer Pro Getting Started for details. 

To use the Interviewer wizard: 
1 Start Composer and connect to a Director. 
2 Click System Design. 
3 From the File menu, select Run Interview. 

Example: System specifications 
Use either the Control4 Composer Pro views or the Interviewer wizard to create a project.  

First start by reviewing these system specifications to understand what is in three (3) rooms of 
the home and which Control4 devices are used in each room. The example scenario sets up 
home control for a Theater, a Bedroom, and the Front of the home. Follow the sections in order. 

http://dealer.control4.com/dealer/support/documentation


Composer Pro 2.5 User Guide   Example home project: Interviewer method 

136 

Devices by room 

 

This project includes the following rooms and Control4 devices in those rooms: 

• Theater 
• Controller  
• Theater dimmer 
• Theater light switch  
• Wireless outlet switch 
• System remote control 
• 6-Button Keypad 
• Receiver 
• Television 
• DVD player or Sony CX 777ES disc changer 
• Motorized Screen 
• Door contact sensor 

• Bedroom 
• Touch screen  
• Bedroom dimmer 
• Gas fireplace 
• Gas fireplace relay 

• Front 
• 3-Button Keypad or 6-Button Keypad 
• Thermostat 
• Electronic gate 
• Sprinklers, doorbell 
• Motion sensor 
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Hardware connections 
The following tables detail the connections that need to be made for the devices to be 
automated. Refer to these tables as you move through the project creation process. 

Table 1. Output to Input 

Connect From Output Device: Connect To Input Device: 

Controller 

Video Out 1 (Video—COMPOSITE) Receiver (INPUT VIDEO 1—Theater) 

Stereo 1(Audio—STEREO) Receiver (INPUT VIDEO 1—Theater) 

Contact Sensor 1 (Control—CONTACT_SENSOR) Motion Sensor (Contact Sensor—Front) 

Contact Sensor 2 (Control—CONTACT_SENSOR) Doorbell (Contact Sensor—Front) 

Contact Sensor 3 (Control—CONTACT_SENSOR) Door Contact Sensor (Contact Sensor—Theater) 

IR Output 1 (Control—IR_OUT) Television (IR Sensor—Theater) 

IR Output 2 (Control—IR_OUT) Receiver (IR Sensor—Theater) 

IR Output 3 (Control—IR_OUT) DVD (IR Sensor—Theater) 

Relay Port 1 (Control—RELAY) Gas Fireplace (Relay—Bedroom) 

Relay Port 2 (Control—RELAY) Sprinklers (Relay—Front) 

Relay Port 3 (Control—RELAY) Motorized Screen (Relay—Theater) 

Relay Port 4 (Control—RELAY) Electronic Gate (Relay—Front) 

Receiver - Tuner — Harman Kardon AVR 230 

Output (Video—COMPOSITE) Television (AV In — Theater) 

Output (Audio—STEREO) Television (AV in —Theater) 

DVD Player — Samsung HD841 

Video Out (Video—COMPOSITE) Receiver (INPUT DVD—Theater) 

Mixed Audio Out (Audio—STEREO) Receiver (INPUT DVD—Theater) 

Table 2. Input to Output 

Connect from Input Device: Connect to Output Device: 

Receiver — Harman Kardon AVR 230 

INPUT VIDEO 1(Video—COMPOSITE) Controller (Video Out 1— Theater) 

INPUT DVD (Video—COMPOSITE) DVD (Output—Theater) 

INPUT VIDEO 1(Audio—STEREO) Controller (Stereo 1—Theater) 

INPUT DVD (Audio—STEREO) DVD (Output—Theater) 

IR Sensor (Control—IR_OUT) Controller (IR Output 2—Theater) 

Television — Samsung TX-P1430 

Input Side (Video—COMPOSITE) Receiver (Output—Theater) 

Input Side (Audio—STEREO) Receiver (Output—Theater) 

IR Sensor (Control—IR_OUT) Controller (IR Output 1—Theater) 

Contact Sensor (Control—Contact_Sensor) Television 
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DVD Player — Samsung HD841 

IR Sensor (Control—IR_OUT) Controller (IR Output 3—Theater) 

Motorized Screen 

Relay (Control—RELAY) Controller (Relay Port 3—Theater) 

Door Contact Sensor 

Contact Sensor (Control—CONTACT_SENSOR) Controller (Contact Sensor 3—Theater) 

Gas Fireplace 

Relay (Control—RELAY) Controller (Relay Port 1—Theater) 

Electronic Gate 

Relay (Control—RELAY) Controller (Relay Port 4—Theater) 

Sprinklers 

Relay (Control—RELAY) Controller (Relay Port 2—Theater) 

Doorbell 

Contact Sensor (Control—CONTACT_SENSOR) Controller (Contact Sensor 2—Theater) 

Motion Sensor 

Contact Sensor (Control—CONTACT_SENSOR) Controller (Contact Sensor 1—Theater) 

Refer to “Example: Design and create the project” to go to the next example steps. 

Example: Define devices in each room 
This section discusses using Control4 Interviewer wizard in Composer Pro to define devices in 
each room.  

Note: This procedure follows “Example: Design and create the project.” If you have not read that 
section, go there first before you review this section.  

You are now in the Rooms section of Interviewer. In this section, Interviewer asks you a series of 
questions about each room to find out what devices you want to control there, and it asks 
questions about the selected room before moving to the next room. 

To define devices in the Theater: 
1 Check the boxes to indicate the types of devices in this room.  

Example: For the Theater room: De-select Multi-Room Audio. Check Controllers, User 
Interface, AV Components, Lighting, Motorization, and Sensors.  
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2 Click next. 

 

3 Add the controllers that reside in the room.  

The Digital Audio and Controller objects appear in the 'Devices in the Room' pane. The 
Digital Audio object represents the audio that exists on the Control4 controller. Only one (1) 
Digital object added per project, so if you tried to add another controller, a second Digital 
Audio object would not be added to the project tree.  

Note: When you click next and return to this screen, the object no longer appears on the 
screen. However, if you look in Composer Pro project tree, it still appears.  

Example: Add the Controller to the Theater. The Digital Audio and Controller objects 
appear.  

4 Click next. 
5 Add the objects for the devices to this room. Double-click a device (or select it and click 

Add) to move the devices from the 'Available Devices' list to the 'Devices in Room' list.  

Example: Double-click 6-Button Keypad and system remote control to add them to the 
Theater room (If you do not have a 6-Button Keypad, add a 3-Button Keypad).  

Note: If you have access to a Wireless Touch Screen, add it to your project now.  

6 Click next. 
7 Add all AV component devices in this room. For example, if a DVD player, a receiver, and a 

television are in this room, add them as described in the following sub-steps.  

Tip: To add AV components, double-click the device; from the dialog that appears, select a 
manufacturer (from the drop-down list), and double-click the model.  

a Add DVD to the 'Devices in Room' list from the online database.  

Example: Add the DVD Player, select Online Database, select the manufacturer 
Samsung, and then double-click the model DVD-HD841 [IR] model from the Online 
Database. If you can access the Sony CX 777ES Disc Changer, add this instead. 
Instructions about how to scan this bi-directional Disc Changer is described later in this 
section.   
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Double-click to add a DVD to the project. On the dialog that appears, click the Online 
Database radio button, then use the scroll-down menu in Manufacturer to select 
Samsung.  

Double-click to add the model to the Devices in the Room list. 

 

b Add the Receiver to the Devices in Room list using the Online Database.  

Example: Add the Receiver, select the Online Database, select the manufacturer 
Harmon Kardon, and then double-click the model AVR 230[IR] from the list.  

c Add the Television to the 'Devices in Room' list using the online database.  

Example: Double-click Television, select Online Database, select the manufacturer 
Samsung, and then double-click the model TX-P1430. This adds the device driver for 
cable TV and UHF/VHF.  

d Click next.  
8 Add the Dimmers, Switches, and Outlet Switches to the Devices in Room list, and give 

each a descriptive name (edit immediately after adding while still in edit mode, or right-click 
later).  

Example: Use the previous examples to  

a Add a Wireless Dimmer, and rename it Dimmer. 
b Add a Wireless Switch, and rename it Light Switch. 
c Add a Wireless Outlet Switch, and rename it Television Outlet Switch.  

9 Click next. 
10 Add the Sensors and Contacts to the Devices in Room list, and give each a descriptive 

name.  

Example: Add a Door Contact Sensor for the door to the Theater.  

11 Click next. 
12 Add the Motorized Devices to the Devices in Room list.  

Example: Add a Motorized Screen to the Theater.  

13 You have just completed the setup for the Theater. Click next to move to the Bedroom. 

To define devices in the Bedroom: 
1 Notice that the selected room on the left is now Bedroom. For the selected room, check the 

appropriate boxes to indicate the devices used in this room. 

Example: For the Bedroom: De-select AV Components and Sensors. Check User Interface, 
Multi-Room Audio, Lighting, and Motorization.  
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2 Click next. 
3 Add the devices to this room. Double-click a device to move the devices from the Available 

Devices list to the Devices in Room list.  

Example: Add a Touch Screen to the Bedroom.  

4 Click next. 
5 Select how the digital audio is received in this room.  

Example: Audio is sent digitally to the touch screen. Select Through a Touch Screen.  

6 Click next. 
7 Add the Dimmers, Switches, and Outlet Switches to the Devices in Room list, and give 

each a descriptive name (edit immediately after adding while still in edit mode, or right-click 
later).  

Example: Add a Wireless Dimmer and rename it “Dimmer.”  

8 Click next. 
9 Add the Motorized Devices to the Devices in the Room list.  

Example: Add the Gas Fireplace to the Bedroom.  

10 You have just completed the setup for the Bedroom. Click next to move on to the Front of 
the house. 

To define devices in the Front Room: 
1 Notice that the selected room on the left is now Front Room. For the selected room (Front 

Room), check to identify the types of devices you have in that room, and then click next.  

Example: De-select AV Components, Multi-Room Audio, and Lighting. Check User 
Interface, Motorization, and Sensors.  

2 Click next.  

  

3 Identify which Navigators are included in each room by selecting the Navigator, and then 
clicking the double-arrow button.  

Example: Add a 3-Button Keypad for the Navigator in the Front Room.  
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4 Click next. 
5 Add the Sensors to the Devices in the Room list.  

Example: Add the Doorbell and Motion Sensor to the Front Room.  

6 Click next. 
7 Add the Motorized devices to the Devices in the Room list.  

Example: Add Electronic Gate and Sprinklers.  

8 If you have a thermostat, add it in Composer Pro after you exit Interviewer. See “Configuring 
HVAC systems.”  

9 Click next to continue to the next section to identify the network connections. 

Example: Identify the devices on the network 
This section discusses using Control4 Interviewer wizard in Composer Pro to identify the devices 
you've added in the project to the network.  

Note: This process follows “Example: Define Devices in Each Room.”  

You are now ready to set up the network connections in the Network section of Interviewer. In 
this section, you identify the physical device to its network address so the devices can 
communicate with the controller.  

Follow the on-screen instructions specific to the selected device to identify it on the network. The 
first item is selected by default automatically. When selected, the device is placed in 'Identify' 
mode. Devices that use network connections and associated instructions are found in “Example: 
Make and Verify the Connections.”  

Note: To program lighting and keypad buttons, see “Programming the System.” To set up 
Lighting Scenes, see “Program with the Lighting Scenes Agent.” 
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To identify devices on the network, go to the physical device and follow these 
instructions.  

The diagram for the device indicates which button to press. 

1 Go to the controller hardware, and press the Select dial to identify the device. When the 
address appears, click next. 

  

2 Pick up the system remote control, and press the 4 button to identify the device. You may 
need to press it repeatedly until the address appears. When the address appears, click 
next. 

3 Go to the 6-Button Keypad, and press the top left button four (4) times in rapid succession 
to identify the device. When the address appears, click next. 

4 Go to the Theater Dimmer, and press the top button four (4) times to identify the device. 
When the address appears, click next. 

5 Go to the Theater Light Switch, and press the top button four (4) times to identify the 
device. When the address appears, click next. 

6 Go to the Theater Outlet Switch, and press the button four (4) times to identify the device. 
When the address appears, click next. 

7 Go to the Touch Screen, and identify the device. When the address appears, click next. 
8 Go to the Bedroom Dimmer, and press the top button four (4) times to identify the device. 

When the address appears, click next. 
9 Go to the 3-Button Keypad, and press the top button four (4) times in rapid succession to 

identify the device. When the address appears, click next. 
10 Click next to continue to the next section to define Audio/Video connections. 



Composer Pro 2.5 User Guide   Example home project: Interviewer method 

144 

Example: Define the audio/video connections 
This section discusses using Control4 Interviewer wizard in Composer Pro to define the audio 
and video connections. You set up the software for audio and video connections that directly 
correspond to your hardware connections between your devices.  

Note: This process follows “Example: Identify the devices on the network.”  

You are now in the Audio/Video section of Interviewer. In this section you identify any devices 
and their connections that carry audio and/or video signals. Using the Smith Home example 
project (a controller project), complete the following steps. 

To define audio/video connections: 
1 Select the device(s) to which the specified controller sends audio and video signals.  

Example: The controller in the Theater Room sends audio and video to the Receiver. Add 
Theater > Receiver to the Connected Devices list.  

2 Click next. 

 

The Receiver is the only device connected to the Television. Both the DVD player and the 
Controller route their audio and video signals through the Receiver to get to the 
Television.  
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3 Select how the controller stereo outputs connect to the receiver.  
a Select how the controller Stereo 1 Output connects to the Receiver.  

Example: In Audio Connections, check INPUT VIDEO 1 and check STEREO.  

b Click next. 
c Select how the controller stereo 2 output connects to the receiver.  

Example: Ensure that none is checked (controller stereo 2 does not connect to the 
receiver).  

d Click next. 
e Select how the Controller Stereo 3 Output connects to the receiver. 

Example: Ensure that none is checked (controller Stereo 3 does not connect to the 
Receiver).  

f Click next. 
4 Select how the Controller Video Out Outputs connect to the receiver  

a Select how the controller Video Out 1 Output connects to the receiver.  

Example: In Video Connections, check INPUT VIDEO 1, and then check 
COMPOSITE.  

b Click next. 

 

5 Select the device(s) to which the DVD sends audio and video signals.  

Example: In the Audio/Video list on the left, check DVD, and then double-click Theater > 
Receiver to add it to the Connected Devices list.  

a Click next. 
b Select how the Theater DVD Output connects to the Receiver.  

Example: In Audio Connections, check INPUT DVD, and then check STEREO. In 
Video Connections, check INPUT DVD, and then check COMPOSITE.  
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c Click next.  

 

6 Select the device to which the Theater Receiver sends audio and/or video.  

Example: Double-click Theater > Television to add it to the 'Connected Devices' list.  

a Click next. 
b Select how the Theater Receiver Output connects to the Television, and then click 

next.  

Example: In Audio Connections, check INPUT AV1, and then check STEREO. In Video 
Connections, check INPUT AV1, and then check COMPOSITE.  

c Click next. 
d If applicable, select the device(s) to which the Theater Tuner sends audio and/or video 

signals. Make connections only to stand-alone tuners. A tuner that is a built-in 
component to another AV device, such as Receiver, uses the host’s connections.  

Example: The tuner in this project is a built-in tuner to the receiver, and therefore, uses 
the same AV connections set up previously for the receiver.  

e Click next.  
7 Select how the Bedroom Touch Screen sends audio and/or video signals.  

Example: The touch screen does not send audio to any of these devices. It only sends 
audio to the powered speakers, which are not shown in Composer Pro projects. Ensure that 
nothing is selected.  

8 You have just completed defining audio/video connections. Click next to continue to the next 
section to define Control connections. 
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Example: Define the control connections 
This section discusses using Control4 Interviewer wizard in Composer Pro to define the Control 
connections.  

Note: This process follows “Example: Define the audio/video connections.”  

You are now in the Control section of Interviewer. In this section, you identify all Control 
connections in the system. 

Tip: To complete this section, refer to the control connection tables shown in the "Hardware 
Connections" section "From Output to Input" in “Example: System Specifications.”  

Using the Smith Home example project (a controller project), complete the following steps. 

To define Control connections: 
1 Define the IR OUT port connections on the Controller. 

a Select IR OUT 1 to Television IR Sensor, and then click next. 

 

b Select IR OUT 2 for the Receiver IR Sensor, and then click next. 
c Select IR OUT 3 for the DVD IR Sensor, and then click next. 

Tip: If you prefer to set up a video or contact sense loop instead of using a macro, see 
“Changing Power Management Options.” After you add a video sense loop connection to the 
DVD player driver, add a control connection between the controller and DVD player.  

2 Define the Contact and Relay connections on the controller. 
a Select Contact 3 for the Theater Door Contact Sensor, and then click next. 
b Select Relay 3 for the Theater Motorized Screen, and then click next. 
c Select Relay 1 for Bedroom Gas Fireplace, and then click next. 
d Select Contact 2 for the Motion Sensor, and then click next. 
e Select Contact 1 for the Motion Sensor, and then click next. 
f Select Relay 4 for the Electronic Gate, and then click next. 
g Select Relay 2 for the Sprinkler, and then click next. 

3 You have completed the setup of the system. Click next to exit the system. 
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After you have completed setting up the system using Interviewer, you may want to do one of the 
following: 

• If you followed the “Example” instructions exactly and have completed all the Interviewer 
screens, you are ready to verify your connections and test the device control on the system. 
For instructions about how to do this, see “Connecting Devices.” 

• If you want to learn how to set up the same example project using the Composer Pro 
screens rather than Interviewer, you can clear your sample project, and go to “Example 
Smith home: Composer Views method.” 

• If you understand what occurred in the previous procedure and you are ready to create your 
own project, go the Composer Pro Getting Started for planning and design steps. 

Example home project: Composer 
views method 

The following sample project sections step you through the creation of a Control4 project using 
the Composer Pro views. Alternatively, you can create a new project using the Interviewer wizard 
in Composer Pro. 

To use Composer Pro views: 
1 Start Composer and connect to a Director. 
2 Click System Design.  

Example: Design and create the project 
There are two ways you can design and create a project. Use the Control4 Composer Pro views 
or Interviewer wizard in Composer Pro to design and create a project. 

Interviewer Wizard 
You begin the Interview with the System section. In this section, Interviewer asks you questions 
regarding the entire system, including types of devices and the rooms that contain devices. 

To define system information: 
1 Start Interviewer. 
2 Type the Project Name: Franklin Smith Home. 
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3 Type a valid Zip Code to automatically populate the appropriate latitude and longitude 
coordinates, and then click next. These coordinates are editable if necessary. The Control4 
system uses these coordinates to identify the local sunrise and sunset times (to be used in 
future programming calculations). 

Example: Enter Zip Code: 84003 

 

4 Check the boxes to indicate which types of devices you are adding to the system.  

Example: Check AV Components, Multi-Room Audio, Lighting, Motorization, Temperature 
Control, and Sensors.  

5 Click next.  
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Tip: Temperature control is not fully implemented in Interviewer. If you have a thermostat, 
you need to add it and identify it to the system outside of Interviewer. For instructions on 
how to do this, see “Configuring HVAC Systems” for more information. 

6 Add rooms by double-clicking a room or selecting a room, and clicking the double-arrow 
button.  

Example: Add Theater, Bedroom, and Front.  

7 When you’ve added the rooms, click next. 

 

8 Select the method that distributes multi-room audio. Multi-room audio choices include: 
• Digitally—Set up a multi-room audio system utilizing the network as an audio 

distribution system with digital-end points. 
• Audio Switch —Install and set up a multi-room audio system, utilizing a traditional 

analog audio switch and amplifiers. 
• Receivers—Install and set up a multi-room audio system, utilizing a receiver in each 

room to distribute audio.  

Example: Audio is streamed (through Ethernet) to the touch screen to the Bedroom, so you 
would select Digitally.  

9 You have just completed your system setup. Click next to continue to the next section to 
complete Rooms setup. 

Composer views 
In this view, you create the foundation of the Control4 system by building the project tree. 

To design the Smith Home project: 
1 Start Composer and connect to a Director on a local network. 
2 Enter the Project Properties for the Smith home. 

• Name—Franklin Smith Home. 
• Zip Code—84003 or enter a latitude and longitude manually. 
• Date & Time—Use the drop-down menu to change these as desired. 
• Time Zone—Use the drop-down menu to select the appropriate zone. 
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3 Add rooms to the project tree. 
a In the Locations tab, double-click on a room to add it to the project tree. 
b Continue to add rooms until you have included all rooms you want in the house (rooms 

that will have automated devices). You can also drag these items to an object in the 
project tree.  

Example: Add three (3) rooms.  

• Theater 
• Bedroom 
• Front  

Tips: To build the system design, define the project configuration in the project tree. You do 
not have to add all the items in the project tree manually, such as Site > Building > Floor > 
Room because Composer Pro automatically adds the required infrastructure.   

Also, you can rename the objects as desired; for example, Franklin Smith Home > Home > 
House > Main >Theater. For more information, see Composer Pro Getting Started. 

 

To add the devices: 
1 Add the controller to a room in the project tree. 

a When setting up a system, first add the controller driver to the list. In the project tree, 
select the room where you want the controller to reside. In the Items pane > My 
Drivers tab, double-click a controller to move it to the room. See the example below.  

Note: If you installed this version of Composer Pro on a computer with an older version 
of Composer Pro, right-click in the My Driver tab, and select Restore Default List. This 
will update the My Driver list.  

Example: Add a controller to the Theater Room:  
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b From the project tree, select Theater. In the Items pane > My Drivers tab under 
Controllers, double-click Controller or drag it to the room where it resides—in this case, 
Theater. The controller and Digital Audio appear in the project tree. The Digital Audio 
object resides on the controller, but shows up as a separate object in the project tree. 
The Digital Audio provides the functionality to play media. 

 

2 Add the Lighting and Navigators to the applicable rooms. The example below shows 
some devices you can add.  

Example: Select Theater in the project tree. In the My Drivers tab, do the following:  

a In Lighting > Light, double-click Wireless Dimmer, and then rename to Dimmer. 
b In Lighting > Light, double-click Wireless Switch, and then rename to Light Switch. 
c In Lighting > Light, double-click Wireless Outlet Switch, and then rename to 

Television Outlet Switch. 
d In User Interface, double-click System Remote Control. 
e In User Interface, double-click 6-Button Keypad.  

Tip: Use a descriptive name. When adding devices to the home, right-click and select 
Rename to rename them with a descriptive name. For example, if you have two (1) dimmers 
in a room, give them a descriptive name such as “Wall Dimmer” or “East Dimmer.” This 
helps you identify the specific dimmer later when identifying connections. If there's only one 
dimmer or switch in a room, however, you can keep the generic title "Dimmer" or "Switch."  

3 Add a Receiver to the applicable room.  

Example: Add a Receiver to the Theater. To add, select Theater in the project tree. From 
the My Drivers tab, do the following:  

a In Audio/Video, double-click Receiver. 
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b In the dialog box that appears, select Online Database, select the manufacturer 
Harmon Kardon, and then double-click AVR146[IR] to add the receiver to the project 
tree. 

 

4 Add a Television to the applicable room. This will probably be the same room where the 
controller is.  

Example: Add the television to the Theater. To add, select Theater in the project tree. From 
the My Drivers tab, do the following:  

a In Audio/Video, double-click Television. 
b In the dialog box that appears, select Online Database, select the manufacturer 

Samsung, and then double-click HC-J655W[IR].  

The UHF/VHF object may be added to enable you to scan for UHF/VHF broadcast 
channels. 

 

5 Add additional Audio/Video devices to the room.  

Example: Add the DVD player to the Theater. To add, select Theater in the project tree. 
From the My Drivers tab, do the following:  

a In Audio/Video, double-click DVD. 
b In the dialog box that appears, select Online Database, select the manufacturer 

Samsung, and then double-click DVD HD841[IR]. 
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Note: If you can access a wireless touch screen, add it now to your project. If you previously 
had a wireless touch screen on your system prior to Release 1.3, follow the special update 
instructions in “Information about older releases.” 

6 Add a motorized device or sensor to the applicable room. 

Example: From the My Drivers tab, add a motorized screen and a door contact sensor to 
the Theater room from the online database. To add, select Theater in the project tree. In the 
My Drivers tab, do the following: 

a In Motorization, double-click Motorized Screen. 
b In Sensors, double-click Door Contact Sensor. 

7 Repeat Steps 2 through 6 as needed to add more devices to the applicable rooms. 

Example: To finish creating the project tree for the example project, add devices to the 
Bedroom and Front Room as follows. 

Bedroom: 

a Select Bedroom in the project tree. In the My Drivers tab, do the following: 
• In Lighting > Light, double-click Wireless Dimmer, and then rename it to Bedroom 

Dimmer. 
• In User Interface, double-click Touch Screen. 
• In Motorization, double-click Gas Fireplace. 

Front Room: 

b Select Front Room in the project tree. In the My Drivers tab, do the following:  
• In User Interface, double-click 3-Button Keypad. 
• In Motorization, double-click Electronic Gate. 
• In Motorization, double-click Sprinklers. 
• In Sensors, double-click Doorbell. 
• In Sensors, double-click Motion Sensor. 
• In HVAC, double-click Wireless Thermostat. 

Example: Make and verify the connections 
This section discusses using Control4 Composer Pro views to make and verify the connections. 

Note: This process follows Example: Design and create the project. 

In the Connections view, you can: 

• Identify Control4 devices to establish a network connection  
• Check all network connections 
• Define AV connections 
• Define control connections 

Note: When only one appropriate connection is available in a room for a given connection type, 
Composer Pro assumes the connection (example: if a TV is the only Audio Output device in a 
room, the system assumes that the Audio Output connection is routed to the TV). This feature 
adds value to Composer Pro, but increases the need to verify every connection. 

Note: To remove a connection, right-click on the connection and select Disconnect. 

To make connections: 
1 In Composer Pro, click the Connections view. 
2 Identify the Control4 devices that connect to the controller through the network. Go to each 

physical device and press the button indicated on the Composer Pro screen.  
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a Click the Network tab > IP Network. 

 Notice the devices that do not have an address listed under the Address column. 

 

b Select the controller, and then click Identify. The screen to identify the controller 
appears (in this example, the HC1000).  

c At the physical controller, press the Identification button. This identifies the controller 
with a unique address in the system. When the address appears on the screen, click 
Next. 
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d Select Dimmer, and then click Identify. The screen to identify the dimmer appears. 
Press the top dimmer button four (4) times. This identifies this specific dimmer with a 
distinctive address to the system. When the address appears, click Next. 

 

e When the Light Switch identification screen appears, press the top button four (4) 
times. When the address appears, click Next. 

f When the system remote control identification screen appears, holding the physical 
system remote control press the red 4 button once. When the address appears in the 
box, click Next to continue. 

g If you have a touch screen in your project, press the Enter button on the front of the 
touch screen. When the address appears in the box, click Next to continue. 

h When the Outlet Switch identification screen appears, press the button on the module 
four (4) times. 

i When the 6-Button Keypad identification screen appears, press the top left button four 
(4) times. When the address appears, click Next. 

j When the Dimmer identification screen appears, press the top button four (4) times. 
When the address appears, click Next. 

k When the touch screen identify screen appears, press the indicated button as shown. 
When the address appears, click Next. 

l When the 3-Button Keypad identification screen appears, press the top button four (4) 
times. When the address appears in the box, click Next. 

m When the Control4 Wireless Thermostat identification screen appears, press the 
middle button four (4) times. When the address appears in the box, click Close to exit 
Identify mode. 

n When you finish identifying the devices, notice that the Address column now has an 
address for every network device. 
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3 Define the AV and Control connections. 

Control and AV connections for a device are visible when you click the Connections view > 
Control/AV tab, and then select the device. To make a connection between inputs and 
outputs, from the top pane drag a device’s input (or output) to the output (or input) in the 
bottom pane. 

For each device, define the following when applicable: 

• Video connections (path of video signals) 
• Audio connections (path of audio signals) 
• Control connections (how the controller communicates with the device) 

 

a Define the AV connections for the Receiver. 

Example: In the Connections view under Theater, click Receiver. The right top pane 
displays all the inputs and output on the back of the Receiver. For Receiver, from the 
top pane in Audio Video Inputs, make the following connections: 

• Click INPUT DVD (Video-COMPOSITE), and drag it to DVD (Output-Theater) in the 
bottom pane. 

• Click INPUT VIDEO 1 (Video-COMPOSITE), and drag it to Home Controller HC300 
(Video Out 1- Family) in the bottom pane. This connects the Receiver Video 1 input 
to the Controller Video 1 output. 

• Click INPUT DVD (Audio-STEREO), and drag to DVD (Output-Theater) in the 
bottom pane. 

 

b Define the Control connection for the Receiver to the Controller.  
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Example: In the Connections view under Theater, click Receiver. The right top pane 
displays all the inputs and output on the back of the Receiver.  

For Receiver, from the top pane under Control Inputs, make the following connections: 

• Click IR Sensor (Control-IR_OUT), and drag it to Controller (IR Output 2-Theater) in 
the bottom pane. 

 

c Define AV and Control connections for the Television. 

Example: In the Connections view under Theater, click Television. The right top pane 
displays all the inputs and outputs on the back of the Television. For Television, from 
the top pane do the following: 

In Audio Video Inputs: 

• Click AV (Video-COMPOSITE), and drag it to Receiver (Output-Theater) in the 
bottom pane. 

• Click AV (Audio-STEREO), and drag it to Receiver (Output -Theater) in the bottom 
pane. 

In Control Inputs, click IR Sensor (Control-IR_OUT), and drag it to Controller (IR 
Output 1—Family) in the bottom pane. 

 

d Define the Control connections for the DVD player to the Controller. 

Example: In the Connections view under Theater, click DVD. The right top pane 
displays all the inputs and outputs on the back of the DVD. From the top pane, do the 
following: 
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In Control Inputs, click IR Sensor (Control-IR_OUT) and drag it to Controller (IR 
Output 3-Family) in the bottom pane. 

 

Tip: If you prefer to set up a video sense loop instead of using a macro, see “Changing 
Power Management Options.” After you add a video sense loop connection to the DVD 
player driver, add a control connection between the controller and the DVD player. 

e Define the Control connections for the Motorized Screen to the Controller. 

Example: In the Connections view under Theater, click Motorized Screen. The top 
right pane displays all the inputs and outputs on for the screen. 

In the top pane under Control Inputs, click Relay (Control-RELAY), and drag to 
Controller (Relay Port 3-Family) in the bottom pane. 

 

f Define the Control connections for the Door Contact Sensor to the Controller. 

Example: In the Connections view under Theater, click Door Contact Sensor. The top 
right pane displays all the inputs and outputs for the Door Contact Sensor. 

In the top pane under Control Inputs, click Contact Sensor (Control-
CONTACT_SENSOR), and drag it to Controller (Contact Port 1-Family) in the bottom 
pane. 

g Define the Control connections for the Gas Fireplace to the Controller. 

Example: In the Connections view under Bedroom, click Gas Fireplace. The top right 
pane displays all the inputs and outputs for the Gas Fireplace. 
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In the top pane under Control Inputs, click Relay (Control-RELAY), and drag it to 
Controller (Relay Port 1-Family) in the bottom pane. 

h Define the Control connections for the Electronic Gate to the Controller. 

Example: In the Connections view under Front, click Electronic Gate. The top right 
pane displays all the inputs and outputs for the Electronic Gate. 

In the top pane under Control Inputs, click Relay (Control-RELAY), and drag it to 
Controller (Relay Port 4-Theater) in the bottom pane. 

i Define the Control connections for the Sprinklers to the Controller. 

Example: In the Connections view under Front, click Sprinklers. The top right pane 
displays all the inputs and outputs for the Sprinklers. 

In the top pane under Control Inputs, click Relay (Control-RELAY), and drag it to 
Controller (Relay Port 2-Theater) in the bottom pane. 

j Define the Control connections for the Contact Sensor to the Controller. 

Example: In the Connections view under Front, click Doorbell. The top right pane 
displays all the inputs and outputs for the Doorbell. 

In the top pane under Control Inputs, click Contact Sensor (Control-
CONTACT_SENSOR), and drag it to Controller (Contact Sensor 2-Theater) in the 
bottom pane. 

k Define the Control connections for the Motion Sensor to the Controller. 

Example: In the Connections view under Front, click Motion Sensor. The top right 
pane displays all the inputs and outputs for the Motion Sensor. 

In the top pane under Control Inputs, click Motion Sensor (Control-
CONTACT_SENSOR), and drag it to Controller (Contact Sensor 1-Theater) in the 
bottom pane. 

4 Go to the next section, “Example: Verify the network connections.” 
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Example: Verify the network connections 
This section discusses using Control4 Composer Pro views to verify the network connections. 

Note: This process follows “Example: Make and verify the connections.” 

There are two places to verify network connections: 

• The Network tab (shown below) 
• The Tools menu 

 

Follow the instructions below to check your connections in both locations. 

To check your connections from both locations: 
1 From the Connections view > Network tab, verify that every device that communicates to 

the controller using TCP/IP, WiFi, and/or ZigBee has a network address. If a device doesn’t 
have a network address, the device needs to be identified. 

2 To identify a device from this location, right-click on the device and select Identify (or click 
the Identify button). Follow the on-screen instructions provided for each device, such as 
those listed in the following table. 

After identifying the network connection, the device’s address appears in the list. 

Device Instructions to Identify a Device to the Control4 System  
Controllers Press the Identification button on the controller. 

Lights and keypads 
Press top button 4 times (6-Button Keypad — press top left button). For 
Release 1.8 and later, press any button 4 times. MiniApp mode: press 
bottom left or bottom button 4 times. 

System remote controls Press the red 4 button on the remote control. 

Speaker point Press button 1 time. 

Multi-tuners Press button 1 time. 

16-channel amps Press button 1 time. 

Thermostats Press center button 4 times. 

Wireless outlet switches  Press button 4 times. 

Wireless touch screens Press the Enter button on the front of the touch screen 1 time. 

Black & Decker Kwikset 
locks 

Press the Top Left button on the top of the board (remove the lock's 
cover first) 4 times. To disconnect, press the Top Right button on the top 
circuit board 9 times. 
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Device Instructions to Identify a Device to the Control4 System  
1-button products Release 1.8 and later, press 4 times. 

IO extenders Press the Link button on the back of the IO extender. 

Media players Press the Link LED button on the front of the Media Player. 

Touch screens Press the button indicated on the diagram of the device in Composer Pro. 

Using the Network tab 
To ensure all devices have been identified from the Network tab: 
1 Click Connections > Network tab > IP Network. 
2 In the Address column, make sure there is an address for every line item. 

 

Using Network Tools 
To ensure all network connections exist and are active from Network Tools: 
1 From the Tools menu, select Network Tools. 
2 Check both the IP Network and Zigbee Network tabs for Green, Yellow, and Red 

connection icons. The colors indicate the following: 
• Green—An address is identified, and the device is online (communicating). 

Example: The dimmer is identified and communicating to the system. 

• Yellow—An address is identified, and the device is offline (not communicating). 

Example: If the system remote control goes to sleep, the status turns Yellow. This 
indicates that the system remote control has been identified, but is offline (not 
communicating). Make the device active so it can communicate to the system. 

• Red—A device is not identified. Go to the Connections view > Network tab, and 
identify the device to the system or see “Example: Make and Verify the Connections.” 

3 If you find yellow or red icons, do the following: 
• Yellow Icons—Go to the device, and activate it according to its documentation. 
• Red icons—Go to the Connections view > Network tab, and identify the device to the 

system. 
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Example: At this point in your example project, the system remote control should be 
yellow (or the only device not green). The system remote control turns green as soon as 
you wake up the system remote control. To wake up the system remote control, press 
the red Control4 4 button. 

Example: Define the control and audio/video connections 
This section discusses using Control4 Composer Pro views to define AV connections.  

Note: This process follows “Verifying the network connections.”  

Control/AV connections are visible when you select the Control/AV tab in the Connections view. 
The Control/AV tab lets you define the physical connections between the controller or other 
devices, including AV signals, IRs, relays, contacts, and/or serial connections. 

 

Tip: If connections do not appear as needed, edit the driver to create the needed connections. 
See “Editing a Driver Using the Driver Wizard.” 

The following steps are described in the next sections: 

“Verify that all control and AV connections use room properties” 

“Disconnect/Remove control/AV connections” 

“Re-assign control/AV connections” 

“Update connections in the project if you change locations” 

Verify that all control and AV connections use room properties 
To verify all Control and AV connections by checking room properties: 
1 Click the System Design view. 
2 Select a room. 
3 On the default tab Audio Video Devices, see if your AV devices are accessible in the room. 

If an AV device is not there, see “Make and Verify Connections.” 
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Disconnect/Remove control/AV connections 
To disconnect or remove a control/A/V connection: 
1 Click the Connections view. 
2 Select the Control/AV tab. 
3 In the Control/AV project tree, select a device for the device’s control and AV connections to 

appear. 
4 In the Control and AV Connections pane, right-click an input (or output) connection and 

click Disconnect. 

Re-assign control/AV connections 
To reassign Control/AV connections: 
1 Click the Connections view > Control/AV tab. 
2 In the project tree, select a device for the device’s control and AV connections to appear. 
3 In the Control and AV Connections pane, drag an input from the top pane to a different 

output on the bottom pane. The connection is moved to the specified output. 

Update connections in the project if you change locations 
If you use the same project but you change locations, you have to update all of the connection 
information. 

To update the connection information in an existing project: 
1 Click the Connections view. 
2 Click the Control/AV tab, and review your connections to ensure that they are updated in 

the current control and AV topology. 
3 Click the Network tab and disconnect all connections by right-clicking and selecting 

Disconnect. 

 

Example: Configuring the Intercom agent 
Use the Control4 Composer Pro Agents and Programming views to program this agent. To better 
illustrate the process, this procedure uses an example setup. 

The Intercom agent lets you set up 5" or 7" In-Wall Touch Screens (supports audio intercom 
only) or the 7” Portable Touch Screen with Camera (C4-TSMC7), 7" In-Wall Touch Screen with 
Camera, or Door Station  (supports audio and video intercom) so that the Control4 system 
acknowledges the intercom system on those touch screens.  

Tip: For an example of setting up an Intercom macro, see the Programming chapter. 

Notes: (1) Only the touch screens mentioned above are capable of intercom functionality. (2) 
This agent also lets you configure third-party PBX systems for multi-dwelling units (MDUs) using 
the SIP Proxy tab (for a future release). See “SIP Proxy Tab” below for more information. 

CAUTION! The SIP Proxy tab is for advanced users only; or those who understand how to set 
up and use SIP and a PBX system. See your SIP specialist and PBX administrator for details. 

With the Intercom agent you can send a broadcast, monitor a room, and other controls.  
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Example: If you have an elderly parent living in their own home, you can create a macro and 
assign it to a keypad button. If your family member is in stress, they simply press the keypad 
button to notify you that something is wrong. Another example is a “Good Night” setting where all 
touch screens in the house can be set to “Do Not Disturb” when it’s time to go to sleep. Or you 
can monitor your kids’ room after they’ve gone to bed to ensure that they’re settling down when 
they should. 

Example: This example demonstrates how to send a ‘test’ announcement to a touch screen in 
the Master Bedroom that says “You are being monitored.” The Master Bedroom is then 
monitored. 

Tip: Many of the steps below (creating or removing groups, adjusting settings, etc.) can be 
performed on the supported touch screens. See the Control4 System User Guide for details. 

Notes: (1) Broadcasting does not work in a room that’s being monitored if that room is in Monitor 
Mode. When in Monitor Mode, you will not want the person in that room to be disturbed, for 
example, a sleeping child. (2) Before you use broadcasting, make sure your WiFi router is set to 
allow multicasting. Some routers do not allow multicasting. Check with your dealer or Control4 
Technical Support for details. 

Prerequisites 

The example below uses the following items in the project: 

• Controller  
• 7" In-Wall Touch Screens (two or more) 
• Intercom license 
• Intercom agent (see below) 
• Kitchen 
• Master Bedroom 
• Macro agent 

Note: As of June 1, 2013, the HC-800 (C4-HC800-BL-1) and HC-250 (C4-HC250-BL-1) ship with 
included support for Intercom and MyHome. For controllers shipped before that time, you must 
purchase an Intercom and MyHome license for consumers who want this feature. In either case, 
the license must be assigned and active on the consumer's account for the Intercom or MyHome 
to function. See Managing Dealer Accounts on My.Control4.Com in the Control4 Knowledgebase 
for details. 

To set up an Intercom agent: 
1 Start Composer Pro and connect to a Director. 
2 Click Agents. 
3 (First time only) Click Add to add the Intercom agent to the project. 

http://dealer.control4.com/dealer/support/documentation
http://kb.control4.com/
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4 Select Intercom, and then click OK to add Intercom to the agent types list in the project. 
The next time you want to configure the intercom function, just select the Intercom item in 
the Agents pane. 

 

Add new Intercom group 
An Intercom group is a set of Intercom-supported touch screens that can be identified by a 
specific group name. This saves time when you want to send a broadcast to a group of people. 
Example: You can create a group (John’s Group) and then send a broadcast to that group. 

You can create Intercom groups (groups of touch screens) and send broadcast messages 
them. 
1 Select Intercom in the left pane, and click New. 
2 Name the Intercom group, and click Add. Example: John’s Group. 
3 Add the devices to the new group (see “Intercom Devices Tab” below). 
4 Adjust the settings for each touch screen (see “Intercom Devices Tab” below). 

Intercom Devices tab 
Group properties 

You can add devices to an existing group of 5" or 7" In-Wall Touch Screens, 7” Portable Touch 
Screen with Camera, or 7” In-Wall Touch Screen with Camera. This lets the broadcaster from 
one touch screen send out broadcasts to the group of devices. 

To add or remove devices in a group: 
• Add—Select the device in the Intercom Devices tab, and then click Add. Click OK. 
• Remove—Select the device in the right box of the Intercom Devices tab, click Remove, 

then click OK. 
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Intercom Devices properties 

To add or remove settings for each touch screen: 
1 Use the Intercom Devices tab to change the settings on each supported touch screen. 

IMPORTANT! Make sure you review all of the customer’s intercom settings for the new 
touch screens with and without cameras in OS 2.2 or later before you finish the upgrade. For 
example, if Auto Answer was disabled in Intercom V1, the settings do not transfer when you 
upgrade a system to Intercom V2 in OS 2.2. Auto Answer is ON by default for Intercom V2 
in OS 2.2. If your customer wants Auto Answer disabled, the best method is to disable Auto 
Answer on all touch screens using the Intercom agent under Intercom Device Properties. 
Otherwise, you or the customer will have to go to the settings in each touch screen and 
disable it manually.  

• Manual Answer Popup Timeout (seconds)—Use the up or down arrow keys or type 
how much time is allowed to answer an incoming call. 

You can set the following options for each touch screen in the Intercom Device Properties 
pane: 

• Exclude from Navigator—Select if you do not want these options enabled. This option 
is useful when you want to broadcast messages to the touch screens. 

• Do Not Disturb—Select to enable. When a broadcast or call tries to connect to another 
touch screen (for example, John’s Room), the message or call is blocked, and the 
caller’s touch screen displays a ‘Do Not Disturb’ or ‘Station Busy’ message from the 
‘John’s Room’ touch screen. On the caller’s touch screen, tap Close to close the 
message. 

• Auto Answer—Select to enable. When a call comes in from another touch screen, that 
touch screen rings and the caller's voice is heard (and video if activated). John, for 
example, (or whoever is in John's Room) can then speak to the caller from his or her 
touch screen. 

• Send Video— (not supported on 5” In-Wall Touch Screens or 7” In-Wall Touch Screens 
without a camera). Select to enable. When a call comes in from another touch screen, 
the touch screen rings and the caller's voice and video appear (if activated) on the 
caller's touch screen. John, for example, (or whoever is in John's Room) can speak into 
his or her touch screen and the caller can see them on the screen. See the Control4 
System User Guide for more details and examples. 

• Monitor Mode—Select to enable. This monitors a room through the touch screen in 
that room. This option sends audio and/or video to the touch screen that is monitoring 
another room, for example, John’s Room. See “Monitor a Room” in the Control4 System 
User Guide for more details. 

2 Click Apply Changes when you're finished. 

SIP Proxy tab 
The columns used in this tab are for SIP (session initiation protocol) and an external PBX 
service. To enable SIP for an MDU, see your SIP specialist.  

Configure—The Domain and TSL Port columns use the default. These are populated by 
Director. 

CAUTION! Do not change these values unless under extreme circumstances, and you know 
exactly what you are doing. 

Routes—To add values to the URI, Method, Event, Destination, and Order columns, see a 
SIP specialist. 

http://dealer.control4.com/dealer/support/documentation
http://dealer.control4.com/dealer/support/documentation
http://dealer.control4.com/dealer/support/documentation
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Users—The user@domain, Name, and E-Mail columns are used for troubleshooting 
purposes. See your SIP specialist. These are intercom-supported Control4 devices. 

Registrations—The AOR, Contact, Instance ID, Reg ID, and Expires in (sec) columns are 
used for troubleshooting purposes. See your SIP specialist. These are users who are 
registered via Director. 

Tip: Your PBX administrator may benefit by going to these sites: 

• http://www.reciprocate.org/using repro. Explains how URI works. 
• http://www.regular-expressions.info/tutorial.html. Explains how regular expressions 

work.  

Programming Intercom with a macro 
Example: The steps below use an example where a macro is set up to monitor the Master 
Bedroom from the Kitchen using the intercom on both 7" In-Wall Touch Screens. 

To set up a program that monitors a room using the Intercom agent: 
1 If the Macro agent hasn't been added to the project, add it (Agents view > Add > Macros). 
2 Create a new macro called Monitor Master Bedroom. 
3 In the Programming view, create programming for the "Monitor Master Bedroom" macro 

event (Programming > Macros in the Device Events pane, and then select the macro 
Monitor Master Bedroom). 

4 Add the programming to start monitoring the Master Bedroom (Programming > Actions > 
Intercom in the Device Actions pane). 
a In the Commands tab, select the device that will be doing the monitoring: 7” In-Wall 

Touch Screen in the Kitchen. 
b Select the Session Action: Monitor. 
c Select the Target Intercom Device that will be monitored (Master Bedroom). 
d Drag the green arrow to the Script pane. 

5 Test the Programming by clicking Execute. 

Tip: You can add the macro to a Custom Home page on the Navigator; another option is to 
program this same action against a button press on a keypad.  

Example: Manage apps with the 
4Store agent  

Use the Control4 Composer Agents view to manage 4Store apps and themes. 

Note: Currently, you cannot perform any programming functions with this agent. 

The 4Store agent provides these functions: 

• Centralized logins—Manage 4Store logins from a central location. 
• Update purchased 4Store apps—Allows you to update the list of purchased apps to be from 

Composer Pro. 
• Manage themes—Allows you to update the list of purchased themes from Composer Pro. 
• Manage storage—Purchased apps and themes can be stored on other storage devices.  

http://www.reciprocate.org/using
http://www.regular-expressions.info/tutorial.html
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Note: The Control4 system allows up to 5 MB of files for the 4Store apps and themes. 
Obviously, this is not enough space for very many apps or themes. Options are available in 
this agent to allow additional storage. If you run out of space, an error message appears. 

Prerequisites 

• Ensure that you have a valid 4Store account for the system. You'll have to go to the 4Store 
web site to purchase apps and themes. 

• Ensure that the storage devices you will use (e.g., Network File Storage and controller) have 
been added and identified in the system. 

To use the 4Store agent: 
1 Start Composer Pro and connect to a Director. 
2 Click Agents. 
3 (First time only) Click Add to add the 4Store agent to the project 
4 Enter the 4Store login and password, and then click Save. The login information appears in 

the 4Store Accounts list. Use this list to add, locate and log in to your customer's 4Store 
accounts. After you’ve logged in, you can update their account and keep track of which apps 
and themes they’ve purchased. 

 

5 Select an account in the list to log in to 4Store. The Account Properties pane is populated 
with the information you added when you saved it. Click Activate to log in to that account. 
Note: When you log in to an account from Composer Pro, all of the Navigators are logged 
into 4Store. 
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To select the storage: 
1 Use the File Storage Locations drop-down list and select what to store your apps and 

themes to: Network File Storage or a controller (see next figure). After you select the storage 
device, click Update to transfer the apps or themes to the new location. 

2 Click Set. 

 

To update the apps and themes purchased for an account: 
1 Click Update at the bottom of the page. This not only updates the list, but also all of the 

Navigators attached to this Control4 system. When you update, the list populates with the 
account's apps and themes and their size. 

Example: Use the Access agent  
Use the Control4 Composer Agents view to allow or deny access. The Access agent is ideal for 
commercial applications including hotels, bars, or board rooms where settings need to be locked 
or hidden to restrict their use by unauthorized personnel. By adding this agent to a project, an 
access code is required to gain access to selected functions of the Status Bar or the More and 
Settings modules. When enabled, the Access agent settings apply to all touch screens and on-
screen Navigators in the system.  

Status Bar Buttons 
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The Access agent provides these key features: 

• Access Code—The programmer can establish a four-digit access code to restrict access to 
the Status Bar, More and Settings buttons globally. 

• Status Bar Lock—Lock the Control4 Home, Back, Favorites, Room Selector and Intercom 
buttons available on the Status Bar so that a user must first enter the Access Code to use 
these features. 

• Status Bar Hide—Hide the Favorites and Room Selector functions from users. 
• More and Settings Button Lock—Lock the More button on the Control4 Home Screen and 

Settings button in More. 
• Localization—For English-speaking locales, the Access agent keypad user interface 

includes Latin characters for users that use a mnemonic to remember their Access Code. 
Non-English speaking locales display only the numerals. 

Prerequisites 

• Figure out which Status Bar or More button functionality you want to restrict or hide from 
unauthorized users. For example, do you want to lock the Room Selector? Keep others from 
getting into Settings? Hide the Favorites button? 

• Establish an access code. 

To use the Access agent: 
1 Start Composer Pro and connect to a Director. 
2 Click Agents. 
3 (First time only) Click Add to add the Access agent to the project. 
4 Select Access and click OK. 
5 Enter a four-digit access code on the numeric keypad. 
6 Click Set Access Code. The new access code appears in ‘Current Access Code’ window. 

 

The following settings are available to the programmer as indicated by the names next to the 
drop-down selectors: 

• Access Agent—To enable or disable the Access agent, use the arrow drop-down list, and 
then select Enabled or Disabled. Disabling the Access agent enables the programmer to 
keep all the current Access agent settings, but disable its use while testing Flash Navigator 
functionality. 
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• Hide Digits—To hide or display the access code digits when entered on the Flash 
Navigators, use the arrow drop-down list, and then select Enabled or Disabled. By enabling 
Hide Digits, an asterisk symbol (*) will appear in place of each digit as it is entered. 

• Control4 Home—To lock or unlock the Control4 Home button on the Status Bar, use the 
arrow drop-down list, and then select Unlocked or Locked. If locked, enter the access code 
after pressing this button before returning to the Control4 Home screen. On the on-screen 
Navigator, the Control4 Home button is accessed using the Control4 SR-250 or SR-150 
remote controls. By locking this feature, you must enter the access code after pressing the 
Control4 button on the remote control. 

• Back Button—To lock or unlock the Back button on the Status Bar, use the arrow drop-
down list, and then select Unlocked or Locked. If locked, you must enter the access code 
after pressing this button before returning to the previous screen. 

• Favorites—To lock, unlock or hide the Favorites button on the Status Bar, use the arrow 
drop-down list, and then select Unlocked or Locked or Hide. If locked, you must enter the 
access code after pressing this button before accessing the Favorites functionality. If hidden, 
the Favorites button is not displayed. 

• Room Selector—To lock, unlock or hide the Room Selector functionality on the Status Bar, 
use the arrow drop-down list, and then select Unlocked or Locked or Hide. If locked, you 
must enter the access code after pressing this button before accessing the Room Selector 
functionality. If hidden, the current room is displayed and the user cannot change rooms 
from the Flash Navigators. 

• Intercom—To lock or unlock the Intercom button on the Status Bar, use the arrow drop-
down list, and then select Unlocked or Locked. If locked, you must enter the access code 
after pressing this button before accessing the intercom functionality. 

• Settings—To lock or unlock the Settings button within the More screen, use the arrow drop-
down list, and then select Unlocked or Locked. If locked, you must enter the access code 
after pressing this button before accessing the Settings functionality. 

• More—To lock or unlock the More button on the Home Screen, use the arrow drop-down 
list, and then select Unlocked or Locked. If locked, you must enter the access code after 
pressing this button before accessing the More functionality. 

• Edit Lighting Scenes—To lock, unlock or hide the Edit Lighting Scenes functionality from 
within the Lighting screens (available with OS 2.3.0 or later), use the arrow drop-down list, 
and then select Unlocked or Locked or Hide. If locked, you must enter the access code 
after pressing this button to access the Edit Lighting Scenes functionality. If hidden, the Edit 
Lighting Scenes functionality will not be accessible to users. 

As a reminder, the current implementation of Access agent enables the programmer to globally 
restrict certain features and settings from all users on touch screens and on-screen Navigators. 
Any changes to Access Codes or these settings can only be made using Composer Pro. If the 
Access Code is lost or forgotten, it can be recovered only using Composer Pro. 

Keypad user interface and localization 

When you enable the Access agent, the user will be presented with an Access agent keypad on 
their touch screens and on-screen Navigators based on the settings described above. A picture 
of this new user interface component is shown below. When entering the access code, the user 
can cancel the process or delete an incorrect digit from their current entry. 
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Access agent keypad for English locales 

 

Access agent keypad for all other locales  

Note: Cancel, Delete, and Enter will be translated into locale language where available. 
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Example: Use the Advanced Lighting agent  
Use the Control4 Composer Pro Agents and Programming views to program this agent. (For OS 
2.3.0 or later, this agent supports the Panelized Lighting product line with full functionality. Older 
lighting products are also supported, but with limited functionality.) This agent provides more 
advanced features than the Lighting Scenes agent. See also “Example: Program Using the 
Lighting Scenes Agent” in this document. 

The Advanced Lighting (Scenes) agent provides these features: 

• LED tracking for Lighting Scenes 
• Toggle Lighting Scenes 
• Ramp and fade Lighting Scenes 
• Set delays within Lighting Scenes 
• Scene sequencing 
• Flash lights in Lighting Scenes 

To use the Advanced Lighting agent: 
1 Start Composer Pro and connect to a Director. 
2 Click Agents. 
3 (First time only) Click Add to add the Advanced Lighting agent to the project. Note: You 

must add the Advanced Lighting agent to the project before your customers can edit Lighting 
Scenes on a Navigator. 

4 Select Advanced Lighting, and then click OK. 
5 In the Agents pane, select Advanced Lighting and then click New. 
6 Enter a name on the dialog that appears (for example, Party Lights). 
7 Click Create. Notice that you have more options than if you were using the Lighting Scenes 

agent. Note: You can click the Rename button to rename a scene. 
8 Adjust the scene as desired. 

• Show flash option—Select this option to add a Flash checkmark in the list of lighting 
devices below. When Flash is checked, lights can flash on and off at set intervals. Use 
this option with the Delay option. For example, this option works well in a situation 
where you want to alert someone so you can set a porch light to flash in case of an 
emergency or to get someone’s attention. Note: For older lighting devices (earlier than 
OS 2.3.0), flashing is not supported. 

• Activate Scene—Click this button to activate the scene immediately. Note: The 
Execute On and Execute Off buttons do not appear in the Advanced Lighting agent. 
Use the Activate Scene button. 

• Sync This Scene—Click this button to synchronize this scene with other scenes. This 
option isn’t really needed for Panelized Lighting unless there seems to be a problem. 

• Sync All Scenes—Click this button to synchronize this scene with all scenes created. 
This option isn’t really needed for Panelized Lighting unless there seems to be a 
problem. 

• Colors—This is the keypad color. Click the Active or Inactive colored boxes to select 
another color. 

• Tracking—Click All Loads to track a dimmer or switch by name, tracking status, delay, 
rate, level %; and all loads must match their tracking condition before the scene will be 
considered active. Click Any Load and only a single load needs to match their tracking 
condition before the scene will be considered active. 

• Hold Rates (sec) —Use the up or down arrows to select the Up hold ramp rate or 
Down hold ramp rate. At the keypad, press and hold for a set period of time in seconds. 
This action behaves the same as hold rates for dimmers. 
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• Toggle Scene—This pull-down allows you to select which scene to activate when the 
current scene is prompted to deactivate. This applies to all scenes except for the 
current one selected. Here, you can toggle scenes on or off. 

Example: Create an Advanced Lighting Scene called “Dining.” Notice the number of 
switches and dimmers in the Advanced Lighting pane and their values. 

 

a Create a Dining ‘Toggle’ scene. Notice the difference in switches and dimmers and their 
values from the previous screen. 
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b Now click the Connections view to connect the keypad bindings on a 3-Button Keypad.  

 

When you toggle the 3-Button Keypad in the Dining room, various lights go on or off at 
various levels. For more information about connections, see “Connecting and Verifying 
Devices.” 

Now go back to the Agents view. 

• Toggle Scene/Create Default—Click Create Default to create a toggle scene as a 
copy of the selected scene. From the copied scene, you can rename the new scene 
and adjust the values on some of the dimmers or switches in that scene. 

• Current State—Shows ‘Active’ when the conditions are met to consider the scene 
Active or Inactive if the conditions have not been met.  

• Add/Remove Load—Click to add or remove specific dimmers or switches to the scene. 
Check the lighting loads that you want to add, and then click OK. This can be a single 
light, a single room, all lighting loads in an entire house, or any combination of these 
options. 

9 Assign the settings for each load: 
• Dimmer and Switch Options: 

• Name—The top line is the room, and the bottom line is the name you assigned to 
the dimmer or switch. 

• Tracking—This lets you track the lights in the system. Use the down arrow to 
select one of these options. 
• Don’t Track—Tracking is ignored. 

• Is Off—Track when the dimmer or switch is off. 
• Is On (Any Level)—The text displays only if the light is a dimmer. Switches just 

indicate ‘Is On.’. 
• On At Level (%)—Track when the dimmer is on at a specific level. 
• At Scene Final Level—Track at the final level of the last sequence. For example, if 

someone changes the level on a Navigator, this might be the final level. 
• Delay—Use the up or down arrows or type the delay value in seconds.  

Tip: If you have several dimmers in a long hall, and you want to set up sequencing, you 
can use this option with the green + buttons and increase the delay of each dimmer in a 
row by two (2) seconds. 
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• Rate—Lets you set the ramp rate, which is the speed the load ramps to for the specified 
lighting level. Use the up or down arrows to set the milliseconds (ms), seconds (sec), 
or minutes (min) of the ramp rate. Then set the amount of time the device takes to 
change the level.  

Example: Set the time to 1 second for both the Bedroom Dimmer and the Theater 
Dimmer. 

• Level (%)—Lets you set a target lighting level as appropriate by using the pull-down 
menu, for example, 50 percent for the Bedroom Dimmer and 20 percent for the Theater 
Dimmer. The green + gives you the ability to add ‘paths’ to a scene. Each row in the 
path uses single delay/rate/level settings. Use the green + to add another step, click the 
red x to delete a step, or you don’t need to have any steps. Note: Older lighting devices 
(prior to OS 2.3.0) only allow 0 or 1 steps. 

• Apply To—Click this option to allow other lights to use the same scene. 
• Ignore Scene Ramp/Fade—Check this option to have the light ignore commands to 

ramp or fade a scene. 
• Graph—Shows in graphical form (red lines) the settings for each dimmer or switch. 

Dimmers will show ramp rates, delays, and levels as angled, horizontal, or vertical lines.  
10 Now click Programming. To program a scene, follow the basic steps in “Programming 

Basics for Control4 Systems.”  

Note: In the Programming view, the Advanced Lighting Scene has variables, conditionals, 
and loops that do not exist in the Lighting Scenes agent. This agent also has ‘read-only’ 
variables for the length of each scene.  

Example: Note the screens below. The Events and Actions panes use different options than 
the Lighting Scenes agent (Activate, Deactivate, etc.). 

Event: (Is Invoked, Becomes Active, Becomes Inactive) 

• Is invoked—This event fires when the scene has been explicitly told to activate. If the 
scene is already activated, and it is told to activate again, this event will still fire. 

• Becomes Active—This event fires when the scene transitions from the Inactive state to 
the Active state. 

• Becomes Inactive—This event fires when the scene transitions from the Active state to 
the Inactive state. 
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• Actions— (Activate, Deactivate) 

 

A programming example for use with the Advanced Lighting agent might be where, if the 
front door opens and it’s past 9 PM at night, all the lights turn on in the home at various 
levels. 

Example: Use the Rhapsody agent 
Use the Control4 Composer Pro Agents view to activate or disable a Rhapsody agent. After you 
add this agent, refresh the Navigators for the Rhapsody icon to appear.  

Note: Rhapsody is a subscription-based music service that gives you unlimited access to a 
catalog of millions of full-length, CD-quality tracks. You can listen to whatever you want 
whenever you want, in any room of your house through the Control4 system. 

Prerequisites 

• Ensure that a Rhapsody account has been set up. See "Register Your System" in Composer 
Pro Getting Started. 

• Ensure that the devices you want to use for Rhapsody output are added and identified to the 
system. 

To activate a Rhapsody agent: 
1 Start Composer Pro and connect to a Director. 
2 Click Agents. 
3 (First time only) Click Add to add the Rhapsody agent to the project. 
4 Select Rhapsody, and then click OK. 

http://dealer.control4.com/dealer/support/documentation
http://dealer.control4.com/dealer/support/documentation
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5 With Rhapsody selected in the left pane, click New. The following dialog box appears in the 
right pane. 

 

6 Enter your Rhapsody account name and password.  
7 Click Save. 
8 Click Activate. 

To disable Rhapsody: 
1 Start Composer Pro and connect to a Director. 
2 Click Agents. 
3 Select Rhapsody from the agents list. 
4 Select Disable Rhapsody. 

Example: Use the SNMP 
Configuration agent  

Use the Control4 Composer Pro Agents view to:  

• Add devices using the SNMP Configuration agent 
• Manage an SNMP device 
• Change SNMP system and user variables 

Prerequisites 

To use SNMP in a Control4 system, you need: 

• An NMS console or an installed MIB browser and the three (3) Control4 MIBs (installed by 
default in Composer 2.2 and later): CONTROL4-DIRECTOR-MIB, CONTROL4-GLOBAL-
REG, and CONTROL4-TEST-MIB. These MIBs are located in 
Program>Files>Control4>Composer 2.2>SNMP>MIBs/ on the computer with Composer Pro. 

• SNMP MIBs. Make sure the NMS console you use has the following SNMP MIBs: SNMPV2-
SMI, SNMPV2-TC, SNMPV2-CONF, and INET-ADDRESS-MIB. The Control4 MIBs 
reference these MIBs. 

• SNMP Configuration Agent. To configure SNMP in a Control4 system, you must add the 
SNMP Configuration agent in the Composer Pro Agents view (see below). 

Procedure 

To set up the SNMP Configuration agent: 
1 Start Composer Pro and connect to a Director. 
2 Click Agents. 
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3 (First time only) Click Add to add the SNMP Configuration agent to the project. 
4 Select SNMP Configuration in the Agents pane, and then click OK. 

 

• To add, copy, or delete devices; add trap targets; or configure the SNMP Configuration 
agent see “Configuring the SNMP Agent” in Composer Pro Getting Started or “SNMP 
Configuration agent properties” next. 

• To set up system or user variables, see “SNMP Configuration agent system variables” 
or “SNMP Configuration agent user variables” below. 

• To install the Control4 MIBs, see “Installing the Control4 MIBs” in Composer Pro Getting 
Started. 

SNMP Configuration agent properties 
To configure SNMP settings: 
1 In the SNMP Configuration pane, click Properties. 
2 If they are SNMP-enabled, all of your controllers, IO Extender, and touch screens in the 

project will appear in the Managed SNMP Devices pane. If you've updated the system to OS 
2.2, those devices appear automatically. 

3 Use the Properties pane to disable SNMP from the project, add traps, set community 
strings, and change contact information. 
• SNMP Enabled—By default SNMP is enabled if controllers, IO Extender, and touch 

screens have been updated to OS 2.2. Uncheck to disable a selected device. 
• Trap Targets. Use to add the IP address for the NMS console or MIB browser to send 

SNMP traps to. See "To add trap targets" below. 
• Community Strings—The default is Read: Public, Write: Private. Use the MIB browser 

and this Properties tab to change these settings for Get and Set commands. The strings 
must match in the MIB browser and in this page. Example: Read: Public must be the 
same in the MIB and in the Properties tab. 

http://dealer.control4.com/dealer/support/documentation
http://dealer.control4.com/dealer/support/documentation
http://dealer.control4.com/dealer/support/documentation
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• Contact Information.  
• sysContact. Check Use Project Primary Contact to populate this text box with 

information from the Info tab in the System Design view, or uncheck and type a 
contact name here. 

• sysLocation. Check Use Project System Owner Address to populate this text 
box with information from the Info tab in the System Design view, or uncheck and 
type the owner's address and city here. 

• sysName. Check Use Room to populate this text box with information from the 
room name that the device is in (appears automatically), or uncheck and type 
another value, for example, a hotel room number. 

To add one or more devices:  

Add devices that you want to manage using SNMP. 

1 In the Managed SNMP Devices pane, click Add or right click, and select Add Device to add 
the agent to the project. 

2 In Add Device, select the device to add. To add several devices use CTRL or SHIFT and 
select the devices. 

3 Click OK. The device(s) appear in the Managed SNMP Devices pane. 

 

Note: If you select multiple devices and their properties are different, a red warning 
message appears, and Composer Pro attempts to notify you of the conflict. 

Tip: You can configure one device and then copy it to other devices to save the properties 
you've defined. See the next steps for details. 

To copy a device: 

Copy a device to other devices if you want to use the device's properties. 

Note: You cannot copy a device to another device that's already been identified in 
Composer Pro. 

1 In the Managed SNMP Devices pane, click Copy or right click, and select Copy Device. 
2 In Target Device, select the device to copy. 
3 Click OK. The device appears in the Managed SNMP Devices pane. 
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4 In the Managed SNMP Devices pane, select the devices to copy to. 

 

To delete a device: 

Remove a device from the managed list. 

1 In the Managed SNMP Devices pane, click Delete or right click, and select Delete Device. 
2 In Target Device, select the device to delete. To delete several devices use CTRL or SHIFT 

and select the devices. 
3 Click OK. The device(s) disappear from the Managed SNMP Devices pane. 

Notes: (1) Deleting a device removes it from the list, but the properties are saved. (2) You 
can add the device back into the project with the last saved SNMP settings. 

To add trap targets: 

Add the IP address or host name of the NMS console to send trap targets to. 

1 In the Managed SNMP Devices pane, select the device to manage. 
2 In the Trap Targets pane, click Add. 
3 In Add Trap Target, type the following:  

• Target. IP address of the console that will receive the traps. 
• Community. (Optional) Information will be taken from the Community Strings boxes. 
• Port. (Optional) The default is 162. 
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4 Click OK. The information will be added to the Trap Targets pane. 

 

Tip: If you click the System Variables tab, and check SNMP Trap Enabled, the traps will 
be enabled for the selected variable. 

Note: You may have conflicts if the Trap Enabled values in System Variables are different 
(some True, some False). 

SNMP Configuration agent system variables 
Change the 'Trap Enabled' status in the System Variables pane when you want traps sent to the 
NMS console you set up (see the previous steps) for the selected variable(s) agents or in 
programming.  

Example: You can set a 'Trap Enabled' status to 'True' for the CURRENT_SELECTED_DEVICE 
variable in Room 100. 

1 In the SNMP Configuration agent, click the System Variables tab. 
2 Select the variables to change. Select all that apply. 
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3 Check or uncheck SNMP Trap Enabled or right click and select Enable Trap or Disable 
Trap in System Variables. The 'Trap Enabled' column changes from 'False' to 'True' or vice 
versa for those selections. 

 

SNMP Configuration agent user variables 
Change the 'Trap Enabled' status in the User Variables pane when you want traps sent to the 
NMS console you set up (see the previous steps) for the selected variable(s) agents or in 
programming. Example: You can set a 'Trap Enabled' status to 'True' for 'Boolean Var.' 

1 In the SNMP Configuration agent, click the User Variables tab. 
2 Select the variables to change. Select all that apply. 
3 Check or uncheck SNMP Trap Enabled or right click and select Enable Trap or Disable 

Trap in System Variables. The 'Trap Enabled' column changes from False to True or True to 
False for those selections. 
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Setting Up Media 
Use this chapter to learn how to: 

• Scan your network for media files 
• Access media from disc changers 
• Play AV from television stations 
• Play audio from radio stations 
• Add a switch 
• Create a playlist 
• Test a media connection 
• Edit media information 

Media types 
To take full advantage of media lookup services by Gracenote, your customers must be 
registered in 4Sight. See Composer Pro Getting Started for details.  

To add and scan songs and albums for playlists, they must be available in MP3, M4A/AAC, or 
FLAC format on a PC, controller, or network share. 

To add Internet radio stations, the Internet radio driver must be bound to the controller. See 
“Setting Up Internet Radio Stations” in this document. 

Tip: In OS 2.4 and later, you can use the TuneIn app to stream radio, news, sports and more 
from Internet stations worldwide. See the TuneIn Setup Guide or TuneIn User Guide for details. 

You can set up your customer's audio and video media in a Control4 system for: 

• Controllers 
• Disc changers 
• Media players 
• Dock for iPod (iPods, iPhones, etc.) 
• iPod, iPhone, iPad, Android, PCs, tablets, or MACs (using MyHome or TuneIn apps) 
• Television broadcast channels 
• Radio broadcast stations 
• Internet radio 

http://dealer.control4.com/dealer/support/documentation
http://www.control4.com/residential/products/resources/
http://www.control4.com/residential/products/resources/
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• Satellite broadcast channels or music stations 
• Other external storage devices: USB flash drives and shared network drives  

You can also: 

• Add CDs and DVDs 
• Add individual songs 
• Add cover art, titles, albums, etc. 
• Create playlists 
• Use the auto-scan feature to scan movies or music 
• Add and scan supported files from third-party media managers, for example, iTunes 
• Edit media information for DVDs, CDs, etc. 
• Test media control  

To view and select the media from the Navigators, including wireless touch screens, on-screen, 
MyHome or TuneIn apps, and System Remote Control devices, you first need to add and scan or 
set up the media to the Control4 controller (for example, Home Controller HC-1000).  

For the MP3, M4A/AAC, or FLAC files that you add and scan, you can create playlists saved to 
the Control4 controller’s hard drive in the media database.  

Note: Speaker Point does not support M4P/AAC. Play songs through Speaker Point using MP3. 
However, for example, an HC-300 connected to an amplifier will play MP4/AAC.  

Note: Internet radio ONLY supports MP3 streaming radio stations. 

Tip: The Control4 system must be functioning correctly before performing any of the tasks 
mentioned in this section. For example, if a disc changer does not appear in the project tree and 
is identified and connected to the system, media cannot be added to it. 

Overview of media management 
Media configuration and media management are controlled in the Control4 Composer (Pro, HE, 
and ME) software. The primary controller that runs Director always runs Media Manager and the 
media database (SQLite 3.1).  

• Media Database—Migrating from pre-OS 2.0 to OS 2.0 and later requires a media database 
conversion and schema changes; consequently, the media databases in OS 2.0 are smaller. 

• Media Manager—All scans are performed by the Media Manager running Director on the 
primary controller. Note: Composer Pro configures scanning only, and does not scan the 
media. 

• Media Lookup Service—This service now runs either in Composer Pro or Media Manager. 
• Composer New/Edit – Search—For media metadata lookup when media has not been 

scanned properly. The information retrieved can be edited and written to the media 
database, and/or the metadata can be written to the tags. 

• Media Manager—Uses online media lookup. IMPORTANT! Controller registration is 
required on my.control4.com to use this service for versions later than Release 1.6.  

Note: The AMG c4lookup service used in previous releases has been changed to 
Gracenote. The Sony 777 Disc Changer uses Gracenote, but the Media Controller can no 
longer access album, title, or artist information from AMG. CDs, however, can be imported 
and will show up in the Media database with a date and time stamp.  

Other Media Managers: You can use other media managers, for example, iTunes, Windows 
Media player, and Media Monkey to create MP3s. You can still use Composer Pro, 
Composer ME and Composer HE to configure  media files for a Control4 system. 
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Media Manager 
New scans 

• Id3 tags are in the file. 
• The title, album and artist names are extracted from the file system folder and filenames. 
• The metadata lookup based on title searches comes from Gracenote. 
• In OS 2.0 and later, scans are now much faster. 
• Press F5 to refresh after new scans. 
• Scans can be tied to events, button presses, etc. 

Scans where content is in the media database 
• Id3 tags are in the file, or you can synchronize the media database based on the 

configuration. 
• If no metadata is in the media database, the metadata lookup is based on title searches 

from Gracenote. 

Other Media Manager considerations 
• Media Manager scans only one device at a time. If several devices are configured and are in 

the queue, they will be scanned sequentially. 
• Composer Pro does NOT need to be connected when Media Manager is performing a scan. 
• Scans can be performed manually in Composer Pro as an event or in an automated 

schedule. 
• If the path becomes disconnected, the metadata will not be deleted. 
• If devices are modified, the tags will update. 
• If you are using a third-party Media Manager, synchronization will occur if set. 

Media storage 
Audio and video files can be stored on one or more of the following devices: 

• Home Controller disk space—Home controllers with disk space can host audio and video 
content. Note: Dealers must provide their own backup solution or use a NAS with 
mirror/recovery capabilities. 

• USB-attached storage—Both audio and video can be stored on these devices, although 
Control4 does not recommend doing so due to poor performance. 

• Network-attached storage (Samba-mounted)—Control4 recommends this solution for 
audio and video files due to better performance and backup/recovery capabilities. 

As with previous releases, all media storage devices must be added and configured in the 
Composer Pro project. Composer Pro does not automatically discover new media storage 
devices. The storage locations are not available in the Navigators until the device is scanned. 

Media lookup service 
• Control4 uses Gracenote for its lookup services.  
• Media lookup is optional. See the Media view in Composer Pro Getting Started to disable 

lookup (set to Never in scheduling). 
• Media lookup requires that the controller be registered at my.control4.com. 

http://www.control4.com/residential/products/resources/
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Configure video scanning of network 
storage 

Use the Control4 Composer Pro System Design view to set up scanning of video devices, such 
as disc changers or media players, to play video files from network-attached storage. Scanning 
can occur for devices or extensions. 

Prerequisites 

• Ensure that the video device is installed as directed in the Control4 Installation and Setup 
Guide for the device. 

• Ensure that the Network File Storage driver is added to the room in the Composer Pro 
project. 

To configure video scanning: 
1 Start Composer Pro and connect to a Director. 
2 Click System Design. 
3 In the project tree, select Network File Storage. 
4 (Optional) To access the files in the storage, if you have password protection enter your user 

name, password, and workgroup in the Properties pane. If you do not have password 
protection, go to Step 6. Click the browse button to locate the path if you don't know it. 

5 Click the Search button to locate the storage. 
6 Click Connect. 

  

 

7 Click the Media view. 
8 In the tree, select Media Scanning Options to set up a schedule for scanning. To set up to 

scan the media now, click Scan Now, skip Step 9, and then read the Scanning Schedule in 
Step 10. 
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9 Set up the scanning schedule and the files to scan. 

 

10 Set the schedule as follows: 
• Scanning Schedule—Select one. 

• Never—Select if you never want to schedule an automatic scan. 
• Every x Days or Weeks (up to 10) —Select the frequency to scan. 
• On the following days—Select Sunday through Saturday. 
• At <time>—Use the up and down arrows to select the time. Highlight AM or PM 

and type the value: AM or PM. 
• Files To Scan—Select a device and extension. 

• Network File Storage—Select if you have a NAS you want to scan. 
• USB Drive—The manufacturer's USB drive appears here. Select if you have a 

USB drive you want to scan. 
• Extensions—Use the up and down arrows to select the format to add or remove 

from the list. To add a format if it doesn't appear in the list, use the down arrow to 
select the extension, select Video, and then click Add. Click Remove to remove 
that format from the list. Note: The list only allows format types that are supported 
in the Control4 system. 

• Use Online Media Lookup to improve scan results—Check if you don't want the 
search to access the Internet for every format lookup, for example, a specific title or 
cover art. Tip: Properly tagged files will result in must faster access. 

• Remove media from the database if the files no longer exist—Check to remove 
database information when a media file has been deleted. Be careful, however, 
because if, for example, you disconnect a USB drive with media on it, the database 
files will delete them if checked, and you may not want to delete them if you use the 
drive again. 

• Update media database if file tags have changed—Check to have the database 
updated if the metadata changes. 

11 Click Apply. 
12 Click Scan Now to start the scan immediately or Stop Scan if you've started the scan and 

want to stop it. 
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Setting up media auto-scan 
Use the Control4 auto-scan feature in Composer Pro to scan media automatically. This section 
applies to disc changers, media players, network-attached storage, and USB drives.  

Note: Composer Pro does not need to be open to scan media. This lets you use other media 
managers (iTunes, Windows Media Player, etc.). Also, scheduled scans can run automatically or 
be started through programming. 

Prerequisites 

• Ensure that the video device is installed as directed in the Control4 Installation and Setup 
Guide for the device. 

• Ensure that the Network File Storage driver is added to the room in the Composer Pro 
project. 

Media Player 
Note: The Media Player uses the Network File Storage option in the Media view. Anytime you 
add new content, scan the files.   

For information about scanning files for the media player, see the Media Player Installation and 
Setup Guide, Media Player User Guide, or the Documentation tab in the Media Player's 
Properties pane. 

Disc changer 
This section applies to a Sony CX777ES Disc Changer. The benefits of running a disc changer 
with bidirectional communications (RS-232), such as the Sony CX777ES, is that you can scan 
your DVDs/CDs stored in the disc changer to identify and index media, and automatically apply 
cover art and information about the media. 

You can configure your system in Composer Pro to scan media on the associated disc changer 
either automatically or manually when the Auto Scan option is selected in the System Design 
Properties pane for the disc changer. The default is to scan media manually (Auto Scan: Off).  

When the Auto Scan Enabled option is checked on the Disc Changer Properties page, the Auto 
Scan feature automatically detects when a disc is added to an empty slot or when a disc is 
removed. The Navigators are automatically updated with the change. The Auto-scan feature 
does not detect when a disc is replaced or swapped.  

Note: If a DVD/CD is scanned and the media is not recognized, it is titled 'unknown.' You can 
edit the information about the DVD/CD, and manually provide this information from either 
Composer Pro or the Navigators. If this DVD/CD is then moved to a different slot, the system 
applies this same information. 

To auto-scan added media to a disc changer: 
1 Start Composer Pro and connect to a Director. 
2 Click System Design. 
3 In the project tree, select the device, for example, Disc Changer with a serial connection 

(RS-232) to the controller, for example, the Sony CX 777ES Disc Changer.  
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4 In the device's Properties pane, ensure that the Auto Scan Enabled option is checked. 

 

5 Open the disc changer drive, and add or remove the DVD/CD. 
6 Close the drive to begin the auto-scan. The information for the added DVD/CD is 

automatically made available on the Navigators. See also “Setting Up Media Stored on a 
Disc Changer.” 

Setting up media stored on a controller 
If you set up media on a Control4 controller with storage space for that media (not all controllers 
have media storage), the controller has a built-in digital audio player. Digital Audio is the 
segment of the controller that provides the digital audio streaming. Each source device that can 
provide an audio stream, whether it is a CD changer plugged into the analog inputs on a 
Control4 Speaker Point or a Control4 controller, it can provide audio to the digital audio servers. 
Each must have a connection to the digital audio components. 

When configuring these types of connections in the Connections view, there is always an open 
connection to the digital audio components for each digital audio server or digital audio client. 
You can see many connections to the digital audio components depending on the hardware 
configured in the project. 

Prerequisites 

• Ensure that a controller is added to your project and identified to the network. 
• Ensure that your controller has storage space for media. 

To add and scan available media on a controller: 
1 Start Composer Pro and connect to a Director. 
2 Click System Design. 
3 Click Connections. 
4 In the Network tab, ensure that the controller has an address. If it does not, you must go 

back and identify the controller to the network. 
5 Click Media. 
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6 Select the Controller with the media you want to add, and click Add. 

 

Tip: If a dialog box displays and states that you cannot add the media, make sure you 
identify the controller in the Connections view > Network tab. 

7 Browse to the directory of music files to be added to the controller. After you add the files, 
the scan automatically starts. After a few moments, the media is scanned, and a list of 
albums appears. You may see the on-screen Navigator update during this process. 

Tip: Another way to add files from a network share to a controller is to go to the Windows 
Start menu, and select Run. Type //<Controller's IP 
Address>/media/audio/music/<Artists>/<Albums> and copy the files there. 

8 From the File menu, select Refresh Navigators to make the new media is accessible 
through the Navigators in the Control4 system. 

Setting up media stored on a disc changer 
Use the Control4 Composer Pro Media view to add and scan media according to the options 
available on your disc changer. Adding and scanning DVDs and CDs loaded in the disc changer 
populates the media information in the media database. This permits users to view the media 
from their Navigators.  

This section covers how to: 

• Add media to a disc changer 
• Scan media in a disc changer 

Prerequisites 
• The system must be registered at my.control4.com before using the online Media Services. 

To register the system, see 'Registering the System' (Composer Pro Getting Started). 
• Ensure that a controller is added to the project tree and identified to the network. 
• Ensure that a disc changer is added to the project tree and identified to the network. 

To add media to a disc changer: 
1 Start Composer Pro and connect to a Director. 
2 Click Media. 
3 Select Disc Changer in the Media project tree. If any of the following options are available 

for the selected disc changer, the buttons will be active (not grayed out): 

http://my.control4.com/
http://dealer.control4.com/dealer/support/documentation
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Scan—Lets you scan all media located on the disc changer to add to the media database 
(recommended if available).  

Note: Because media scanning has been moved to the background, the scanning status is 
only available through Director status messages. To do this, you can either watch the 
Director status line or re-select the media to view the content that has been scanned.  

 

Search—Lets you search for media titles located on the disc changer to scan and add them 
to the media database. 

Edit—Lets you edit your entries (artist, album, title, etc.). 

New DVD or New CD—Lets you add new DVDs and CDs to the media database.  

4 Always use File > Refresh Navigators to make the new media accessible through the 
Navigators in the Control4 system.  

Note: Control4 has not implemented a UI for browsing CDs stored in a disc changer. Use a 
Legacy Navigator (prior to OS 2.0) that supports this functionality if this is an important 
consideration.  

Scanning media in a disc changer 
The following sections describe how to add media to the media database using the options listed 
above. 

To scan media loaded in a disc changer to add it to the media database: 
1 Click Connections. 
2 Ensure the disc changer is connected to a serial port on the controller.  

Example: From the Control/AV tab, select Sony CX777ES Disc Changer; ensure that the 
Serial RS-232 is connected to the correct serial port (1 or 2).  

3 From the Network tab, ensure that the controller has an address. 
4 Click Media. 
5 Select Disc Changer. 
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6 In the Disc Changer pane, click Scan > OK to Scan all. 

 

Note: If the following error message displays, "Your system has not been registered on 
my.control4.com," you can click Yes to continue scanning music without registering, but the 
music scans based only on the current metadata stored in the music files. You will need to 
enter any missing information manually for each disc.  

Example: If no cover art is found in the file’s metadata, then no cover art is associated with 
the music unless the system is registered in 4Sight, and you can go to the online media 
lookup (Media view > Edit > Name > Search > Select > Next) to obtain the cover art for the 
music. See "Registering the System in Composer" in Composer Pro Getting Started for 
instructions. 

Automatically scan media 
The following steps use the Sony CX777ES Disc Changer as an example.  

To auto-scan added media: 
1 From the project tree, click the Sony CX 777ES Disc Changer. The device Properties pane 

appears for this device. 
2 Ensure that the Auto Scan Enabled box is checked.  

When you select the Auto Scan Enabled option from the device's Properties page in 
Composer Pro, an automatic scan of the disc(s) is available if you add a new disc to an 
empty slot, or if a disc is removed. In those cases, the disc changer automatically 
recognizes the change, and the Navigators automatically update the changes. The disc 
changer recognizes the changes in its slot when its door closes to perform the auto-scan. 
The Auto-scan feature does not detect when a disc is replaced or swapped.  

Note: Control4 recommends that you check the Ignore Unexpected Play, Stop, or Pause 
option. This option should be checked if you are configuring a system with lighting, for 
example, when the movie starts playing, and the lights in the room dim. Normally, you can 
use the Play, Stop and Pause functions on the disc changer during the course of a movie 
being played. By checking the option, these functions are ignored by the system.  

3 Open the disc changer drive's bay, and change the existing DVD or CD.  
4 Close the bay. 
5 The auto-scan begins automatically when the disc changer door closes, and the information 

for the new DVD or CD is available in the Navigators. 

http://dealer.control4.com/dealer/support/documentation
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Searching media in a disc changer 
To search media loaded in the disc changer to add it to the media database: 
1 Click Media. 
2 Select the Controller in the project tree. 
3 In the Disc Changer pane, click Search. 

 

4 Type the DVD name in the blank box. The possible DVD titles from the Web database 
appear in the Search Results window. Use the scrollbar to find the appropriate DVD title  

Example: “A Beautiful Mind” 

Select the appropriate DVD title, drag it over the empty line item, and then select it again.  

  

5 Repeat the previous steps for each of the DVDs/CDs in the disc changer you want to add to 
the media database. 

6 Click Finished. 
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Edit CD or DVD information 
To edit a scanned DVD or CD: 
1 Select the CD or DVD to edit. 
2 Click Edit. 
3 Change the Title, Director or Artist, Album or Movie, Studio, Genre, etc. You can also 

change the location, locate the cover art (Find Art File), and so on.  
4 Click OK.  

 

Adding a DVD or CD 
To add a DVD or CD: 
1 Click Media. 
2 Select Disc Changer in the Media pane. 
3 Select the empty box for the New DVD and New CD buttons to appear.  
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4 Click either New DVD or New CD as appropriate. The New Movie or New Album dialog 
appears. 

5 In the Title box, enter the DVD you want to play. 

Example: "A Beautiful Mind"  

6 Click Search.  

 

7 When the Search dialog appears, use the scrollbar to find the appropriate cover art, and 
select it. 

8 Change the search criteria, and search again if needed. The possible matches from the web 
database appear in the Search Results window. 

9 Click Next. 
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10 (Optional) Customize the DVD/CD information before adding it to the media database by 
editing the text in the box. 

 

11 Click Finished. 
12 Click OK. 

Setting up videos for a Media Player 
Use the Control4 Composer Pro Media view to identify the videos that you want the Media 
Player to play. 

Prerequisites 

• Ensure that the Media Player is installed and added to Composer Pro as directed in the 
Control4 Media Player Installation and Setup Guide and Control4 Media Player User Guide. 

• Ensure that the network-attached storage contains the videos that will play on the Media 
Player, and that the NAS is added to your Composer Pro project. 

Setting up media for radio stations 
Use the Control4 Composer Pro Media view to set up radio stations for a Control4 system. 

To set up media for radio broadcast stations: 
1 Start Composer Pro and connect to a Director. 
2 Click Media. 
3 Select the broadcast media type (XM Radio, AM Radio, Dish Network, etc.). 
4 Click Search. 
5 In the Zip box, type the ZIP Code of where the Control4 system is located. 

http://dealer.control4.com/dealer/support/documentation
http://dealer.control4.com/dealer/support/documentation
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6 Click Search, and use the pull-down menu to select the listings. The available stations are 
populated in the Search Results window. 

7 Check the individual boxes of stations that you want to make available in the Navigators; or 
click Select All, and then click OK. 

  

The selected stations populate the media source channel list (such as the FM Radio list 
shown next).  

  

8 Repeat the previous steps for each additional media source, e.g., cable, satellite, XM radio, 
or AM radio. (Each of these services must be set up separately.) 
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Setting up media for television stations 
Use the Control4 Composer Pro Media view to set up television channels for the Control4 
system. 

To set up media for television broadcast channels: 
1 Start Composer Pro and connect to a Director. 
2 Click Media. 
3 Select the broadcast media type (UHF/VHF, satellite, cable, etc.). 
4 Click Search. When the dialog appears, type the ZIP Code for the Control4 system’s 

location in the box. 
5 Click Search, and use the pull-down menu to select Local Broadcast Listings. The 

available channels are populated in the Search Results window. 
6 Check the individual boxes of channels that you want to make available in the Navigators, or 

click Select All, and then click OK. 

 

The selected channels populate the media source channel list (such as the UHF/VHF 
channel list shown next). 
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7 Repeat the previous steps for each additional media source, e.g., cable, satellite, XM radio, 
AM radio, or FM radio. (Each of these services must be set up separately.) 

Setting up Internet radio stations 
Use the Control4 Composer Media view to add Internet radio stations that you can play from 
touch screens, MyHome apps, or on-screen Navigators. 

Prerequisites 

• Ensure that the controller is installed and identified as directed in the controller's installation 
guide. 

• Ensure that the Internet radio stations you add are in MP3 format. You'll need to create a 
new form for each station you add. 

To configure Internet radio: 
1 Start Composer Pro and connect to a Director. 
2 Click the Media view. 
3 From the media list, click Internet Radio. 
4 In the Internet Radio pane, click New. 

 

5 Fill out the form: 
a Name—Add the name of the station. 
b Description—Add a description that's meaningful. 
c Channel—Add the URL for the channel. Note: Locate the URL of the MP3 stream that 

starts with http://... Note: Ensure that Audio Only is checked. 
d Genre—Add a genre if appropriate. 
e Check Audio Only for listening. 
f Cover Art—If you'd like, you can copy the radio station art to your list. In a browser, go 

to the link and click Images. Click Find Art File to locate an image, copy it to your 
clipboard and then click Paste from Clipboard. 
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g Click OK. 

 

6 Go to the touch screen, MyHome app, or on-screen Navigator and select the Listen > 
Station. Note: If you have several sources, Internet Radio appears under Sources. 

Importing a DVD list from a file 
Use the Control4 Composer Pro Media view to populate DVD metadata stored on a disc 
changer. 

To import a DVD list: 
1 Start Composer Pro and connect to a Director. 
2 Click Media view. 
3 Right-click on the Disc Changer, and select Import DVD List from File. Composer Pro 

automatically populates the slots of the disc changer with the DVDs stored in each slot as 
listed in the file that is imported.   

The imported file must be a CSV (comma-separated value) file listing the slots and the titles 
of the DVDs, one per line. You can create this file using a simple text editor or spreadsheet 
program by exporting a spreadsheet file in a CSV formatted file. This new feature provides a 
simple and easy way to quickly configure all of the DVDs in any manufacturer’s disc 
changer.  

Example formatting for CSV file: 

• 1, Toy Story 
• 2, The Incredibles 
• 3, The Perfect Storm 
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Using external storage devices 
You can access digital music from an external storage device in your Control4 system. External 
storage devices include USB flash drives, USB external hard drives, or a shared network storage 
area (for example, a computer’s hard drive).  

The following applies when setting up an external storage device: 

• USB flash drives or USB external hard drives must be formatted as FAT32 devices. 
• Shared drives on a Windows system cannot contain a space in the directory/pathname.  

Set up the external storage device or networked file storage as described in this section.  

Note: When you disconnect the external drive (USB, network, etc.) from the system, the music is 
no longer available. Reconnecting the external drive makes the media available again. 

Attach and scan external storage devices 
To attach and scan external storage devices using a USB connection: 

Note: External storage devices must have media stored in unprotected MP3 format. 

1 Power up the external storage device. 
2 As appropriate, use the documentation provided with your Control4 controller to attach the 

external hard drive using the USB port. 
3 Start Composer Pro and connect to a Director. 
4 Click Media. 
5 In the project tree, select the external device. 
6 Click Scan in the device's pane. 

You can add media from the external storage device when it is connected to the controller. 
However, it is recommended that you connect your external drive directly to the PC where 
you want to copy the media. When scanning, the media appears on the device. 

Access and scan network storage devices 
To access and scan network storage devices: 

Note: The network location must be an open share location (no password required). 

1 As appropriate, use the documentation provided with your operating system to create a 
shared network drive.  

Example: Using Windows XP to make a local C:/ Drive directory available on the network, 
right-click the folder and select Sharing and Security. Click the Share this folder button.  

2 Click System Design. 
3 From the My Drivers tab, double-click Network File Storage to add it to the project tree. 
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4 Highlight Network File Storage in the project tree, and configure the username, password, 
and workgroup (or domain) for the network file share, and then browse to its network 
location. 

 

This information varies between types. Contact your System Administrator or Control4 
Technical Support if you need help with this information.  

5 Click Media. 
6 In Network File Storage, notice the options: Audio Media and Video Media. 

 

7 To add or scan audio files, in the media list select Audio Media, and then click New or 
Scan.  

Notes: 
• When adding music to Network File Storage from the desktop, the music folder must 

reside in My Network Places so components can access the music files. A mapped 
network drive is not applicable in this situation. 

• Audio files must be in one of the following formats to be scanned and played by the 
Control4 system: MP3 or FLAC. If you connect an iPod or another audio device, the 
Control4 system can play back the files supported on that device; but only MP3 files can 
be decoded.  

8 To scan video files, in the media list select Video Media, and then click Scan.  
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Notes: 
• Video files must be in one of the following formats to be scanned by the Control4 

system: .avi, DVD, .iso, .m4a, mpeg, .mpg, or .wmv. These video files can only be 
played using a Media Player device.  

• Video is not supported from a USB drive, so the Video Media option is not displayed in 
the list under a USB drive.  

Adding an audio or audio/video switch 
Use Control4 Composer Pro to add audio or audio and video switches to a Control4 system. 

Prerequisites 

Set up the audio or audio/video switch and any associated hardware to the Control4 system. 

To add an audio switch or audio/video switch: 
1 Start Composer Pro and connect to a Director. 
2 Click System Design. 
3 In System Design, from the Search tab add the audio switch or audio/video switch to your 

project. 
4 Using the Local or Online Database, select the device type: Audio Switch or AV Switch, 

and select All manufacturers.  

Example: To add the applicable Knox AV switch (RS-232) driver, use the Search tab, and 
select the Device Type: AV Switch > Manufacturer: All manufacturers.  

5 When the AV Switch object is added to the project tree, select the object to view the device 
properties and change the configuration if applicable.  

Example: The Knox AV Switch has no properties to modify, but other switches have 
properties, such as the Control4 Audio Switch.  

6 Connect the network or control/AV devices as necessary for your configuration. 
7 Modify any room connections as needed for your configuration. 

Creating a playlist 
Use Control4 Composer Pro to create a playlist from streaming media, for example Rhapsody.  

You can create playlists from the touch screens, MyHome apps, or on-screen Navigators also. 
See the Control4 System User Guide for details. 

To create a playlist: 
1 Start Composer Pro and connect to a Director. 
2 Click Media. 
3 In the Media view, go to the Media menu, and select New Playlist. 
4 Name the playlist.  

Tip: You can rename it any time by right-clicking the playlist, selecting Rename Playlist, 
and then typing a new name.  

5 Select the controller or other media on which the songs are stored, and ensure that you 
have scanned the media from the storage to make the media known to the controller. 

http://dealer.control4.com/dealer/support/documentation
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6 Drag the list of songs to the playlist.  

These playlists are designed exclusively for streaming media in digital audio. If the customer 
subscribes to the Rhapsody Music Service, then Rhapsody playlists can be created using a 
Navigator (see the Control4 System User Guide for details). In OS 2.0 and later, playlists 
can include CDs/DVDs, broadcast channels or stations, but they are a separate playlist from 
those in Rhapsody.  

Note: To set up a Rhapsody subscription on behalf of the user or yourself, obtain a 
Rhapsody account at http://www.control4.com/rhapsody, and then refer to the information 
about Rhapsody in the Control4 System User Guide.  

7 Drag every album or song you want to add to the playlist onto the playlist name. 

 

8 After adding at least one (1) album or song, select the playlist to view the contents. 
9 (Optional) Remove songs:  

• To remove a song, right-click and select Delete. 
• To remove multiple songs, press and hold the Shift key. Select the songs, right-click 

anywhere in the selected list, and select Delete. 

http://dealer.control4.com/dealer/support/documentation
http://www.control4.com/rhapsody
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• To remove selected songs, press and hold the Ctrl key. Select the songs to delete, and 
select Delete. 

 

The playlist can now be played from or edited in the Navigators. 

Testing the media connection 
To test control of media through the Control4 Navigators (System Remote Control, on-screen 
Navigator, or any of the other Navigators or touch screens), use the steps outlined in the 
Control4 System User Guide.  

Suggested test items: 

• Play an album 
• Add an album or track to the Now Playing queue 
• Play a playlist created in Composer Pro 
• Create a playlist on a touch screen or on-screen Navigator 
• Play multiple streams of music (play different music in different rooms) 
• Play a movie on the television 

http://dealer.control4.com/dealer/support/documentation
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Editing media information 
Use the Control4 Composer Pro Media view to edit the media information for 'unknown' DVDs or 
CDs. You can edit the media information in the Navigators: on-screen, touch screen, or MyHome 
app. 

Editing CD information 
Use the Control4 Composer Pro Media view to edit CD album names, artists, genre, or cover art 
for a Control4 system. 

To edit information about a CD: 
1 Start Composer Pro and connect to a Director. 
2 Click Media. 
3 In the project tree, double-click the CD storage device on which you want to edit CD 

information; for example, CD, disc changer, or controller. 
4 Select an album and click the Edit button, or double-click the album title. 
5 In the Album tab, edit the Album Name, Artist, Label, Genre, or Art. Make text changes as 

applicable. 
6 Click OK, or use the additional features outlined below.  

  

7 Search on a Name or Artist to search the database for similar entries.  
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8 Select a search result. Double-click to select an album title, and click Next. 

 

9 View or edit the information about the album: Name, Artist/Composer, Label, Genre, Year, 
Art, and Notes. 

10 Change the information as needed, and then click Finished to save your changes. 

  

11 Select the Track tab, and edit or remove tracks as needed. 
12 Select the Notes tab, and edit as needed for future reference. 
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Editing DVD information 
Use the Control4 Composer Pro Media view to edit DVD title, director, studio, genre, runtime, 
release date or rating in a Control4 system.  

Tip: New in OS 2.0 and later, you can edit DVD and video titles on the touch screens and on-
screen Navigators. 

To edit information about a DVD: 
1 Start Composer Pro and connect to a Director. 
2 Click Media. 
3 In the project tree, double-click the Disc Changer or DVD. 
4 Select a movie and click the Edit button, or double-click under Discs. 
5 In the Movie dialog under the Movie tab, edit the DVD title, director, studio, genre, runtime, 

release date or rating information as needed. 
6 Click OK, or use the additional features outlined below. 

 

7 Click Search to present similar entries. 
8 In the results list, double-click a DVD. 
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9 Edit the DVD information. 

 

10 Replace the cover art using one of the options provided. 
11 Click the Cast and Synopsis tab to edit text displays as needed. 
12 Click Finished to save your changes. 
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Programming 
Use the Control4® Composer Pro Programming view to program the Control4 system. This 
section assumes that you have a general understanding about how to use Composer Pro to add 
and identify devices, and that you are now familiar with the Composer Pro interface. If not, read 
“The Basics” sections or refer to Composer Pro Getting Started. 

Use this chapter to learn: 

• Programming basics 
• Programming with commands 
• Programming with conditionals 
• Programming using rooms 
• Programming using variables 
• Programming with agents 
• And more 

Programming basics 
Use the Control4 Composer Pro Programming view to program events and other actions that 
affect Control4 system devices. 

Tip: A useful tool is available in OS 2.0 and later that can help you keep track of your 
programming scripts. The tool is called Programming Detective which is part of the Detective 
Suite, in Tools > Detective Suite. See the Composer Pro Getting Started guide for details. 

To get to the Programming view: 
1 Start Composer Pro and connect to a Director. 
2 Click Programming. In the Programming view, you can perform basic programming task. 

Event-driven programming 
Programming is based on events. When an event is triggered, other actions can take place.  

Example: If you program to lower the projector screen in the Theater by pressing a keypad 
button. You can program the receiver, DVD player, and projector to power up and start playing a 
DVD also. Programming the system is where the true value of Composer Pro becomes a reality.  

http://dealer.control4.com/dealer/support/documentation
http://dealer.control4.com/dealer/support/documentation
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To program the system using Composer Pro, you drag and drop Events and Actions that you 
create for corresponding devices to a programming Script pane. The sections below show these 
panes. 

Events (Programming pane) 

Select an event (left side of the window): 
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Actions (Actions pane) 

Select the action(s) (right side of the window): 

 

Script (Script pane) 

Drag the Events and Actions commands to the Script pane (middle pane): 

 

The next table describes events, actions, and the script. 
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Programming Item Description 

Events 

Events All programming begins with events. An event is a “when” 
statement. An event is the trigger report that something happened 
that results in an automation. Events happen instantaneously. On a 
keypad, pushing a button is one event. Actions all occur under 
Events. Examples of events include: 

• When the door opens 
• When it is 7:00 AM 
• When it is sunrise 

Actions 

After the event identifies to the system that something occurred, it 
sends actions. The following are the methods that are used by the 
system to define actions: 

• Commands. The Commands tab displays all available 
commands for a selected item in the Action Device Tree. A 
command is a “do” statement. Commands are actions the 
Director tells the device to do. Examples of commands 
include: 
Light: on, off 
VCR device: play, stop, pause 
CD Changer device: go to disk 
Security device: arm, disarm 
TV device: Power on/off, change channel 

• Conditionals. The Conditionals tab displays all available 
conditionals for a selected item in the Action Device tree. A 
conditional is an “if” statement. An “if” statement asks a 
true/false question to the device. Examples of conditionals 
include: 
If door is open 
If after 5 PM 
If light is greater than 50 percent 

• Loops. The Loops tab displays all available loops for a 
selected item in the Action Device tree. A loop is another 
type of conditional. A conditional loop is a “while” 
statement. It is something that is ongoing. Examples of 
conditional loops: 
While the sprinklers are on 
While the motion detector detects movement 
While a doorbell switch is being pressed 
Warning: Using loops (WHILE statements) can potentially 
overwhelm the controller’s CPU. Use loops sparingly. 

• Delays. A delay stalls a program from running to ensure 
actions that occur at the right time. 

Script the linking of events and actions is defined on the script. 

Script The linking of events and actions is defined in the script. 

Tip: To configure or program devices, you can use properties, agents and variables also. These 
are considered advanced configuration and programming tasks. See “Programming with agents” 
or “Programming with variables.” 
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Programming elements 
Basic programming consists of two (2) parts: 
1 Define a device’s events that trigger actions. 
2 Define a device’s actions to trigger when an event fires. 

The following steps introduce the basic programming flow and script creation: 
1 Define the device's event (Events pane) and select the event. Notice that it appears in the 

Script pane. 

 

2 Define the device's actions (Actions pane): commands, conditionals, or loops.  

 

3 Drag the actions to the script (Script pane). 
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4 In the Script pane, click Execute. 

Note: Programming can make use of agents also, where you can include pre-programmed 
system functionality, such as scheduling, delays, or setting up Lighting Scenes. Example: 
To program around sunrise and sunset, use the Scheduler agent. 

See “Programming with agents” for more information about using agents in programming. 

See the next section or Composer Pro Getting Started for example programs you can create. 

Programming with commands 
A Command for a Control4 system is a “do” statement. Commands are actions that tell a device 
what to do. 

Example: The example in this section shows you how to program a 3-Button Keypad to turn on 
the sprinkler system using Relay 2 for control. 

To program a 3-Button Keypad to toggle sprinklers on and off: 
1 Start Composer Pro and connect to a Director. 
2 Click System Design. 
3 The following devices need to be added and identified in the project: 

• Controller 
• 3 Button Keypad 
• Sprinklers 

4 Click Connections. 
5 Make sure the sprinklers are connected to the correct relay port. 

a Click the Control/AV tab. 
b Select Sprinkler System from the project tree. 
c In the Control & Audio Video Connections pane, ensure Sprinklers is connected to 

Relay 2. 
6 Click the Network tab. 
7 From the Network tab, ensure that the controller and 3-Button Keypad have an address in 

the IP Network Connections pane. 
8 Click Programming. 
9 In the Device Events pane project tree, select 3-Button Keypad. 
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10 In the 3-Button Keypad Events pane, click the button that you want to program—Button 1 
(default). This automatically identifies the Press event for programming Button 1 on the 
keypad. The event appears at the top of the Script pane. 

 

11 In the Actions pane, click Sprinkler System. 
12 Click the Commands tab, and select Toggle the Sprinkler System. The command you 

chose is displayed in the Sprinkler System Actions pane with a green arrow.  

Note: The title of this pane varies depending on the device you select. 

13 Click the green arrow, and drag it to the Script pane (center pane). 

 

14 Click Execute in the Script pane to turn on the sprinklers. 
15 Click Execute again to turn off the sprinklers. 

Results: The top button of the 3-Button Keypad now toggles the Sprinklers on and off. 
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Programming with Delay, Stop, and Break commands 
Control4 Composer Pro programming provides a Delay command in response to an event that 
waits for a specified amount of time before executing the next command in a code sequence. 
See “Programming with a While Statement” for one example; another example is listed below. 

When programming a device, you always have the following options: 

• Delay—Lets you delay an action from taking place. 
• Stop—Lets you stop all programming. 
• Break—Lets you break out of a ‘While’ or loop or 'If' statement when a specified condition is 

met and returns to the programming outside of the loop. 

Note: Break commands do not break out of a conditional. See “Programming with Conditionals” 
for details. 

Delay command 
To use the Delay command during programming, see this example using a Motorized 
Screen and a DVD player: 
1 Start Composer Pro and connect to a Director. 
2 Click Programming. 
3 Select the Motorized Screen in the project tree. 
4 Select the event When the Motorized Screen is put down. Notice the string that appears 

in the Script pane. 

 

5 To use the Delay command, in the Device Actions pane click Programming Control. Scroll 
to the bottom of the tree to find it. 

6 In the Programming Control Actions pane, click the Commands tab. 
7 Select Delay and type 5, then use the drop-down menu and select seconds (default). 
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8 Drag the green arrow Delay command to the Script pane. This ensures that there is a 
five-second delay after the projector powers up. 

 

9 Scroll up and select DVD in the project tree. 
10 Click the Commands tab, and click Power > On. 
11 Drag the green arrow ‘Turn on the <room’s> DVD’ to the Script pane. 

Stop command 
To use the Stop command during programming, see this example using a Motorized 
Screen and a DVD player: 
1 In the DVD Events pane, select the DVD and click Power On. ‘When <room>-> DVD Turns 

On’ appears at the top of the Script pane. This assumes that the device is on before turning 
it off and using the Stop command. 

2 Go to the Device Actions pane, and click Programming Control. 
3 Click the Commands tab, and select Delay and 5 seconds (default). 
4 In the Programming Control Actions pane, click the green arrow ‘delay 5 seconds,’ and 

drag it to the Script pane. 
5 Click the DVD in the Device Actions pane project tree. 
6 In the DVD Actions pane, click the Conditionals tab, and then click On. 
7 Click the blue question mark next to ‘If the <room>'s->DVD is On,’ and drag it to the Script 

pane. 
8 Click the Commands tab, and click Off. 
9 Drag the green arrow ‘Turn Off the <room’s>-> DVD’ over the blue question mark in the 

Script pane to nest it below ‘If the <room’s>->DVD is On.’ 
10 Click Programming Control, and click the Commands tab. 
11 Click Stop, and drag the green arrow ‘Stop’ over the blue question mark in the Script 

pane to nest it below ‘Turn off the <room’s>->DVD.’ 
12 Add other conditionals and commands as desired. In this case, the conditional ‘If the 

<room’s>->Motorized Screen is down’ and nested command ‘Put the <room’s>->Motorized 
Screen up’ are added, along with another conditional and command. 

13 In the Device Actions pane, click Motorized Screen in the project tree, and click the 
Conditionals tab. 
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14 Select the Motorized Screen is down, and then drag the blue question mark ‘If the 
<room’s>->Motorized Screen is down’ to the Script pane. 

15 Click the Commands tab, and select Put the <room’s>->Motorized Screen up. 
16 Drag the green arrow ‘Put the <room’s>->Motorized Screen up’ on top of the blue 

question mark ‘If the <room’s>->Motorized Screen is down.’  

 

Break command 
Here are some rules about using the Break command (see example script below).  

• A break in a 'While' loop jumps to the first statement after the While statement.  
• A break in an 'If' statement (nested in a 'While' statement) jumps to the first statement after 

the 'If.'  
• A break not in a 'While' or an 'If' statement should behave like a Stop command (jumps to 

the first statement after the function). 
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Note the 'Break' command in the statement below. If the 'While' statement above the 'Break' 
command (in an 'If' statement) is met (True), then the program continues to the next 'While' 
statement. Otherwise it skips to the next command (green arrow) statements at the bottom 
of the script. 

 

See “Programming with a While Statement” or “Programming with Conditionals” for details. 

Programming with a While statement 
A ‘While’ statement runs continuously in a loop until the evaluation is shown to be False 
(Boolean value). ‘While’ statements can be repeating ‘if’ statements also. 

Caution: When programming with WHILE statements, the script must incorporate delays, or the 
script will run so fast that it will consume all available CPU resources and decrease system 
performance. 

To program a While statement, follow this example: 
1 Start Composer Pro and connect to a Director. 
2 Click System Design. 
3 Ensure that you have the following devices in your project: 

• Controller 
• Door Contact Sensor 
• Theater Dimmers 

4 Click Connections. 
5 Make sure the devices are connected to the correct Relay port. 
6 Click the Control/AV tab. Select Door Contact Sensor in the project tree, and ensure it is 

connected to Contact Sensor in the Control & Audio Video Connections pane. 
7 Click the Network tab, and ensure that the controller and Bedroom Dimmer have an 

address. 
8 Click Programming. 
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9 Before programming the ‘While’ statement, program a way to turn off the ‘While’ statement 
by doing the following (when the door closes, the Bedroom Dimmer turns off): 
a Click Programming, and select Door Contact Sensor to trigger an event in the Door 

Contact Sensor Events pane. 
b Select the When the Door Contact Sensor closes event. The selected event appears 

at the top of the Script pane. 

 

c In the Actions pane, select Theater Dimmer. 
d Click the Commands tab below, and select Off. The action appears in the right middle 

Actions pane. 
e Drag the green arrow to the Script pane. This turns off a blinking light when the door 

closes. 
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10 Program the While statement (when the Door opens, and while it is open, turn the Theater 
Dimmer on): 
a In the project tree, select Door Contact Sensor to trigger an event. 
b Select the When the Door Contact Sensor opens event. The event appears at the top 

of the Script pane. 

 

c In the Actions pane, select Door Contact Sensor to trigger an action. 
d Click the Loops tab, and select the While Loop option: the Door Contact Sensor is 

Open. 
e The While loop While the Living Room > Door Contact Sensor is open appears in 

the Actions pane next to a red circle arrow. 
f Drag the red circle arrow to the Script pane. 

 

g In the Actions pane, select Theater Dimmer. 
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h Click the Commands tab, and select On. 
i Drag the green arrow icon Turn on the Theater > Theater Dimmer on top of the red 

circle arrow icon in the Script pane to nest it under the loop statement. 

 

j Delay the action 5 seconds. In the Actions pane, scroll down to select the 
Programming Control Delay agent. 

k Click the Commands tab, and set the Delay time to 5 seconds. 
l Drag the green arrow on top of the red circle arrow in the Script pane to place the 

delay action below the previous action. 

 

m Turn the Theater Dimmer off. In the Actions pane, select Theater Dimmer again. 
n Click the Commands tab, and select the Off command. 
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o Drag the green arrow icon on top of the red circle arrow icon in the Script pane to 
place the command below the previous action. 

 

p Click Execute. 
q Test the While statement by opening the actual door. The light should blink on and off 

while the door is open. 
r Close the door. The light should turn off when the door is closed. 
s Select the When the Door Contact Sensor opens event. 

Programming with Favorites (bookmarks) 
Use the Control4 Composer Pro Programming view to add a bookmark page created in a touch 
screen or on-screen Navigator to a programming script.  

Prerequisites 

• Ensure that the touch screens, My Home apps, or on-screen Navigators that contain the 
bookmarks have been added to the system. 

• Ensure that the bookmark you want to use in the script has been created on a touch screen 
or on-screen Navigator. See Control4 System User Guide for information about how to 
create a bookmark (Favorite). Note: If you use the Access agent, Favorites on the touch 
screens are hidden. 

To add a bookmark to a programming script: 
1 Start Composer Pro and connect to a Director. 
2 Click Programming. 
3 Ensure that the following devices are in this example project: 

• 3 Button Keypad 
• 7” Touch Screen 
• Access to 4Store 

4 In the Device Events pane, select the device to program (for example, 3-Button Keypad). 
5 In the 3-Button Keypad Events pane, select the button (for example, Button 2). 
6 In the Device Actions pane, select the touch screen that contains the bookmark you created. 

http://dealer.control4.com/dealer/support/documentation
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7 In the Touch Screen - 7" Actions pane, select the Commands tab. 
8 Scroll to the bottom of the tab, and locate the Bookmarks options. There should be a list of 

favorites from which to select (see the screen below for details). Select the bookmark to use; 
for example, My Apps. 

 

9 When you press Button 2 on your 3-Button Keypad, the touch screen displays the My Apps 
page. 

Programming with conditionals 
A Control4 conditional is an 'If' statement in Composer Pro that asks a true or false question to 
the device. 

• A 'Break' command used in an 'If' statement should jump to the first statement after the 'If'. 
See “Programming with Delay, Stop and Break Commands” for details. Note: A 'Break' 
command in an 'If' statement won't behave as a 'Stop' command, but will move to the next 
level in the script. 

• A break not in a 'While' or 'If' statement should behave like a 'Stop' command (jumps to the 
first statement after the function). 

Example: The example in this section shows how to use conditionals in programming. If a light is 
off when the doorbell is pressed, the light is programmed to turn on. Conditionals also use When 
statements (events). When the doorbell is pressed, if the light is off, program the light to turn on. 

To program a conditional that turns on the light when the doorbell is pressed and the light 
is off: 
1 Start Composer Pro and connect to a Director. 
2 Click System Design. 
3 Ensure that the following devices are in the project: 

• Controller 
• Doorbell 
• Theater Switch 

4 Click Connections. 
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5 Make sure the control or network connection is made.  
a Click the Control/AV tab. 
b Select the Doorbell in the project tree. 
c In the Control & Audio Video Connections pane, select Doorbell. Ensure it is connected 

to the Contact Sensor. 
6 Click the Network tab. 
7 In the IP Network Connection pane, ensure that Controller and Theater Switch have an 

address. 
8 Click Programming. 
9 In the Device Events pane project tree, select the Doorbell. 
10 Select the When the Doorbell is pressed event. The event appears at the top of the Script 

pane. 

 

11 In the Actions pane, select the Light Switch. Notice that the light switch actions that can be 
programmed for this device appear in the Light Switch Actions pane below the Device 
Actions project tree. 

12 Click the Conditionals tab, and select Is Off. Composer Pro displays the conditional you 
chose in the Theater Switch Actions pane: ? If <room>'s Light Switch is off. 
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13 Drag the blue question mark icon to the Script pane. 

 

14 Click the Commands tab, and select On. The command you chose displays in the Theater 
Switch Actions pane. 

15 Drag the green arrow to the blue question mark in the Script pane to make it a child under 
the "When..." statement. 

Tip: If you drag the action to the text, or you drag the action under the text to the open 
space, it places the action as an equal above the conditional. 

If you drag the action to the question mark, it becomes a subset of the conditional. Notice 
the direction of the arrow to place the action as a peer or a subset under the statement. 

 

16 Click Execute. With the Theater Switch light off, press the doorbell; the light should come 
on. 
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Programming using digital audio and 
rooms 

You can program a Control4 system using the Digital Audio and Room objects in Composer Pro. 
You can use digital audio events when a session starts or stops. A session is when a song or 
playlist begins and ends. A list of songs can be compiled into a playlist. You can compile the list 
by songwriter, album, song type, or any combination. Room events include turning the room off 
and on, when media sessions begin and end, etc. 

Program a button to play media or a playlist 
Use the Control4 Composer Pro Programming view to program a button on a keypad to play an 
album or playlist.  

Example: The example in this section uses a 6-Button Keypad for the Theater room. When you 
press Button 1, music or a movie plays in the Theater room. 

Prerequisites 

• Ensure that a 2, 3, or 6-Button Keypad is installed as directed in the Control4 2, 3, or 6 
Button Keypad Installation Guide. 

• Ensure that your project has an audio end point, such as Speaker Point, added and 
identified on the network. 

To program a button on a 6-Button Keypad to play music: 
1 Start Composer Pro and connect to a Director. 
2 Click Programming. 
3 In Programming in the Device Events pane, select the 6-Button Keypad. 
4 In the 6-Button Keypad Events pane, press Button 1, and select the Press radio button. 
5 In the Device Actions pane, select the Theater room. 
6 Click the Commands tab, and press the Select Media radio button. 
7 In the new window, select the media type to play, such as Playlist. 
8 Select the movie, playlist, etc. 
9 Click OK. 
10 In the Actions pane, drag the green arrow to the Script pane. 

http://dealer.control4.com/dealer/support/documentation
http://dealer.control4.com/dealer/support/documentation
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11 Click Execute in the Script pane. 

 

Program a button to turn up the volume 
Use the Control4 Composer Pro Programming view to let you use a keypad button to turn up the 
volume in a room.  

Example: The example in this section uses a 6-Button Keypad for the Theater room. When you 
press Button 2 the volume increases in the Theater room. 

Prerequisites 

• Ensure that a 2, 3, or 6-Button Keypad is installed as directed in the Control4 2, 3, or 6 
Button Keypad Installation Guide. 

• Ensure that your project has an audio end point, such as a Speaker Point, added and 
identified on the network. 

To program a button to turn up the volume: 
1 Start Composer Pro and connect to a Director. 
2 Click Programming. 
3 In Programming on the Device Events pane, select the 6-Button Keypad. 
4 In the 6-Button Keypad Events pane, press Button 2, and then select the Press radio 

button. 
5 In the Device Actions pane, select the Receiver. 
6 Click the Commands tab. In Sound, select Volume > Start > Up. 
7 Drag the green arrow in the Receiver Actions pane to the Script pane. 
8 Click Execute. 

http://dealer.control4.com/dealer/support/documentation
http://dealer.control4.com/dealer/support/documentation
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Program a button to add a room to another room’s music 
session 

Use the Control4 Composer Pro Programming view to use a keypad button to play music in 
additional rooms.  

Example: The example in this section uses a 6-Button Keypad for the Theater room. When you 
press Button 3, music starts playing in the Bedroom as well as the Theater room. 

Prerequisites 

• Ensure that a 2, 3, or 6-Button Keypad is installed as directed in the Control4 2, 3, or 6 
Button Keypad Installation Guide. 

• Ensure that your project has an audio end point, such as Speaker Point, added and 
identified on the network. 

To program a button to add another room's music session: 
1 Start Composer Pro and connect to a Director. 
2 Click Programming. 
3 In Programming on the Device Events pane, select the 6-Button Keypad. 
4 In the 6-Button Keypad Events pane, press Button 3, and then select the Press radio 

button. 
5 In the Device Actions pane, select Digital Media. 
6 Click the Commands tab. 
7 Use the pull-down menu to select the Theater room as the Selected Room. Select the Add 

Rooms radio button. 
8 Check the box next to Bedroom to indicate that this is the room that is going to join the 

music session. 
9 Drag the green arrow in the Digital Audio Actions pane to the Script pane. 
10 Click Execute. 

Set the default for a room’s music volume 
Use the Control4 Composer Pro System Design view to set the default music or media volume 
for a room. 

Example: The example in this section uses the Theater room. When you set the default, the 
volume stays at a certain level for the Theater room until you change it. You can change the 
volume for every room that uses music or media. 

Prerequisites 

• Ensure that the controller is added and identified on the network.. 
• Ensure that your project has an audio end point, such as Speaker Point, added and 

identified on the network. 

To set the default volume for a room: 
1 Start Composer Pro and connect to a Director. 
2 Click System Design. 
3 In the project tree, click a room. 
4 In the Properties pane, click the Miscellaneous tab. 

http://dealer.control4.com/dealer/support/documentation
http://dealer.control4.com/dealer/support/documentation


Composer Pro 2.5 User Guide   Examples: programming with variables 

233 

5 In the Miscellaneous tab, check the Enable Default Volume box. Adjust the Audio Volume 
and Video Volume as desired for the room. The default volumes are enabled immediately. 
Repeat these steps for each room in the Control4 system. 

Program a button using room programming 
Use the Control4 Composer Pro Programming view to use a keypad button to add another room 
to a program, for example, music.  

Refer to “Program a Button to Add a Room to Another's Room's Music.” The steps are the same, 
except that the example in that section refers to adding a music session. 

Examples: programming with variables 
Use the Control4 Composer Pro Programming view to program the Control4 system using 
configuration, properties, variables, delays and agents.  

Variables provide other programming options not available using commands, conditionals or 
loops.  

There are three (3) types of variables you can use: 

• Room Variables—Provide you with additional programming options not available in the 
Room object programming. Use Room object programming as a preference to room 
variables whenever possible. See “Example: Using Room Variables.” 

• Custom Variables—Let you define additional programming options using: 
• Boolean—Provides a True/False option. For example, the light is on or off. If the light is 

on, it is True; if the light is off, it is False.  
• Device—Provides a list of device options. 
• Number—Provides a value option. For example, the light level is 70 percent.  
• String—Provides the option to enter a string.   

To program using a custom variable, in the Agent view select Variable and click New to set 
up a new variable.  

Example: Use one keypad button to toggle between turning on the Theater Dimmer and the 
Theater Switch.  

• Container Variables—Provides the ability to connect two (2) or more devices together by 
using the device variables. A variable is a representation of information about the controlled 
devices, for example, a power state or current level of the device. It works much like a Media 
Scenes agent (see “Programming with Agents” for details). Container variables are available 
in the Agent view by selecting Variables.  

Note: Container variables are provided only for backward capability in Release 1.3 and 
later. Issues with various implementations have been found. The use of Container variables 
for future implementations is not recommended. Where possible, replace existing 
implementations with alternate programming.  

The sections below provide examples you can follow when you use variables. 
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Example: Using room variables 
Control4 room variables provide greater flexibility in programming, letting you program using 
events and actions at the room level.  

Note: Most of the functions in Room Variables are available by selecting the Room object which 
is the recommended method for programming the room. Whenever possible, use the Room 
object rather than Room Variables. 

To use room variables: 
1 Start Composer Pro and connect to a Director. 
2 Click Programming. In this view listed under every room in the project tree is a Room 

Variables object. 
3 Click to expand the Room Variables options. Room variables are available as events and 

actions. 

 

The room variables are described in the following table: 

Events/Actions Description 

CURRENT_SELECTED_DEVICE Lets you do programming when any device changes in the 
room. 

CURRENT_MEDIA Lets you do programming when any media changes in the 
room. 

POWER_STATE 
Lets you do programming when any device’s power state 
changes from True to False in the room (read only). A device 
in the room is required to detect the power state. 

CURRENT_VOLUME 
Lets you do programming when the volume of the currently 
selected audio path changes in the room (requires discrete 
volume). Use conditional programming. 
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Events/Actions Description 

HAS DISCRETE_VOLUME 
Lets you do programming when any devices changes in the 
room (requires discrete volume). Use command 
programming. 

HAS_DISCRETE_MUTE Lets you do programming when Mute state is known 
(MUTE_ON or MUTE_OFF). 

IS_MUTED Lets you do programming when in Mute state (MUTE_ON). 

IN_NAVIGATION Lets you do programming when On-screen is available. 

USE_DEFAULT_VOLUMES 

Lets you do programming any time a selection changes to 
reset the default volume. For example, when changing from 
viewing a DVD to listening to music, the volume is reset to the 
default discrete set volume. 

DEFAULT_AUDIO_VOLUME Lets you program the default Audio volume. 

DEFAULT_VIDEO_VOLUME Lets you program the default Video Audio volume. 

VOLUME_IS_LINKED Lets you set programming not to affect already linked volume. 

MUTE_IS_LINKED Lets you set programming not to affect already linked mute 
state. 

ROOMOFF_IS_LINKED Lets you set programming not to affect already linked room 
off state. 

SELECTIONS_LINKED Lets you set programming not to affect already linked 
selections. 

ROOM_HIDDEN Lets you set programming to hide rooms from appearing on 
the navigation device. 

MEDIA_SCENE_ACTIVE Lets you set programming to set a media scene as active. 

Variable handling 
In programming, variables are easier to define than conditional loops. 

Note: It is important to type the variable names precisely. A typographical error causes the 
program to fail. 

Variable handling enhancements: 

• Preserve user-defined variables—Preserves the user-defined variable values (for 
example, the current dimmer light level) across a normal system restart. It may not preserve 
them if the system shuts down abnormally. 

• Program a system startup event —Initializes variables or performs other programming at 
system startup with a system startup event (in Programming, select the root of the project, 
and then select the event When the project is loaded). 

• Define one variable to equal another—Defines one variable to equal another variable. 
This can be used to save and restore variable values. 
Example: The level of a light or the volume of music in a room. 

After this value is saved to the variable, you can restore the system variable to the value 
stored in the user variable. The system can then compare the two variables and determine if 
it needs to reset one of them. 

• Create the event “When a System reboots”—Sends an email notification to the Control4 
dealer that a customer’s system rebooted, helping the dealer monitor the system’s 
performance. 
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Example: Using custom boolean variables in an agent  
Use the Control4 Composer Pro Programming view to create custom variables in an agent using 
a Boolean value. 

In this example, when someone is at the door: 

• Program to activate the Media Scene 'Someone is at the door,' and turn on the porch light. 
• Program to play a song in the Bedroom and the Theater. 
• When the Motion Sensor stops sensing motion at the door, program to turn the music and 

porch light off. 

Prerequisites 

The following devices are added and identified in the project: 

• Controller 
• Porch Light Switch 
• Bedroom music 
• Theater music 
• Motion Sensor 

To program using a custom Boolean variable in an agent: 
1 Start Composer Pro and connect to a Director. 
2 Click System Design. 
3 Click Connections. Make sure the connections are correct.  

Note: Ensure that the Front Light is connected to the correct Contact Sensor on the 
controller.  

4 Click the Network tab, and ensure that the controller and Porch Light have a network 
address. 

Create a new variable 

5 Click Agents. 
6 Select Variable. The Variables view appears. 
7 Click New. 
8 On the dialog that appears, do the following:  

d Click New Variable. 
e In the drop-down menu, select Boolean. 
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f Name the Variable Power State and click OK. The default value is false. 

 

Create a media scene ‘Someone is at the door’ 

9 Select Media Scenes, and click New. 
10 Name the Media Scene Someone is at the door. Click OK. 
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Add the bedroom and theater room 

11 Click Add Room, and add the Theater and the Bedroom (see above). 

 

12 Set the volume in the Bedroom to 50, and the volume in the Theater to 75. 

 

13 Click Programming. 
14 In the project tree and the Device Events pane, click to expand Variables, and select Power 

State. 
15 In the project tree and in the Device Actions pane, click to expand Variables, and select 

Power State. 

Add the conditionals and commands 

16 Follow the previous programming steps to create a script with Conditionals. 
17 Click the Conditionals tab. 
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18 In the Conditionals tab, click Is False, and drag the blue question mark to the Script pane. 

 

19 Click the Commands tab. 
20 In the Commands tab, click Set to True, and drag the green arrow on top of the blue 

question mark in the Script pane to make it the first subset item of the first conditional. 
21 In the Device Actions pane, select Light Switch. 
22 Click the Commands tab. 
23 In the Commands tab, click On, and drag the green arrow on top of the blue question 

mark in the Script pane to make it the second subset item of the first conditional. 

 

24 In the project tree and in the Device Actions pane, select Media Scenes. 
25 Click the Commands tab. 
26 Click Activate in the Commands tab, and drag the green arrow on top of the blue question 

mark in the Script pane to make it third subset item of the first conditional. 
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27 In the project tree and in the Device Actions pane under Variables, select Power State. 
28 Click the Conditionals tab. 
29 In the Conditionals tab, click Is True, and drag the blue question mark to the Script pane. 
30 Click the Commands tab. 
31 In the Commands tab, click Set to False, and drag the green arrow on top of the blue 

question mark in the Script pane to make it the first subset item of the second conditional. 
32 In the project tree and in the Device Actions pane, select Light Switch. 
33 Click the Commands tab. 
34 In the Commands tab, click Off, and drag the green arrow on top of the blue question 

mark in the Script pane to make it the second subset item of the second conditional. 
35 In the project tree and in the Device Actions pane, select Media Scenes. 
36 In the Commands tab, click Deactivate, and drag the green arrow on top of the blue 

question mark in the Script pane to make it the third subset item of the second conditional. 

 

37 In the project tree and in the Device Events pane, select Media Scenes and select the event 
Someone is at the Door. 

38 In the project tree and in the Device Actions pane, select the Bedroom object. (Repeat the 
next four steps for the Theater.) 

39 Click the Commands tab. 
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40 In the Commands tab, click Select Media. 

 

41 In the dialogue that appears, select the album and song that you want to play when 
Someone is at the Door executes. In this example, Rhapsody’s ‘50s Hits’ is used. Click 
OK. 

42 Drag the green arrow to the Script pane. 
43 Repeat steps 37-41 for the Theater. 
44 In the project tree and in the Device Events pane, select Motion Sensor under Front, and 

select the event When the Motion Sensor senses motion. 

Add the Boolean Values 

45 In the project tree and in the Device Actions pane, click to expand Variables, and select 
Power State. 

46 In the Conditionals tab, click Is False, and drag the blue question mark to the Script pane 
(this is the third conditional). 

47 In the Commands tab, click Set to True, and drag the green arrow on top of the blue 
question mark to make it the first subset of the third conditional. 

48 In the project tree and in the Device Events pane, select the event When the Motion 
Sensor stops sensing motion. 

49 In the project tree and in the Device Actions pane, click to expand Variables, and select 
Power State. 

50 In the Conditionals tab, click Is True, and drag the blue question mark to the Script pane. 
51 In the Commands tab, click Set to False, and drag the green arrow on top of the blue 

question mark to make it the second subset of the third conditional. 
52 Click Execute. 

Results: The porch light turns on and plays a song in the bedroom and theater whenever the 
motion sensor senses motion at the front door. 
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Example: Using a custom number variable in an agent  
Use the Control4 Composer Pro Programming view to create custom variables in an agent using 
a numeric value. 

In this example, program one keypad button to toggle between turning on the Theater Dimmer 
and the Theater Switch. 

Prerequisites 

The following devices are added and identified in the project: 

• Controller 
• Dimmer (Theater) 
• Light Switch (Theater) 
• 6-Button Keypad 

To program using a custom variable agent number: 
1 Start Composer Pro and connect to a Director. 
2 Click System Design. Make sure the project has the correct devices and rooms. 
3 Click Connections. Make sure the connections are correct. 

Note: In the Network tab, ensure that the controller, dimmer (Theater), switch (Theater), and 
6-Button Keypad have a network address. 

Add a new variable 

4 Click Agents. 
5 Select Variables. The Variable Agents view appears. 
6 Click New. 
7 On the dialog that appears, do the following: 

a Select New Variable. 
b Name the variable Keypad releases. 
c Use the Variable Type pull-down and select Number. 
d Click OK. 
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8 In the Variables pane, select the variable Keypad_releases. The available variables for 

your devices appear in the right pane. 
9 Enter the value as 0 (zero). 

Create an event 

10 Click Programming. 
11 In the project tree and in the Device Events pane, select 6 Button Keypad. 
12 Click Button 1 on the 6 Button Keypad. 
13 Select Press for the event. The event appears at the top of the Script pane. 

Create the actions 

14 In the Actions pane, scroll down to view the agents. 
15 Click to expand Variables. 
16 Select Keypad_releases. 
17 In the Commands tab, select the following to add 1 to the present value: 

a Select the radio button by the plus (+) sign. 
b Ensure the plus sign is selected. 
c Select 1 (one). 

The action appears in the Actions pane. 

18 Drag the green arrow icon to the Script pane. 

Create the conditionals 

19 Click the Conditionals tab. 
a Select the Is radio button option. 
b Select the equals (=) sign. 
c Select 1 (one). 

20 Drag the blue question mark below the previous command in the Script pane. This places 
the conditional Action parallel to the previous Action command. 

21 In the Actions pane, select Theater Dimmer. 
22 In the Command tab, select On. The action command appears in the Actions pane. 
23 Drag the green arrow to the blue question mark in the Script pane to make it a subset of 

this conditional item. 
24 In the Actions pane, scroll down to Variables and select Keypad_presses. 
25 Click the Conditional tab. 

a Select the Is radio button option. 
b Select equals (=) sign. 
c Select 2 (two). 

26 Drag the blue question mark to the blank space under the previous Action command. This 
places the conditional Action parallel to the previous Action conditional. 

27 In the Actions pane, select Light Switch. 
28 In the Command tab, select On. The action command appears in the Actions pane. 
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29 Drag the green arrow to the blue question mark in the Script pane to make it a subset of 
the conditional item. 

 

30 In the Actions pane, scroll down to the agents. 
31 In the Variable agent, select the Keypad_presses variable. 
32 In the Commands tab, select the following: 

a Select the Set to Value radio button. 
b Set the value to 0 (zero). The Action command appears in the Actions pane. 

33 Drag the green arrow icon to the blue question mark icon in the Script pane to make it a 
second subset of the conditional. 

34 Click Execute. 

Results: Press Button 1 on the 6-Button Keypad to toggle between turning on the Theater 
dimmer and the light switch. 

Example: Using a custom string variable in an agent  
Use the Control4 Composer Pro Programming view to create custom variables in an agent using 
a numeric value. The steps in this section are for more advanced users of Composer Pro.  

In this example, program Button 4 on a Keypad to toggle through four (4) playlists.  

Note: This procedure is relatively complicated to create. Review the steps first to understand 
how the conditionals work. 

Prerequisites 

The following items are added and identified in the project: 

• Controller 
• 6-Button Keypad 
• 4 Playlists: Mom’s Favorites, Dad's Favorites, Choral Music, and Kid’s Music 
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To program using a custom variable agent string: 
1 Start Composer Pro and connect to a Director. 
2 Click System Design. Make sure the project has the correct devices and rooms. 
3 Click Connections. Make sure the connections are correct. 

Note: In the Network tab, ensure that the controller and the 6-Button Keypad have an 
address. 

Add a new variable 

4 Click Agents. 
5 Select Variables. The Variables agent list appears. 
6 Click New. 
7 On the dialog that appears, do the following:  

c Select New Variable, and name the variable My Playlists. 
d In Variable Type, use the pull-down menu to select String, and click OK. 

 

Set up a ‘Mom's Favorites’ playlist in the theater 

8 Click Programming. 
9 In Programming select the 6 Button Keypad in the Theater from the Device Events pane. 
10 In 6-Button Keypad Events, click Button 4 on the Keypad. 
11 In the Device Actions pane, scroll down and click to expand Variables. 
12 Select My Playlists. 
13 In the My Playlists Actions pane, click the Conditionals tab, and enter the name of a 

playlist; for example, Mom’s Favorites. 
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14 Drag the first blue question mark to the Script pane. 

 

15 In Device Actions, select the Theater room object. 
16 In Theater Actions, select Select Media. 
17 In the window that pops up, select Playlists, Mom’s Favorites, and then click OK. 
18 Drag the green arrow icon on top of the first blue question mark in the Script pane to make 

it the first subset of the first conditional. 

 

19 In Device Actions, select Variables > My Playlists. 
20 In the Commands tab under My Playlists, enter the name of the next playlist that you’d like 

to play; for example, Dad’s Favorites. 
21 Drag the green arrow on top of the first blue question mark to the Script pane to make it a 

second subset of the first conditional. 
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The next time the button on the keypad is pressed, the value of the variable will be Dad’s 
Favorites, and will then cue that playlist in the Theater. 

 

22 In Device Actions, scroll up and select the 6 Button Keypad in the Theater. 
23 In 6 Button Keypad Actions, click Button 4. 
24 Under Color Settings select LED On. 
25 Click the square of color to select the color you want Button 4’s LED to be when Mom’s 

Favorites plays. Select the color in the menu that pops up (in this example: green), and click 
OK. 
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26 Drag the green arrow on top of the first blue question mark in the Script pane to make it a 
third subset of the first conditional. 

 

27 In Device Actions, scroll down and select Programming Control. 
28 In the Programming Control Actions, select the Stop radio button. 
29 Drag the green arrow on top of the first blue question mark in the Script pane to make it a 

fourth subset of the first conditional. 

Note: It is important to add a Stop command here so that when the conditional is fulfilled, 
the programming will not continue. Because of the way this programming is set up when it’s 
finished, without the stop, the button on the Keypad will always select the last playlist in the 
script. 

 

Set up a ‘Dad's Favorites’ playlist 

30 In Device Actions, select My Playlists again. 
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31 In the Conditionals tab, next to ‘Is’ enter Dad’s Favorites in the text box. 
32 Drag the second blue question mark to the Script pane. 
33 In Device Actions, select the Theater. 
34 In Theater Actions, select Select Media. 
35 In the window that pops up, select Playlists, Dad’s Favorites, and then click OK. 
36 Drag the green arrow on top of the second blue question mark in the Script pane to make it 

the first subset of the second conditional. 

Set up a ‘Kid's Room’ playlist 

37 In Device Actions, select My Playlists. 
38 In the Commands tab under My Playlist Actions, enter the name of the next playlist that 

you’d like to play; for example, Kid’s Music. 
39 Drag the green arrow on top of the second blue question mark in the Script pane to make it 

a second subset of the second conditional. 
40 In Device Actions, select the 6 Button Keypad in the Theater. 
41 In 6 Button Keypad Actions, click on Button 4. Click the square of color to select the color 

you want Button 4’s LED to be when Kid’s Music plays. Select the color in the menu that 
pops up (in this example: purple), and click OK. 

42 Drag the green arrow on top of the second blue question mark in the Script pane to make it 
a third subset of the second conditional. 

43 In Device Actions, select Programming Control. 
44 In the Programming Control Actions pane, select Stop. 
45 Drag the green arrow on top of the second blue question mark to make it a fourth subset of 

the second conditional. 
46 In Device Actions, select My Playlists again. 
47 In the Conditionals tab, enter Kid’s Music. 
48 Drag the blue question mark to the Script pane to make it the third conditional. 
49 In Device Actions, select the Theater room object. 
50 In Theater Actions, select Select Media. 
51 In the window that pops up, select Playlists, Kid’s Music, and then click OK. 
52 Drag the green arrow on top of the third blue question mark in the Script pane to make it 

the first subset of the third conditional. 

Set up a ‘Choral Music’ playlist 

53 In Device Actions, select My Playlists. 
54 In the Commands tab under My Playlists, enter the name of the next playlist that you’d like 

to play; for example, Choral Music. 
55 Drag the green arrow on top of the third blue question mark to make it a second subset 

item of the third conditional. 
56 In Device Actions, select the 6 Button Keypad in the Theater. 
57 In 6 Button Keypad Actions, click on Button 4. Click the square of color to select the color 

you want button 4’s LED to be when Kid's Music plays. Select the color in the menu that 
pops up (in this example: red), and click OK. 

58 Drag the green arrow on top of the third blue question mark in the Script pane to make it 
the third subset of the third conditional. 

59 In Device Actions, select Programming Control. 
60 In the Programming Control Actions, select the Stop radio button. 
61 Drag the green arrow on top of the third blue question mark in the Script pane to make it a 

fourth subset of the third conditional. 
62 In Device Actions, select My Playlists again. 
63 In the Conditionals tab, enter Choral Music. 
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64 Drag the fourth blue question mark to the Script pane. 
65 In Device Actions, select the Theater room object. 
66 In Theater Actions, select the Select Media radio button. 
67 In the window that pops up, select Playlists, Choral Music, and then click OK. 
68 Drag the green arrow on top of the fourth blue question mark in the Script pane to make it 

the first subset of the fourth conditional. 
69 In Device Actions, select My Playlists. 
70 In the Commands tab under My Playlists, enter the name of the next playlist that you’d like 

to play; for example, Mom’s Favorites. 
71 Drag the green arrow on top of the fourth blue question mark in the Script pane to make it 

a second subset of the fourth conditional. 
72 In Device Actions, select the 6 Button Keypad in the Theater. 
73 In 6 Button Keypad Actions, click on Button 4. 
74 Click the square of color to select the color you want Button 4’s LED to be when Choral 

Music plays. Select the color in the menu that pops up (in this example: yellow), and click 
OK. 

75 Drag the green arrow on top of the fourth blue question mark to make it a third subset of the 
fourth conditional. 

76 In Device Actions, select Programming Control. 
77 In the Programming Control Actions, select the Stop radio button. 
78 Drag the green arrow on top of the fourth blue question mark to make it a fourth subset of 

the fourth conditional. 
79 In Device Actions, select the Theater room. 
80 In Theater Actions, select Media. 
81 In the window that pops up, select Playlists, Mom’s Favorites, and then click OK. 

Note: You do this is because the first time the button on the Keypad is pushed, the string 
variable does not have a value, and nothing happens. This last command is created when 
none of the conditionals are fulfilled, something will play; each time the button is pushed 
thereafter, a conditional is fulfilled. 

82 Drag the green arrow below the previous Stop command in the Script pane. It is not a 
subset of the previous conditionals, but a command on its own. 

83 In Device Actions, select My Playlists. 
84 In the Commands tab under My Playlists, enter the name of the next playlist that you’d like 

to play; for example, Dad’s Favorites. 
85 Drag the green arrow below the previous command in the Script pane. 
86 In Device Actions, select the 6 Button Keypad in the Theater. 
87 In 6 Button Keypad Actions, click on Button 4. Click the square of color to select the color 

you want Button 4’s LED to be when Mom’s Favorites plays. Select the color in the menu 
that pops up (in this example: green), and click OK. 

88 Drag the green arrow below the previous command in the Script pane. You do not need a 
stop at this point, because the programming automatically stops at the end of the script. 

Results: Press Button 4 on a 6-Button Keypad repeatedly to toggle through four (4) playlists. 
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Examples: Programming with agents 
Use the Control4 Composer Pro agents and Programming views to program agents. 

Major steps 
When you program with agents, you typically use these general steps:  

1 In Agents, define an instance of a type of agent. 
2 In Programming, use the instance of the agent to program event actions.  

Example: In the Agent view, you can create an instance of a Custom Button where you identify 
all the buttons you want to program. In Programming, you program the Custom Buttons.  

Note: Agents vary greatly in functionality and flexibility. 

Agent types 
• Advanced Lighting Scenes—Lets you change the lighting state, toggle lights, ramp/fade 

lights, delay on/off, use scene sequencing, flash lights, and so on. In OS 2.3.0, this agent 
supports the Panelized Lighting products with some limitations for older lighting devices. 

• Announcements—Plays a pre-recorded .WAV file, or displays a text message whenever a 
given event occurs. You can play an audio announcement on any audio output device with a 
supporting text message that displays on selected Navigators.  

Example: A doorbell announcement plays a .WAV file that sounds like chimes and displays 
the following text on a touch screen: “Someone is at the door” each time a doorbell is 
pressed. See “Example: Program using the Announcement agent.” 

• Custom Buttons—Lets you make user interface buttons for specialized devices on the 
Navigators. See “Example: Program using the custom buttons agent.”  

• E-mail Notification—Lets you send an email message to your email address when 
specified events occur as defined in programming. See “Example: Program using the E-Mail 
Notification agent.”  

Notes: (1) Remote Access is required to use the E-mail Notification agent. See the 
Composer Pro Getting Started for details about Remote Access.(2) Avoid setting up email 
notifications for events that occur frequently (e.g., when a Motion Sensor detects motion). If 
the email notification trigger event occurs too often, it will cause the system to become 
sluggish. 

• Intercom—Sets up the intercom audio function for 5” or 7” In-Wall Touch Screens (for OS 
2.0.2 and later); 7” In-Wall Touch Screens for OS 2.0.6 and later, 5” In-Wall Touch Screens); 
audio and video intercom for the 7” Portable Touch Screen (C4-TSMC7) for OS 2.2 and 
later; and the 7" In-Wall Touch Screen with Camera (C4-TW7CO) or Door Station – Exterior 
(C4-DSC-EN for OS 2.2.1 and later). It also lets you set up SIP for multi-dwelling units 
(MDUs). See “Example: Program using the Intercom agent.” 

• Lighting Scenes—Sets up a Lighting Scene.  

Example: By pressing one button on a keypad, you can turn on assigned lights to specified 
ramp levels. See “Example: Program using the Lighting Scenes agent.” 

• Macros—Macros agents associate programming with events.  

Example: You can create one macro to use in several different programming events or to 
use on a touch screen when creating Favorites. See “Example: Program using the Macros 
agent.”  

http://dealer.control4.com/dealer/support/documentation
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• Media Scenes—Creates a media scene that plays music in selected rooms on your system. 
See “Example: Program using the Media Scenes agent.”  

• Rhapsody—Lets you activate or disable a Rhapsody account. See “Example: Program 
using the Rhapsody agent.”  

• Scheduler—Defines conditionals of time to the system, and adds the ability to have 
scheduled events. See “Example: Program using the scheduler agent.”  

• Screen Saver—Lets you set up a Screen Saver agent so you can create various Screen 
Savers. See “Example: Program using the Screen Saver agent.”  

• SNMP Configuration—Lets you set up and configure devices to monitor via SNMP. 
Requires knowledge of SNMP and network management. See Example: Program using the 
SNMP Configuration agent. 

• Timer—Starts, stops, or repeats a timer based on a given event and action.  

Example: If a Motion Sensor in the system turns on a light when it detects motion, you can 
use a timer to turn off the light after 15 minutes. Alternatively, you can set a timer to repeat 
an action whenever the timer expires. See “Example: Program using the Timer agent.” 

• Variables—Create Boolean, string, and number variables. Review “Programming with 
Variables” for information about creating Variable agents.  

• Wakeup—Initiates a pre-specified wakeup time in the Navigators. This agent lets you play 
music, turn on lights, and change temperatures. See “Example: Program using the Wakeup 
agent.”   

The agent examples listed in the following sections will guide you through the programming 
steps for each agent type. 

Example: Program using the Announcements agent 
Use the Control4 Composer Pro Agents and Programming views to program this agent. 

You can create announcements that: 

• Display a text-message or Web page on any of the Navigators (on-screen Navigator  or 
touch screens) 

• Play a WAV-formatted audio announcement through any audio end point 
• Combine the two mentioned above 

Note: The Control4 system allows up to 10 MB of files for the Announcement agent, and plays a 
maximum of 15 seconds per announcement. 

Example: This example demonstrates how to create a 'Dinner is Ready' announcement that is 
activated when the family chef (or dad) presses a custom-programmed button. When the button 
is pressed, the text message, 'Come to Dinner!,' displays on all of the Navigators in the home, 
and an audio file of a dinner bell ringing plays. 

Prerequisites 

The following devices are added and identified (with a network address) in the project: 

• Controller 
• Audio output device (television or connected speakers) 
• Navigator with a screen (touch screen or television) 
• Any device involved in the triggering event (doorbell contact, 3-Button Keypad, etc.) 

To set up an Announcements agent: 
1 Start Composer Pro and connect to a Director. 
2 Click Agents. 
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3 (First time only) Click Add to add the Announcements agent to the project. 
4 Select Announcements, and then click OK to add Announcements to the agent types list in 

the project. The next time you want to create an announcement, just select the 
Announcements item in the Agents pane and click New. 

5 With Announcements selected in the left pane, click New. 
6 Name the new announcement, and click Create. Example: Come to Dinner! 
7 Set up the Navigator text message you want to display. 

 

a Check the Display Navigator Text/Image Popup box. 
b Click Edit Text/Image. 
c Type a text message, a URL, or browse to an image (JPG, GIF, or PNG) to display. 

The text box accepts any HTML code. While certain links and scripts won’t be handled, 
when the announcement is triggered, for example, if you put this text in an 
announcement, it will show up just as if it were a web page. For example, the following 
HTML text will display the latest snapshot of a web page: 

<HTML><BODY><IMG 
SRC="http://tbn0.google.com/images?q=tbn:1uOhCnlc3zbQgM:http://www.inkycircus.c
om/jargon/images/mountain.jpg" ALT="pumpkin"><a 
href="http://www.w3schools.com/">Visit W3Schools!</a></BODY></HTML> 

Note: A static image file (JPG, GIF, or PNG) only has to be added to your project once 
because it is copied to the controller. When added, it is available in the Text Message 
drop-down menu for use in any additional announcements created. 

d Select the time you want the text message to display using the Close after drop-down 
menu (supported display times are from five (5) seconds to 10 minutes). 

e Click Add/Remove and check the Navigators that will display the message. Click OK. 
8 Audio file—Add a WAV audio file, and set up the audio file to be played. 

a Check the Play Audio File box. 
b (One time per audio file) Click Add and browse to the WAV audio file to add it to the 

drop-down menu. 
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Note: An audio file only has to be added to your project one time because it is copied to 
the controller. When added, it is available in the Audio File drop-down menu for use in 
any additional announcements created. 

c Select the WAV file from the drop-down menu. 
d Click Add/Remove Rooms and check the rooms where the audio file will play. Click 

OK. 
e Set the volume of the audio play for each room. 

Note: The volume for an announcement only can be set on devices with discrete 
volume control. 

 

9 Click Programming. 
10 Verify that the new Announcements agent displays in the Actions list (bottom of list). 

a Select Announcements. 
b Make sure the 'Come to Dinner!' message displays in the Announcement Actions pane 

and that the command is there (green arrow). 
11 Program the announcement to play or display with a triggering event. 

Example: Program a button-press event (left pane) to trigger the Announcements agent to 
run 'Come to Dinner!' (right pane). 
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Example: Program using the Custom Buttons agent 
Use the Control4 Composer Pro Custom Buttons agent to create up to four (4) custom screens 
to display on the Navigators (including touch screens, MyHome apps, and on-screen). 

Example: If you have a heated driveway or some other specialty device, you can set up a 
screen with custom buttons to operate the heated driveway from the Navigators. 

Guidelines 
• You can access each screen on the Navigators from the Control4 main menu or for a room 

from four (4) available tabs. Example: The heated driveway screen is accessed from a 
custom tab on the main menu. You can configure the tab to be viewed system-wide on all 
screens, or to view in one room only. 

• The Navigators allow up to four (4) tabs per room to access custom screens with custom 
buttons. Each screen can provide up to six (6) custom buttons for a total of 24 custom 
buttons. The four (4) tabs in each room can be allocated as either room or as global tabs. 

• On the Navigators, you can set up a room or global tabs. The example shows the creation of 
custom tabs that appear in the Front Room and access a custom screen. 

Note: If you want to create a Custom tab to appear globally, check the Global box next to the 
Screen Name. Because only four (4) screens are available for each room, if a Global button is 
added and another room already has four (4) screens, the Global button replaces the first screen 
in that room. 

Prerequisites 

The following devices are added and identified (with a network address) in the project: 

• Controller 
• Electronic Gate (In the Control & Audio Video Connections tab, ensure that the Electronic 

Gate is connected to controller relay Port 4.) 

To set up a Custom Buttons agent: 
1 Start Composer Pro and connect to a Director. 
2 Click Agents. 
3 (First time only) Click Add to add the Custom Buttons agent to the project. 
4 When the dialog appears, from the list, select Custom Buttons. 
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5 Click OK. 

 

6 Select the Custom Buttons agent. 
7 From the list that appears in the left pane, select the room for the custom button; for 

example, select Family. 

 

8 When the Custom Buttons interface appears, in the Screen 1 area, click Add. Note: In the 
Navigator, Screen 1 appears in the top left corner; Screen 2 appears in the lower left corner, 
Screen 3 appears in the top right corner, and Screen 4 appears in the lower right corner. 

9 Enter the name of the buttons to appear on the Navigator screen. 
10 Enter the relevant information for the device. 

The Screen Name is the name that appears on the access tab to enter the custom screen. 
The buttons are the names that appear on the custom buttons. 



Composer Pro 2.5 User Guide   Examples: Programming with agents 

257 

Example: For the Garage Door, enter the following: 

• Screen Name: Garage Door 
• Button 1: Toggle 

11 Click OK. 

 

12 Click the Programming view to program your Custom Buttons. 
13 In the Device Events pane, scroll down to the agents and select the Custom Buttons agent. 
14 In the Custom Buttons Events pane, ensure that Family-Garage Door is selected under the 

Event Screen next to Toggle, and then select the Press radio button. When custom button 
‘Toggle’ on screen ‘Garage Door’ in Family is pressed, it appears at the top of the Script 
pane. 

 

15 In the Actions pane, select Garage Door. 
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16 From the Command tab, select the Toggle the Garage Door radio button. The action 
command appears in the Actions pane. 

17 Drag the green arrow to the Script pane. 
18 Select File > Refresh Navigators. 

Example: Program using the E-Mail Notification agent 
IMPORTANT! An active 4Sight Internet Service subscription is required for Email Notification to 
work. See Composer Pro Getting Started or the Control4 System User Guide. 

Use the Control4 Composer Pro E-Mail Notification agent to have an email sent to an email 
address automatically when specific events occur as defined in programming. 

Example: If you want to know when the basement door opens, you can set up an E-mail 
Notification agent to send an email to your email application’s Inbox when the Basement door 
opens. 

• The E-mail Notification is a Control4 service. To use E-mail Notification agent, remote 
access is required to facilitate a secure connection between the controller and the Control4 
service. 

• The E-mail Notification agent uses templates to enhance usability. You can use a template 
to define a To, Subject, or Body for use when creating instances of the Email Notification 
agent. See "Connecting to a Director Using Remote Access" in Composer Pro Getting 
Started. 

• Use the Programming view to define the individual instance that triggers an email and 
completes the definition. 

Example: A security threat to the house notified you of broken windows, doors opening, and 
motion detected in Away mode. In the template, you define Subject: Security Alert and To: 
fsmith@myemail.com. In the Programming view, you might define the zone. Examples of other 
incidents to use E-mail Notification include: Basement Door Opened, Front Gate Opened, Water 
Sensor detection, Carbon Monoxide Sensor detection, Motion Sensor detection, Sprinklers 
On/Off, etc. 

Tip: When setting up an E-mail Notification agent, note the frequency that an event can happen; 
because if it is too frequent, it can slow down the system. For example, if an email is sent when a 
Motion Sensor detects motion, the frequent email messages could cause sluggishness. 

Prerequisites 

The following example devices are added and identified (with a network address) in the project: 

• Controller 
• Door Contact Sensor 

To set up an E-Mail Notification agent: 
1 Start Composer Pro and connect to a Director. 
2 Click Agents. 
3 (First time only) In the Agents view, click Add to add the E-mail Notification agent to the 

project. 
4 When the dialog appears, select Email Notification. 
5 Click OK. 
6 Select Email Notification, and click Add in the pane that follows. The New Template Name 

dialog appears. 

Tip: Control4 now includes Control4 system and user-defined variables in the templates 
created using this agent. To use this function, you can create or modify email templates 
using Composer Pro > Agents > E-Mail Notification, and then use the Add Variable option. 

http://dealer.control4.com/dealer/support/documentation
http://dealer.control4.com/common/pagedetail.aspx?PageCode=Documentation
http://dealer.control4.com/dealer/support/documentation
http://dealer.control4.com/dealer/support/documentation
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7 Enter a name on the dialog that appears, for example, 'Security Alert.' 
8 Click Create. 
9 In Email Notification Template Name, select Security Alert for the Composer Pro email 

screen to appear. 
10 Fill out the information for the email you want sent to you when an event occurs. 

Example: 

To: fsmith@myemail.com 

Subject: Security Alert 

Body: The security of the Franklin Smith House may have been compromised. 

 

11 Do the following as needed: 
a Click Send Email to test and see if you receive and email to your email address. 
b Click Add Variable if you've created a variable agent. Scroll down the list to locate the 

variable, and then click OK. 
c Click Save to exit and go to the Programming view to set up the programming. 
d Click Reset to clear the To, Subject, and Body of the email to start again. 

12 With the Agent template created, you can create one instance of the Security Alert for each 
security zone (or object). When you've saved the template, click Programming. 

13 In Programming under Theater, select Door Contact Sensor. 
14 In Door Contact Sensor Events, select When Door Contact Sensor opens. 
15 In the Actions pane, scroll down and select Email Notification. 
16 Make any changes to the email as necessary. 
17 Drag the green arrow to the Script pane. 
18 In the File menu, click Refresh. 
19 Test the Email Notification agent by going to the door and opening it. An email is sent to 

your Inbox with the Security Alert as a subject. 



Composer Pro 2.5 User Guide  Example: Programming Intercom with a macro 

260 

Example: Programming Intercom with a 
macro 

Example: The steps below use an example where a macro is set up to monitor the Master 
Bedroom from the Kitchen using the intercom on both 7" In-Wall Touch Screens. 

To set up a program that monitors a room using the Intercom agent: 
1 If the Macro agent hasn't been added to the project, add it (Agents view > Add > Macros). 
2 Create a new macro called Monitor Master Bedroom. 
3 In the Programming view, create programming for the "Monitor Master Bedroom" macro 

event (Programming > Macros in the Device Events pane, and then select the macro 
Monitor Master Bedroom). 

4 Add the programming to start monitoring the Master Bedroom (Programming > Actions > 
Intercom in the Device Actions pane). 
a In the Commands tab, select the device that will be doing the monitoring: 7” In-Wall 

Touch Screen in the Kitchen. 
b Select the Session Action: Monitor. 
c Select the Target Intercom Device that will be monitored (Master Bedroom). 
d Drag the green arrow to the Script pane. 

5 Test the Programming by clicking Execute. 

Tip: You can add the macro to a Custom Home page on the Navigator; another option is to 
program this same action against a button press on a keypad.  

Example: Program using the Light Properties agent  
Use the Control4 Composer Agents and System Design views to add and configure dimmable, 
non-dimmable, and 0-10V lights for Panelized Lighting devices. 

Use this agent to make it easy to set up load and wattage information in the Panelized Lighting 
Properties pages for a project. 

To use the Light Properties agent: 
1 Start Composer Pro and connect to a Director. 
2 Click Agents. 
3 (First time only) Click Add to add the Light Properties agent to the project. 
4 Select Light Properties, and then click OK. 

In the Light Properties pane, change the columns for each light in the Panelized Lighting 
system. 

Note: Ensure that the Panelized Lighting module is added and identified to the system. After 
you do, the name of the device will display in this agent’s Light Properties pane. See the 
Panelized Lighting Quick Start Guide for details. 

These options are editable. 

• Name—The name of the module you identified in the system. 
• Load Number—Assign a load number for each module in the system. 
• Watts—Assign the wattage for each module in the system. 
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Example: Program using the Lighting Scenes agent 
Use the Control4 Composer Pro Agents and Programming views to program this agent. Lighting 
Scenes let you set up lights in a home at a pre-determined setting and ramp rate. See also 
“Example: Program using the Advanced Lighting agent” in this document to set up more 
advanced features. Both agents will communicate with each other.  

Notes: (1) The Off state in Lighting Scenes is available only in programming and is not in the OS 
2.0 Flash Navigators. Use specific Off scenes where needed for the Navigators. (2) You must 
add the Advanced Lighting agent to the project before your customers can edit Lighting Scenes 
on a Navigator.  

Example: Set up the Bedroom Dimmer and Theater Dimmer at a pre-determined level and ramp 
rate when turned on. Turn the switch off and on. Assign the Lighting Scene to Button 1 on a 6-
button keypad. 

Prerequisites 

The following devices are added and identified (with a network address) in the project: 

• Controller 
• Theater Dimmer 
• Theater Switch 
• Bedroom Dimmer 
• 6-Button Keypad 

To set up a Lighting Scenes agent: 
1 Start Composer Pro and connect to a Director. 
2 Click Agents. 
3 (First time only) Click Add to add the Lighting Scenes agent to the project, and then click 

OK. 
4 In the Agents pane, select Lighting Scenes and then click New. 
5 Enter a name on the dialog that appears (for example, Evening Lights). 
6 Click Create. 
7 The instance of the agent you created appears below the Agents pane. Select the instance 

you just created, and click Add/Remove Load to continue. 
8 Check the lighting loads that you want to add, and then click OK. This can be a single light, 

a single room, all lighting loads in an entire house, or any combination of these options. 
9 Set the specific settings for each load: 

• Dimmer Options: 
• Level—Lets you set a lighting level as appropriate by using the bar or Level pull-

down menu, for example, 50 percent for the Bedroom Dimmer and 20 percent for 
the Theater Dimmer. 

• Ramp Rate—Lets you set the Ramp Rate, which is the speed the load ramps to 
the specified lighting level. Use the pull-down menu to set the Milliseconds, 
Seconds, or Minutes of the ramp rate. Then set the amount of time you want the 
level to change. Example: Set the time to 1 second for both the Bedroom Dimmer 
and the Theater Dimmer. 

• Remove Load—Lets you remove this particular load by clicking Remove Load. 
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• Switch Options—You can turn the light On or Off for the Theater Switch. Example: 
Lighting Scene, select Off. 

 

10 When the settings are configured for each load in this Lighting Scene, click Execute On 
Scene. Note: Other buttons may apply as needed: 
• Add/Remove Load—Click to add or remove dimmers or switches. Select the dimmer or 

switch from the project tree and click OK. 
• Execute On Scene—Click to have all dimmers and switches in this scene turn on when 

executed. 
• Execute Off Scene—Click to have all dimmers and switches in this scene turn off when 

executed. Can combine with other scenes to turn off. 
• Convert to Adv Scene. Click to convert this scene to an Advanced Lighting agent. The 

scene will show up in the Advanced Lighting agent if it has been added to the project. 
• Sync This Scene—Click to synchronize the behavior of the devices in this scene. Used 

mostly for updates and testing. 
• Sync All Scenes—Click to synchronize the behavior of all devices in all scenes. Used 

mostly for updates and testing. 
11 A dialog appears that the scene is executed. Click OK. 
12 Click Programming. 
13 In the project tree, select the device to program. Example: 6-Button Keypad. 
14 In the Events pane, click an event. For example, if you chose the 6-Button Keypad, click 

Button 4. 
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15 Select Press at the event to trigger programming. The event appears at the top of the Script 
pane. 

 

16 From the Actions pane, scroll down to view the available agents in the project tree. 
17 Select the agents that you want to use in programming. Example: “Lighting Scenes” and 

'Evening Lights.' The available commands appear in the Lighting Scenes Device Actions 
pane and Commands tab in Lighting Scenes Actions. 

 

18 In the Commands tab, select the command to view it, for example, 'Evening Lights - ON.' 
19 Drag the green arrow to the Script pane. 
20 Press Button 4 on the 6-button keypad, or click Execute in the Script pane to test the 

Lighting Scene. 
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Example: Program using the Macros agent 
Use the Control4 Composer Pro Agents and Programming views to program this agent. Macros 
agents are routines that associate programming with events. Examples: You can create and 
name a macro to use in several different programming events. The macro can be called from a 
particular program in the Programming Actions pane or you can create a Favorite on your touch 
screens or on-screen Navigator to call a Macros agent. 

You can create Macros agents: 

• To use in various programmed events 
• To use in Custom pages 
• To embed directly into the Navigators 
• To create shortcuts (Favorites) 

Prerequisites 

The following devices are added and identified (with a network address) in the project: 

• Controller 
• Light Switch 
• Navigator with a screen (touch screen, MyHome app, TV screen, etc.) 
• Any device involved in the triggering event (doorbell contact, 3-Button Keypad, etc.) 

To set up a Macros agent: 
1 Start Composer Pro and connect to a Director. 
2 Click Agents. 
3 (First time only) Click Add to add the Macros agent to the project. 
4 Select Macros, and then click OK. 

To create a new Macros agent: 
1 Select Macros in the Agents pane, and click New. 
2 Name the new macro, for example, Bob, and then click Create. 

To add the agent's programming script: 

In this example script, you will select the Family Room Switch which is on, and then turn off 
everything in the Living Room. 

1 Click the Programming view. 
2 In the Device Events pane, scroll down to Macros and select Bob. "When Bob is executed" 

appears in the Script pane. 
3 In the Device Actions pane, select Family Room and the Switch. 
4 Under Light, select On. 
5 Drag the green arrow ‘Turn on the Family > Switch' to the Script pane. 
6 Under Light, select Off. 
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7 Drag the green arrow 'Turn off the Family > Switch' to the Script pane. 

 

8 You can add the Macros agent to many programs that you create if you want to perform 
similar tasks, or you can program the agent for a specific device. For example, you can 
assign this agent to Button 1 on a 3-Button Keypad to run the program when executed. 

Note: A unique Macros agent cannot be edited or copied; only created or deleted. If you 
want to create a new Macros agent based on another one, you must create a new one. 

Example: Program using the Media Scenes agent 
Use the Control4 Composer Pro Media Scenes agent to allow simpler multi-zone audio control. 
Media Scenes link source, volume, and room-off commands. With Media Scenes, you can 
configure one or more rooms in a system to play the same music at the same volume.  

Example: A Media Scene for the entire house can include all the rooms in the Control4 system. 
Another Media Scene can include only the Master Bedroom and Bath. You can create any 
number of Media Scenes containing any number of rooms. 

Guidelines 
• To successfully activate a Media Scene (with the rooms being controlled simultaneously), 

activate the Media Scenes agent before starting any music playback. 
• Media scenes are persistent; when activated, a Media Scene remains active until 

deactivated or until the controller is powered down. If a Media Scene is deactivated while 
music is playing, the music continues to play in the associated rooms, but the rooms are no 
longer controlled in unison. Therefore, music can be stopped in one room while it continues 
to play in another room. 

• You can set up a Media Scene one time, and activate it when desired. Then play the music. 

To create a Media Scenes agent: 
1 Start Composer Pro and connect to a Director. 
2 (First time only) In the Agents view, click Add to add the Media Scenes agent to the project. 
3 On the dialog that appears, click Media Scenes, and then click OK. 
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4 In the Agents pane, select Media Scenes, and click New. 
5 Enter a name for your new Media Scene. Example: Party Music. 
6 In the Agents pane, select Party Music, and then click Add Room in the Media Scenes 

pane. 

 

7 In the dialog box is a list of rooms in your system. Check the rooms where you want to play 
your Party Music, and then click OK. Example: Theater and Family. 

Tips: To remove a room from a scene, click Remove Room. To create another Media 
Scene, return to Step 1. 

 

Tip: You can add all rooms on a floor by clicking, for example, Main. This automatically 
selects all other rooms in that category. You can also include all rooms in your entire system 
in the Media Scene by clicking House. 
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The rooms you selected appear in the new Media scene 'Party Music.' 

 

8 To activate the scene, click Activate Scene at the top of the screen. 
9 To deactivate, click the Deactivate Scene button.  
10 You can program a button for your Media Scene. Do this by creating a new Custom Button. 

a In the Agents view, click Custom Buttons, and then below, click a room. In the Custom 
Buttons pane, click Add. 

b In the Add Screen dialog that appears, enter the name of the Custom Button, and then 
click OK.  

Example: Click Theater and call the Screen name Media Scene. Name Button 1: On/Off 
and click OK.  

The custom button name appears in the pane.  

11 Click the Programming View. 
12 In the Device Events pane, scroll down and click Custom Buttons. In the pane below, 

Custom Button Events, select the screen you want to program, and then select the Press 
radio button.  

Example: Select the screen Kitchen - Media Scene, and select the Press radio button.  

13 In the Actions pane, select Kitchen. 
14 In the Kitchen Actions pane under Conditionals, press the Media Scene Active button 

which also selects True. 
15 Drag the blue question mark to the Script pane. 
16 In the Actions pane, scroll down and select Media Scenes. 
17 In the Media Scenes Actions pane under Commands, press the Deactivate button, and then 

select Party Music. 
18 Drag the green arrow on top of the blue question mark in the Script pane. 
19 In the Actions pane, scroll up and select Kitchen. In the Kitchen Actions pane and in 

Conditionals, press the Media Scene Active button, and then the False button. 
20 Drag the blue question mark to the Script pane. 
21 In the Actions pane, scroll down and select Media Scenes. In the Media Scenes Actions 

pane and in Commands, press the Activate button, and then select Party Music. 
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22 Drag the green arrow icon on top of the blue question mark in the Script pane.  

 

The Script pane now reads, 'When custom button ‘On/Off’ on screen ‘Media Scene’ in 
Kitchen is pressed...Activate scene ‘Party Music.’' 

23 To execute the scene, click Execute. 

Example: Program using the Scheduler agent 
Use the Control4 Composer Pro Agents and Programming views to program this agent. The 
Scheduler agent lets you schedule time on the Control4 system to trigger specific events to 
occur. You can program a specific one-time event or multiple events to re-occur daily, weekly, 
monthly, yearly, etc.  

Example: Schedule an event to play dad’s favorite song at 7:30 AM on his birthday. 

Prerequisites 

The following devices are added and identified (with a network address) in the project: 

• Controller 
• 3-Button Keypad 

To set up a Scheduler agent: 
1 Start Composer Pro and connect to a Director. 
2 Click Agents. 
3 (First time only) In the Agents pane, click Add to add the Scheduler agent to the project. 
4 Select Scheduler in the Agents list, and click OK. 
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5 In the Agents pane, select Scheduler. The Scheduler panes appear. 

 

6 In the Scheduler pane, click New. 
7 In the New Event dialog, enter the relevant information for this Scheduler instance: 

a In Name: type Dads Birthday. 
b In Time, add the following: 

• Select the Time radio button. 
• Highlight the hour: 07, minutes: 30, and AM. Use the drop-down menu to select 

each time separately, or 
• Select Sunrise/Sunset, and select Sunrise from the drop-down menu. 

c In Randomize time by +/-, keep the default of 15 minutes. This executes the Scheduler 
either 15 minutes before or 15 minutes after the actual time you assigned. This is useful 
when you go on vacation and you want your lights to go on at different times so 
outsiders think someone is home.  

d In Start Date, select one of the following: 
• Select the Start on radio button. Use the drop-down menu and select today’s date. 
• Select the Start on the radio button to select an exact day, month, and year. Use 

the drop-down menus to make your selections. 
e Select Repeats. 

• Select Yearly. 

Example: You want dad’s favorite song to play at 7:30 AM. This dialog lets you 
schedule one-time events and recurring events. 

• Select Stop on, and use the drop-down menu to select a month and year to stop 
this agent. 

f Click OK. The event is now added to the list of events. 
g To delete an event, select the event in the list, and click Delete. 

8 Click Programming. 
9 In the Device Events pane, select the Scheduler object at the bottom of the list. 
10 In Scheduler Events, click Dads Birthday event. The Script pane shows Dads Birthday 

event. 
11 Select the device actions to initiate in the Actions panes. 
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12 Drag the actions to the Script pane. These scripted actions execute when the Dad’s Birthday 
event executes. 

13 You can use the Scheduler agent in programming also to add conditionals or loops to your 
scripts. 

14 In the project tree, select 3 Button Keypad. 
a In the Actions pane, scroll down and select the Scheduler agent. 
b Click the Conditionals tab, select Time, and Within 5 minute(s) Before Sunset. 
c Drag the blue question mark to the Script pane. 
d In the project tree, select the light. 
e In the Commands tab, select turn the room on, and drag the green arrow on top of 

the blue question mark in the Script pane. 

Results: When the top button on the 3-Button Keypad is pressed, if it is within five (5) 
minutes before sunrise, the light comes on. The Scheduler agent lets you define one-time 
events and recurring events. 

Example: Program using the Screen Saver agent 
Use the Control4 Composer Pro Agents view to set up a Screen Saver agent. 

Prerequisites 

Ensure that the devices you will use to set up a screen saver and store your photos (for example, 
a network-attached storage device) are attached to the Control4 system are attached to the 
primary controller. If you use a USB device, ensure that it is formatted to FAT 32. 

To set up a Screen Saver agent: 
1 Start Composer Pro and connect to a Director. 
2 Click Agents. 
3 (First time only) Click Add to add the Screen Saver agent to the project. 
4 Select Screen Saver, and then click OK. The next time you want to create a Screen Saver, 

click the Screen Saver item in the Agents pane, and then click New. 
5 From the drop-down menu, select the File Storage Location. 
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6 Click the Media view. 
7 Click Screen Saver in the Media pane. 
8 Click Add to scan and add new photos to the Screen Saver pane from the device you 

selected in the Network Storage Location box. 
9 To set up a custom screen saver on the Navigators, see also: 

• “Setting Up the Photo Screen Saver Option” 
• “Setting Up Custom Screen Saver”  
• Control4 System User Guide 

Example: Program using the Timer agent 
Use the Control4 Composer Pro Agents and Programming views to program this agent. The 
Timer agent lets you start, stop, or repeat a timer based on a given event and action.  

Example: A Motion Sensor turns on a light when it detects motion; use a timer to turn off the 
light after 15 minutes. Alternatively, you can set a timer to repeat an action whenever the timer 
expires, such as a Bathroom fan that restarts each time the Bathroom light turns on. 

Prerequisites 

The following devices are added and identified (with a network address) in the project: 

• Controller 
• Any device involved in the triggering event (for example, a Motion Sensor) 

To set up a Timer agent: 
1 Start Composer Pro and connect to a Director. 
2 Click Agents. 
3 (First time only) Click Add to add the Timer agent to the project. 
4 Select Timer, and then click New. 
5 Type the name of the new timer (for example, Bathroom Fan), and click Create. 
6 In Interval, use the drop-down menu to set the timer in seconds, minutes, or hours 

(hh:mm:ss), and click OK. 
7 Click Start to start the timer. 
8 Click Programming. 
9 Select the Timer Action in the Actions pane, and ensure the new timer options display in 

the Commands tab (Start, Stop, Reset, and Change). 
10 Start, Stop, Restart, or Change the timer as needed. 

The following table outlines how the timer behaves depending on the state of the timer when 
a command is executed. 

Command  
Executed is... Time is... Then Event Effect on Timer 

Start Running None Restarts 
Reset   Stop and Start Restarts 
Stop   Stop Stops 
Start Not Running Start Starts 
Reset   Start Starts 
Stop   Stop Stops 

 

http://dealer.control4.com/dealer/support/documentation
http://dealer.control4.com/dealer/support/documentation
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• When you program to execute a Start command on a timer when a timer is running, no 
event is fired and the time is restarted. 

• When you program to execute a Start command on a timer when the timer is not 
running, the Start event is fired and the timer starts. 

• When you program to execute a Reset command on a timer when a timer is running, 
the Stop and Start events are fired and the time is restarted. 

• When you program to execute a Reset command on a timer when a timer is not 
running, the Start event is fired and the time is restarted.  

11 Program to connect the timer to an event and action, and choose to Start, Restart, or Stop 
the timer.  

See the example programming screens that follow. Notice how the timer is first used as an 
action, and then as an event. 

Event screen: 

 

Action screen: 
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Example: Program using the Variables agent 
Use the Control4 Composer Pro Agents view to set up a Variables agent. Ensure that the 
devices you want to use for variables are added and identified to the system.  

These sections provide information about how to create the type of variable that you want to use 
in programming.  

• “Example: Using room variables” 
• “Example: Using a custom variable agent number” 
• “Example: Using a custom string variable in an agent” 
• “Example: Using custom Boolean variables in an agent” 

Example: Program using the Wakeup agent 
Use the Control4 Composer Pro Agents and Programming views to program this agent. The 
Wakeup agent lets you set wakeup times, lighting, music, and so on.   

Note: Wakeup times set in Composer Pro synchronize with the Navigators. Likewise, wakeup 
times changed on the Navigators will synchronize with Composer.  

Example: At a user-specified time in the Navigators, start playing music from a CD in the 
Bedroom, and move the light progressively from 10 to 70 percent light level in 15 minutes. Thirty 
(30) minutes before wakeup starts, adjust the temperature in the room to 72 degrees. After 15 
minutes of playing music, turn on the TV and broadcast the Local News. 

Prerequisites 

The following devices are added and identified (with a network address) in the project: 

• Controller 
• Digital Audio (ensure that you can play music in the project) 
• Bedroom Dimmer 
• Gas Fireplace 

The following agents need to be added: 

• Wakeup Scene 1 and 2 
• Scheduler for ‘Bedroom Wakeup' 

To set up a Wakeup agent: 
1 Start Composer Pro and connect to a Director. 
2 Click Connections. 
3 Make sure the connections are correct. Example: From the Control & Audio Video 

Connections tab, ensure that the Gas Fireplace is connected to Relay Port 1. 
4 Schedule a Wakeup time (see “Example: Program using the Scheduler agent”). 
5 Click Agents. 
6 (First time only) Click Add to add the agent to the project. 
7 Select Wakeup, and then click OK. 
8 In the Agents pane, select Wakeup. The Wakeup interface panes appear. 
9 In the Wakeups pane, click New. 
10 On the dialog that appears, enter a name. Example: Bedroom Wakeup. 
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11 Click Create. 

 

12 Enter Wakeup Scene 1 information. 
• Media—Click Choose Media (default). Use the drop-down menu to select Playlists, 

and then click a particular album and song you want to play when the Wakeup starts, 
such as ‘Choral Music.' Set the desired volume using the scrollbar or the drop-down 
menu. Select Shuffle or Repeat. 

• Lights—Use the scrollbar or enter the Light Level to 70; use the drop-down menu to set 
the Ramp Rate to 15 minutes. 

• Temperature—Set the temperature to 72 degrees F to come on 30 minutes before 
wakeup starts. 

 

13 Enter Wakeup Scene 2 information. 
14 Scene 2—Check Wakeup Scene 2 and set the Start time to 15 minutes after Wakeup 

Scene 1. Set the desired volume for Scene 2 using the scroll bar or drop-down menu. 
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• Media—Click Choose Media and use the drop-down menu to select Broadcast Video. 
Then, select a local channel, such as 4-KTVX and click OK. Select Volume at 70. 

• Lights—Uncheck the box to make no changes for Wakeup Scene 2. 
• Temperature—Uncheck the box to make no changes for Wakeup Scene 2. 

 

15 Click the Programming view.  

Note: Your scene saves automatically even when you leave the Agent view.  

16 In the Device Events pane, scroll down to view the available agents. 
17 Select the Scheduler agent and Scheduled Event. 

The agent event appears at the top of the Script pane.  

  

In the Actions pane, scroll to the bottom to see the available agents. 
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18 Select the Wakeup agent. The available commands appear. 

 

19 In the Commands tab, do the following: 
a In the Wakeup Actions pane, select the Wakeup scene you want to use, such as 

Bedroom Wakeup. 
b In 'Location to play scene,' select the location to play the scene, such as Bedroom. 

20 Drag the green arrow to the Script pane. 
21 When you are finished, click Execute in the Script pane. 

 

To add a device to the Wakeup scene: 
1 In the project tree > Device Events pane include additional devices in your wakeup. Scroll to 

the bottom of the project tree to the devices, rooms and other information about the project. 
2 Select the Wakeup agent again. 
3 In Wakeup Events, select the Bedroom Wakeup. The Wakeup event appears at the top of 

the Script pane. 



Composer Pro 2.5 User Guide   Other programming tasks 

277 

4 In the Device Actions pane, select the device to trigger actions when the Wakeup event 
occurs. For example, select Fireplace. 

5 In the Command tab, select the On radio button. The action appears in the Actions pane. 
6 Drag the green arrow to the Script pane. 
7 Click Execute to execute the command. 

Bedroom Wakeup Example 

At a user-specified time in the Navigators: 

• Thirty minutes prior to wakeup time, the temperature rises to 72 degrees. 
• The playlist starts playing at 6:19 AM. 
• Lights should start ramping up to 70 percent light level by 6:34 AM. 
• The fireplace turns on. 
• In 15 minutes, Wakeup Scene 2 begins. 
• The local news turns on at 6:49 AM. 
• The Wakeup is complete.  

Note: Users can schedule the wakeup time from their Navigators: touch screens, TV screen, or 
MyHome app. See the product documentation or the Control4 System User Guide for more 
information about how to schedule the wakeup time from the Navigators.  

Tip: Some homeowners may want a Wakeup agent executed Monday through Friday, but not on 
the weekends. To turn off Wakeup for weekends, turn it off as a programmable event not to 
execute on weekends. 

Other programming tasks 
Programming using Find and Replace 

The Control4 Composer Pro Find and Replace programming feature lets you find one device 
already programmed and replace it with another.  

Example: You want Button 1 on your 6-Button Keypad to turn on all the dimmers in your 
Control4 system. Currently, Button 1 is programmed to turn on all the lights in your system. Use 
the Find and Replace programming option to replace the lights with dimmers in your 
programming.  

http://dealer.control4.com/dealer/support/documentation
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To program using the Find and Replace feature: 
1 Start Composer Pro and connect to a Director. 
2 Click Programming. 
3 In the Script pane, right-click and select Find and Replace. A Find and Replace dialog 

appears. 

 

4 Replace the programming device object with the one you want. 

Find: Family > Left Dimmer 

Replace with: Theater > Theater Dimmer 
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5 Click Replace. The statement in the Script pane changes to the replacement script. 

 

6 Repeat for each line in the Script pane. 

Find: Family > Middle Dimmer 

Replace with: Bedroom > Bedroom Dimmer 

Find: Family > Right Dimmer 

Replace with: Front > Front Dimmer  

When you complete this process, the script reflects that you have changed all the lights in your 
Control4 system to dimmers. 

Programming using Copy and Paste 
The Control4 Composer Pro copy and paste programming feature lets you copy the 
programming you configure from one device and paste it to another device. By creating the same 
command, loop, or conditional for a device, you can copy it for use in another programming 
script.  

Example: You want all of the lights in the Control4 system and the fireplace to turn on by 
pressing Button 1 on the 6-button keypad. When you press Button 4, you want to turn all the 
lights on in the system except in the Bedroom. In this example, you can copy the first set of 
actions into the second set and not include the Master Bedroom.  
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To program the 6-button keypad: 
1 Start Composer Pro and connect to a Director. 
2 Click System Design. 
3 Ensure that you have the following devices added and connected to the Control4 system: 

• Controller 
• Gas Fireplace 
• Bedroom Dimmer 
• 6-Button Keypad 

4 Click Programming. 
5 Select 6-Button Keypad in the project tree of the Device Events pane. 
6 In 6-Button Keypad Events, push Button 1, and select the Press radio button. 
7 In the Device Actions pane, scroll down and select Dimmer. 
8 In the Dimmer Actions pane, click the Commands tab, and click the On radio button. 
9 Drag the Dimmer Action green arrow to the Script pane. 
10 Repeat Steps 1 through 9 for all the lights in your system and your fireplace. This includes 

the Light Switch and Dimmer in the Theater, and the Dimmer and the Gas Fireplace in the 
Bedroom. 

11 Move to the Script pane, right-click, then select Copy from the options. This automatically 
copies all arrow statements in the pane. 
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12 Click Button 4 in the 6-Button Keypad Events pane, and then select the Press radio button. 
13 Right-click in the Script pane, and select Paste. The programming of the lights shows up in 

the Script pane for Button 4. 

 

You have completed Copy and Paste Programming. Now you can edit the Button 4 Script as 
needed. 

Example: You can remove the Bedroom Dimmer from the Button 4 Script, so when you 
push Button 1 all the lights in the system come on; and when you push Button 4, all the 
lights come on except for the dimmer in the bedroom.  

Tip: This feature is very useful when programming complex loops and conditionals. 

Programming using IR inputs with third-party remotes 
Some popular programmable remote controls are available on the market, such as the Phillips 
Pronto, Harmony Remote, or MX3000 that consumers of home theater and home control 
systems enjoy. These and any other programmable remotes are supported in the Control4 
system. 

Guidelines 
• Supported controllers. The controllers that support IR input are Media Controller, HTC, 

HC-200, and HC-300. 
• Published list of Control4 IR Input codes. To use one of these programmable remote 

controls with the Control4 system, Control4 has a list of Control4 IR Input codes on the 
Control4 system. See the table, 'IR Input Values and Commands,' at the end of this section 
for a list of supported IR custom commands and their values. The Control4 IR Input codes 
are available online at http://kb.control4.com/. From this list, you can copy and paste the 
codes for your programmable remote control. 

http://kb.control4.com/
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• The Control4 system is based on rooms. This comprehensive Control4 IR Input code list 
provides all currently supported device codes included in the Control4 system. The Control4 
system’s Navigators are room based. For example, a touch screen is configured to change 
control of devices in a particular room. Other Control4 Navigators include System Remote 
Control, wireless touch screen (10.5”), on-screen Navigator (viewable on a television), etc. 
Each Navigator is configured to exist in the context of a room in a Composer Pro-created 
project. The Navigator’s codes are then sent to the Control4 system in the context of the 
room while using the same set of IR Input codes. 

• Sets of commands for rooms 1 through 15. The Control4 IR Input codes contain one 
complete set of command codes for every room (rooms 1 through 15 supported). You can 
program up to 15 rooms. Each set of codes includes a mask code that associates the 
remote to a particular room. Example: You can program a remote for use in a Living Room 
using mask code 1. Then you assign Mask 1 to the Living Room. This lets you use the 
particular remote in the Living Room. 

• Set of commands for global use. A global mask is available (mask 0 or None) that 
overrides the mask code (1 through 15) in any room. Example: You can use a remote 
programmed with mask 0 in any room where remotes are programmed to one of the masks 
(1 through 15). Remotes programmed using masks 1 through 15 are only for use in the 
assigned room. 

• Assign a mask number for each room. When setting up the remote, assign the mask 
number for that room in the Room Properties. Access Room Properties in the System 
Design view by right-clicking a room, selecting the Miscellaneous tab, and in Multi-Room 
Shared IR Settings. 

• IR receiver requirement for each room with a third-party remote control. Place an IR 
receiver in the room where you plan to use the third-party remote. The controller both have 
IR receiver windows built into the front panel. You can also purchase third-party IR receivers 
which attach to the four (4) IR Input ports on the back of the controller. You can connect up 
to 15 IR Receivers into one (1) IR import controller port. 

• Configure each IR receiver as an IR receiver for a specific room. The room is assigned 
to an IR mask on the Properties page for that room which automatically assigns it to the 
device in the room that handles IR receiving, such as a controller or third- party IR receiver. 

• Various configurations and implementations supported. The IR code sets allow various 
configurations. The controller has four (4) ports on the back that can potentially support up 
to 15 rooms. This means that one (1) controller can support 60 rooms from the back four (4) 
ports, and one (1) room from the front IR receiving window. If needed, you can stack the 
controllers to support additional rooms as necessary. 

To use Control4 IR Input codes for programming third-party remote control devices: 
1 Plan where remote controls will be used in the house or site. Each room is assigned a mask 

number. You can program the rooms using a different mask number for up to 15 rooms.  

Example:  

Master Bedroom - Mask 0 

Theater Room - Mask 1 

Family Room - Mask 2 

Bedroom 1 - Mask 3 

Bedroom 2 - Mask 4 

Bedroom 4 - Mask 5  

2 Using the IR Input codes provided at http://www.control4.com in an XML file, program the 
third-party remote by copying and pasting the codes. Note: The room mask is included in 
the individual codes in each set.  

http://www.control4.com/


Composer Pro 2.5 User Guide   Other programming tasks 

283 

Example:  

Program Remote Controls using the codes associated with the mask: 

Master Bedroom (Global Remote) - Mask 0 

Theater Room (Remote 1) - Mask 1 

Family Room (Remote 2) - Mask 2 

Bedroom 1 (Remote 3) - Mask 3 

Bedroom 2 (Remote 4) - Mask 4 

Bedroom 4 (Remote 5) - Mask 5  

3 In the Composer Pro project and the System Design view, select a room and click the 
Miscellaneous tab under Properties. 

4 In Multi-Room Shared IR Settings, use the pull-down menu to select the IR Room Mask 
number (None through 15).  

 

0 Not Defined 39 Not Defined 78 HOUSE 117 Not Defined 

1 PLAY 40 Not Defined 79 MYINFO 118 PAGE_UP 

2 STOP 41 Not Defined 80 CONTROL4 119 PAGE_DOWN 

3 PAUSE 42 Not Defined 81 Not Defined 120 INFO 

4 SKIP_FWD 43 Not Defined 82 Not Defined 121 CANCEL 

5 SKIP_REV 44 Not Defined 83 Not Defined 122 RECALL 

6 SCAN_FWD 45 Not Defined 84 Not Defined 123 PVR 

7 SCAN_REV 46 Not Defined 85 Not Defined 124 GUIDE 

8 RECORD 47 Not Defined 86 Not Defined 125 Not Defined 

9 Not Defined 48 Not Defined 87 Not Defined 126 Not Defined 

10 NUMBER_0 49 Not Defined 88 Not Defined 127 Not Defined 

11 NUMBER_1 50 Not Defined 89 Not Defined 128 PULSE_SUR_UP 

12 NUMBER_2 51 Not Defined 90 Not Defined 129 Not Defined 

13 NUMBER_3 52 Not Defined 91 Not Defined 130 Not Defined 

14 NUMBER_4 53 Not Defined 92 Not Defined 131 TUNE_UP 

15 NUMBER_5 54 Not Defined 93 Not Defined 132 TUNE_DOWN 
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16 NUMBER_6 55 Not Defined 94 Not Defined 133 SEARCH_UP 

17 NUMBER_7 56 Not Defined 95 Not Defined 134 SEARCH_DOWN 

18 NUMBER_8 57 Not Defined 96 Not Defined 135 PRESET_UP 

19 NUMBER_9 58 Not Defined 97 Not Defined 136 PRESET_DOWN 

20 Not Defined 59 Not Defined 98 Not Defined 137 MUTE_ON 

21 Not Defined 60 Not Defined 99 Not Defined 138 MUTE_OFF 

22 STAR 61 Not Defined 100 Not Defined 139 MUTE_TOGGLE 

23 POUND 62 Not Defined 101 Not Defined 140 Not Defined 

24 HYPHEN 63 Not Defined 102 ROOM_OFF 141 Not Defined 

25 DASH 64 Not Defined 103 Not Defined 142 Not Defined 

26 ON 65 Not Defined 104 CH_UP 143 BASS_UP 

27 OFF 66 Not Defined 105 CH_DOWN 144 BASS_DOWN 

28 Not Defined 67 Not Defined 106 VOL_UP 145 TREBLE_UP 

29 Not Defined 68 Not Defined 107 VOL_DOWN 146 TREBLE_DOWN 

30 PULSE_INPUT 69 Not Defined 108 MENU 147 BALANCE_UP 

31 Not Defined 70 Not Defined 109 BACK 148 BALANCE_DOWN 

32 Not Defined 71 Not Defined 110 Not Defined 149 LOUDNESS_ON 

33 Not Defined 72 RADIO 111 ENTER 150 LOUDNESS_OFF 

34 Not Defined 73 MUSIC 112 TV_VIDEO 151 LOUDNESS_TOGGLE 

35 Not Defined 74 TV 113 UP 152 PULSE_ASPECT_RAT
IO 

36 Not Defined 75 VIDEOS 114 DOWN 153 PIP 

37 Not Defined 76 PICTURES 115 LEFT 154   

38 Not Defined 77 LIGHTS 116 RIGHT 155   
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Customizing 
Navigators 

Use this chapter to learn how to: 

• Set up screen savers 
• Hide & view device availability 

Overview 
Use the Control4® system Navigator interface on your Navigator to make adjustments to the 
Navigator you're using.   

Tip: You or your customer can customize pages in the touch screens, MyHome apps, or on-
screen Navigators also. See the Control4 System User Guide for information. 

Setting up screen savers 
Setting up the photo screen saver 

Use the Control4 Composer Pro Agent and Media views to set up a photo Screen Saver agent to 
view photos from the touch screens, MyHome apps, or on-screen Navigators. In OS 2.1 and 
later, you can use a single photo to display on all of your Navigators. If you change the interval 
on one Navigator, it will change all of them. 

Prerequisites 

Have one of the following storage types available before you copy the photos. You will need to 
set up one or more of them later when you add your photos.  

Note: In some cases, the Control4 system may take a few minutes to recognize the device. 

http://dealer.control4.com/dealer/support/documentation
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• Controller—If the controller has no storage, add and connect a device that contains storage 
for your photos; for example a USB drive or Network File Share (see Step 6 in the next 
section). 

• USB Drive—Ensure that the USB drive is attached to the controller. When you insert the 
USB drive, it will appear in the project tree in the same room as the controller. 

• Network File Share—Ensure that the Network File Share object is added to the project tree 
and connected (see the steps to do this later in this procedure). Ensure that you have 
access to the Network File Share, that you have a valid Username, Password, and 
Workgroup, and that you can identify the network location (you will need to add the path). 

To display photos as screen savers on the Navigators: 
1 Start Composer Pro and connect to a Director. 
2 Click Agents. 
3 (First time only.) From the Agents view > Agents pane, click Add to add the agent to the 

project. 
4 From the Available Agents dialog, select the Screen Saver agent, and click OK.  

Note: If Screen Saver already appears in the Agents pane, it has already been added. Go to 
the next step. If not, see “Example: Program Using the Screen Saver Agent.”  

5 In the Agents pane, select Screen Saver. 
6 From the storage location list, use the drop-down menu to select the location where you will 

save your photos for use on the Navigators (controller, CBM Flash Disk: USB drive, or 
Network File Storage, etc.). 

Notes: 

• If the storage option that you want does not appear in the list, disconnect from Director 
and reconnect. 

• At any given time, only one storage location can be set as the photo Screen Saver 
source. 

• Controller—If you have a controller with disk space (for example, home controller HC-
500 or HC-1000), an option appears in the list (for example, home controller HC1000). 

• CBM Flash Disk (USB drive)—If you inserted the USB drive in the controller earlier, the 
CBM Flash Disk option appears in the list. 

• Network File Storage—If you select Network File Storage, specify where the Control4 
system needs to go to copy the files. Click System Design and select the Network File 
Storage icon in the project tree (you will have to add it from the Items pane). In the 
Properties pane, type the Username, Password, and Workgroup, and then browse to 
the network location. Click Connect. 

7 Click the Media view, and select Screen Saver. 
8 Click Configure in the Screen Saver pane, set the location to copy the files to (for display in 

the Navigators), and click OK.  

Note: If you didn’t select a storage location in Step 6, an error message appears. Click OK, 
and then click Configure to set the location.  
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9 In the Screen Saver pane, click Add. In the My Pictures dialog, browse to the photos you 
want to copy to the storage location, select them, and click Open. The files will be copied to 
the storage location you specified in Step 8, and a folder may be created for you using the 
Control4 name (Example: Control4 pictures). 

Note: When media is added (copied) to the storage device, it is pre-scaled to the resolution 
for all of the Navigators. Control4 preserves the aspect ratio of the original image, and boxes 
the extra space with bars for any given screen size. 

 

10 In Composer Pro, click Tools > Refresh the Navigators to display the copied photos. 
11 To activate the Screen Saver in each Navigator (on-screen, touch screen, or MyHome app), 

do the following: 
a Go to Info > Config > Screen Saver (on the system remote control) or More > Settings > 

Screen Saver. 
b Enable the Custom option, and then select the Photo Screen Saver option along with 

any other screen saver option you want to include. For photos only, check the Photo 
option. See “Setting up a custom screen saver” to display the photos on the Navigator 
or see the Control4 System User Guide. 

Setting up a custom screen saver 
Use the Control4 Navigator to create a custom screen saver to view on touch screens, MyHome 
apps, or on-screen Navigators.  

Note: This task must be completed on a Navigator. Either the Installer or homeowner can set 
this up. The Custom Screen Saver option lets users mix and match available screen saver 
options, including the option to use stored photos. 

Prerequisites 

Before setting up a custom screen saver, photos must be available for viewing from the 
Navigator. See “Setting Up the Photo Screen Saver Option.” 

http://dealer.control4.com/dealer/support/documentation
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To set up a custom screen saver: 
1 From the main menu on an on-screen Navigator, MyHome app, or touch screen press More 

> Settings > Screen Saver or Info > Config > Screen Saver on a system remote control. 
2 In Screen Saver, press the drop-down arrow, and press Custom. 
3 In Turn on, press the drop-down arrow, and press an option to enable the screen saver. 
4 Press Settings. 
5 Press to select one or more of the following options: 

• Media 
• Time 
• Date 
• Temp 
• Photo 
• Shuffle 

6 Press Done. 
7 (Optional) Press Preview to test the settings.  

To set up a custom screen saver in the touch screens, MyHome apps, or on-screen Navigators 
for OS 2.0 and later, see the Control4 System User Guide for details. 

Programming the screen saver sleep mode 
Use the Control4 Composer Programming view to schedule a Screen Saver mode change, for 
example, a ‘Go To Bed’ mode during sleep hours.  

1 In Programming, select Navigator actions. 
2 Create a Scheduled Event (such as ‘Go To Bed’). See “Programming with Agents” for 

details. 
3 Add the following script: 

“Set the screen saver mode on the [graphical navigator device] to Blank.” 
“Turn the screen saver on after [time interval] on the [graphical navigator device].” 

Changing the time on a Navigator screen saver 
Use the Control4 Composer Pro System Design view to change screen saver date, time or time 
zone. 

To change the time on a Navigator screen saver: 
1 Start Composer Pro and connect to a Director. 
2 Click System Design. 
3 In System Design, click the Properties tab. 
4 Use the Date & Time drop-down boxes to modify the time and date.  

Date—To change the Date (month, date, or year), click the drop-down arrow for a calendar 
to appear. Click the left or right arrows to select the month, and then select the day. 

http://dealer.control4.com/dealer/support/documentation
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Time—To change Time (hour, minute, second), click the up or down arrows to the 
appropriate time in hours, minutes, or seconds. 

 

Tip: An easy way to change the hour, minute, or second is to highlight the hour, minute, or 
second number, and then type the new number over the old one.  

Time zone—To change the Time Zone, at the Timezone box, click Edit. Select the time 
zone from the drop-down menu, and click OK. 

Hiding device availability 
Use the Control4 Composer Pro System Design view to hide a device from view in a Navigator. 
In OS 2.3.0 or later, you may find the Access agent useful for device availability. See “Examples: 
Programming with Agents” for details.  

Example: Set availability so that the touch screen in the Bedroom cannot control music in the 
Theater. 

Prerequisites 

Ensure that the following devices are added and identified to the network: 

• Controller  
• Digital audio 
• Navigator 

To hide a device so others cannot see it: 
1 Start Composer Pro and connect to a Director. 
2 Click System Design. 
3 In System Design and in the project tree, select Bedroom. 
4 Go to the Navigator tab in the Properties tab. 
5 Select Music in the Menu box, and then click Modify. 
6 Select Digital Audio in the Theater, click Hide, and then click OK. 



Composer Pro 2.5 User Guide   Viewing device availability in navigators 

290 

Viewing device availability in navigators 
Use the Control4 Composer Pro System Design view to change the order of devices to view. 
This task is useful if you have a lot of media devices, and some are used more frequently than 
others.  

Example: Change the order of a Tuner to appear in a Navigator before the Receiver. 

Tips: (1) In OS 2.2 and later, you can use Shift+Click or Ctrl+Click to add or remove devices. 
(2) In OS 2.3.0 or later, you may find the Access agent useful for device availability. See 
“Examples: Programming with Agents” for details. 

Prerequisites 

Ensure that the following devices are added and identified to the network: 

• Controller  
• Digital audio 
• Navigator 

To enable a device to be viewed in a specific order in a Navigator: 
1 Start Composer Pro and connect to a Director. 
2 Click System Design. 
3 In System Design, select Theater. 
4 Go to the Navigator tab in the Properties tab. 
5 Select Radio under Menu, and then click Modify. 
6 Click Tuner, and then click Move Up. 
7 Click OK. 
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Creating Drivers 
Use this chapter to learn how to: 

• Use the DriverEditor 
• Use the Driver Wizard 
• Create IR controller drivers 
• Create serial-controlled drivers 
• Configure Composer Pro properties 
• Create two-way drivers 
• Export a driver 

Creating device drivers 
To complete device support using Composer Pro® for a Control4 system, every device requires a 
corresponding driver. 

To add a device to the Control4 system that does not have a supporting driver, use the built-in 
Driver Creation Wizard in Composer Pro or Driver Editor to create the driver prior to adding the 
device.   

Setting up a network configuration 
Use the Control4 Composer Pro Tools menu to set up a WiFi network configuration using static 
IP addresses.  

For more information about setting up the network for a Control4 system, refer to the "Basic 
Networking" training sessions conducted by the Control4 Training team. Training information is 
available in the Dealer portal on control4.com under ‘Training.’ 

Note: This example procedure only applies to Speaker Point, touch screens, amplifiers, tuners 
and audio switch devices. 

To set up the network configuration for Speaker Point or touch screens: 
1 Start Composer Pro and connect to a Director. 
2 From the Tools menu, select System Manager. 



Composer Pro 2.5 User Guide   Setting up a network configuration 
 

292 

3 In the Devices pane, select the network address of the Director for the device for which you 
want to set up the network configuration, and click Connect.  

 

Tip: If the device’s network address is not on this list, click Refresh. If it still does not 
appear, click Add to enter it manually. If you do not know the network address, find it at the 
Tools menu > Network Tools. 

4 In the Devices pane (double-click the device in "Devices" to open the device pane), click the 
Network tab, and click Configure. 

5 Click Next when a Network Configuration Wizard dialog appears. 
6 In the dialog, enter the new name of the device, and click Next. 

Note: An error occurs if there are any spaces in the new name text. Do not include spaces 
in the new name.  

If the device has already been identified on the Control4 system, and you want to change 
the name, identify the device again because the controller no longer recognizes the name, 
and it cannot communicate with the device. 

7 Select the network you want the device to be a part of, such as an Ethernet or Wireless, and 
click Next.  

8 Select the method for obtaining an IP address, such as DHCP (first option) or Status IP 
(second option), and click Next. 

Example: "Obtain an IP address automatically using DHCP" 

9 Select the method to obtain the DNS server address, such as DHCP (first option) and Static 
IP (second option), and click Next. Control4 recommends that you obtain the DNS server 
address automatically. 

Example: "Obtain DNS server address automatically" 

10 Click Finish when you come to the "Network Configuration Wizard Complete” screen. Make 
a note of the settings on the screen. 

11 Wait for the controller to check the hard disk and restart the system. Do not disconnect any 
temporary Ethernet cables or the power cord until the device is finished and it returns to the 
first Control4 screen. 
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Overview  
Why create a device driver? 

A hardware driver is a small piece of software that allows a computer program to communicate 
with a specific device, for example a controller, in the Control4 system. Every device in the 
Control4 system requires a driver, and that driver must be added to the project tree in Composer 
Pro. Some devices do not have existing drivers in the Composer Pro driver database, or the 
drivers there cannot control a device. In that case, a new device driver needs to be created. 
Control4 provides the means if anyone wants to develop drivers for their products. 

Example: A computer may use a printer driver to send a print order to a printer. Every 
controllable device uses codes that represent commands on that device. To control the device, 
you must capture or enter these codes in the driver. 

Example: An IR-controlled CD player’s commands are Play, Stop, Pause, etc. Using the Driver 
Wizard and controller hardware along with the manufacturer’s remote control supplied with the 
equipment, you can capture these codes and build a working driver using the codes. Serial-
based devices are also supported; you can enter the serial codes to the Driver Wizard manually. 

Tip: Each driver consists of a collection of files. One of those files is a configuration file, which is 
an XML file referred to as a config data file or.c4i file. This file provides specific IR, serial, or 
connection codes that are pertinent to supporting a device model on the Control4 system. In the 
default Composer Pro installation, these files are located on your PC at: c:\program 
files\control4\Composerxxx\drivers\virtual. 

Guidelines for creating device drivers 
The most important information you need to know before you begin to create your own Control4 
device driver is to understand how your devices work. After that, you can use the Driver Wizard 
and/or the DriverWorks SDK or DriverEditor to create your own drivers. Contact Control4 
Technical Support for details. 

IMPORTANT! Before you begin, check the manufacturer's documentation to learn about the 
codes or customized macros required to support your device, and understand the inputs and 
outputs that your device supports and other details about the device as needed. 

For best results, understand the following concepts and guidelines: 
• Supported commands and inputs/outputs of the device—Prior to starting the Driver 

Wizard, have a basic understanding of the device. 
• Discrete versus toggle—In the Driver Wizard, the term 'discrete' indicates a direct setting 

rather than a toggle option between settings. For example, a receiver might have 'discrete 
input select,' which lets you select the input directly (DVD) rather than using a toggle button 
that cycles through all the inputs (DVD, VCR, TV), such as Input Toggle. 

• IR codes versus macros—In the Driver Wizard, some IR codes complete the needed 
command; however, to complete the commands, you may need a macro (a sequence of 
codes). 

• Adding all options for AV connections—When adding AV connections, select all possible 
options for the device so all options are available for selection. 

• Power management options—A variety of supported Power-Management options are 
available to choose from, but the optimal method depends on the device. When no other 
option works, use the Assume the Device is Always On option, and leave it up to the user 
to ensure manually that the device is on. See “Guidelines for Defining Power Management.” 
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• Adding commands and custom commands—The Driver Wizard supports a set of default 
commands for each device type, such as Television, VCR, DVD, etc. If a command you 
need does not appear on the Default Command list, click Add and use the pull-down menu 
to look for the command. You can also add custom commands if necessary. 

• Driver Wizard screens vary for device types—Because different devices, such as 
televisions, VCRs, and DVDs have different functionality, the Driver Wizard steps you 
through different questions as appropriate for that device type, and there are pre-defined 
generic Device Types that have a common set of commands with varying capabilities that 
you can use as a base. The Driver Wizard prompts you to select the appropriate commands 
from these basic commands, as well as identify any additional capabilities that the particular 
device is able to perform. 

Example: All televisions have Up/Down channel and Up/Down volume commands, so these 
basic commands are already included in the generic TV device type. However, not all 
televisions have direct channel selection, where you can select a channel by pressing a 
sequence of numbered keys. 

• Creating or editing multi-featured device drivers—You can create only combination 
types that are listed in the Create New Driver wizard. Control4 recommends that you start 
with an existing driver in the Online Database, add it to your Local Database, and then edit it 
as needed to meet the new device-driver need. Be patient. You may need to change IR 
codes if a code doesn't work with your device. 

• DriverWorks can be used to create 2-way drivers for AV and non-AV devices. It requires 
some programming skills, however, but leverages the Lua-embeddable scripting language, a 
powerful, fast, and light-weight (when compared to other scripting languages). See “Creating 
2-Way Serial or TCP/IP-Controller Drivers Using DriverWorks.” 

Tip: When a device driver is created, you may want to distribute it to multiple projects on 
different computers. To do this, copy the driver file from the default install directory: 
C:\Program Files\Control4\Composerxxx\Drivers\Virtual to the same directory on the 
other computers. 

This action makes this driver file available to all the projects stored on that computer. Driver 
files are named by device type, protocol, manufacturer, and model with a.c4i extension. 

Example: tv_ir_samsung_tx-p1430.c4i. 

• DriverEditor—This tool is designed to assist the dealer or driver developer in creating and 
maintaining their drivers for use with the Control4 system. 

Using DriverEditor 
The DriverEditor is an advanced tool that allows DriverWorks drivers to be developed. This tool 
is free and is available at: http://update.control4.com/DriverEditor/DriverEditor_Installer.exe. You 
can find information about DriverEditor in the Forums under ‘DriverWorks.’ 

Features: 

• Edit AV_GEN or DriverWorks drivers from the same tool.  
• Switching from AV_GEN to DriverWorks requires only a menu choice.  
• No more wondering if the XML portion of the driver is correct. All choices are validated.  
• Capture IR codes from Control4 controllers or enters them manually in pronto hex format or 

by IR code(s).  
• Create/maintain all aspects of IR macros.  
• Commands/notifications are filtered by proxies in the driver.  
• Capabilities are filtered by proxies in the driver.  
• DriverWorks editor with API auto-complete for Control4 APIs and Lua script APIs.  

http://update.control4.com/DriverEditor/DriverEditor_Installer.exe
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• DriverWorks editor with Call tips and syntax highlighting.  
• DriverWorks debugging from within DriverEditor. No longer writing in one application and 

debugging in another.  
• Monitor output from up to four (4) different debug windows.  
• All DriverWorks documentation is accessible from within DriverEditor with context searching.  
• Updating from within DriverEditor. 

Using the Driver Wizard 
Use the Control4 Driver Wizard in Composer Pro to create device drivers for your devices. 

The Driver Wizard is a basic level driver developer tool for IR and one-way serial control. 
Instructions for using this wizard are detailed in this section. 

To start the Driver Wizard from the Driver menu: 
1 Select Create New Driver. See “Menu Options” in Composer Pro Getting Started for details. 

The Driver Creation Wizard (or Driver Wizard) lets you add device support to the system, 
including support for: 
• Infrared (IR)-Controlled — Devices that are controlled using wireless remotes. 

Commands are sent via pulses of infrared light to the device. 

Examples of IR-controlled devices: receivers, televisions, plasma screens, projectors, 
DVD/CD players, DVD/CD changers, VCRs, satellites, cable boxes, DVRs, tuners, 
audio/video switches, amplifiers, blinds, and other specialized equipment. 

• Serial-Controlled—Devices are controlled via a serial connection (RS-232, RS-422, or 
RS-485) to the controller hardware, for example, a Home Controller HC-300. Serial-
controlled devices often control a device at a higher level than IR-controlled devices. 

Examples of serial-controlled devices: projectors, multi-disc DVD changers, and other 
serial-controlled devices. 

Limitations of the Driver Wizard 
The Control4 Driver Wizard is not designed or intended to create drivers in the following 
situations: 

• Bi-directional drivers—Bi-directional drivers provide enhanced support for two-way 
communication between the device and the controller. Custom bi-directional drivers are 
available for some devices (check the Online Database). The Driver Wizard does not create 
bi-directional drivers. If you need to create a custom bi-directional driver, ask your Control4 
Sales Representative about the Control4 software development kit (SDK) program. 

• Logical Calculations—Some devices require logical calculations. The Driver Wizard can 
provide only limited support for devices that require logical calculations. 

• Relays and Contacts—The Driver Wizard is not designed to create drivers for relays and 
contacts. If you cannot find a specific driver for your contact or relay device, use the generic 
drivers provided in the Online Database. 

• Serial Codes—To create serial drivers, get the serial codes from the manufacturer’s 
documentation. Control4 collects the serial codes in a database from the 
manufacturers/dealers that obtain these codes. If you need serial codes, contact Control4 
Technical Support or contact the manufacturer directly. 

http://dealer.control4.com/dealer/support/documentation
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Editing a driver using the Driver Wizard 
To make changes to a driver located in your local Control4 driver database that is NOT fully-
configured and connected in a project, you can use the Composer Pro Driver menu > Edit 
Existing Driver option. This option lets you modify and update the driver options in the Driver 
Wizard. 

To edit a driver using Driver Wizard: 
1 Start Composer Pro and connect to a Director. 
2 From the Driver menu, select Edit Existing Driver. 
3 In the next screen, select the driver type, such as VCR. 
4 Select the Model type. 
5 Select a section, and click next to advance to the screen that you want to edit. 
6 Edit the screens or recapture the codes as needed. See “Creating IR-Controlled Drivers” for 

details. 
7 When you’ve edited the driver, click finish, and click next. 

IMPORTANT! If you edit any inputs or outputs of the driver after editing a driver, you must 
remove the driver from the project, add it to the project again from the Search tab, and then 
make the connections. 

Verifying the IR codes using the Driver Wizard 
Use the Edit Existing Driver menu option to verify your IR codes for the Control4 system.  

Note: Make sure the controller is connected to the device via IR, and that all necessary 
connections are made. 

To verify driver IR codes using the Driver Wizard: 
1 Start Composer Pro and connect to a Director. 
2 From the Driver menu, select Edit Existing Driver. 
3 Select the driver type, such as VCR. 
4 Select the Codes section. 
5 Click next to advance to the screen for the first IR code listed. 
6 On the left side, use the scrollbar to select the code you want to test, and click Emit to verify 

the function of the specific IR code. 
7 Edit or recapture the codes as necessary. 
8 After you’ve edited the driver, click finish. 
9 Click next to save your changes.  

IMPORTANT! If you edit any inputs or outputs of the driver after editing a driver, you must 
remove the driver from the project, add it to the project again from the Search tab, and make any 
necessary connections. 

Tip: To exit the Driver Wizard without saving your changes, click x at the top right of the screen. 
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Power management 
Guidelines for defining power management 

Control4 Power Management options are modifiable using the Driver Wizard in Composer Pro 
which is accessible through the Driver menu during creation or driver edits. 

 

Editing power management options 
If resetting the connections is not required, you can sometimes edit the Power Management 
options from the Composer Pro project tree. 

To edit the Power Management options: 
1 Right-click the device. 
2 Click Edit Driver. 

a If the Edit Driver option does not appear, edit this driver from the Driver menu. 
b Remove and then add the device to the project tree again. 

Options on this screen include: 

• Assume the device is always on—Select this option if the device is always on, or if the 
device is turned on and off by pressing the same button. For example, the system has no 
way to acknowledge if a television is on when the television uses a toggle button (such as 
buttons labeled 'Power' or 'On/Off') instead of discrete (separate) On and Off buttons. 

Note: Use this option for Power Management of a multi-zoned receiver. 

• Send Toggle Codes—This option is selected automatically when you check the Has Power 
feedback box. You can select the other available options, such as Macro. Click next to 
return to this page and reset the page to this option. 

• Use discrete on/off codes—Select this option if the device features a separate button for 
On and Off versus one button used to cycle between On and Off. 
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• Use On/Off macros—Use this option to control power on the device by using a sequence of 
button presses to determine the power state of the device. 

Example: You know the state of most DVD players by sending a Play command, because 
Play typically changes the power state to On. 

You can set up a macro that 

• Sends a Play command. 
• Sends a power toggle command to turn the device off. 
• Sends a power toggle command to turn the device on. 

The system can determine with certainty that the power state is On. 

• Has Power Feedback. 
• Video sense loop—Check this option if you want the system to determine (using a 

Composite video connection) whether a device is On or Off based on whether a video 
signal is present. 

• Contact sensor (power sensing)—Check this option if the device is plugged into a 
wireless outlet switch and is configured as a Contact Sensor. 

• Control power directly (power control)—Check this option if the device is plugged 
into a wireless outlet switch and is configured as a relay. With this option, you can set 
two (2) delays to accommodate special devices.  

For more information, see “Configure a Wireless Outlet Switch.” 

Configuring assignable inputs and outputs 
In a driver, you want to create all possible inputs and outputs on a device. However, a driver can 
only support the physical inputs and outputs that exist on that device, so don’t attempt to create 
inputs or outputs that do not exist on the device. 

Changing power management options 
Use the Power Management options in the Composer Pro Driver menu to change power for a 
Control4 system. 

To change the Power Management option of a driver, you can edit the driver to provide a 
different Power Management option. After editing a driver, you may need to add the driver to the 
project and set up the necessary connections. 

To change Power Management options in a driver: 
1 Start Composer Pro and connect to a Director. 
2 From the Driver menu, select Edit Existing Driver. 
3 Select the driver type, such as VCR. 
4 Select the Manufacturer type, such as Mitsubishi. 
5 Select the Model type. 
6 On the Power Management screen, change the Power Management option.  

Example: To change the Power Management option, check Has power feedback, and then 
select the Video sense loop option.  

7 After you edit the driver, click finish, and click next.  

Example: The Video Sense loop requires a Control connection. A control Video Sense 
connection has been added to the DVD driver.  

8 Make any necessary connections to configure the new Power Management option.  
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Example: With the Video Sense Loop Power Management option, connect the Control 
connection.  

a From Connections, select Control/AV > DVD. 
b From the top pane in Control Connections, drag the Video Sensor connection to a 

Video Sense Loop connection on the controller (e.g., Home Controller HC-1000). 

IR controller drivers 
Creating IR-controlled drivers 

This section provides instructions for creating and testing a driver using the Control4 Driver 
Wizard in Composer Pro. Depending on the device type, the Driver Wizard asks you questions 
for the driver you are creating. The Driver Wizard varies between device types because different 
device types have different functions. Follow the Driver Wizard screens until your driver is 
created. 

Prerequisites 

For the IR Learning capability to work, you must be connected to a Director and have a controller 
added to your project. 

To use the Driver Wizard: 
1 Start Composer Pro and connect to a Director. 
2 From the Driver menu, select Create New Driver. 
3 From the list, select the type of driver you want to create, and click ok. 
4 Enter the Device Information. 

a Fill out the requested information, such as device’s Manufacturer, Model number, and 
the name of the Driver Creator (whoever is creating the driver), and click next. 

b Check whether the device is IR or Serial controlled, select the appropriate options, and 
click next. 

c Define the type of power management, audio parameters, and device properties there 
are, and click next. 

d Identify the relevant commands, add custom commands as necessary, and click next. 
5 Capture, paste, or enter the device codes using one of the following: 

• IR—Use the manufacturer’s remote and the controller’s IR Learning capability for 
capturing IR commands. 

• Serial—Enter the codes. 
6 Create and identify the input and output connection options for the device, and click next. 
7 Create macros if necessary. 
8 Find your driver, add it to the project, and test it. See Composer Pro Getting Started for 

details about how to do this. 

http://dealer.control4.com/dealer/support/documentation
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Guidelines for capturing IR codes 
For best results when capturing IR codes for a Control4 system, follow the on-screen prompts in 
the Driver Wizard. 

Follow these guidelines: 
• Point your manufacturer’s remote control directly at the IR window located just below the 

dial on the front panel of your controller hardware (e.g., Home Controller HC-1000). Avoid 
aiming the beam at an angle, and keep the beam in the same axis as the IR window. 

• While capturing the first few codes, the controller begins to recognize the frequency. Note 
that a message about 'an alternate frequency' might display. This is normal, and it means 
that the controller is adjusting to the remote frequency. 

To help ensure a successful capture: 
1 Hold the manufacturer’s remote at a distance of approximately 6" away from the controller 

hardware, and then press the button requested. 
2 When prompted, press the button again to confirm the code captured. You are prompted 

a third, fourth, and possibly a fifth time to press each of the first few buttons. 
3 If another device in the room emits IR, such as a bi-directional IR device, block the IR so 

it does not interfere with IR capture. 
4 The process of capturing IR codes is very sensitive to light, such as sunlight and 

fluorescent lights. If it is not working properly, turn off the lights, close the drapes or blinds, 
or cover the physical hardware so that the light cannot interrupt the capturing of codes. 

5 When capturing IR codes, press and release the remote button in one (1) second. 

Note: Do not press and hold for long periods (longer than three (3) seconds). Doing so 
increases repeat counts. Typical repeat counts are between three (3) and five (5) seconds. 

6 When capturing IR codes, look for a green light to turn on and off on the controller 
hardware. Also, watch the Driver Wizard screen; it changes the steps to indicate that codes 
are captured. 

7 Avoid IR interference from your laptop by disabling or powering off the IR devices. 

After successfully capturing a few codes: 
1 Hold the manufacturer’s remote at a distance approximately 8" - 12" (about 20 – 30 cm), 

and then press the next button requested. 
2 When prompted, press the button again to confirm the code captured. Most buttons are 

confirmed with the second button press. You may be prompted repeatedly to confirm the 
code captured, including: 

If the remote uses alternative codes—Some manufacturers provide alternate codes or a 
second code to differentiate between two (2) distinct button presses, such as '1' and then '1' 
again for Channel '11.' Some remotes have a different code for each '1.' 

If an incorrect button was pressed, or if there was interference during the IR capture—
If you press the wrong button for a code or there was some interference during IR capture, 
the system may sense this and ask for a different code or request the same code again. If 
you test the code, and it doesn't work, try to capture it again. 

If you pressed a button longer than three (3) seconds.  

To disable the devices from the laptop’s Control Panel: 
1 Select Wireless Link. 
2 Click the Hardware tab, and click Properties. 
3 Ensure that any IR devices are disabled. 
4 After capturing the codes, enable the IR devices again. 
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When the system has finished capturing codes for a device, the Driver Wizard moves to the 
Input/Output category. 

Creating an IR television driver 
This section provides an example for creating an IR television driver using the Control4 Driver 
Wizard in Composer Pro. The example uses the Samsung TX-P1430 television; let’s  create a 
driver for it.  

The major steps are: 
1 Create an IR-Controlled Television 
2 Select the Volume and Other Properties for IR 
3 Indicate How Power Is Handled for IR 
4 Identify the Commands that the Device Supports 
5 Capture the Device Codes for IR 
6 Identify the Input/Output Connections 
7 Define the RF/Antenna and Connection Type 
8 Define the Set Channel Macro 
9 See “Add the IR Driver to the Project Tree.” 
10 See “Connect the Devices for IR Control.” 

Conditions 
• The Samsung TV is using IR for device control as an example. 
• There is not a discrete power on/off option, so you cannot control the power; the control 

system needs to assume this device is always on. 
• As with most TVs, there is Discrete Channel Selection; and the TV can provide audio output. 
• The TV does not have discrete volume control, but it does have mute toggle capability. 

To create an IR-controlled television using the Samsung TXP1430: 
1 Start Composer Pro and connect to a Director. 
2 Ensure that you add a controller to your project (e.g., Home Controller HC-1000). This 

should be the first device added. 
3 To add a controller: 

a Select the room (such as Theater) where the controller is installed. 
b Click the My Drivers tab. 
c Under Controllers, double-click a Controller (e.g., Home Controller HC-1000). This 

adds the controller and the Digital Audio object that resides on the controller to the 
project tree. 
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d In the Connections view, identify the controller you just added. 

 

4 Start the Driver Wizard. From the Driver menu, select Create New Driver. 

 

5 Select the device driver you want to create, and click ok. 

 

6 Enter the information for the driver you are creating, such as device’s Manufacturer, Model 
number, and name of Driver Creator, and then click next. 
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The Created, Modified, and Copyright information is automatically generated. 

• Manufacturer: Samsung. 
• Model: TX-P1430. 
• Device Creator: ACME Integrators. 

7 Under How is this device controlled? select the IR radio button to indicate that this 
television is controlled with an IR device, check Direct Connect if applicable (if IR codes are 
running through a direct cable, such as S-link), and then click next. 

Select the Volume and other properties 

8 Under Volume Properties, select the volume properties for this device, and click next. 
• Select Audio. 
• Select Mute. 
• Leave the other options as they are. 

9 Select the properties that apply to this device, and then click next. 

Options for this screen include: 

• Select Discrete Input Selection—This television has this capability and indicates that a 
television has the ability to select inputs directly. On the television’s remote you can 
select Video 1, Video 2, or Video 3 using three (3) different buttons rather than one 
(1)  toggle button that toggles to each selection. 

• Do not select Discrete Channel Selection—This television does not have this 
capability and indicates that the television has the ability to select channels directly. On 
the remote you can select a “discrete” channel by clicking 05 rather than toggling 
through channels by clicking the Channel Up and Channel Down buttons. 

Indicate how power is handled for IR 

10 Determine how power is handled for the device: 
• For the Samsung TX-P1430 television driver, select Assume device is always on. 
• For a description of each option, see “Guidelines for Defining Power Management” to 

help with a selection. 
11 Click next. 

Identify the commands that the device supports 

12 De-select the default commands not relevant to the device, add any custom commands 
(additional buttons) required, and then click next.  
• Deselect Cancel. 
• Deselect Info. 
• Deselect TV/Video. 

Capture the device codes for IR 

13 Capture the device codes using the manufacturer’s remote and the controller’s IR Learning 
capability. Follow the guidelines listed in “Guidelines for Capturing IR Codes” and the on-
screen instructions. 
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Use the Samsung TX-P1430 television remote control to capture the codes by pointing the 
remote directly at the IR window on the Home Controller HC-1000. 

 

When a code has been captured, Composer Pro puts a check next to the captured code in 
the Codes list, and selects the next code to be captured. When you capture all the codes, 
Driver Wizard automatically moves you to the next section: ‘Input/Output.’ 

(Optional) After you capture a code, if you want to view the code, click back. You can also 
edit and emit the code from this screen. 
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14 When you are finished, click next. 

Note: Sometimes a device can have alternative patterns. In this case, multiple codes show 
up on the screen. 

15 Read the television manufacturer’s documentation to find out the necessary inputs/outputs. 

Identify the input/output connections 

16 Click Add to identify the Input/Output connections on the television, and then click ok. 
17 For the Samsung TX-P1430 television driver, add the following inputs: 

• Line Input—Select Input and Line Level type. 
• RF Antenna—Select Input and RF/Antenna type. 
• Monitor Out—Select Output and Line Level type. 

 

The inputs appear in the Input/Output Connections window. 
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18 When the Input/Output Connections list is completed, click next. 

 

19 Define the connection types for Inputs/Outputs, and then click next. 

For the Samsung TX-P1430 television driver, define the Line Input: 

• Under Audio Connections, select Stereo (RCA). 
• Under Video Connections, select Composite and S-Video. 

 

Define the RF antenna and connection type 

20 Define the RF/Antenna type on the input RF Antenna, and then click next. 

For the Samsung TX-P1430 television driver, select the UHF/VHF radio button. 

21 Define the connection type for output Monitor Out, and then click next. 
• Under Audio Connections, select Speaker. 
• Under Video Connections, select Composite and S-Video. 
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Define the Set Channel macro 

22 Define a Set Channel macro to set the number of digits required by the TV to change 
channel so that the system can imitate the behavior of the TV’s remote. Some TVs require 
two (2) numbers and others require three (3). 

The Samsung uses a 2-digit channel entry. Select CHANNEL 3 and use the Minimum 
Length drop-down menu to change to 2. 

23 Increase the inter-digit delay (delay button code) if necessary for the TV you are adding. 
24 Click the blue number sign (#) to move the settings into the center pane. 
25 Click next. 

 

26 You have completed the setup of this driver. You can view the driver you created in the 
Search tab. Click next, and then click ok to continue. 

27 Next, add the new driver to the project tree and connect the device. See “Add an IR Driver to 
the Project Tree” and “Connect the Devices for IR Control” below. 

Add the IR driver to the project tree 
After you create an IR driver using the Control4 Composer Pro Driver Wizard, you must add it to 
the Composer Pro project tree. This section uses the Samsung TXP1430 as an example. 

To add the IR driver to the project tree: 
1 Start Composer Pro and connect to a Director. 
2 Click System Design. 
3 In the project tree, remove the existing television driver that you previously added to the 

example project (if it was added). 
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4 From the Search tab, use the drop-down menu to select the Device Type and 
Manufacturer of the driver you just created. 

Example: 

a At Device Type, select Television. 
b At Manufacturer, select Samsung. 

5 Double-click the new driver to add it to the project tree. Example: Samsung TXP1430. 
6 Make the connections. See “Connect the Devices for IR Control.” 

Connect the devices for IR control 
After you create an IR driver using the Control4 Composer Pro Driver Wizard, you must add it to 
the Composer Pro project tree and connect the device. This section uses the Samsung TXP1430 
as an example. 

To connect the IR device: 
1 Start Composer Pro and connect to a Director. 
2 Click the Connections view to make the appropriate video, audio, and control connections 

or network connections (if appropriate) for the device.  
3 For the Samsung TX-P1430 television driver, select Television. 
4 Make all the necessary Control and AV connections. 

Example (Television): In Connections under Theater, click Television. The right pane 
displays all of the inputs and outputs on the back of the television. For television, from the 
top pane:  

Under Audio Video Inputs, drag the object from the top pane to the bottom pane: 

a Click AV In (Video—COMPOSITE), and drag it to Receiver (Output—Theater). 
b Click AV In (Audio—STEREO), and drag it to Receiver (Output —Theater). 
c Under Control Inputs, click IR Sensor (Control—IR_OUT), and drag it to Home 

Controller HC-500 (IR Output 1—Theater). 
5 Click System Design, and double-click the device on the project tree. 
6 Use the Device Control window to test the control of the device. For the Samsung TX-P1430 

television driver, double-click Television. 

Editing an IR-controlled receiver driver 
This section takes you through an example of creating a custom IR-controlled receiver driver for 
a Control4 system by starting with an existing driver with multiple outputs, and then editing it.  

Example: In this example, pick the driver for the Harman Kardon AVR-230 Receiver. The 
Harman Kardon AVR-230 receiver is using IR for device control. 

Conditions 
• There is a discrete power on/off option. 
• Like most receivers, the device uses Discrete Input Selection and Discrete Surround 

Selection. 
• It does not have Volume Discrete Control, but it does have Mute toggle capability. 
• The Harman Kardon AVR-230 Receiver has the capability of Discrete Power on/off. 
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To edit an existing device driver: 
1 Start Composer Pro and connect to a Director. 
2 Pick an existing driver in the Online Database to edit. 

a From the Driver menu, select Manage Drivers. 
b In the Local Driver Database screen, click Add to access the online database. 
c In the Search dialog box, use the drop-down menus to select the Device Type and 

Manufacturer, and then click Search. 

Example: For the Harman Kardon AVR-230 use the following information: 

• Device Type: Receiver. 
• Manufacturer: Harman Kardon. 

d In the Search Results list, select the Model Number. 

Example: Select Harman Kardon AVR-230. 

e Click OK to add this driver to your local database. 
f Click Exit. 

3 From the Driver menu, select Edit Existing Driver to begin editing the driver in your local 
database. 

Note: If you right-click on the driver in the project tree, you will edit ONLY the driver in the 
project and not the driver in your local database. 

4 Select the Device Type (for example, Receiver) to view list of manufacturers. 
5 Select the Manufacturer (for example, Harmon Kardon) to view list of model numbers. 
6 Select the Model Number (for example, AVR-230). 
7 Click OK to open the existing driver (with all of its current settings) in the Driver Wizard. 

 

Edit the device information 

8 Edit the Device Info form as needed, including Manufacturer, Model number, and Driver 
Creator. This should reflect how you want this driver to display in your Local Database. 

9 For the Harman Kardon AVR-230 use the following information: 
• Manufacturer: Harman Kardon. 
• Model: AVR-230 [IR] - Edited. 
• Driver Creator: ACME Integrators. 

10 Click next. 
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Indicate how the device will be controlled 

11 Indicate how this device is controlled using IR or Serial. Example: Select IR and Direct 
Connect. 
• IR—Select this radio button if the device you want to create a driver for is IR (infrared) 

controlled. 
• Direct Connect—Check this box if your IR codes are running through a direct cable, 

such as S-link. 
• Serial—See “Creating a Serial-Controlled Device Driver” for information and example 

implementation. 
12 Click next. 

Edit the volume properties 

13 Edit the volume properties for the Harman Kardon AVR-230: 
• Check Audio. 
• Check Mute, but do NOT check Discrete Control. The Harmon Kardon AVR-230 has 

mute toggle only. 
14 Leave the other options unchecked. The Harman Kardon AVR-230 does not have these 

features. 
15 Click next. 

Edit the existing properties for the driver 

16 Edit the existing properties for the driver as needed. 
17 For the Harman Kardon AVR-230 driver: 

g Accept the defaults of Discrete Input Selection and Discrete Surround Sound Selection. 
h Click Add to add surround sound modes and in the dialog that appears type the Name, 

and click ok. 
i Do this for each of the surround sound modes, including Dolby Pro Logic, DTS Neo 6, 

and THX. 
18 Click next. 

Indicate how power is handled for the device 

19 For the Harman Kardon Receiver driver, select Use discrete on/off codes, and click next. 
See “Guidelines for Defining Power Management” for help making a selection on this 
screen. 

20 Click next. 
21 De-select the commands not relevant to the device as needed, For the Harman Kardon 

Receiver driver, click to de-select. 
• Cancel 
• Info 
• Mute Off 
• Mute On 
• Power Toggle 
• Pulse Surround Mode 
• Recall 
• Toggle Input 
• TV/Video 

22 See the diagrams that follow. 
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Add the commands 

23 From the extended command list, add several commands: DVD and Video 1. 
24 To add the commands from the extended command list for each individual command, click 

Add. 
25 On the dialog that appears, use the drop-down menu to select the commands, and click ok. 

The new command appears in the Default Commands pane. 
26 Add custom commands for surround modes, including DTS Neo 6, Dolby Pro Logic, and 

THX. To add custom commands for each individual command, click Add. 
27 Enter the name of the command, and then click ok. The new commands appear in the 

Custom IR Commands pane. 

 

28 Click next. 
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Capture the codes 

29 Capture (or recapture) the device codes as needed using the manufacturer’s remote and the 
controller’s IR Learning capability. Follow the guidelines for capturing IR codes in 
“Guidelines for Capturing IR Codes.” 

When a code has been captured, Composer Pro puts a check next to the captured code in 
the Codes list, and selects the next code to be captured. When you have captured all the 
codes, it automatically moves you to the next section Input/Output. 

30 Use the Harman Kardon AVR-230 Receiver remote control to capture the codes by pointing 
it directly at the IR window on the Home Controller HC-1000. 

31 Use the Harman Kardon Receiver remote control to capture the codes. 

Add the input and output connections 

32 Add the input and output connections. For the Harman Kardon Receiver driver: 
a Add 2 inputs: DVD and Video 1. 
b Add 1 output: Monitor Out. 

The inputs and outputs appear as shown: 

 

33 Click next. 
34 Define the connection types for input DVD. 

a In Audio Connections, check Stereo. 
b In Video Connections, check Composite, S-Video, and Component. 

35 Click next. 
36 Define how you select DVD. Select Code. Use the drop-down menu, and select DVD. 
37 Click next. 
38 Define the connection types for input Video 1. 

a In Audio Connections, check Stereo. 
b In Video Connections, check Composite, S-Video, and Component. 

39 Click next. 
40 Define how you select Video 1. Select Code; use the drop-down menu, and select Video 1. 
41 Click next. 
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42 Define connection types for input Video 1. 
a In Audio Connections, check Stereo. 
b In Video Connections, check Composite, S-Video, and Component. 

43 Click next. 
44 Define connection types for input Monitor Out. 

a In Audio Connections, check Stereo. 
b In Video Connections, check Composite, S-Video, and Component. 

45 Click next. 
46 Define three (3) macros for Dolby Pro Logic, DTS Neo 6, and THX. 

a Use the scrollbar to skip all the macros until you get to “Set output Mon...” 
b Select this macro. 
c Go to the window in the bottom right corner and find Dolby Pro Logic. 
d Ensure Pulse is selected, and click the green arrow. This adds the macro to the center 

pane. The screen heading should read “Define the macro to: Set Monitor Out surround 
mode to Dolby Pro Logic?” 

e Do the same for DTS Neo 6 and THX. 
47 Click finish. 
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48 See the diagram series that follows. 

 

49 You have now completed your driver setup. View the driver you edited in the Search tab. 
50 Drag the new driver to the project tree. 
51 Connect the video, audio and control or network connections (as appropriate) for the device. 
52 Click System Design, and double-click the device in the project tree. 
53 Use the Device Control window to test the control of the device. 
54 For the Harman Kardon Receiver driver, double-click Receiver. 
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Serial-controlled device drivers 
Creating a serial-controlled device driver 

Create serial drivers using the Control4 Driver Wizard in Composer Pro. Instead of capturing the 
code as you do with IR, you enter the specific serial data that you must send for each command. 

To create a serial-controlled driver: 
1 Follow the same steps used in “Creating IR-Controlled Drivers” and select a serial-controlled 

driver rather than an IR-controlled driver. 
2 Follow the wizard pages to create the driver. 

Guidelines for entering serial codes 
This section describes the different formats you can enter for the serial data of each command in 
Control4 serial drivers. 

These formats include: 

• Basic Method to Enter Bytes—Shows you how to enter a basic code. 
• Method to Enter Delays—Shows you how to enter a delay code that you need to control 

some devices. 
• Method to Enter Parameters—Shows you how to enter the needed parameters. 
• Method to Enter Checksums—Shows you how to enter the checksums. 

Method Description 

Basic Method to Enter 
Bytes 

All serial data in the end becomes bytes. There are three (3) basic formats to 
represent bytes, but in the end the resulting data is just bytes, and any format 
would suffice for the entry. For ease-of-use, multiple formats are supported. 
  
Examples for all methods: Data is equivalent to the ASCII string “DVD” with a 
carriage return at the end. 
  

Decimal Data—With decimal data and between any of the different 
formats there must be a space to act as a delimiter between different 
pieces of data. To enter decimal data, enter the value to be stored in the 
byte in decimal. Valid data is from 0-255. 
  
Example: Data (“DVD” with carriage return): 
  
68 86 68 13 
  
Hexadecimal Data—With hexadecimal data and between any of the 
different formats, there must be a space to act as a delimiter between 
different pieces of data. To enter hexadecimal data, enter the ‘$’ symbol 
immediately followed by the value to be stored in the byte in 
hexadecimal. Valid data is from $00-$FF. 
  
Example: Data (“DVD” with carriage return): 
  
$44 $56 $44 $0D 
  
ASCII Data—All ASCII data must be inside double quotes. Each byte 
inside the quotes represents one byte of data. Look at any ASCII table to 
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Method Description 
see the real values each character represents. The same ASCII 
characters supported in the C programming language are supported. 
Escape characters are also supported in the same way. Supported 
characters include \n (new line), \r (return), \t (tab, and \” (double quotes). 
  
Example: Data (“DVD” with carriage return): 
  
“DVD\r” 
  
Mixing formats — All of the above formats can be used together, and the 
person can use whichever seems most efficient. 
  
Example Data (All examples represent the exact same data): 
  
“DVD” $0D 
68 “VD” 13 
“DV” $44 13 
$44 $56 68 13 
68 $56 68 “\r” 

Method to Enter Delays 

Many times it is necessary to create delays when sending data to a serial 
device. The ‘#’ character is used to represent that the following number is a 
delay in milliseconds. A space is required between each element in the data. 
  
Example: This example assumes that the protocol calls for a “PWON\r” 
command followed by a 1500 millisecond delay followed by a “PLAY\r”. 
  

ASCII Example: 
  
“PWON\r” #1500 “PLAY\r” 
  
Decimal Example: 
80 87 79 78 13 #1500 80 76 65 89 13 

Method to 
Enter Parameters 

Many commands have parameters. Examples of these commands are the 
GO_TO_CHANNEL command for TVs and Satellite receivers or 
GO_TO_DISC commands for DVD and CD changers. 
  
During driver creation, you are allowed to create macros to embed the 
parameter in the data that is being entered. This creates different problems 
depending on whether the protocol is a binary or ASCII protocol. When 
entering ASCII parameters, use a modified version of the format that C uses in 
its printf function. 
  

Example: This example is a GO_TO_CHANNEL command where the 
protocol specifies that the devices need the ASCII command “Channel 
XXX\r” where the XXX is the three digit (decimal) channel number that is 
being requested with zeroes padded (on the left) if the number is less 
than 100. The parameter name is CHANNEL_NUMBER. 
  
ASCII Example: 
  
“ChannelHarman Kardon03dCHANNEL_NUMBER \r” 

  
Later, at run time when this command is called with the Channel 56, the 
output appears as follows: 
“Channel 056\r” 
  
During driver creation, you can also enter parameters in a binary protocol 



Composer Pro 2.5 User Guide   Serial-controlled device drivers 
 

317 

Method Description 
format. Borrowing from the last format with the modification that following 
the%, first is the byte count (valid counts are 1, 2 and 4), followed by the byte 
order (E = big endian, e = little endian), followed by the data format (D = 
decimal, others to follow). This is obviously followed by the actual parameter 
name as in the example above. 
  

Example: This example assumes the protocol needs a start byte that is 
the number 2, followed by the GO_TO_CHANNEL command code which 
is 57, followed by a 2-byte big endian channel number, followed by the 
end byte which is 0. 
  
2 57%2EDCHANNEL_NUMBER 0 

  
Later on at run time when this command is called with the Channel 357 the 
output looks like the following using our format. 
  

2 57 1 101 0 
(Hint 0x0165 is hexadecimal for 357, and 1 = 1 in decimal and 65 = 101) 

  
If the protocol used little endian for the parameter, the data entry is: 
  

2 57%2eDCHANNEL_NUMBER 0 
  
The output for the previous example is: 
  

2 57 101 1 0 

Method to Enter 
Checksums 

Many protocols require a calculated checksum. A way must be provided for 
the user to calculate a checksum. There are several formats for checksums, 
so different types of checksums must be allowed. The ‘&’ signifies that the 
software needs to enter a checksum followed by a byte count (valid counts are 
1, 2, and 4), followed by the byte index in the command where the checksum 
calculation starts (valid numbers are 0-9), followed by the byte size of the 
checksum chunks (valid sizes are 1 and 2), followed by byte order (E = big 
endian e = little endian), followed by the checksum calculation format (STD = 
standard (chunk size wide) addition inverted, CRC = CRC). 
  

Example: The example uses the same devices as previously mentioned 
and assumes the big endian GO_TO_CHANNEL command, where that 
command needs a checksum (before the 0 end byte) starting at the 
beginning of the command, and the command is a simple 1-byte 
checksum. 

  
The data entry displays the following: 
  

2 57%2EDCHANNEL_NUMBER &101ESTD 0 
  
And the output for the previous examples is (channel = 357): 
  

2 57 1 101 94 0 
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Example: Creating a serial driver  
InFocus LP850 projector 

When creating a serial driver using the Control4 Driver Wizard in Composer Pro, the driver 
supports one-way communications. 

Example: In this example, you create a driver to support the serial-controlled InFocus LP850 
Projector. 

To create a new serial driver: 
1 Start Composer Pro and connect to a Director. 
2 Ensure that you have added a controller to your project (this should be the first device 

added). 
3 To launch the Driver Wizard, from the Driver menu select Create a New Driver. 
4 In the Driver Wizard, select the device driver you want to create, and click ok. 
5 Fill out the driver information, such as Manufacturer, Model, and Driver Creator name. The 

date created, date modified, and the copyright information is generated automatically. 

For the InFocus LP850 Projector, use the following information: 

• Manufacturer: InFocus 
• Model: LP850 
• Driver Creator: ACME Integrators 

6 Indicate how this device is controlled using IR or Serial. Example: Serial. 
7 Set up the serial settings. 

• Serial—Select this radio button if the device you want to create a driver is for serial 
controlled. The following serial options are specific settings on serial devices. 

• Baud Rate—The number of symbols or characters per second sent over a serial link. 
Options: 110, 300, 1200, 2400, 4800, 9600 – default, 19200, 38400, 57600, 115200, 
230400, 460900, 921600. 

• Data Bits—Use the drop-down menu to select (5, 6, 7, 8 – default). 
• Flow Control—The control of the transfer of data to avoid congestion. Options: None - 

default, Xon/Xoff, Hardware. 
• Stop Bits—Options: 1-default, 1.5, 2. 
• Parity—The process for detecting whether bits of data have been altered during 

transmission of data. A parity bit is appended to an array of bits to make the sum of all 
the bits always odd or always even for error detection. Options: None – default, Even, 
Odd, Mark, Space. 

8 For the InFocus LP850 Projector, use the following settings: 
• Baud Rate: 19200 
• Data Bits: 8 
• Flow Control: None 
• Stop Bits: 1 
• Parity: None 

9 Click next. 

Define the audio parameters 

Example: Projectors do not have audio, so do not check anything. 

10 Click next. 
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11 Fill out the device properties for the driver you are creating. Properties are features that vary 
between the different models of the same device type. For example, some Televisions have 
discrete power control and some only offer toggle power on/off. You must define in the driver 
you’re creating the features supported in the model. 

12 For the InFocus LP850 Projector driver, check Discrete Input Selection. 
13 Click next. 

Indicate how the power is handled 

14 For the InFocus LP850 Projector driver, select Use discrete on/off codes. For more 
information about power management options, see “Guidelines for Defining Power 
Management.” 

15 Click next. 

Select the appropriate codes 

16 For the InFocus LP850 Projector driver, de-select the following commands: 
• Cancel 
• Channel Down 
• Channel Up 
• Enter 
• Info 
• Number 0 through 9 

17 Click Add to enter any custom commands. 
18 Add the following options: 

• Aspect Ratio: 16:9 
• Aspect Ratio: 4:3 
• Aspect Ratio: Native 
• Ceiling mount off 
• Ceiling mount on 

19 Enter the serial code for each serial command. 
20 Click next to continue through the codes. For information about how to enter serial codes, 

see “Create a Serial-Controlled Driver.” 
21 Click Add to identify the Input connections on the device. 
22 For the InFocus LP850 Projector, add the following input connections: 

• Video 1 (Input, Line Level) 
• Video 2 (Input, Line Level) 
• Video 3 (Input, Line Level) 
• Computer 1 (Input, Line Level) 
• Computer 2 (Input, Line Level) 
• Computer 3 (Input, Line Level) 

23 Click next. 

Define the connection types for the inputs and outputs 

24 Define the connection types for Inputs/Outputs for all the inputs/outputs. For the InFocus 
LP850 Projector driver, define all the previous inputs identified previously. 

25 Click next until you have defined all of the inputs and outputs. 

Define the macros 

26 Enter any additional serial codes needed to perform the desired action. For Serial Drivers, 
based on the selections you made in the Device Info section (where you defined Driver 
capabilities), both Codes and Macros have to have the serial strings entered. 
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27 Click next. 
28 Click next again. 
29 Click OK to return to Composer Pro. The driver you created is located in the Search tab in 

Composer Pro. 
30 You have now completed the setup of you driver. Select the Search tab and the driver type 

you just created. 
31 To check whether your driver is in the Online Database, select the driver. For the InFocus 

LP850 Projector driver, select Projector > InFocus LP850. 
32 Drag and drop the new driver to the project tree. 
33 Make the appropriate video, audio, and control connections or network connections (if 

appropriate) for the device. 
34 Click System Design and double-click the device in the project tree. Use the Device Control 

window to test the control of the device. 

 Example: Double-click Projector. 

DriverWorks Two-way serial or TCP/IP 
driver  
Creating a 2-way serial or TCP/IP-controlled driver 

You can create most serial drivers using the Control4 Driver Wizard in Composer Pro. Instead of 
capturing the code as you do with IR, you enter the specific serial data that you must send for 
each command. 

Use DriverWorks instead of the Control4 Driver SDK to create 2-way drivers for AV and non-AV 
devices that are controlled using a serial or TCP/IP connection. 

DriverWorks exposes each of the driver APIs previously published through the Control4 Driver 
SDK (now discontinued). It is an SDK framework that allows 2-way drivers to be written for the 
Control4 system. 

DriverWorks drivers can be written and installed without requiring platform- and version-specific 
compiling. Using DriverWorks does require some programming skills, but this tool leverages the 
Lua-embeddable scripting language, which is powerful, fast, and light-weight language (when 
compared to other scripting languages). DriverWorks comes installed with Release 1.6 and later 
software releases. 

For information on using DriverWorks, refer to the SDK DriverWorks documentation (“Getting 
Started with DriverWorks”), which is downloadable from the documentation area on the Control4 
Dealer Web site: Go to http://dealer.control4.com/dealer/support/software-updates. 

Related tasks 
Here are a few other tasks related to using Control4 device drivers in Composer Pro. 

 “Exporting a driver in the project” 

“Verifying IR codes using the Driver Wizard” 

http://dealer.control4.com/dealer/support/software-updates
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Using a new device driver in an existing project 
A new device driver can be added to an ongoing project in the Control4 system. 

To add a new driver to an existing project: 
1 Start Composer Pro and connect to a Director. 
2 Delete (right-click > Delete) the driver from the existing project. 
3 Add the device to the project again. 
4 Re-configure any connections (see the Network or Control/AV tabs in the Connections view) 

and any associated programming. 

Exporting a driver in the project 
For all audio/video equipment, you can export a Control4 driver to save or add to other projects. 
This essentially saves a driver for other uses outside of the current project.  

Example: Export the driver you have edited on one Control4 system to another Control4 system, 
and save it with your company name. 

To export a connected driver: 
1 Start Composer Pro and connect to a Director. 
2 In an existing project and from the project tree, right-click the driver you want to export and 

select Export Driver. This option is available from System Design, Connections, or 
Programming. 

3 On the dialog that appears, type your company name in the Creator Name box. 
4 Click the Search tab to find the saved driver. 
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Maintaining Your 
System 

Use this chapter to learn how to: 

• Update Composer and Director 
• Create Panelized Lighting reports 

Updating Composer and Director 
Use the Control4® Composer Pro software to update Composer Pro and Director. 

IMPORTANT! Before you begin any update, check the Control4 website for any Release Notes 
or upgrade documents associated with the update, especially if it's a major update such as up to 
Release 1.8.2 or OS 2.0. Read those documents first. 

Depending on the type of upgrade you need to perform, the following tools and website may 
need to be used. 

• Control4 website 
• Update Manager 
• Network Status 
• System Manager 
• Device Properties (Sony STR-DA2800ES/DA5800ES AV Receiver only) 

http://www.control4.com/
http://www.control4.com/
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Control4 website 
Composer Pro updates (software releases) are available on the Control4 Dealer website at 
http://dealer.control4.com/dealer/products/software-updates/. You will need a Dealer login and 
password to access this site. 

Prerequisites 
Ensure that Release 1.8.2 and Composer Pro 2.0 are installed before you begin a subsequent 
update. See Composer Pro Getting Started for details. If you have an earlier release, see the 
update instructions for that release. You must update first to Release 1.7.4 and then 1.8.2 before 
updating to OS 2.0 and later. 

Activate your licenses. See "Purchasing and Setting Up Dealer Licenses" in Composer Pro 
Getting Started or Managing Dealer Accounts on my.control4.com on the Control4 
Knowledgebase for details. 

To access the software updates: 
1 Log in and go to: http://dealer.control4.com/dealer/products/software-updates/. 
2 Under Software Updates select the software version to download and install. 

The following 
software releases 
are available on the 
Control4 website: 
Composer 1.2.5 

Composer 1.8.2 Composer 2.1.0 Composer 2.2.2 

Composer 1.3.2 Composer 2.0.4 Composer 2.1.1 Composer 2.2.4* 

Composer 1.6.0 Composer 2.0.5 Composer 2.2.0 Composer 2.3.0 

Composer 1.7.4 Composer 2.0.6 Composer 2.2.1 Composer 2.4.0 

Composer 2.5.0    

*For the Sony STR receiver, use the ‘receiver’ Properties page. See “Sony STR-
DA2800ES/5800ES with full Control4 Automation” in this guide. 

Other software utilities are available for download also at the Dealer software download site. 

IMPORTANT! For new installations, it is always a best practice to use the latest version of the 
released software. 

http://dealer.control4.com/dealer/products/software-updates/
http://dealer.control4.com/dealer/support/documentation
http://dealer.control4.com/dealer/support/documentation
http://dealer.control4.com/dealer/support/documentation
http://kb.control4.com/
http://dealer.control4.com/dealer/products/software-updates/
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Update Manager 
Update Manager in Composer Pro automatically updates Director and all of the IP-connected 
devices that are available in your project (identified and online), allowing you to update all the 
devices in the project configuration also. You can use Update Manager to update from all 
previous releases. 

To support multiple releases, the release (for example, 1.7.x) installs in a Composer Pro 
directory (for example, Composer17x), which differs from previous releases that were installed in 
the Composer Pro directory. You do not need to uninstall previous releases to install a new 
release, but you must install Composer 2.0 or later before you begin the update to the latest 
release. 

Note: You cannot use Update Manager to update a Sony STR-DA2800ES/DA5800ES Receiver 
with Full Control4 automation. See “Updating Firmware” in this guide or the Sony STR-
DA2800ES/DA5800ES Receiver Control4 Automation Activation Guide in the dealer Product 
pages at control4.com for details. 

To access Update Manager: 
1 Start Composer Pro and connect to a Director. 
2 From the Tools menu, click Update Manager. 

Network Tools 
Composer Pro Release 1.7.3 or later uses this option. 

To access Network Tools: 
1 Start Composer Pro and connect to a Director. 
2 From the Tools menu, click Network Tools. 
3 Network Tools has three (3) tabs (Release 1.8.0 or later). Use these tabs as required by the 

software:  
• IP Network 
• ZigBee Network 
• EmberNet Upgrade 

System Manager 
System Manager provides some of the functionality as in previous releases, but it does not 
perform the update. Use System Manager to add, refresh, connect, or disconnect devices. 

Updating firmware 
Sometimes you’ll receive new devices that aren’t on the same firmware version. For all devices 
to be able to communicate with each other, they do need to be on the same firmware version. 
Refer to the current Release Notes to get the latest updates on firmware. 

ZigBee devices 
ZigBee devices update automatically to the current firmware version when they are installed and 
identified to the system. 
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IP devices 
To update IP devices, run Update Manager. You can check the firmware version either in 
System Design > Properties pane (for the device), or in Tools > Network Tools > ZigBee tab for 
ZigBee devices.  

Black & Decker locks 
Note: Ensure you're running a current version of Composer Pro and Director on the system. 
Without the current version, the latest firmware will not be available. 

To force a firmware update on the lock: 
1 Remove the batteries from the lock (press a key or two to eliminate any charge in the lock). 
2 Put the batteries back in. 
3 Press the top left button four (4) times. 
4 Press the top right button four (4) times. 

The firmware should start updating. If it does not, ensure that your batteries are fresh. If you 
cannot manually start the firmware update, the lock should automatically check in for an update 
after the first check-in of the lock, at 3 AM. 

Sony STR-DA2800ES/DA5800ES with Full Control4 Automation 
In OS 2.2.4 and later Sony prohibits the use of a USB update using Update Manager. This is a 
security breach to Sony’s system, so they do not allow it outside of a Sony factory or technician-
repair scenario. As such, you still can perform a firmware update in Composer Pro. 

To update the Control4 software in the receiver: 
1 In Composer, locate the Sony STR receiver device in the project (receiver). This driver 

signals updates and coordinates with Sony’s web service where the approved updates are 
kept. 

2 Click on the receiver to view the Properties page. 
3 The ‘Auto Updates Enabled’ property defaults to ‘false.’ Do not change this setting. 

 

When a new firmware update is posted to the Sony update web service, the receiver will 
detect the update and ask you if you want to update if 

• the receiver has been rebooted (power off and back on, not on ‘standby’), 
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• an update exists on the Sony update web server, 
• the receiver is connected to the Internet, and  
• the TV screen connected to the receiver is on. 

A Sony UI page will display and ask you to accept or cancel the update by clicking OK or 
CANCEL (displays either in the Sony UI or the on-screen Navigator). Use the Sony remote 
shipped with the receiver to make the selections. 

4 (Optional) The Actions tab gives you another way to get an update if the previous conditions 
are met (see the list in Step 3).  
a Click on the Actions tab. 

 

b Click Start Update. This action checks the Sony update web server for updates. If there 
is an update, a Sony UI displays in the on-screen Navigator and will ask you to accept 
or cancel the update by selecting OK or CANCEL. 

Guidelines for updating a Control4 system 
Use these Control4 guidelines to update a Control4 system. 

IMPORTANT! Before you begin any update, check the Control4 Dealer website for any Release 
Notes, Read This First, or upgrade documents associated with the update and the release. Read 
those documents first. 

Note: The update behavior and steps for various releases differs. Make sure you review any 
documentation associated with the release before you begin your updates. 

Follow these important guidelines for updating Composer Pro: 
• Back Up Your Project. If you have a project in an earlier version of Composer, back it up 

before you update. 
• Verify the Network Connections. Update Manager requires an active network connection 

to function properly. Ensure that the network connection is up and working prior to 
performing the upgrade. 

• Update Errors. If you notice any errors during the update process in the Update Manager’s 
output pane, take note of the error message, and follow instructions provided at 
“Troubleshooting the Upgrade Process.” 

IMPORTANT! You cannot have both connection methods identified on the system. Remove 
the network connection to Zigbee and identify it again using the Ethernet connection. 



Composer Pro 2.5 User Guide  Updating Composer and Director 
 

 327 

• Power On. Ensure that the power state of all devices is On. You can verify that all devices 
are online from the Network Tools page. 

• Know When the Update is Completed. When upgrading the Control4 controller running 
Director, you are disconnected from Composer Pro and streaming audio stops. 
a After this occurs, restart Composer Pro and reconnect to the system. 
b Go to Tools > Update Manager and watch the update process. 
c Also, go to Tools > Network to ensure that everything is connected. If it is not 

connected, it cannot update that firmware. 
d After Update Manager indicates that it is completed (you may see a message like 

“Finished site update attempt,” all the IP devices on the system are now updated. This 
does not include ZigBee devices or hybrid devices (containing both IP and Zigbee). 

e Go to Tools > Network Tools to view the firmware versions to ensure they are updated 
to this release. 

Tip: Be patient. In cases where the ZigBee mesh is moved, it can take up to five minutes 
for all connections to be re-established. 

Guidelines for updating specific devices 
• Primary Controller. The primary controller holds a new firmware image file, which is 

transferred and reflashed when an Ethernet network connection is present. After the update, 
disconnect the IP identification and identify again using Zigbee. 

• ZigBee Devices. When upgrading a controller associated with ZigBee devices, such as 
dimmers, switches, and keypads, these are also upgraded. As these devices upgrade, the 
device’s LEDs and the associated lighting loads may flicker. This is normal behavior. 

• ZigBee Pro Devices. Follow the instructions in Composer Pro Software Release Update 
Instructions - 1.7.3 to 1.8.0 for details about ZigBee Pro updates. 

• Home Theater Controller and Speaker Point. During the update, the LEDs flash, 
indicating the upgrade process is in a critical mode. 

Note: In OS 2.0 and later, Speaker Point does not support the M4P/AAC format. Use MP3. 

WARNING! Do not stop the update or disconnect the network during an update. 

• Audio Matrix Switch or Multi Channel Amplifier. If you are updating an Audio Matrix 
Switch or Multi Channel amplifier that is using a ZigBee connection, you must temporarily 
connect these devices to an Ethernet connection before updating for the firmware update to 
occur. 

Estimating Control4 system update times 
Use Control4 Composer Pro to update the Control4 system. 

Estimating update times per device type 
The update time is dependent on the size of the Control4 system, the available network 
bandwidth, and the types of devices you are updating.  

There are three (3) types of devices: IP devices that communicate solely by TCP/IP, ZigBee, 
ZigBee Pro devices that communicate via ZigBee or ZigBee Pro, and hybrid devices that use 
both TCP/IP and ZigBee for communication.  

http://dealer.control4.com/dealer/support/documentation
http://dealer.control4.com/dealer/support/documentation
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Depending on the device type, some devices, such as the IP devices update in parallel; other 
ZigBee or hybrid devices are updated sequentially, one after another. Generally, the IP devices 
are updated in parallel immediately after the primary controller updates. After that, the ZigBee 
devices update in sequence starting with the system remote control, and then followed by the 
hybrid devices which update in sequential order. The system remote control is the first ZigBee 
device to update if it is in Wake mode. During or after the update, if the system remote control 
was in Sleep mode, it updates immediately after it wakes up. 

The following list identifies some typical Control4 devices and update time estimates. 

• IP devices (updated in parallel immediately after the primary controller): 
• Controllers—20 to 40 minutes 
• 7” touch screens—15 to 20 minutes 
• Speaker Point—10 to 15 minutes 

• ZigBee devices (updated sequentially): 
• System Remote Control—3 to 5 minutes (updated as the first ZigBee device if awake) 
• Dimmer/Keypad/Switches—3 to 5 minutes 
• Thermostat—10 minutes 

• Hybrid devices (both Zigbee and IP - updated sequentially): 
• Multi-Channel Amplifier -16-5 minutes 
• Contact/Relay Extender—5 minutes 
• Audio Matrix Switch—5 minutes 
• Multi Tuner V1 and V2—5 minutes 
• XM Module—5 minutes 
• Dock for iPod—5 minutes 
• Media Player—5 minutes 
• IO Extender—5 minutes 

Note: An update from Release 1.7.4 to Release 1.8.2 may take longer than other updates. 

Example: a total of 

• 20 devices may take 110 minutes or longer 
• 30 devices may take 150 minutes or longer 
• 60 devices may take 300 minutes or longer 

to complete the process. Dimmers and switches do not need to be updated. 

You may want to practice on your own Control4 system first before upgrading a customer's 
home; for example, an update to Release 1.8.2 is not trivial. 

Best practices for updating a Control4 system 
These sections will help you understand the best practices to follow when performing a Control4 
update in Composer Pro. If you follow these sections in order until your system updates 
successfully, you may avoid some unnecessary pitfalls. 

General procedure 
To update your system and software: 
1 Back up the current project and media. 
2 Check that you have a good network connection. 
3 Check the currently-installed Composer Pro and Director versions. 
4 Update Composer Pro software and drivers. 
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5 Update Control4 products using Update Manager (except for Sony STR Receivers). 
6 If you have problems, see “Troubleshoot the Upgrade Process” or contact Control4 

Technical Support. 

Tip: The update process is highly dependent on valid network configurations and Internet 
connection availability and bandwidth. Please confirm that the devices on your network have a 
valid connection to the Internet. If you are using DHCP, confirm that your DHCP is active and 
can issue valid IP addresses to clients on the network. 

IMPORTANT! Do not use a previous release of Composer Pro to modify a 2.0 system. Likewise, 
do not use a 2.0 version of Composer Pro to modify a previous release of the Control4 system. 

Back up the current project and media 
To back up your current project and media: 
1 Back up your current project file from a previous release by using File > Backup As. Give it 

a filename that clearly identifies it as the backup. 
2 (Optional) Back up your media. Copy all directories to your computer's hard drive or other 

storage media from the media storage location on your Control4 controller at: \\<ip address 
of Control4 controller>\media\audio. 

3 Continue to the next section. 

Check the currently installed Composer version 
It is helpful to check the currently-installed Composer Pro version before installing the update to 
make any necessary project adjustments. 

To check currently installed Composer Pro version: 
1 In Composer Pro, click Help > About Composer. 
2 From the dialog that appears, write down the Composer Pro and Director versions. 

Example: Composer version 2.3.0.190646 and Director version 2.3.0.190646. 

To ensure that the Control4 system is working properly, the Composer Pro and Director 
versions should always be consistent and have the same version number. 

Note: You do not need to be on a certain version, however, to update. Update Manager 
updates the Control4 system from all previous releases. The only reason you need to know 
this information is to determine when your project was set up. Control4 always recommends 
that you write down these versions in case this information is needed later. 

3 Continue to the next section. 

Update Composer software and drivers 
The Composer Pro software download consists of Composer Pro software and new or updated 
device drivers to support Control4 hardware and other third-party products. The following steps 
outline how to launch the software executable and ensure that you have the latest drivers. 

Note: The Inspector utility can be used to verify each package after installation. Inspector reads 
all of the md5sums in the /var/lib/dpkg/info directory, and runs a new md5sum against them. Any 
missing files or files where the md5sums have changed are reported in 
/tmp/Inspection.$timestamp. 
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To install a released Composer Pro software version: 

The following steps are an example of a software installation. Refer to the Release Notes 
associated with the software release for specific instructions. 

1 Download the software package from the Internet at www.control4.com. 
2 Install the current Composer Pro software, for example, Composer Pro 2.4.0. 
3 Follow the on-screen instructions to complete the installation. 
4 During the installation process, click the Continue Anyway button for the installation to 

proceed. 
5 Continue to the section, "Update Control4 Products Using Update Manager." 

 (Optional) To ensure the driver database is updated: 
1 From the Driver menu, select Manage Drivers. In the utility, you can see the creation and 

modification dates for all drivers in the local database residing on your computer. 
2 Click Add to search the online database, and compare the modified dates to determine if a 

new driver is available. 
3 If a newer driver is available and you want to download it, check the box next to the device 

model number, and click OK to download the newer associated driver. 

Tip: When Composer Pro is first installed, the My Drivers tab is pre-populated with a list of 
drivers. The My Drivers tab provides shortcuts to commonly-used drivers. You can add, 
remove, and re-order items to the My Drivers tab as needed. Removing drivers from My 
Drivers tab only removes the driver from the list. It still exists in the Local Database. To get 
back to the default My Drivers tab list and to include newly-added Control4 devices, right-
click any device and click Restore Default List. This action does not affect the Local 
Database in any way. Also, right-click the My Drivers tab, select Add Driver, and then 
select all the Control4 devices not currently in the list. 

Note: Devices that use SDDP for Auto Discovery (OS 2.2.4 and later) do not require you to 
identify the device; just add the device to the room. See the Composer Pro Getting Started 
guide for details. 

Update Control4 products using Update Manager 
Refer to the following sections to guide you through the update process: 

• Update from Release 1.7.4 to 1.8.2. See “Update from Release 1.7.4 to 1.8.2.” 
• Update from Release 1.8.2 to 2.0. See “Update to Release 1.8” or “Update to Release 2.0.” 
• Refer to the Release Notes in subsequent releases for additional update instructions. 

Update from Release 1.7.4 to 1.8.2 
Use Control4 Composer Pro to update your system from Release 1.7.4 to Release 1.8.2. 
Detailed instructions about how to update from Composer Pro Release 1.7.4 to 1.8.2 are not 
included in this document. For those instructions, refer to the Composer Pro Software Update 
Instructions - Release 1.7.4 to 1.8.2 on the Control4 dealer Documentation page. The document 
provides general steps, terms and concepts, and what to prepare for prior to performing the 
update. It then describes the steps for the update. 

Ensure that Composer Pro and Director are using the same version of 1.7.4, and that all devices 
are identified on the network before starting this update. 

http://www.control4.com/
http://dealer.control4.com/dealer/support/documentation
http://dealer.control4.com/dealer/support/documentation
http://dealer.control4.com/dealer/support/documentation
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What’s new in the update? 
Release 1.8.x introduces support for ZigBee Pro 1.1. During the update from 1.7.4 to 1.8.2 all 
ZigBee devices will be updated to run on the ZigBee Pro stack which requires a complete 
replacement of the firmware on all devices. This enhancement allows Control4 to operate with 
other ZigBee Pro-compliant devices which opens up a whole world of new devices that are 
compatible with the Control4 system. 

Highlights of the update 
• New terms such as ZigBee Access Point (ZAP), ZigBee Pro, MiniApp, and EmberNet are 

introduced and described. 
• Two (2) stages of upgrade occur for MiniApps (dimmers, switches, keypads, and outlet 

modules): the ZigBee Pro stack is installed, and then all the devices must be joined to the 
network. When updating the MiniApps, special LEDs on the devices indicate their status. 

• Products not supported with ZigBee Pro: 
• System remote control V1 and V2 
• LCD keypad (use Ethernet) 
• Contact/Relay extender (use Ethernet) 
• Audio products (audio matrix switch, multi-channel amplifier, and multi-tuner). Use 

Ethernet. 
• The Network Tools screen (formerly Network Status) has a new tab for EmberNet Upgrade. 

This shows all of the devices on the current network that haven’t been updated to ZigBee 
Pro. 

Update to Release 1.8.2 
Use the Control4 Composer Pro Update Manager to update to Release 1.8.2. 

IMPORTANT! To update to Release 1.8.2, the Control4 system first must be updated to Release 
1.7.4. After that, follow the instructions in the Composer Pro Software Release Update 
Instructions - Release 1.7.4 to 1.8.2 on the Control4 Knowledgebase. 

Update to Release 2.0 and later 
Use the Control4 Composer Pro software to update to OS 2.0. 

Note: Before you begin the update, ensure that the Control4 system has been updated first to 
Release 1.7.4 and then to 1.8.2. Also, ensure that you have installed Composer Pro 2.0. 

For update instructions, refer to 

• Composer Pro Software Release Update Instructions - Release 1.7.4 to 1.8.2 
• Composer Pro Software Release Update Instructions – Release 1.8.2 to 2.0 
• Control4 System Software Release Version 2.0 Release Notes 

on the Control4 Dealer website or on the Control4 Knowledgebase. These documents provide 
important terms and concepts that you must understand, and what to prepare for prior to 
performing the update. It then describes the steps to follow to complete the update. 

To install updates later than OS 2.0, follow the instructions in “Updating Composer and Director.” 

http://kb.control4.com/
http://kb.control4.com/
http://dealer.control4.com/dealer/products
http://dealer.control4.com/dealer/support/documentation
http://dealer.control4.com/dealer/support/documentation
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Updating with a USB device (USB Stick Creator) 
Create an Install on a USB device 

These steps show you how to create an install to a USB device attached to your computer’s hard 
drive and use the same USB device to install your customer’s system without an Internet 
connection. 

Note: You cannot create a USB install for a Sony STR-DA2800ES or STR-DA5800ES receiver. 
See “Updating Composer and Director” for details. 

Prerequisites 

• Have a USB drive handy, formatted for FAT32 with at least 2GB (OS 2.2.2 or earlier) or 4GB 
(OS 2.2.2 or later) total available disk space. 

• Only installs for OS 1.7.4, 1.8.2, 2.1 or later can be created using this procedure. Note: This 
creation procedure does not work on OS 2.0.x releases. If you are creating an install using 
an older software version, refer to USB Stick Creator White Paper at control4.com  on the 
Knowledgebase to create the install. 

• A valid license on the controller to be updated. 

To copy an install to a USB device: 
1 Open a browser and go to www.control4.com.  
2 Log in as the dealer. 
3 Go to Products > Software > Software Updates > USB Installer. 
4 Click on the USB Install Creator program. 
5 Follow the instructions in the USB Stick Creator White Paper (located next to USB Installer) 

to complete the process. 
6 Connect the USB drive to your customer’s system using Composer Pro, and then follow the 

instructions in the USB Install White Paper. 

http://dealer.control4.com/dealer/support/software-updates
http://kb.control4.com/
http://www.control4.com/
http://dealer.control4.com/dealer/support/software-updates
http://dealer.control4.com/dealer/support/software-updates
http://dealer.control4.com/dealer/support/software-updates
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Reports 
Panelized Lighting reports 

Use the Control4 Composer Pro Tools menu to create reports for Panelized Lighting installations 
(Tools > Reports).  

Creating reports in Composer Pro is essential for the electrician to use as a reference before 
they install and wire the Panelized Lighting devices in the panels. Use the Tools > Reports 
option to select and generate the reports.  

IMPORTANT! Before you begin to design and plan a Panelized Lighting system, make sure you 
attend the Panelized Lighting training sessions and videos, and then review the Panelized 
Lighting documentation in the Products section on the Control4 website. 

 

Report types 
• Panel Report. This report lists all Control4 panels in the project. Each panel shows the 

modules and associated terminal blocks that should be installed in each slot. 
• Module Report. This report can be generated for one or all panels in the project. This lists 

each module, where it goes in the panel, the circuit breaker information for the module, and 
all loads connected to the module. 

• Load Schedule Report. This report lists all of the Panelized Lighting lights in the project. 
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Create a Panel Report 
Create and generate this report for Control4 2-Slot or 5-Slot panels. 

To create a Panel Report: 
1 In the Reports list, select Panel Report. 

 

2 Click Display Report. 

 

3 View, save, or print out the report. The report shows a graphical view of the panels and 
where the devices should be installed. 
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Create a Module Report 
Create and generate this report for Panelized Lighting modules. 

To create a Module Report: 
1 In the Reports list, select Module Report. 

 

2 Select to create a report for All Panels or a specific panel. 
3 Click Display Report. This report shows the channels, loads, load name and location, 

wattage, and power booster. 

 

4 View, save, or print out the report. 
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Create a Load Schedule Report 
Create and generate this report for the load schedule. 

To create a Load Schedule Report: 
1 In the Reports list, select Load Schedule. 
2 Click Display Report. 

 

3 View, save, or print out the report. This report shows the load number, name, and location, 
the connections and the wattage. 
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Troubleshooting 
Use this chapter to learn how to: 

• Follow general guidelines for troubleshooting 
• Troubleshoot controllers 
• Troubleshoot a Director connection 
• Troubleshoot media 
• Troubleshoot devices 
• Troubleshoot the upgrade process 

Guidelines for troubleshooting 
This section outlines general troubleshooting guidelines to check first if you are having problems 
with a Control4® system. 

The following table lists the main areas typically found to resolve some issues on the Control4 
system. 

Guideline Where to go 

Check room 
connections 

Composer Pro automatically sets room connections when you set up a 
system. These settings are default settings, and may not necessarily match 
your physical connection. Ensure that the room connections are set to match 
your specific system.  
 
If you move a device to another room, move it in the project tree also, and 
then identify it again to make sure it's connected properly.  
 
For more information, see:  
“Connecting rooms”  
“Testing device controls”  
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Guideline Where to go 

Check Control/AV 
connections 

The Control and AV connections identify the physical connections to the 
system. When these are defined, the system is completely automated and 
programmable. However, if one of the connections is not correctly identified, it 
can cause the system not to run properly. Ensure that the control and AV 
connections match the physical configuration. 
  
For more information, see: 
“Control/AV tab” (see Composer Pro Getting Started) 
“Control and audio video connections” (see "Control/AV tab" in Composer Pro 
Getting Started) 

Check network 
connections 

If a device is not using a control connection to communicate to the Control4 
controller, it uses a network connection: a type of connection that uses a 
network address such as TCP/IP (Ethernet), ZigBee, ZigBee Pro and WiFi. 
  
1. Ensure that the network connections viewable in the Connections view > 
Network tab all have a network address associated with the device. If not, 
identify the device again. 
2. Ensure that the Control4 controller, such Home Controller HC-250, has a 
network address. If the address is not appearing, identify the device again. 
 
From the Tools menu, select Network Tools. This lets you see all of the 
ZigBee and IP network addresses on the network. It shows whether the 
device has an address, if it has an active connection to the network (status is 
online), and the ZigBee signal strength of each device. 
  
For more information, see: 
  
“Network Tab”  (see Composer Pro Getting Started) 
“Network Tools Dialog”  (see "Tools menu" and "Network tools dialog"  in 
Composer Pro Getting Started) 
Connecting a Device to the Network (see “Connecting devices”) 
“Cannot identify the device to the network” 
“Verifying the network connections” 

Ensure Navigators are 
connected to Director  

From any of the Navigators, press Info > Director (for releases prior to 2.0) or 
More > Settings > Network (OS 2.0 or later) to ensure that you are 
connected to the Control4 controller’s network address. You can find out the 
Control4 controller’s network address from the Connections view > Network 
tab. 
  
For more information, see ”Customizing Navigators.” 

Ensure music is added 
and scanned 

In Composer Pro, ensure that your music is available (added to the controller) 
and is scanned into the system. 
  
1. Make sure the stored or broadcast media is added or scanned. 
2. Check the Room Properties page to see if the media was added. 
3. Ensure that Navigators were refreshed after scanning media. 
4. If the controller reboots, re-scan the media. 
  
For more information, see: 
  
“Items pane” (see Composer Pro Getting Started) 
“Setting up media stored on a controller” 
“Setting up media stored in a disc changer” 
“Setting up media for television channels” 
“Setting up media for radio stations” 
“Using external storage devices” 
“Adding an audio switch or audio/video switch” 

http://dealer.control4.com/dealer/support/documentation
http://dealer.control4.com/dealer/support/documentation
http://dealer.control4.com/dealer/support/documentation
http://dealer.control4.com/dealer/support/documentation
http://dealer.control4.com/dealer/support/documentation
http://dealer.control4.com/dealer/support/documentation
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Guideline Where to go 
“Creating a playlist” 
“Editing media information” 
“Testing media control” 

Refresh Navigators Whenever you update the system, scan music, or update devices or device 
information, from the File menu, select Refresh Navigators. 

Troubleshooting controllers 
The following table lists troubleshooting problems on Control4 system controllers. 

Symptom Possible problems and solutions 

The controller has 
N/A for IP address 

1. The controller has no network connection. Plug in your Ethernet cable. After 
a few moments, the addresses should appear. 
2. The power cable is not plugged in. Plug in your power cable. 
3. No DHCP on the network. Ensure that DHCP is operational. 

The controller has a 
blank front display 

1. Either your cables are unplugged, or they are not connected. If both are 
connected, unplug them and connect the Ethernet cable before connecting the 
power cord. 
2. The controller is not connected to a cable/modem/switch/ using DHCP. 
3. Ensure that the Reset button is not jammed behind the plastic cover (older 
controllers only). 

The controller doesn't 
come back up after a 
power outage 

To receive a notification of the controller going down and coming back up, set 
up an Email Notification agent to alert you when the project is loaded and the 
controller comes back up. When you create the alert, place the alert on the 
project (Device Events top level). See Example: “Program using the E-Mail 
Notification Agent.” 

Rebooting the Control4 system 
At one time or another you may have configured the Control4 system incorrectly, or the 
connection to the network is not behaving the way it should. In this case, you can reboot or reset 
the system. You don't have to do anything in Composer Pro other than check that the device you 
reboot is on the network. 

To reboot a controller: 
1 Disconnect the power cord from the controller. 
2 Plug the power cord back into the controller. 
3 Verify that the controller comes back on the network in Composer Pro. See “Connecting a 

device to the network” or your controller’s installation guide for details. 

Note: To reboot a Sony STR-DA2800ES/DA5800ES receiver with full Control4 automation, 
unplug the receiver and plug it back in. See the Sony STR-DA2800ES/DA5800ES Receiver 
Control4 Automation Activation Guide on the Documentation page or Product page for details. 

http://dealer.control4.com/dealer/support/documentation
http://dealer.control4.com/dealer/support/documentation
http://dealer.control4.com/dealer/support/documentation
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Resetting the Control4 system 
Use the Control4 system Composer Pro to reset a controller. You reset a controller to reset it 
back to the factory defaults. Refer to your controller’s installation guide for reset and factory 
restore instructions. 

Note: To reset or restore a Sony STR-DA2800ES/DA5800ES receiver with full Control4 
automation, see the Sony STR-DA2800ES/DA5800ES Receiver Control4 Automation Activation 
Guide for details. 

Troubleshooting a Director connection 
The following table lists troubleshooting problems connecting to a Director. 

Symptom Possible problems and solutions 

Cannot see the 
Network Address of 
Director in the 
Director’s dialog 

1. In Tools > System Manager, click Refresh several times to see if the network 
address appears. 
2. If not, select Add and enter the name and network address. 
3. Make sure Director is enabled on the controlling device. 
     a. At a command line, enter telnet [controller IP address]. 
     b. Enter the root username and password. 
     c. Enter sysman status. 
     d. If Director is not enabled, enter sysman enable director. 
     e. Enter sysman status and verify the Director is now enabled. 
     f. Enter exit. 

Troubleshooting media 
The following table lists troubleshooting problems with Control4 system media. 

Symptom Possible problems and solutions 

DVDs not showing up 
in the disc changer 

Ensure that you have a serial disc changer. Only bi-directionally-controlled 
serial disc changers can scan media. 
  
If you have a serial disc changer, see the following: 
  
1. Ensure that music is added and scanned 
2. Check these sections: 
   “Setting up media stored in a disc changer” 
   “Connecting rooms” 
   “Checking control/AV connections” 
   “Connecting a device to the network” 

Cannot play music or 
music channels not 
appearing in the 
Navigators 

If music is not running, see the following: 
  
1. Ensure that the Navigator is connected to Director. See Composer Pro 
Getting Started. 
2. Ensure that a room is appearing on the Navigator. If not, click the room and 
change the room to one that can play music. 
3. Ensure that music is added and scanned. 
4. See “Connecting rooms.” 

http://dealer.control4.com/dealer/support/documentation
http://dealer.control4.com/dealer/support/documentation
http://dealer.control4.com/dealer/support/documentation
http://dealer.control4.com/dealer/support/documentation
http://dealer.control4.com/dealer/support/documentation
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5. See “Checking control/AV connections.” 
6. See “Connecting a device to the network.” 
7. Refresh the Navigators. See the Composer Pro Getting Started. 

Troubleshooting device control 
The following table lists some control problems on Control4 system devices. 

Symptom Possible problems and solutions 

The Device is not 
Controllable from a 
Navigator  

If the device, such as a dimmer, is not controllable from the Device Control 
window (double-click the device from the project tree); no connection exists. 
  
Refer to the following sections: 
“Connecting rooms” 
“Checking control/AV connections” 
“Connecting a device to the network” 

Troubleshooting Navigators 
The following table lists troubleshooting problems with Control4 Navigators. 

Symptom Possible problems and solutions 

Not seeing Room 
Location on the 
Navigators 

From a Navigator (on screen or touch screen), ensure that the device is 
connected to Director. See “Connecting rooms.” 
Check the connections: 
1. For an on-screen Navigator, see “Checking control/AV connections.” 
2. For touch screens, see “Connecting a device to the network.” 

Troubleshooting driver creation 
The following table lists troubleshooting problems when creating Control4 drivers. 

Symptom Possible problems and solutions 

IR Learning is not 
working 

1. A controller must exist in the project to run IR Learning. Add a controller. 
2. The process of capturing IR codes is very sensitive to lights, such as 
sunlight, fluorescent lights. If it is not working properly, turn off the lights or 
cover the physical hardware so that the light cannot interrupt the code capture. 
For a complete list of IR capturing guidelines, see “Guidelines for capturing IR 
codes.” 

http://dealer.control4.com/dealer/support/documentation
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Troubleshooting dimmers, switches, and 
keypads 

The following table lists troubleshooting problems with Control4 system dimmers, switches, and 
keypads. 

Symptom Possible problems and solutions 

Dimmers, switches, or 
keypads are 
not behaving correctly 

1. Reboot. Try rebooting the device by tapping the top button 15 times. On the 
6-Button Keypad, this is the top left button. This action reboots the device, but 
does not clear programming associated with the device. 
2. Reset. 
     a. Tap the top button 5 times. 
     b. Tap the bottom button 5 times. 
     c. Tap the top button again 5 times. If you are using the 6-Button Keypad, 
this is the top left and bottom left button. This clears all your network 
connections. 
     d. Go back into the Connections view > Network tab, and identify the 
device again after resetting. 

Cannot identify the device to the network 
This section provides troubleshooting instructions to identify a Control4 system device on the 
network. 

If you cannot identify a device on the network, follow these steps until the problem is 
resolved: 
1 Make sure the Control4 controller is identified in Composer Pro. In the Connections > 

Network tab, see the line item for the Control4 controller. Is there a network address for the 
controller? 

2 (Controller only) In System Design, select the controller object to check the Zserver status. 
Is the Zserver running? If not, click Enable. 

3 If the controller is identified and Zserver is running, check whether any other devices 
identify. Do they? 
• If yes, a problem exists with the individual device. On switches, dimmers, and keypads, 

if you tap the top of the button 9 times, the bottom 9 times, and the top 9 times again 
(pause for a breath in between each 9 count), this will reset the device. Doing the same 
thing with 7, 4, and 7 will make the device’s LED flash the channel it’s on (if it’s on 
Channel 14, it will flash 14 times). If the channel doesn’t match the one for your system 
remote control and controller, the channel will need to be changed. Call Control4 
Technical Support. 

Note: For Release 1.8 and later, ZigBee Pro devices select one (1) channel. Control4 
recommends that you not change the channel; Zserver determines which channel to 
use automatically based on the available frequency space. Refer to the Composer Pro 
Software Release Update Instructions - 1.7.4 to 1.8.2 on the Control4 Knowledgebase 
or on the Dealer website for details. 

• If no, some other devices in the house may be causing interference. Power down any 
2.4 GHz devices, such as microwaves and cordless phones. Continue to the next step. 

http://dealer.control4.com/dealer/support/documentation
http://dealer.control4.com/dealer/support/documentation
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4 Will the devices identify now? 
• If yes, something in the house is causing interference. Replace it, or reset the channel 

on all of your devices. You cannot reset the channel on wireless dimmers, switches, 
etc., at this time. Call Control4 Technical Support. 

• If no, a problem exists with the controller’s radio transmitter. Call Control4 Technical 
Support. 

Troubleshooting the upgrade process 
Follow these guidelines if you are experiencing Control4 upgrade or update problems.  

Basic troubleshooting guidelines 
1 Reset the device’s network settings. See “Resetting the Control4 system.” 
2 Attempt to have the update successfully downloaded while connected to a different network 

or by using a USB drive update (see “Information about older releases”). 
3 Allow the device to retry downloading the update as it automatically restarts and retries it. 
4 Is the defect install/update related to an ongoing system operation? 
5 Media not available? If it is a USB drive or network file share, make sure it is mounted (use 

the System Design view). If the media is on USB drive connected to a secondary controller, 
re-scan the media for that device. 

6 Navigator not connected to Director? Reconnect Navigator to Director. 
7 Are strange things happening to the devices?  

• Make sure all ZigBee devices are updated to the latest firmware.  
• Make sure Director and Composer Pro are using the same version. 
• Disconnect and identify any problematic devices again.  
• Power cycle all IP devices. 
• Be patient. In cases where the ZigBee mesh is moved, it can take up to five minutes for 

all connections to get re-established. 
8 Turn on Diagnostic Logging (in Composer Pro, Tools > System Diagnostics > Logging > 

Start). Use the Logging tool to determine what was happening on the system. Can you 
duplicate it, and is there a workaround? For details, see “Logging Diagnostics Information.” 

Tip: Report any problems during the update process to:  

Control4 Technical Support: 
http://www.control4.com/residential/products/resources/#techsupport  
Email: support@control4.com 
Telephone: 1-888-400-4072 

Status message  Description Resolution 
1. Device IP address detected with a 
different version — update needed. 

The Director discovered a device that is 
a different version than the Director box. Perform update. 

2. Device IP address indicated it needs 
to be updated.  

The device sent a status message to 
the Director that says it needs to be 
updated. 

Perform update. 

3. Finished update attempt. 
Current update is completed. A 
separate message notifies you of how 
many devices succeeded or failed. 

(Status message only) No action is 
required. 

http://www.control4.com/residential/products/resources/#techsupport
mailto:support@control4.com
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Status message  Description Resolution 
4. Update information was missing or 
invalid. Reinstall the files for the USB 
drive, and attempt the update again. If 
the problem persists, contact Technical 
Support. 

A Director could not find the matching 
update information for a device retrieved 
from the USB drive. This would be the 
case if files were deleted from the USB 
drive. 

Re-install the files for the USB drive, 
and attempt the update again. If the 
problem persists, contact Technical 
Support. 

5. Update information was missing or 
invalid. Contact Technical Support.  

The Director could not find the matching 
update information for a device retrieved 
from the Web. The database contains 
invalid data. 

Contact Technical Support. 

6. Director device is not yet identified. 
Please identify the Director device and 
attempt the update again. 

The system has not yet discovered the 
Director device. 

Identify the Director device, and perform 
the update again. 

7. Starting update to version 
<targetVersion>. Director version is 
<version of Director>. 

An update has started.  (Status message only) No action is 
required. 

8. Detected USB device containing 
update information. The USB device will 
be used for the update.  

The system has detected a USB drive. (Status message only)  

9. Device <ipaddress>: <Status data 
received from the device> 

The system received data from the 
device.  

(Status message only) No action is 
required. 

10. Updated: <number of updated 
devices> Failed: <number of failed 
devices> 

Follows the message “Finished update 
attempt” (number 3) to provide specific 
details. 

Reconnect, re-identify, and restart the 
update. 

11. Device <ipaddress> failed to update. 
Provides the specific IP address of any 
device that failed to update. Follows the 
message number 10 when applicable.  

Try to identify the device again, and try 
the update again. If not successful, 
contact Technical Support. 

12. Failed email results to <entered 
email address>”. Error was: <error 
number>. Verify that the VPN is 
correctly setup and functioning on your 
Director box and that a valid mail 
address was entered. Contact Technical 
Support if this problem persists. 

This is called if an error is returned 
when trying to send the summary via 
email. 

Verify that the VPN is correctly set up 
and functioning on your Director box, 
and that a valid mail address was 
entered. Contact Technical Support if 
this problem persists. 

13. Unable to obtain update version 
information from the Web interface at 
URL <url used for getting the version, 
i.e., http://webdev-1.control4.com/...>. 
Verify that Internet access is available 
from Director. 

System has not received the version 
information back from the database.  

1. Ensure that you can communicate to 
the Internet to the Website from your 
computer. Use a prompt box to ping the 
address. 
2. Ensure that you can connect to the 
Control4 controller through the Local 
Area Network. 
3. Ensure that a firewall is not blocking 
the update. 
4. If you still cannot update, use a USB 
drive for the installation. 

14. Detected devices that still need to 
be updated. Restarting the update 
process. 

To allow an update to propagate 
throughout the system, the system waits 
5 minutes after the start of the update 
before checking the status of connected 
devices. If outdated devices are still 
detected, this message is sent, and the 
system restarts the update process. 

(Status message only). No action is 
required. 

15. The information on the USB drive is 
invalid. Reinstall the update on the USB 
drive and attempt the update again. 

The system cannot parse the update-
info.html file on the USB drive. The file 
is not valid xml.  

Re-install the update on the USB drive, 
and attempt the update again. 
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Status message  Description Resolution 
16. Not enough free space on file 
system to store update information. Disk 
free = <amount of free space> needed = 
<space needed>.  
Remove stored media, log files, etc., 
and attempt the update again.  

There is not enough free space on the 
box running Director to store the largest 
set of packages for a device type.  

Remove the stored media, log files, etc., 
and attempt the update again. 

17. Unable to access the directory for 
update information. Please contact 
Technical Support.  

System cannot access the /packages 
directory. Either the disk has a serious 
problem, or the mounts didn’t work right.  

1. Ensure that you can communicate to 
the Internet to the Website from your 
computer. Use a prompt box to ping the 
address. 
2. Ensure that you can connect to the 
Control4 controller through the Local 
Area Network. 
3. Ensure that a firewall is not blocking 
the update. 
4. If you still cannot update, use a USB 
drive for the installation. 

18. Out of file space for packages.  

Ran out of disk space while 
downloading the software packages. 
The update fails, then restarts after 5 
minutes, and the “Not enough free 
space” message (number 16) displays. 

Remove the stored media, log files, etc., 
and attempt the update again. 

19. Device <ipaddress> failed because 
it reported a status of <reported device 
status>. 

The device reported that it failed to 
update. 

Try to identify the device again, and 
restart the update. If it fails again, 
contact Technical Support. 

20. Touch screen device at <IP 
address> must be docked before 
upgrading. Please dock the touch 
screen and restart the update. 

A Wireless Touch Screen was not 
properly seated in its dock when the 
update started. 

Please dock the touch screen, and 
restart the update. 

Diagnosing trouble spots 
Use the Control4 System Diagnostics tool in Composer Pro to view, monitor, and troubleshoot a 
Control4 system. 

System Diagnostics tool 
The Control4 system includes many devices running embedded operating systems 
communicating over a wired or wireless network. During installation, configuration, and 
troubleshooting, the ability to look at the overall status of the components becomes very useful.  

The System Diagnostics tool lets you gather system information to help you determine if any 
issues encountered are configuration problems, performance issues, or potential defects. 

System Diagnostics uses 
Possible uses of the System Diagnostic tool include: 

• Viewing controller performance information: 
• CPU usage 
• CPU usage history 
• Memory usage 
• Memory usage history 
• Processes running 
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• Viewing controller networking information: 
• Network type 
• Connection status 
• MAC address 
• IP address 
• Subnet mask 
• Gateway  
• DHCP status 
• DNS server information 
• View system information 

• Viewing system information: 
• Detailed lower-level information about the devices listed 

• Viewing logging information: 
• When troubleshooting a problem that is reproducible, use the System Diagnostics tool 

to capture logged information while reproducing the problem to email to Control4 
Technical Support. 

• When troubleshooting a problem that is not reproducible, connect the controller, enable 
logging, and allow the logging to continue running for a specified period of time to 
capture the problem. The logs are then captured and emailed to Control4 Technical 
Support. 

Use the Control4 Composer Pro System Diagnostics tool to view, monitor, and troubleshoot a 
Control4 system. The diagnostics information is organized into four (4) tabs: 

• Controller Performance 
• Controller Networking 
• System Info 
• Logging 

To access the System Diagnostics tool: 
1 Start Composer Pro and connect to a Director. 
2 On the menu bar, click Tools menu, then click System Diagnostics. The tool is available 

over a LAN connection using remote access. 
3 Use the tool to diagnose problems on your own, or capture and send information to Control4 

Technical Support. 
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System Diagnostics interface 
Controller Performance 
• Controller Performance—Lets you view controller performance information, including CPU 

and memory usage.  
1 Click the History button to view the history of the CPU and memory performance. 

 

Controller Networking 
View controller networking information, including network type, connection status, MAC address, 
IP address, Subnet mask, Gateway, DHCP status, and DNS server information. 

1 Click the Test Internet Connection button to test the current Internet connection. 
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System Info 
View detailed system information. 

1 Click the Save to File button to specify the location and filename for a text-file version of the 
output. 

 

Logging 
• Log system problems. 
1 Click the Start Logging button to indicate what type of logging you want displayed, and then 

allows you to “Start” the logging process. 

 

2 Click the Stop Logging button to stop the tool from logging information. 
3 Click Open Controller Log to view the logged information in a file. 
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Viewing controller performance information 
Use the Control4 Composer Pro System Diagnostics tool (Tools menu > System Diagnostics) 
to view controller performance. 

The Controller Performance tab contains information regarding CPU and memory utilization for 
the Primary Controller of the project. Asynchronous messages from the Director regarding its 
current state are also displayed. 

To view controller performance information, including CPU and memory usage: 
1 Start Composer Pro and connect to a Director. 
2 From the Tools menu, select System Diagnostics. The Controller Performance tab is 

viewable by default. 
3 View information displayed on the Controller Performance tab: 

• CPU Usage—Shows a graphical form of current CPU usage and CPU usage history for 
the primary controller, which is the Control4 controller used to control the system if 
multiple controllers exist on a system. 

• Memory Usage—Shows in graphical form the current memory usage and memory 
history for the primary controller. 

• CPU and Memory Usage by Component—Shows percentages of CPU and memory 
use per component. 

 

4 Refresh the screen or update the speed. To do this, from the View menu you can: 
• Refresh Now—Restart the real-time display of CPU and Memory usage. 
• Update Speed—Change the speed to High, Normal, Low, or Paused. 

5 View the Directory messages by clicking the History button. 
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Using the controller networking information 
Use the Control4 Composer Pro System Diagnostics tool (Tools menu > System Diagnostics) 
to use controller networking information. 

View the information, including: 

• Network type 
• Connection status 
• MAC address 
• IP address 
• Subnet mask 
• Gateway 
• DHCP status 
• DNS server information 

To use controller networking information: 
1 Start Composer Pro and connect to a Director. 
2 From the Tools menu, select System Diagnostics, and then click the Controller 

Networking tab. 
3 Ensure that the network information shown is reflective of your network. 
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4 To test your Internet connection, click the Test Internet Connection button. The screen 
displays the current status of networking services, including the CD & DVD Lookup Service, 
Media Web Service, and Updates Web Service. 

This screens shows that the example services failed. 

 

5 Click Close to exit the dialog box. 

Using system information 
Use the Control4 system Composer Pro System Diagnostics tool (Tools menu > System 
Diagnostics) to use system information. 

View System Info current configuration settings, state of the primary controller and any other 
Control4 device in the Control4 system’s current project. The information displayed is a summary 
of several commands. 

To use system information: 
1 Start Composer Pro and connect to a Director. 
2 From the Tools menu, select System Diagnostics, and then click the System Info tab. 
3 Select a device or sub-category (expanding the list as needed) in the left pane to display 

the system configuration information in the right pane. 
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4 To save the displayed information to a file, click Save to File and specify the location and 
name for the file. 

Logging diagnostics information 
Use the Control4 system Composer Pro System Diagnostics tool (Tools menu > System 
Diagnostics) to use the logging feature and log files. 

View Logging to configure, start, stop, and schedule diagnostic logging of the Control4 system. 

• Capturing Information While Reproducing a Problem—When troubleshooting a problem 
that is reproducible, use the System Diagnostics tool to capture logged information while 
reproducing the problem to email to Control4 Technical Support. 

• Enabling Logging for Debugging—When troubleshooting a problem that is not 
reproducible, connect to the controller, enable logging, and allow the logging to continue 
running for a specified period of time to capture the problem. The logs are then captured and 
emailed to Control4 Technical Support. 

• ZigBee and I/O Communications—These items are available for logging in System 
Diagnostics. 

• DirectorState.corrupt—If for any reason Director is unable to load a project file, it is saved 
to DirectorState.corrupt prior to loading a clean project file (Tools > System Diagnostics > 
Logging). 

To use system logging: 
1 Start Composer Pro and connect to a Director. 
2 From the Tools menu, select System Diagnostics, and then click the Logging tab. 

 

3 To enable logging, click Start Logging, and then select whether to save the information 
currently displayed (if any). 
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4 Select the logging categories, and then click Start. The results are displayed. 

 

5 (Optional) To save the log, but continue logging the results, click Clear Output. The logging 
feature remains enabled, but a Save As dialog box lets you specify the location and name of 
the text version of the log. 

6 (Optional) To save the log and disable the logging process, click Stop Logging. The logging 
feature is disabled, but a Save As dialog box lets you specify the location and name of the 
text version of the log. 

7 To view the controller Log, click Open Controller Log. 
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Glossary 
Glossary 

4 
4Sight: An Internet service that provides a connection to the home automation system any time 
and from any place worldwide. 

A 
AAC: Advanced Audio Coding. A successor to the MP3 format. A standard, lossy compression 
and encoding scheme for digital audio. Touts better sound quality. 

action: An activity that occurs when an event prompts it to do so. 

agent: In Control4 programming, agents provide the ability to perform complex programming by 
using functional modules. There are various types of agents; for example, Announcements, 
Email Notifications, Scheduler, Lighting Scenes, Wakeup, etc. 

AV: Audio Video 

B 
Boolean: The computer logic used to determine if a statement is ‘True’ or ‘False.’ 

button-link binding: The LED colors used based on the device; the Installer can set these 
colors independently from the device to which the colors are bound. 

C 
CD: (Compact Disc) - An optical disc that stores digital data. This format is compatible with 
Control4 products. 

client: A software or hardware device that communicates to a server for feedback from the 
server via an application for the user. 

Command: A ‘do’ statement; actions the Director communicates to a device. 

Composer: The Control4 software used to design and define a Control4 home automation 
system. 

Composer Pro: Composer is used to set up and configure Control4 devices to communicate 
with each other in a home automation system. 
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conditional: An ‘if’ statement that asks a true/false questions which are acted upon in Composer 
programming. 

configuration worksheet: Used in Composer software training to design and configure a project 
in Composer. 

connection: Binding or linking devices together in Composer so they can communicate with 
each other. 

contact: Contacts are generally used to monitor the status of something (door, window, water 
sensor, etc.) and can be hooked up through a security panel or directly using a Control4 
controller or Contact/Relay Extender. Contacts connected to a Control4 controller or 
contact/relay extender can be configured either as NC (normally closed) or NO (normally open). 

Control4 system: A home automation system designed and developed by Control4. 

Controller: The main device that makes home automation possible. There may be multiple 
controllers within a Control4 system. The controller that runs Director is referred to as the primary 
controller. 

cover art: An illustration of the cover of a DVD or CD album that displays in the Graphical or on-
screen Navigators when playing music or watching videos. 

CSV: comma-separated value. Can be used when adding media to a Control4 system. 

 

D 
device: A component that requires a device driver; code that is used to allow the Control4 
system to work with that device. 

device driver: Every device in the Control4 system needs a corresponding device driver to 
control the device. 

DHCP: DHCP (Dynamic Host Configuration Protocol) - A protocol used between a network client 
and a DHCP server (usually a router or access point) that dynamically assigns IP addresses 
from a pre-defined list to clients on a network. 

Director: Each Control4 controller (such as a Home Controller HC-500) ships with pre-installed 
Director software (Linux based) embedded in the device. The Director communicates with 
Control4 products and third-party products to enable home automation and interaction of 
individual devices. Director runs the Control4 devices. Composer Pro is the software used to 
connect to and program a system Director that resides on a controller. 

DriverWorks: The DriverWorks SDK is used to create two-way drivers for audio video (AV) and 
non-AV devices. 

DVD: (Digital Versatile Disc) – A media format for video and data storage. 

E 
end point: The end point is the final point (device) on the defined path over which audio and/or 
video content is routed to a room. An example of this would be a TV or Receiver. 

Ethernet: Uses Ethernet category 5 (CAT5 or CAT5e) wiring to transfer data. Ethernet uses a 
star network topology that allows multiple points to communicate to a single point. The Speaker 
Point® and Mini Touch Screens use Ethernet to communicate to the Control4 controller. 

event: An action; used to trigger Composer programming when programming Control4 devices. 
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F 
forward-phase dimming (also known as leading edge dimming): A type of phase-cut 
dimming in which the load is dimmed by cutting off the leading edge of each electrical cycle. This 
type of dimming must be used with magnetic transformers (magnetic low-voltage loads) and 
works well for many other load types including incandescent and cold cathode. It should not be 
used with electronic transformers (electronic low-voltage loads) unless the transformer 
specifications specifically state that Forward Phase dimming is allowed. 

file format: A format used by applications to store/read files. 

FLAC: Supported by Control4 for software release 1.8, this is a free, open source, lossless audio 
codec format that supports tagging, cover art and fast seeking. Audio is compressed with no loss 
in quality. 

full duplex: The simultaneous transfer of data in both directions. For example, on a 5” or 7” In-
Wall Touch Screen the caller can send out a call and the receiver on the other end of the call can 
answer via his or her 5” or 7” In-Wall Touch Screen and then respond. 

G 
gateway: (router)- Provides a means of communicating between two separate networks. 

H 
home network: A network installed in the customer’s home that provides an Ethernet or wireless 
connection so that Control4 devices can communicate with each other. 

home automation system: The Control4 system: a line of home automation products that 
communicate with each other over Ethernet, WiFi, or ZigBee for a total home automation 
experience. 

I 
intercom: A two-way audio and/or video communication among supported Control4 touch 
screens. 

Interviewer Wizard: An automated setup program in Composer that builds a project for home 
automation. 

IR: A device controlled using a wireless remote control device. Commands are sent via pulses of 
infrared light to the device. 

K 
keypad managed: On a keypad, the LED state is controlled by the buttons on the keypad. 

keypad unmanaged: On a keypad, the LED state of the buttons is controlled through 
programming rather than from the keypad buttons. 

L 
LCD: (Liquid Crystal Display) - A display used with some Control4 interfaces. 

LCD Navigator: An LCD device used to control lighting, music, videos, etc., on an LCD screen. 

Linux: An operating system used by several Control4 devices. 

List Navigator: A system remote control device uses a Navigator that lists the options. 

Live Connection: A term used in Composer Pro to indicate an actual connection to the network. 

loop: A type of conditional in programming; a ‘while’ statement; for example, “while the sprinklers 
are on…” 
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M 
Media Manager: Media information is stored in the Media Manager database, which will permit 
users to view the media information from the Navigators. 

MP3: A music format that makes streaming audio available. 

MP4: An audio and video format. Can also store images and subtitles. 

 

N 
Navigator: A Control4 Navigator used with the Control4 system to control lights, music, videos, 
etc. Navigator is software that the customer interacts with using a universal remote control, on-
screen Navigator, touch screen, or LCD Screen. 

O 
on-screen device: Allows you to select the controller (Media Controller or Home Theater 
Controller) in the room that controls the source for the on-screen display. 

P 
playlist: A list of songs compiled in a list. The list can be compiled by songwriter, album, song 
type, or any combination. 

Power Over Ethernet (POE): Network cabling that provides Ethernet connectivity and device 
power over a single cable for Control4 devices. 

programming: A machine-readable artificial language used to express computations that can be 
performed by a device. 

project tree: A tree view in Composer where the project is layered by the larger branches 
(Home, Office, etc.) and then the lower branches (floor, rooms, etc.), and finally to the leaf level 
(drivers). 

R 
ramp rate: The rate that a dimmer ramps up its voltage. 

relay: An electrical switch that opens and closes. A relay is controlled by another electrical 
circuit. 

remote access: The ability to access a device from a remote location. 

Remote Director: Connects you to the home network while working in Composer from a remote 
location. 

retrofit: The ability to set up a home automation system in an existing structure or home. 
Compare this with new building construction. 

reverse-phase dimming (also known as trailing edge dimming): A type of phase-cut dimming 
in which the load is dimmed by cutting off the trailing edge of each electrical cycle. This type of 
dimming must be used with electronic transformers (electronic low-voltage loads), and works well 
for many other load types including incandescent; some types of dimmable fluorescent and 
compact fluorescent; and some LED power supplies. It should never be used with magnetic 
transformers (magnetic low-voltage loads). 

RJ-45 jack: An eight-pin jack used to connect CAT5e network cables to devices through 
Ethernet signals. 

router: See gateway. Functions similar to an AP but with additional functionality for controlling 
the network; for example, coordinating traffic between different networks. 
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S 
SDDP (Simple Device Discovery Protocol): A protocol developed by Control4 to allow devices 
to be easily added to a control system. It has the ability to leverage other protocols and work on 
almost any physical layer. SDDP offers four primary functions: 

• Enable devices to use Dynamic Host Configuration Protocol (DHCP) while still being able to 
identify them uniquely. 

• Enable Director to discover devices residing within the Control4 system. 
• Enable Director to identify devices residing within the Control4 system. 
• Enable automatic installation of drivers for discovered devices. 

serial-controlled device: Serial-controlled devices with an RS-232 interface and control 
protocol often have a higher level of controllability than IR-controlled devices. Examples of serial-
controlled devices are projectors, multi-disc DVD changers, etc. 

switch: An extension of a router that adds more Ethernet ports to support additional devices or 
clients on the local network. 

system event: An action that causes another action; for example, if a projector turns on, it 
enables the other devices in the system that work with the projector. 

system remote: System remote control 

system remote control: A Control4 system remote control is a universal solution that replaces 
system remote control devices from other manufacturers, and includes programmable buttons. 
This system remote control can access on-screen (graphical) Navigators. 

T 
touch screen: A touch screen is a home automation system Navigator that controls the home’s 
lighting, music, videos, and other devices on the home automation system. 

U 
UI (user interface): The preferred term is Navigator. The Control4 interface used with Control4 
devices to control home automation, such as touch screens, MyHome apps, or on-screen 
Navigators. 

universal remote: Universal remote control. A third-party remote control that can be 
programmed to replace other remotes in the home so that only one remote is needed, replacing 
all others. Control4 system remote control devices are a type of universal remote control. 

USB (Universal Serial Bus): A format used with USB sticks that plug in to a USB port on 
Control4 devices. 

V 
Virtual Connection: A term used in Composer Pro to indicate a connection outside the network. 

Virtual Director: A connection to a virtual controller only (a PC is the Director host rather than 
the controller). Projects created or edited here are benign until the saved project is loaded onto a 
controller. 

W 
WAP: Wireless Access Protocol. The protocol used to enable wireless access of Control4 
devices. 
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WiFi: Uses bi-directional wireless technology to transfer data. WiFi (wireless fidelity) devices 
“connect” to each other by transmitting and receiving signals on a specific frequency of the radio 
band using a wireless access point. This technology uses the star network topology. WiFi uses 
high bandwidth 802.11. 

wired network: Uses Ethernet Category 5 (CAT5) wiring to send and receive data between 
devices connected to a network. 

wireless access point: A router extension with an antenna that communicates with WiFi 
devices and clients in the home. A wireless hub that connects to the wired network, and 
distributes the wireless signal. 

wireless switch: Uses the ZigBee. UL listed dimmer. Single or multi-gang. Has an air gap to cut 
power. 

WLAN: Wireless local area network. 

WMA (Windows Media Audio): – Audio data compression technology developed at Microsoft; 
an audio file format that competes with MP3. 

Z 
ZigBee: A wireless network that uses bi-directional wireless mesh network technology to transfer 
messages from one device to another. Unlike a star network topology where devices can only 
send messages to each other by sending them first to a single central device (which then 
delivers the message to the recipient device), a mesh network topology allows the devices to 
forward messages from one device to another, thereby extending the effective range of the 
network. Uses low bandwidth 802.15.4. 250 devices are allowed per controller but Control4 
recommends 125. 

ZigBee Pro: The 1.1 version of ZigBee that provides improvements in standardization by: 
allowing more interoperability with other Control4 devices, support for home automation profiles, 
and improves the scalability of multiple ZigBee access points. 

Zserver: A ZigBee server that contains software which runs on a Control4 HC-class controller. 
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Index 
Index 
0-10V (Panelized) 

Properties, 42 
0-10V dimmer, 28 
1.8.2 update, 331 
2-, 3-, 6-Button Keypad 

change LED colors, 62 
configure, 61 
Properties, 61 

3-way lights 
configure, 67 
configure 2-Button Keypad for, 67 
configure 3-Button Keypad for, 68 

4-zone amp 
configure, 72 
Properties, 73 

7" In-Wall Touch Screen with Camera 
configure, 56 

7" Portable Touch Screen 
configure, 58 
Properties, 58, 59 

7" Tabletop Touch Screen 
configure, 59 
Properties, 60 

8-Channel 0-10V Dimmer 
configure, 47, 48, 49 
Properties, 48, 49, 50 

8-Channel Dimmer 
configure, 44 
Properties, 45 

8-Channel Relay 
configure, 46 
Properties, 46 

Actions pane 
programming, 214 

Adaptive phase dimmer, 28 
Advanced Device Configuration, 

thermostat, 101 
Advanced Lighting agent, 251 

Agent 
4Store, 168 
Access, 170 
Advanced Lighting, 174 
Announcements, 252 
Custom Buttons, 255 
E-Mail Notification, 258 
Light Properties, 260 
Lighting Scenes, 261 
Macro, 264 
Media Scenes, 265 
Rhapsody, 178 
Scheduler, 268 
Screen Saver, 270 
SNMP Configuration, 105 
Timer, 271 
Variables, 273 
Wakeup, 273 

Agents 
program, 251 

Announcement agent, 251 
audio end point, 120 
Audio Matrix Switch 

configure, 71 
Audio switch 

add, 205 
configure, 71 

audio volume, 120 
Auxiliary stages, thermostat, 103 
AV devices 

configure, 71 
AV switch 

configure, 71 
Back up system, 329 
Black & Decker lock 

configure, 104 
update firmware, 325 

Bookmarks 

program, 226 
Boolean variable, 233 
Break command, 219, 221 
Broadcast message, intercom, 60 
CBM Flash Disk 

and Photo Screen Saver, 286 
CD 

add, 196 
edit, 208 

CD information 
edit, 196 

Celsius, 99 
Certified Only, 9 
CFL Load 

Wireless Dimmer, 29 
Wireless Puck Dimmer Module, 21 

Change location, 164 
Cold Start Level 

Wireless Dimmer Module, 21 
Cold Start Time 

Wireless Puck Dimmer Module, 21 
Commands 

programming, 217 
using Delay, Stop, Break, 219 

Composer Pro 
basic tasks, 1 
check version, 329 
defined, xi 
purpose, xi 
update, 322 

Composer Views Method 
example, 148 

Conditional 
program, 227 

Configure 5" or 7" In-Wall Touch 
Screen, 60 

Connection 
audio and video, 111 
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control, 111 
IP Network, 112 
network, 111 
room, 111 
verify, 112 
verify network, 124 
WiFi, 123 

Connections 
test, 129 
update when location changes, 128 

Contact information, x 
Container variables, 233 
Control and AV connections, 126 

define, 114 
disconnect, 127 
example, 115 
re-assign, 128 
verify, 127 

Control/AV connections 
disconnect, 164 
example, 163 
re-assign, 164 

Control/AV tab, 23, 126 
Control4 website, 323 
Controller 

configure, 10 
troubleshoot, 339 

controller networking, 350 
Controller networking, 347 
Controller performance 

view, 349 
Controller properties, 13 
Controllers 

configure multiple, 14 
Cooling Cutoff Point, thermostat, 102 
Cooling system 

configure, 97 
Copyright, x 
CPU Usage, 349 
Create script 

programming, 216 
Custom Buttons agent, 251 
Custom variables, 233 
Delay command, 219 
Design project 

example, 148 
Device 

cannot identify, 342 
connect to the network, 123 

Device control 
test, 129 

Device Control window 
device examples, 130 

Device driver 
create, 291 
create 2-way serial, 320 
create TCP/IP controlled, 320 
edit, 296 
export for projects, 321 
use new driver in project, 321 

Device driver creation 
overview, 293 

Device driver wizard, 291 
Device driver, locate, 8 
Device properties, 2 
Device Properties 

example, 3 
device type, 9 
Device type, 9 
Device, configure 

guidelines, 5 
Devices 

add, 324 
change order in Navigator, 290 
connect, 324 
disconnect, 324 
hide, 289 
install, 1, 185, 291 
refresh, 324 
troubleshoot, 341 
view, 290 

Dimmable (Panelized) 
Properties, 39 

Dimmer 
change LED colors, 36 
configure, 16 
Properties, 17 
troubleshoot, 342 

Director 
troubleshoot, 340 
update, 322 

disc changer 
add media, 193 
add media to, 192 
auto-scan media, 194 
media storage, 192 
search media, 195 

Disclaimer, x 
Discrete power control, 130 
Dock for iPod 

configure, 72 
Document scope, xi 
Door Station 

configure, 70 
Driver 

assign inputs and outputs, 298 
Driver creation 

guidelines, 293 
Driver database 

updates, 330 
Driver Wizard 

IR-controlled drivers, 299 
limitations, 295 
using, 295 

Drivers 
troubleshoot, 341 

DriverWorks SDK, 293 
DVD 

add, 196 
edit, 210 

DVD information 
edit, 196 

E-mail Notification agent, 251 
Emergency Stage, thermostat, 102 
Engraving 

keycaps, 65 
Events pane 

programming, 213 
External storage device 

using, 203 
Fahrenheit, 99 
Favorites 

program, 226 
Forward phase dimmer, 28 
Full duplex, intercom, 60 
Gas Fireplace Relay 

configure, 91 
Properties, 91 

GNU, x 
Gracenote, x 
Hardware connections 

example, 137 
HC-1000 

configure, 10 
HC-250 

configure, 10 
HC-300 

configure, 10 
HC-500 

configure, 10 
HC-800 

configure, 10 
Heat Stage, thermostat, 102 
Heating Cutoff Point, thermostat, 102 
heating system 

configure, 97 
HVAC 

configure, 97 
Identify device, 161 
Intercom, 60 
Intercom license, 60 
Intercom, user experience, 60 
Internet radio 

set up, 201 
Interviewer Method 

example, 135 
Interviewer wizard 

example, 135 
IO Extender 

configure, 16 
IP camera 

configure, 103 
IP device 

update, 325 
iPod dock 

configure, 72 
Properties, 72 

IR codes 
guidelines for capturing, 300 
verify in Driver Wizard, 296 
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IR driver 
create, 295, 299 
edit, 308 

Keycap 
engraving, 65 

Keypad 
troubleshoot, 342 

Keypad dimmer, 28 
LED colors 

changing on dimmer or switch, 36 
legal notice, x 
License 

Intercom, 60 
Lighting 

configure, 16 
Lighting Scenes agent, 251 
List View properties, 2 
local database, device drivers, 9 
Locks 

configure, 104 
Logging, 348, 352 
Loop, 221 
Macro agent, 251 
Make connections 

example, 154 
Manufacturer, device drivers, 9 
Max On Level 

Wireless Puck Dimmer Module, 21 
Maximum Run Time, thermostat, 102 
Media 

Auto-scan, 190 
Controller, 191 
Disc Changer, 190 
edit, 208 
Media Player, 190 
radio station, 198 
scan schedule, 189 
set up, 185 
storage, 187 
television station, 200 
test connection, 207 
troubleshoot, 340 

media database, 186 
Media Lookup Service, 186 
media management, 186 
Media Player 

configure, 83 
Properties, 84 
scan videos, 83 
set up videos, 198 

Media Scenes agent, 252 
Memory usage, 349 
Minimum On Level 

Wireless Puck Dimmer Module, 21 
Minimum Run Time, thermostat, 102 
Mobile devices 

use with Control4 system, 69 
Model, device drivers, 10 
MPEG, x 
Multi Tuner 

configure, 76 
Multi-channel amp 

configure, 74 
properties, 75 

My Drivers list, 11 
My Drivers tab, 7 
Navigator 

configure, 50 
set up Photo Screen Saver, 285 

Navigators 
troubleshoot, 341 

Network storage 
scan videos, 188 

Network tab, 124 
example, 162 

Network Tools, 124, 324 
example, 162 

Non-Dimmable (Panelized) 
Properties, 41 

Number variable, 233 
Online database 

device drivers, 9 
on-screen device, 120 
Ordering 

Keycap engraving, 65 
OS 2.0 update, 331 
Outlet Light object 

switch, 23 
Phased dimmer, 28 
Photo Screen Saver 

setup, 285 
Playlist 

create, 205 
Power Control 

switch, 23 
Power Learning, 24 

switch, 23 
power management, 297 

editing options, 297 
Power Management 

change options, 298 
Power sensing, 24 

example, 25 
wireless outlet switch, 23 

Programming 
add a room to play music, 232 
agents, 251 
basics, 212 
button to play music, 230 
button to turn up volume, 231 
commands, 217 
Conditionals, 227 
Copy and Paste, 279 
digital audio, 230 
elements of, 216 
Find and Replace, 277 
IR inputs, 281 
rooms, 230 
set default music volume, 232 

Project properties, 1 

Project tree 
add devices, 8 

Properties 
SNMP Configuration agent, 180 

Properties pane, 1 
proxy, 9 
Puck Dimmer Module 

Properties, 20 
Puck Switch Module 

Properties, 20 
Reboot Control4 system, 339 
Reboot controller, 339 
Related documents, xii 
Relay, pulse type 

configure pulse single relay, 92 
Properties, 92 

Relay, single contact 
configure, 93, 94 
Properties, 93 

Replace Legacy Control4 Device, 31 
Replace Light setting, 31 
Rhapsody agent, 252 
Rhapsody playlist, 205 
Room connection 

types, 120 
Room connections, 118 
Room properties, 2 
Room variables, 233 
Scan media 

from network, 203 
new, 187 

Scan songs, 185 
Scheduler agent, 252 
Screen Saver 

change time, 288 
program, 288 
set up custom, 287 

Screen Saver agent, 252 
Script pane 

programming, 214 
SD Video Mode, 12 
Search tab, 8 
security system, 120 
Serial codes 

for device drivers, 315 
Serial device driver, 315 

create, 318 
Serial driver 

create, 295 
SIP, 167 
SNMP Configuration agent, 105, 252 

Example, 179 
system variables, 183 
user variables, 184 

SNMP, configure, 105 
Speaker Point 

configure, 79 
configure for WiFi, 80 
network configuration, 291 

Stage Cutoff Delay, Auxiliary, 103 
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Stage Delay, Auxiliary, 103 
Stage Minimum Off Time, thermostat, 

102 
Stop command, 219, 220 
String variable, 233 
Switch 

change LED colors, 36 
troubleshoot, 342 

System configurations 
examples, 120 

system diagnostics, 345 
System information, 348, 351 
System Manager, 324 
system remote control SR-150 

properties, 51 
System Remote Control SR-150B 

configure, 51 
program buttons, 52 

system remote control SR-250 
change ZigBee channel, 54 
program buttons, 54 

System Remote Control SR-250 
change Watch/Listen sources, 51 
configure, 53 
paging, 55 
properties, 53 

Television driver 
creating IR, 301 

Temperature and temperature Control, 
120 

Temperature calibration, thermostat, 
101 

Test Internet connection, 347 
Thermostat 

heat/cool engage delta, 101 
lock, unlock, 100 
remote temperature sensor, 100 
set backlight, 100 
set date and time, 100 
setting advanced properties, 101 

Thermostat driver, 103 
Thermostat schedule, change, 100 
Thermostat, set Vacation mode, 100 
Third-party devices 

configure, 10 
Timer agent, 252 
touch screen 

configure, 60 
Touch screen 

5" or 7", 60 
Troubleshooting 

guidelines, 337 
Update Composer Pro, 322 
Update Director, 322 
Update Manager, 324 
Update system 

best practices, 328 
general steps, 328 
guidelines, 326 
software and drivers, 329 
update times, 327 

Update time 
per device, 327 

Upgrade 
troubleshooting, 343 

USB drive 
and Photo Screen Saver, 286 

USB stick 
create, 332 

USB WiFi adapter 
HC-300, 12 

Variable 
handling, 235 
room example, 234 
room, variable options, 234 
using Boolean, 236 
using custom variable agent 

number, 242 
using custom variable agent string, 

244 
Variables 

use in programming, 233 
Variables agent, 252 
Version 

updating to same firmware version, 
324 

video audio end point, 120 
Video End Point, 120 

Video mode 
set correctly, 14 

Video scanning 
from network, 188 

Video switch 
add, 205 

Video volume, 120 
Wakeup agent, 252 
Web image 

configure, 103 
While statement, 221, 222 
WiFi adapter 

HC-300, 12 
WiFi configuration, 291 
WiFi connection 

controllers, 11 
Wireless Fireplace Switch 

configure, 91 
Properties, 92 

Wireless Music Bridge, 87 
Wireless outlet dimmer 

configure, 27 
Properties, 28 

Wireless outlet switch 
configure, 22 
define connection, 23 

Wireless Puck Dimmer 
configure, 18 
Properties, 19 

Wireless Puck Switch 
configure, 18 
Properties, 19 

Wireless Thermostat 
program the schedule, 97 
Properties, 99 
setup, 97 

ZigBee 
signal strength, 126 

ZigBee device 
update, 324 

ZigBee Server, 11 
ensure it is running, 13 
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